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Аннотация
Программа AutoCAD уже многие годы является одним из наиболее мощных и

широко распространенных инструментов проектирования. Данная книга представляет
собой превосходное практическое руководство по AutoCAD 2010. Она предназначена для
всех, кто хочет освоить работу с этой программой и научиться чертить на компьютере.
Вы найдете описания всех стадий работы – от начальной настройки параметров чертежа
до вывода его на печать. Кроме того, здесь рассмотрены специальные возможности и
технологии AutoCAD 2010.
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Андрей Александрович Орлов
AutoCAD 2010

 
Введение

 
Книга, которую вы держите в руках, посвящена программе AutoCAD 2010 – это уже

23-я версия данного пакета. За долгие годы развития продукт компании Autodesk транс-
формировался из простого инструмента, способного лишь заменить собой кульман, в про-
грамму, пригодную не только для формирования двухмерных чертежей, но и для создания
реалистичных трехмерных моделей. Фактически на данный момент AutoCAD 2010 явля-
ется самой мощной системой автоматизированного проектирования (САПР), работающей
на персональном компьютере.

Данный видеосамоучитель, ориентированный в основном на начинающих пользова-
телей, послужит вам путеводителем в захватывающем мире AutoCAD. Книга снабжена
большим количеством практических примеров, а на компакт-диске находятся видеоуроки,
поэтому если вы обладаете хотя бы небольшими навыками работы на компьютере, то понять
основные приемы работы с программой сможете довольно быстро. В этом вам помогут
начальные главы. Инструменты, предлагаемые AutoCAD 2010, настолько разнообразны,
что умение их рационально использовать будет приходить постепенно, с выполнением все
новых и новых упражнений.

Значительная часть книги посвящена созданию трехмерных чертежей. Научившись
настраивать множество параметров, а также использовать разнообразные материалы и
источники света, вы сможете довольно легко создавать трехмерные реалистичные модели.
Возможно, заключительные главы видеосамоучителя, как и описание новых возможностей
программы, будут полезны опытным пользователям.
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От издательства

 
Ваши замечания, предложения и вопросы отправляйте по адресу электронной почты

dgurski@minsk.piter.com (издательство «Питер», компьютерная редакция).
Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете подробную информацию о

наших книгах.
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Глава 1

Знакомство с AutoCAD 2010
 

• Запуск программы
• Интерфейс программы
• Установки файлов чертежей
• Работа со справочной системой AutoCAD
• Резюме
Программа AutoCAD уже многие годы является одним из наиболее мощных и широко

распространенных инструментов проектирования. С выходом каждой новой версии возмож-
ности приложения становятся все шире, элементы управления модернизируются, появля-
ются новые. Если вы новичок в области автоматизированного черчения и не обладаете опы-
том работы с AutoCAD, то, прежде чем приступить к работе, вам необходимо ознакомиться с
интерфейсом программы, а также с основными принципами работы в ней. Из данной главы
вы узнаете, как запускать AutoCAD 2010, познакомитесь с ее интерфейсом, а также научи-
тесь пользоваться справочной системой приложения.
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Запуск программы

 
Как и любое приложение, разработанное для операционной системы Windows, про-

грамму AutoCAD можно запустить несколькими способами. Рассмотрим наиболее распро-
страненные из них.

• Использование меню Пуск. Для запуска программы нужно выполнить команду Пуск
→ Все программы → Autodesk → AutoCAD 2010 → AutoCAD 2010 – English.

• Использование ярлыка программы на Рабочем столе. Для запуска приложения доста-
точно найти на Рабочем столе его ярлык и дважды щелкнуть на нем.

• Если вы хотите не просто запустить программу, а открыть определенный файл чер-
тежа, необходимо открыть Проводник или любой другой файловый менеджер, с его помо-
щью найти нужный вам файл и запустить его. В результате загрузится AutoCAD и откроется
требуемый файл, а если вы уже запустили программу ранее, то просто откроется нужный
файл.

• По умолчанию программа AutoCAD не создает ярлык на панели быстрого доступа,
однако вы можете сделать это, перетащив туда ярлык с Рабочего стола или из меню Пуск
при нажатой клавише Ctrl. Запуск приложения с данной панели удобен тем, что для этого
не нужно открывать меню. Кроме того, панель быстрого доступа всегда отображается на
экране, в то время как Рабочий стол может быть закрыт запущенными приложениями.

Открыв AutoCAD любым удобным способом, вы увидите на экране окно, в кото-
ром программа предлагает указать область деятельности, наиболее приближенную к вашей
работе: архитектура, гражданское строительство, производство и т. д. (рис. 1.1).

 

Рис. 1.1. Окно мастера настройки интерфейса
В зависимости от выбранного варианта автоматически настраивается интерфейс про-

граммы. В результате инструменты, которые, по мнению разработчиков AutoCAD, больше
всего подходят для заданного вида деятельности, будут под рукой.

Чтобы открыть окно AutoCAD с параметрами по умолчанию, щелкните на кнопке Skip
(Пропустить), а в следующем окне – на кнопке Start AutoCAD 2010 (Запустить AutoCAD
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2010). В будущем при необходимости вы сможете изменить тип интерфейса в настройках
программы.

После старта программы откроется окно New Features Workshop (Семинар по новым
возможностям) (рис. 1.2).

 

Рис. 1.2. Окно New Features Workshop (Семинар по новым возможностям)
Если вы работали с предыдущими версиями AutoCAD, то можете ознакомиться с

новыми возможностями продукта в окне справки. Если вы ранее не сталкивались с этой
программой, просто откажитесь от просмотра семинара. Чтобы данное окно не появля-
лось каждый раз при запуске AutoCAD, установите переключатель в положение No, don't
show me this again (Больше не показывать). В дальнейшем при необходимости вы сможете
открыть это окно в любой момент.

Нажав кнопку OK, вы увидите рабочее окно программы AutoCAD 2010 (рис. 1.3). Воз-
можно, на первый взгляд оно покажется вам очень сложным и громоздким, однако на самом
деле интерфейс очень удобен и способен адаптироваться под конкретные задачи.
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Рис. 1.3. Рабочее окно AutoCAD 2010
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Интерфейс программы

 
Окно программы AutoCAD состоит из нескольких частей, каждая из которых выпол-

няет определенные функции: ввод команд, отображение необходимой при черчении инфор-
мации и т. д. Некоторые инструменты взаимодополняют и даже замещают друг друга.

Центральная область рабочего окна программы называется графическим экраном. В
ней выполняются все построения. На графическом экране указатель мыши приобретает вид
перекрестья и способен выполнять функции, используемые в проектировании: привязку к
объектам, задание координат и направления. При выходе за границы графического экрана
указатель приобретает привычный вид.

В верхней части окна находится лента с вкладками, на которых расположены кнопки
команд (см. рис. 1.3). Она заменила пункты меню, используемые в предыдущих версиях про-
граммы. Для пользователей, предпочитающих прежний вид окна, предусмотрена возмож-
ность переключения в режим, называемый классическим.

Рассмотрим ленту с вкладками, предназначенными для рисования двухмерных объек-
тов (видоизмененная лента для создания трехмерных объектов описана в главе 9).

• Home (Основная) – здесь собраны основные средства, используемые при работе с
чертежами. Данная вкладка содержит следующие группы команд.

· Draw (Черчение) – позволяет создавать графические примитивы, наносить штри-
ховку, создавать области или полилинии из замкнутых элементов, различные маскирующие
объекты и др.

· Modify (Редактирование) – содержит инструменты для такого преобразования объ-
ектов, как масштабирование, удлинение, поворот, выравнивание и др., а также для редакти-
рования штриховки, сплайна и других объектов.

· Annotation (Аннотационные объекты) – содержит инструменты для создания текста
и таблиц, а также для нанесения размеров.

· Layers (Слои) – позволяет работать со слоями.
· Block (Блок) – содержит инструменты для работы с блоками.
· Properties (Свойства) – позволяет управлять свойствами объектов.
· Utilities (Утилиты) – содержит инструменты измерения, быстрого выделения и под-

счета.
· Clipboard (Буфер обмена) – дает возможность работать с буфером обмена (копиро-

вать, вырезать, вставлять фрагменты и т. д.).
• Insert (Вставка) – содержит инструменты для работы с блоками и связями. На вкладке

присутствуют следующие группы команд.
· Reference (Связи) – предназначена для управления связями.
· Block (Блок) – служит для создания, вставки и редактирования блоков.
· Attributes (Атрибуты) – позволяет создавать и редактировать атрибуты данных, нахо-

дящихся в блоках.
· Import (Импорт) – используется для импорта файлов других форматов.
· Data (Данные) – содержит инструменты для работы с обновляемыми полями, объек-

тами OLE, гиперссылками и другими объектами.
· Linking & Extraction (Связывание и распаковка) – содержит команды для работы со

связями.
· Content (Содержимое) – позволяет открыть палитру DesignCenter (Центр управле-

ния), с помощью которой удобно работать с проектом. Кроме того, в данной группе располо-
жена строка поиска, используя которую можно искать уже готовые элементы дизайна, нахо-
дящиеся на сайте http://seek.autodesk.com.
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• Annotate (Аннотация) – здесь собраны инструменты для создания текстовых надпи-
сей в документе. На этой вкладке расположены такие группы команд.

· Text (Текст) – содержит инструменты для работы с текстом (изменения стиля, размера
шрифта и др.).

· Dimensions (Размеры) – предназначена для проставления размеров.
· Leaders (Выноски) – позволяет создавать и редактировать выноски.
· Tables (Таблицы) – содержит инструменты для работы с таблицами.
· Markup (Выделение) – содержит инструменты для создания областей выделения.
· Annotation Scaling (Масштабирование аннотационных объектов) – используется для

изменения масштаба аннотационных объектов. Аннотационными в AutoCAD называют раз-
личные пояснительные объекты – размеры, выноски, текст и т. д.

• Parametric (Параметрические) – включает в себя инструменты для параметрического
черчения, позволяющие работать с геометрическими и размерными ограничениями. При
использовании таких ограничений заданные соотношения между объектами остаются, даже
если сами объекты изменяются. Данная вкладка содержит следующие группы команд.

· Geometric (Геометрические) – предназначена для работы с геометрическими ограни-
чениями.

· Dimensional (Размерные) – позволяет использовать размерные ограничения.
· Manage (Управление) – дает возможность управлять ограничениями (удалять, пере-

именовывать, задавать им числовые значения, формулы и т. д.).
• View (Отображение) – позволяет управлять отображением объектов на экране. Рас-

смотрим некоторые группы команд, которые присутствуют на этой вкладке.
· Navigate (Навигация) – включает в себя инструменты для навигации по документу:

прокрутку, увеличение и уменьшение масштаба и т. д.
· Views (Виды) – позволяет выбрать наиболее удобный в данный момент вид отобра-

жения объекта. Пиктограммы наглядно показывают назначение каждой команды.
· Coordinates (Координаты) – дает возможность указать подходящую систему коорди-

нат.
· Viewports (Видовые экраны) – позволяет создавать и редактировать плавающие видо-

вые экраны.
· Palettes (Палитры) – предоставляет быстрый доступ к различным палитрам, которые

дают возможность управлять свойствами объектов, связями с другими файлами чертежей
и пометками, добавленными к документу; выполнять различные вычисления, публиковать
подшивки листов, групп листов или отдельных листов и т. д.

· Windows (Окна) – содержит команды, используемые при работе с несколькими
открытыми чертежами. С помощью этой группы вы можете размещать окна документов в
рабочей области программы, а также фиксировать их положение.

• Manage (Управление) – содержит инструменты для изменения различных настроек
программы, адаптации интерфейса приложения (рабочего пространства, панелей инстру-
ментов, меню и сочетаний клавиш) для решения конкретных задач. На этой вкладке также
находится группа команд для работы с макросами, создаваемыми на языке программирова-
ния VBA.

• Output (Вывод) – здесь собраны группы команд для настройки параметров предва-
рительного просмотра документа перед печатью, вывода его на печать, публикации в Интер-
нете и экспорта.

• Express Tools (Дополнительные инструменты) – содержит дополнительные инстру-
менты различных категорий, которые просты в использовании и охватывают широкий диа-
пазон функций программы AutoCAD, включая черчение, выделение и изменение объектов.
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Однако следует учитывать, что эти инструменты являются дополнительными и компания
Autodesk не гарантирует их корректной работы.

При выборе определенных объектов на ленте могут появляться дополнительные
вкладки для работы с ними. Например, если вы вставите в документ таблицу, на ленте
появится вкладка Text Editor (Редактор текста) с инструментами для редактирования вво-
димого в таблицу текста.

По умолчанию на ленте расположены все основные вкладки, а на них, в свою очередь,
все группы команд. Чтобы убрать вкладку с ленты, щелкните на ленте правой кнопкой мыши
и в подменю Tabs (Вкладки) снимите флажок возле названия вкладки, которую планируете
удалить с ленты. Если вы хотите убрать с вкладки какую-либо группу команд, щелкните
правой кнопкой мыши на вкладке и в подменю Panels (Группы) снимите флажок рядом с
названием группы, которую необходимо скрыть. Аналогично действуйте, если хотите доба-
вить вкладку или группу на ленту, однако в данном случае флажки придется устанавливать
рядом с нужным пунктом.

Любую вкладку можно извлечь с ленты, чтобы она превратилась в отдельную панель
(рис. 1.4). Такая панель будет отображаться, даже если вы выберете другую вкладку, до тех
пор пока вы не нажмете на этой панели кнопку Return Panels to Ribbon (Вернуть группы
на ленту).

 

Рис. 1.4. Извлеченные с ленты вкладки
Чтобы скрыть ленту, нужно щелкнуть на кнопке с направленным вниз треугольником

 

которая находится справа от названий вкладок ленты. При первом щелчке лента свер-
нется до названий вкладок и групп инструментов, при втором – полностью исчезнет с экрана.
Чтобы снова отобразить ленту, следует опять нажать кнопку с треугольником.

Над лентой расположено меню приложения (кнопка с буквой «А»
 

). В нем вы найдете пункты, которые заменяли ленту с вкладками в предыдущих вер-
сиях AutoCAD, а также некоторые другие элементы.
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Рядом с кнопкой вызова меню приложения находится панель быстрого доступа. По
умолчанию на ней располагаются кнопки часто используемых команд: New (Новый), Open
(Открыть), Save (Сохранить), Undo (Отмена), Redo (Восстановление) и Plot (Печать).

В новой версии программы панель быстрого доступа была дополнена новыми возмож-
ностями, которые позволяют удалять инструменты с панели, добавлять разделители, а также
отображать панель быстрого доступа над или под лентой.

Примечание
Вы можете самостоятельно добавить на панель быстрого доступа

необходимые элементы. Для этого щелкните на панели правой
кнопкой мыши и выберите пункт Customize Quick Access Toolbar
(Настройка панели быстрого доступа). Откроется окно Customize
User Interface (Настройка интерфейса пользователя), в основной
части которого по умолчанию расположен полный список команд
AutoCAD 2010. Чтобы быстрее найти нужную команду, можете выбрать
в раскрывающемся списке, расположенном вверху, необходимую
категорию. Чтобы добавить команду на панель, щелкните на нужной
строке кнопкой мыши и, не отпуская ее, перетащите на панель быстрого
доступа. Затем в окне Customize User Interface (Настройка интерфейса
пользователя) нажмите кнопку OK.

В левой нижней части окна программы отображаются вкладки Model (Модель),
Layout1 (Лист 1) и Layout2 (Лист 2) (рис. 1.5). По умолчанию активной является вкладка
Model (Модель), которая означает, что на экране отображено двух– или трехмерное про-
странство модели. При щелчке на какой-либо из вкладок Layout (Лист) (их количество
может быть любым) вы перейдете к пространству листа, о работе с которым будет расска-
зано в главе 8. Слева от вкладок расположены кнопки перехода между ними.

 

Рис. 1.5. Вкладки переключения между пространствами листов и модели
В левой нижней части графической области окна программы отображается указатель

пользовательской системы координат (ПСК) (см. рис. 1.5) По умолчанию в программе
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AutoCAD используется МСК — мировая система координат (World Coordinate System,
WCS). Ее указатель расположен в точке с координатами (0; 0; 0).

Справа и снизу от графической области могут находиться полосы прокрутки, пред-
назначенные для перемещения по чертежу. По умолчанию полосы прокрутки не отобража-
ются, поэтому при первом запуске программы вы их не увидите.

Совет
Для отображения полос прокрутки на экране перейдите на ленте

на вкладку View (Отображение) и в разделе Windows (Окна) щелкните
на кнопке

 

Будет вызвано окно Options (Параметры), на вкладке Display
(Экран) которого необходимо установить флажок Display scroll bars
in drawing window (Отображение полос прокрутки в окне чертежа)
(рис. 1.6).

 

Рис. 1.6. Вкладка Display (Экран) диалогового окна Options (Параметры)
В нижней части окна программы расположена строка состояния с набором кнопок

для управления отображением чертежа. Их мы рассмотрим далее, в соответствующем под-
разделе.

Программа AutoCAD позволяет пользователю самостоятельно определить цвет раз-
личных элементов рабочего окна. Для этого выполните следующие действия.
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1. Щелкните на кнопке меню с буквой «А» в левом верхнем углу окна AutoCAD.
Появится меню для выбора команд управления программой.

2. В правом нижнем углу данного меню щелкните на кнопке Options (Параметры).
3. В открывшемся диалоговом окне перейдите на вкладку Display (Экран) (см. рис. 1.6).
4. В области Window Elements (Элементы окна) щелкните на кнопке Colors (Цвета).
5. В появившемся окне Drawing Window Colors (Цвета окна чертежа) в списке Context

(Контекст) выберите разновидность окна программы, в списке Inteface element (Элемент
интерфейса) – элемент, а в раскрывающемся списке Color (Цвет) – нужный вам цвет.

Так, например, чтобы изменить фон пространства модели на белый, необходимо
в списке Context (Контекст) выбрать пункт 2D model space (Пространство двухмерной
модели), в списке Inteface element (Элемент интерфейса) – Uniform background (Однород-
ный фон), а в списке Color (Цвет) – White (Белый). При этом в поле Preview (Предваритель-
ный просмотр) цвет фона сменится на белый (рис. 1.7).

 

Рис. 1.7. Изменение фона пространства модели
6. Нажмите кнопку Apply & Close (Применить и закрыть) для сохранения изменений

и выхода из диалогового окна.
Чтобы перейти к классическому виду рабочего окна программы, щелкните на кнопке

Workspace Switching (Переключение рабочего пространства), которая находится в нижней
части окна программы (на данной кнопке написано название текущего рабочего простран-
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ства, например Initial Setup Workspace (Начальное установочное рабочее пространство)),
и выберите в появившемся списке строку AutoCAD Classic (Классический AutoCAD). Окно
программы отобразится в классическом виде, более привычном для пользователей прежних
версий (рис. 1.8).

 

Рис. 1.8. Классический вид окна программы AutoCAD
Познакомимся с ним подробнее. Строка меню включает в себя множество пунктов для

вызова различных команд и открытия диалоговых окон.
• File (Файл). Здесь находятся команды обработки файлов: создания, сохранения, вос-

становления. Кроме того, это меню содержит команды, используемые для печати докумен-
тов.

• Edit (Правка). Пункты данного меню позволяют выполнять стандартные для
Windows операции работы с буфером обмена (вырезать, скопировать, вставить), а также
команды специальной вставки, удаления, выделения и поиска.

• View (Вид). С помощью команд данного меню вы можете управлять отображением
объектов на экране. Здесь расположены такие подменю, как Zoom (Масштабирование), Pan
(Панорамирование) и др. В этом же меню находятся команды регенерации чертежей. Кроме
того, меню View (Вид) содержит команду Toolbars (Панели инструментов), при выборе кото-
рой на экране отображается диалоговое окно Customize User Interface (Настройка интер-
фейса пользователя). С помощью данного окна вы сможете создавать собственные меню,
панели инструментов, назначать сочетания клавиш для быстрого вызова команд и окон, а
также редактировать имеющиеся. Более подробно об этом диалоговом окне будет рассказано
ниже.

• Insert (Вставка). Команды этого меню позволяют вставлять в поле чертежа блоки и
объекты, созданные ранее в сторонних приложениях, а также импортировать в AutoCAD
различные файлы.
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• Format (Формат). Данное меню предназначено для вызова диалоговых окон, помо-
гающих определить множество параметров черчения. Последняя команда – Rename (Пере-
именовать) – служит для переименования различных объектов программы, таких как слои,
материалы, блоки и др.

• Tools (Сервис). Здесь вы можете изменять различные настройки программы, вызы-
вать на экран вспомогательные окна, а также загружать внешние приложения и управлять
ими. В этом же меню находится группа команд для работы с макросами, создаваемыми на
языке программирования VBA.

Подменю Workspaces (Рабочие пространства) предоставляет доступ к рабочим про-
странствам программы. Оно служит для переключения между пространствами, а также для
их настройки и сохранения.

Палитры программы сгруппированы в отдельное подменю – Palettes (Палитры). Рас-
смотрим его содержимое.

· Ribbon (Лента) – включает отображение ленты с инструментами.
· Properties (Свойства) – открывает палитру, позволяющую управлять свойствами объ-

ектов.
· Layer (Слой) – вызывает палитру, содержащую команды для работы со слоями.
· Tool Palettes (Инструментальные палитры) – открывает палитру, содержащую раз-

личные инструменты, такие как блоки, образцы штриховок и т. д., в одном окне для упро-
щения доступа к ним.

· QuickCalc (Быстрый подсчет) – вызывает палитру, позволяющую выполнить различ-
ные вычисления (эту палитру можно также вызвать сочетанием клавиш Ctrl+8).

· External References (Внешние связи) – открывает палитру, которая дает возможность
управлять связями с другими файлами чертежей.

· Sheet Set Manager (Менеджер подшивок) – вызывает палитру, служащую для публи-
кации подшивок листов, групп листов или отдельных листов.

· Markup Set Manager (Менеджер пометок) – открывает палитру, которая позволяет
управлять пометками, добавленными к документу.

· DesignCenter (Центр управления) – вызывает палитру, с помощью которой можно
управлять такими объектами чертежей, как блоки, внешние ссылки или образцы штриховки.

Подменю Palettes (Палитры) также позволяет вызывать различные палитры для
работы с освещением, материалами и визуализацией объектов. Их применение будет рас-
смотрено в главах, рассказывающих о работе с трехмерными телами. Последняя палитра –
dbConnect (Связь с базами данных) – предназначена для работы с базами данных.

Далее в меню Tools (Сервис) находятся команды: Spelling (Правописание), кото-
рая позволяет проверить орфографию в выбранном пользователем тексте, Quick Select
(Быстрый выбор), служащая для быстрого создания групп объектов, и Draw Order (Поря-
док следования), предоставляющая возможность переносить объекты на заданный план.

Подменю New UCS (Новая ПСК) содержит команды для создания новых ПСК (поль-
зовательских систем координат) с использованием различных методов, а также для редакти-
рования имеющихся систем. Команда Named UCS (Именованные ПСК) открывает диалого-
вое окно, отображающее сохраненные пользовательские системы координат.

С помощью пункта Drafting Settings (Режимы рисования) можно устанавливать необ-
ходимые настройки режимов рисования, а пункт Options (Параметры) (как говорилось
ранее) вызывает одноименное диалоговое окно, предназначенное для настройки параметров
программы.

• Draw (Черчение). Команды этого меню предназначены для создания примитивных
двух– и трехмерных объектов.
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· Подменю Modeling (Моделирование) используется для создания трехмерных объек-
тов.

· Пункт Hatch (Штриховка) позволяет наносить штриховку в выбранных областях.
· Команда Boundary (Контур) служит для создания области или полилинии из замкну-

тых объектов.
· С помощью пункта Wipeout (Маскировка) можно создавать различные маскирующие

объекты.
· Подменю Text (Текст) предназначено для создания одно– или многострочного текста.
• Dimension (Размер). С помощью команд данного меню можно создавать размеры

и выноски различных типов, таких как Linear (Линейный), Aligned (Параллельный),
Ordinate (Ординатный). Здесь же расположены команды редактирования размерных над-
писей. Команда Multileader (Мультивыноска) служит для создания мультивыносок (кото-
рые заменили собой используемые в более ранних версиях программы выноски). Более
подробно об этом мы поговорим в главе 5, посвященной нанесению размеров.

• Modify (Редактирование). С помощью этого меню можно выполнять такие преобра-
зования объектов, как масштабирование, удлинение, поворот и др.

Кроме того, здесь находятся команды редактирования таких объектов, как штриховка,
сплайн, текст и др., а также команды различных трехмерных операций и редактирования
трехмерных тел.

Подменю Annotative Object Scale (Масштаб аннотационных объектов) позволяет
добавлять и удалять значения масштаба аннотационных объектов.

• Parametric (Параметрические). Данное меню содержит команды для работы с гео-
метрическими и размерными ограничениями.

• Window (Окно). Это меню включает в себя команды, используемые при работе с
несколькими открытыми чертежами, и служит для поддержки многодокументного режима
работы.

• Help (Справка). В данном меню находятся разделы справки, содержащие полную
информацию, необходимую для работы в AutoCAD. Справочные материалы отображаются
в отдельном окне и не мешают работе с программой. Более подробно о справочной системе
будет рассказано далее.

• Express (Дополнительные средства). Это меню содержит дополнительные команды
различных категорий и обладает собственной системой справки (пункт Help (Справка)), а
также сборником ответов на наиболее часто задаваемые вопросы (пункт Express Tools FAQ
(Наиболее часто задаваемые вопросы по Express Tools)).

 
Панели инструментов

 
Панели инструментов являются графическим интерфейсом команд программы

AutoCAD, то есть выполняют соответствующие им функции. О назначении кнопки вы
можете узнать, подведя к ней указатель мыши. При этом появится всплывающая подсказка
с кратким описанием кнопки. Если для команды назначено сочетание клавиш, оно также
будет показано во всплывающей подсказке. На рис. 1.9 представлена панель инструментов
Standard (Стандартная) с указателем мыши, подведенным к кнопке Save (Сохранить).
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Рис. 1.9. Подсказки панели инструментов
Многие кнопки на панелях инструментов дублируют команды на ленте или в меню

(если вы работаете с классическим интерфейсом программы). Вы можете выбрать более
удобный для себя способ вызова команды.

В правом нижнем углу некоторых кнопок имеется маленькая черная стрелка. Если
какое-то время удерживать на ней нажатой левую кнопку мыши, на экране появится меню
с дополнительными элементами. На рис. 1.10 показано меню Zoom Window (Масштабиро-
вание окна) панели инструментов Standard (Стандартная).

 

Рис. 1.10. Меню дополнительных инструментов Zoom Window (Масштабирование
окна)

Панели инструментов могут быть закрепленными (в таком состоянии они отобража-
ются по умолчанию) и плавающими. Название плавающей панели инструментов можно уви-
деть в подсказке, появляющейся при наведении указателя мыши на панель. Для закрытия
плавающей панели инструментов предназначена кнопка с крестиком, расположенная в ее
правой части. Кнопки плавающей панели инструментов могут располагаться как в один ряд,
так и в несколько. Чтобы сделать панель плавающей, достаточно перетащить ее с помощью
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мыши на некоторое расстояние от края графического экрана. На рис. 1.11 показана плаваю-
щая панель инструментов Standard (Стандартная) с различным расположением кнопок.

 

Рис. 1.11. Различные состояния панели инструментов Standard (Стандартная)
Примечание
Если вы не хотите, чтобы панель инструментов «приклеивалась»

к краю графической области, при перемещении панели удерживайте
нажатой клавишу Ctrl.

Всего в AutoCAD 2010 имеется 44 панели инструментов. Чтобы отобразить или скрыть
какую-либо панель инструментов, щелкните на любой из них правой кнопкой мыши. На
экране появится меню, содержащее список доступных панелей (рис. 1.12).
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Рис. 1.12. Меню отображения/ скрытия панелей инструментов
Для отображения/скрытия любой панели выберите ее в меню. В нижней части меню

расположено подменю Lock Location (Место фиксации), с помощью которого вы можете
блокировать положение панелей инструментов и палитр. Например, чтобы отобразить
панель инструментов View (Вид) и блокировать ее, сделайте следующее.

1. Щелкните правой кнопкой мыши на любой панели инструментов и выберите пункт
View (Вид).

2. С помощью мыши перетащите панель инструментов, как показано на рис. 1.13.
 

Рис. 1.13. Перетаскивание панели инструментов
3. Щелкните правой кнопкой мыши на панели, в открывшемся меню выполните

команду закрепления плавающих панелей инструментов: Lock Location → Floating
Toolbars/Panels (Место фиксации → Плавающие панели ин струментов/группы).

Панель будет блокирована, и вы не сможете перемещать ее по рабочему окну. Для
отмены блокирования снова выполните эту же команду.

По умолчанию в рабочей области программы AutoCAD 2010 классического вида ото-
бражены восемь наиболее используемых панелей инструментов, присоединенных к верх-
ней, левой и правой сторонам графической области программы. Остановимся на двух наи-
более часто используемых панелях инструментов.

• Standard (Стандартная) (см. рис. 1.11) – содержит кнопки, предназначенные для
вызова базовых команд, таких как создание, открытие, сохранение файла, просмотр проекта
перед печатью и вывод его на печать, операции с буфером обмена, отмена и возврат дей-
ствий. Кроме того, здесь расположены команды вызова палитр программы.

• Workspaces (Рабочие пространства) (рис. 1.14) – служит для переключения между
рабочими пространствами программы AutoCAD 2010: 2D Drafting & Annotation (Двух-
мерное черчение и аннотирование), 3D Modeling (Трехмерное моделирование), AutoCAD
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Classic (Классический AutoCAD) и Initial Setup Workspace (Начальное установочное рабо-
чее пространство).

 

Рис. 1.14. Панель инструментов Workspaces (Рабочие пространства)
Остальные панели мы рассмотрим по мере описания работы с программой. Сейчас же

обратимся к основному средству работы с инструментами AutoCAD, а именно к инструмен-
тальной палитре, которая занимает правую часть рабочего окна программы.

 
Инструментальная палитра

 
Чтобы вызвать инструментальную палитру, выполните команду ленты View → Palettes

→ Tool Palettes (Вид → Палитры → Инструментальные палитры). На инструментальной
палитре содержатся кнопки вызова инструментов, сгруппированные по их функциональ-
ному назначению на множестве вкладок (рис. 1.15).

 



А.  А.  Орлов.  «AutoCAD 2010»

28

Рис. 1.15. Инструментальная палитра
Щелчок кнопкой мыши на значке открывает вкладку, содержащую набор кнопок для

выбора инструментов. Рассмотрим вкладки, отображаемые на инструментальной палитре
по умолчанию.

• Draw (Черчение). Кнопки в верхней части вкладки позволяют создавать различные
примитивы: Line (Отрезок), Construction Line (Прямая), Polyline (Полилиния), Polygon
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(Многоугольник) и т. д. Кнопки в нижней ее части служат для ввода более сложных объек-
тов: блоков, рисунков и др.

• Leaders (Выноски). Содержит набор кнопок, позволяющих создавать выноски.
• Command Tool Samples (Образцы командных инструментов). Включает в себя

инструменты для управления вводом команд.
• Tables (Таблицы). Здесь находятся инструменты для создания таблиц разных типов

– расписаний, легенд чертежей.
• Hatches and Fills (Штриховки и заливки). Содержит инструменты, позволяющие

закрашивать поверхность чертежа, создавая узоры, заливки и градиенты. На вкладке содер-
жится множество доступных образцов узоров и заливок.

• Structural (Конструктивные). Здесь находятся инструменты для черчения стандарт-
ных конструкций, например балок различных сечений.

• Civil (Гражданские). На вкладке собраны образцы различных знаков, применяемых
для привлечения внимания: запреты, оповещения и обозначения.

• Electrical (Электрические). Содержит обозначения, применяемые при рисовании
электротехнического оборудования: наборы выключателей, сигнальных ламп и др.

• Mechanical (Механические). Здесь собраны инструменты для рисования механиче-
ских устройств: болтов, гаек, подшипников и т. д.

• Architectural (Архитектурные). Содержит инструменты для рисования дверей, окон
и прочих конструкций, используемых в строительстве.

• Annotation (Аннотационные объекты). Здесь собраны различные пояснительные
обозначения, используемые на чертежах: стрелки, указания и примечания.

• Constraints (Ограничения). На этой вкладке представлены инструменты для работы
с геометрическими и размерными ограничениями.

• Modeling (Моделирование). Содержит сложные элементы, используемые при черче-
нии геометрических объектов: спирали, цилиндры, оси координат и т. д.

Как и все элементы пользовательского интерфейса программы AutoCAD, инструмен-
тальную палитру можно настроить в соответствии с вашими нуждами. Чтобы указать,
какие вкладки должны отображаться, щелкните правой кнопкой мыши на свободной части
палитры, чтобы вызвать контекстное меню. При выполнении команды Customize Palettes
(Настройка палитр) появляется диалоговое окно Customize (Настройка), в котором можно
сконфигурировать инструментальную палитру, добавить на нее новые вкладки и содержа-
щиеся на них инструменты.

 
Командная строка

 
Командная строка (рис. 1.16) расположена ниже графической области программы и

позволяет вводить команды с клавиатуры. В ранних версиях AutoCAD она была основным
инструментом диалога пользователя и программы, однако с выходом новых релизов значе-
ние данного элемента все больше снижается. Существенную роль в этом сыграло появление
в AutoCAD 2006 динамического ввода, позволяющего вводить команды в области рисова-
ния, рядом с графическим курсором. Тем не менее командная строка выполняет определен-
ные функции и все еще остается достаточно важным элементом интерфейса. При работе вы
периодически будете ее использовать.

 

Рис. 1.16. Командная строка
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Независимо от способа ввода команда отображается в командной строке. Кроме того,
здесь присутствуют все параметры команды, а также подсказки. После ввода команды в
командной строке появится запрос на действие с доступными параметрами команды. Вы
можете задать параметры, запустить выполнение команды или прервать его, нажав клавишу
Esc.

Командная строка хранит историю введенных команд. Однако, поскольку область
команд занимает две строки, просмотр истории затруднителен. Вы можете увеличить размер
командной строки, но это уменьшит графическую область, что очень неудобно. Для реше-
ния данной проблемы в программе AutoCAD предусмотрено отображение области команд
в отдельном окне. Если вам нужно просмотреть историю команд, нажмите клавишу F2, и
на экране появится окно AutoCAD Text Window (Текстовое окно AutoCAD) с необходимой
информацией (рис. 1.17). Чтобы убрать его, нажмите еще раз клавишу F2.

 

Рис. 1.17. Диалоговое окно AutoCAD Text Window (Текстовое окно AutoCAD)
 

Строка состояния
 

Как уже говорилось выше, в нижней части окна программы AutoCAD расположена
строка состояния (рис. 1.18).

 

Рис. 1.18. Строка состояния
Она содержит текущие координаты указателя мыши, а также кнопки включе-

ния/выключения режимов черчения. Кратко рассмотрим назначение кнопок.
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Snap Mode (Режим привязки) – включает/отключает режим шаговой привязки, то есть
привязки к точкам сетки с определенным шагом. Эту кнопку дублирует клавиша F9 на кла-
виатуре.

 

Grid Display (Отображение сетки) – включает/отключает отображение на экране
сетки. Щелчок на этой кнопке равнозначен нажатию клавиши F7.

 

Ortho Mode (Ортогональный режим) – включает/отключает ортогональный режим.
При включенном режиме перемещение указателя мыши ограничено горизонтальным и вер-
тикальным направлениями. Эту кнопку дублирует клавиша F8.

 

Polar Tracking (Полярное отслеживание) – включает/выключает режим полярного
отслеживания. Полярное отслеживание ограничивает перемещение указателя направлением
под заданным углом, облегчая выбор точек, лежащих на воображаемых линиях под одним
из заданных полярных углов. Щелчок на этой кнопке соответствует нажатию клавиши F10.

 

Object Snap (Объектная привязка) – позволяет выбирать различные точки объектов
при работе с ними, облегчая позиционирование графического курсора. Эту кнопку дубли-
рует клавиша F3.

 

Object Snap Tracking (Объектное отслеживание) – включает/выключает режим объ-
ектного отслеживания, который помогает вычерчивать объекты под определенными углами
или в определенных соотношениях с другими объектами. При включенных режимах автоот-
слеживания специальные временные линии помогают выполнять точные построения. Щел-
чок на этой кнопке равнозначен нажатию клавиши F11.

 

Allow/Disallow Dynamic UCS (Включить/выключить динамическую систему коорди-
нат) – включает/отключает режим  динамической системы координат, которая предназна-
чена для работы с трехмерными объектами и позволяет временно выровнять плоскость XY
по какой-либо имеющейся плоскости.

 

Dynamic Input (Динамический ввод) – включает/отключает режим динамического
ввода, который позволяет вводить команды и выбирать их параметры в области курсора, без
использования командной строки. Если динамический ввод включен, сведения, отображае-
мые в подсказках рядом с указателем мыши, динамически обновляются по мере его переме-
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щения. Когда команда активна, подсказки обеспечивают место для ввода, осуществляемого
пользователем.

 

Show/Hide Lineweight (Показать/скрыть толщину линий) – включает/выключает
режим отображения линий в соответствии с их толщиной.

 

Quick Properties (Краткие свойства) – включает/выключает отображение панели со
свойствами выбранного объекта.

 

Model or Paper space (Пространство модели или бумаги) – позволяет переключаться
между пространствами модели и листа.

 

Quick View Layouts (Быстрый просмотр листов) – отображает сразу все листы чертежа
в отдельных окнах небольшого размера.

 

Quick View Drawings (Быстрый просмотр чертежей) включает/выключает просмотр
чертежей.

 

Pan (Панорамирование) – панорамирование рисунка.
 

Zoom (Масштабирование) плавное изменение масштаба рисунка.
 

SteeringWheels (Управление колесиком) – включает инструмент Wheel (Колесико)
(рис. 1.19).
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Рис. 1.19. Инструмент Wheel (Колесико)
 

ShowMotion (Показать движение) – вызывает набор инструментов Motion (Движе-
ние).

 

Annotation Scale (Масштаб аннотационных объектов) меню, вызываемое нажатием
этой кнопки, позволяет установить текущее значение масштаба аннотаций. Любые аннота-
ционные объекты, добавленные на чертеж, будут отображаться в масштабе, соответствую-
щем указанному значению.

 

Annotation Visibility (Отображение аннотации) – изменяет значение системной пере-
менной ANNOALLVISIBLE. Когда ее значение равно 1, на экране отображаются все анно-
тационные объекты. Если переменной присвоить значение 0, будут видны лишь те объекты,
которые поддерживаются текущим значением аннотационного масштаба.

 

Automatically add scales to annotative objects when the annotation scale changes
(Автоматически обновлять аннотационные объекты при изменении масштаба) – регулирует
значение системной переменной ANNOAUTOSCALE и отвечает за обновление аннотаци-
онных объектов при изменении аннотационного масштаба.

 

Workspace Switching (Изменение рабочей области) – вызывает меню для выбора
режима отображения рабочей области.
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кнопка для блокирования положения панелей инструментов и окон. Пример использо-
вания данной функции был приведен выше.

 

Performance Tuner (Настройщик производительности) – тестирует вашу видеокарту
и выдает результаты в отдельном окне.

 

Application Status Bar Menu (Меню содержимого строки состояния) – в открываемом
с помощью этой кнопки меню задается отображение кнопок включения/выключения режи-
мов черчения в строке состояния (рис. 1.20).

 

Рис. 1.20. Контекстное меню настройки строки состояния
 

Clean Screen (Очистка экрана) – очищает экран. При ее нажатии исчезают все панели
инструментов – таким образом увеличивается область графического экрана. Эта функция
полезна при работе на мониторах с небольшой диагональю.

 
Палитры

 
Палитры AutoCAD – это отдельные окна, предоставляющие дополнительные функции

(рис. 1.21). По сути, это те же панели инструментов, позволяющие, однако, выполнять более
разнообразные действия и работающие в диалоговом режиме.
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Рис. 1.21. Палитра Sheet Set Manager (Менеджер подшивок)
Как и панели, палитры могут быть плавающими и прикрепленными. В плавающем

режиме у палитры появляется заголовок, содержащий название палитры и три кнопки. Верх-
няя кнопка с крестиком служит для закрытия панели. Расположенная далее кнопка со стрел-
ками скрывает/восстанавливает палитру. Эта функция позволяет палитре не занимать лиш-
нее место и при этом оставаться постоянно доступной. Нижняя кнопка открывает меню
(рис. 1.22), с помощью которого вы можете закрепить палитру у левого или правого края
рабочей области, разрешить/запретить закрепление и скрытие панели. Кроме этих пунктов,
могут быть и другие, характерные для конкретной палитры.

 

Рис. 1.22. Меню палитры Sheet Set Manager (Менеджер подшивок)
Чтобы получить доступ к палитрам, выполните команду ленты View → Palettes → Tool

Palettes (Вид → Палитры → Инструментальные палитры).
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Настройка пользовательского интерфейса

 
Программа AutoCAD предоставляет пользователю широкие возможности адаптации

интерфейса для решения конкретных задач. Управлять настраиваемыми элементами интер-
фейса, к которым относятся рабочее пространство, панели инструментов, меню и сочетания
клавиш, можно с помощью диалогового окна Customize User Interface (Настройка интер-
фейса пользователя) (рис. 1.23). Чтобы его открыть, нажмите кнопку User Interface (Интер-
фейс пользователя) на вкладке Manage (Управление) в группе Customization (Настройка)
ленты или выполните команду меню Tools → Customize → Interface (Сервис → Настройка
→ Интерфейс). Вы также можете щелкнуть правой кнопкой мыши на любой панели инстру-
ментов и в контекстном меню выбрать пункт Customize (Настройка).

 

Рис. 1.23. Диалоговое окно Customize User Interface (Настройка интерфейса пользова-
теля)

Окно открывается на вкладке Customize (Настройка), которая содержит четыре обла-
сти.

• Customizations in All Files (Настройка всех файлов) – здесь представлены элементы
настраиваемого пользовательского интерфейса, в которые можно вносить изменения. Вы
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можете изменять все файлы интерфейса или выбрать какой-либо один из раскрывающегося
списка, расположенного в верхней части области (рис. 1.24).

 

Рис. 1.24. Список файлов настраиваемого пользовательского интерфейса
• Command List (Список команд) – содержит полный перечень команд AutoCAD 2010.

Для упрощения поиска вы можете выбрать в списке категорию, которой принадлежит нуж-
ная вам команда.

• Preview (Предварительный просмотр) – отображает внешний вид выделенного объ-
екта. Здесь же можно изменить вид значка какой-либо команды. Для этого выделите команду
в списке Command List (Список команд) и в области Button Image (Значок кнопки) выбе-
рите один из предложенных значков. Если вы хотите вручную нарисовать значок, нажмите
кнопку Edit (Изменить). На экране отобразится диалоговое окно Button Editor (Редактор
кнопок) (рис. 1.25). Инструменты, предоставляемые редактором, аналогичны возможностям
графического редактора Paint – стандартного инструмента операционной системы Windows.

 

Рис. 1.25. Диалоговое окно Button Editor (Редактор кнопок)
• Properties (Свойства) – позволяет изменять свойства выделенных объектов. Напри-

мер, вы можете изменить вид кнопки, загрузив собственный графический файл.
Теперь, ознакомившись с основными элементами диалогового окна, создадим соб-

ственную панель инструментов и добавим на нее кнопки.
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1. В области Customizations in All Files (Настройка всех файлов) найдите пункт
Toolbars (Панели инструментов). Щелкните на нем правой кнопкой мыши и выберите в
появившемся меню пункт New Toolbar (Создать панель инструментов) (рис. 1.26).

 

Рис. 1.26. Создание новой панели инструментов
2. Введите название панели и определите ее свойства в области Properties (Свойства).
· Раздел General (Общие) позволяет изменить название и описание панели. Для этого

щелкните кнопкой мыши на любом пункте и введите нужное значение в правом столбце.
· В разделе Appearance (Вид) вы можете указать, будет ли панель отображаться по

умолчанию, задать ее ориентацию, координаты появления и количество строк. Например,
чтобы по умолчанию панель инструментов не отображалась на экране, щелкните на пункте
Default Display (Отображение по умолчанию). Справа появится кнопка со стрелочкой.
Щелкните на ней и в открывшемся списке выберите Do not add to workspases (Не добавлять
к рабочим пространствам).

3. Теперь следует добавить на панель команды. Для этого выберите необходимую
команду в списке и с помощью мыши перетяните ее в область Customizations in All Files
(Настройка всех файлов). Поместите указатель напротив созданной вами панели инструмен-
тов (рис. 1.27). Отпустите кнопку мыши – и команда будет добавлена на эту панель.
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Рис. 1.27. Добавление команды на панель инструментов
4. Нажмите кнопку OK для создания новой панели (рис. 1.28).

 

Рис. 1.28. Новая панель инструментов
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Установки файлов чертежей

 
Все чертежи, созданные в программе AutoCAD, хранятся в файлах с расширением

DWG. В таком файле содержится полная информация о чертеже: всевозможные стили, пара-
метры, такие как единицы измерения, режимы черчения и т. д. Формат DWG отличается
небольшим временем сохранения, особенно в случае, если это файлы с большим количе-
ством аннотационных объектов.

По мере развития программы формат используемых файлов также изменяется,
поэтому чертежи, созданные в более новых версиях AutoCAD, не могут быть открыты в
более старых. С выходом AutoCAD 2010 в формат DWG также были внесены изменения,
поэтому чертежи, по умолчанию сохраненные в AutoCAD 2010, не будут открываться в
более ранних версиях.

В предыдущих версиях программы размер единичного объекта на чертеже не мог пре-
вышать 256 Мбайт. В AutoCAD 2010 этот предел был увеличен до как минимум 4 Гбайт (в
зависимости от конфигурации вашей системы).

Для создания нового файла можно применить один из двух способов:
• без использования окна начала работы (это наиболее простой способ, который при-

меняется по умолчанию);
• с заданием различных параметров в окне начала загрузки.

 
Создание нового документа без

использования окна начала работы
 

Для создания нового файла упрощенным способом выполните следующие действия.
1. Щелкните на кнопке New (Новый)

 

на панели быстрого доступа или выполните команду меню File → New (Файл
→ Новый). На экране отобразится диалоговое окно Select template (Выбор шаблона)
(рис. 1.29). Это окно похоже на стандартное окно выбора файлов операционной системы
Windows и отображает содержимое каталога Template (Шаблон), принадлежащего директо-
рии, в которую была установлена программа AutoCAD. В данной папке находятся файлы с
расширением DWT, которые представляют собой готовые шаблоны чертежей, обладающие
некоторыми настройками и использующиеся как основа для создания документов.
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Рис. 1.29. Диалоговое окно Select template (Выбор шаблона)
2. Выделите нужный шаблон. При этом в области Preview (Образец), расположенной в

правой части окна, появится изображение объектов, которые имеются в выбранном шаблоне.
3. Выберите нужный шаблон и нажмите кнопку Open (Открыть).

Примечание
По умолчанию программа AutoCAD не содержит шаблонов,

созданных по российским стандартам черчения, поэтому при
необходимости следует самостоятельно добавить файлы нужных
шаблонов в каталог Template (Шаблон).

Если вы не хотите, чтобы в новом чертеже использовался какой-либо шаблон, нажмите
маленькую кнопку со стрелкой, расположенную справа от кнопки Open (Открыть). В
открывшемся меню выберите единицы измерения чертежа (метрические или британские),
на основе которых будет создан новый файл (рис. 1.30). Если выбрать в меню пункт Open
(Открыть), файл будет создан на основе выделенного в данный момент шаблона.

 

Рис. 1.30. Создание чертежа без шаблона
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Создание нового документа с
помощью окна начала работы

 
Чтобы при создании нового файла использовалось окно начала работы, необходимо

присвоить значение 1 системной переменной STARTUP. Для этого выполните следующие
действия.

1. Введите в командную строку название переменной и нажмите клавишу Enter или
Пробел. Появится запрос:

Enter new value for STARTUP <0>:
2. Введите 1 и снова нажмите клавишу Enter или Пробел.
3. Щелкните на кнопке New (Новый) на панели быстрого доступа или выполните

команду меню File → New (Файл → Новый). На экране появится диалоговое окно Create
New Drawing (Создание нового чертежа) (рис. 1.31).

 

Рис. 1.31. Диалоговое окно Create New Drawing (Создание нового чертежа)
Рассмотрим основные элементы этого окна.
• Заметьте, первая кнопка – Open a Drawing (Открытие чертежа) – неактивна.
Выйдите из программы AutoCAD и снова запустите ее. Теперь при щелчке на кнопке

New (Новый) на панели быстрого доступа или при выполнении команды File → New (Файл
→ Новый) будет открываться окно Startup (Запуск), в котором кнопка Open a Drawing
(Открытие чертежа) будет активна (рис. 1.32). При нажатии кнопки внутри окна отобразится
область Select a File (Выбор файла), позволяющая выбрать созданный ранее файл и открыть
его. Если нужный файл отсутствует в данной области, вы можете нажать кнопку Browse
(Обзор) и в открывшемся окне Select File (Выбор файла) найти необходимый документ. Это
окно очень похоже на Select template (Выбор шаблона), описанное выше.
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Рис. 1.32. Открытие чертежа
• Вторая кнопка – Start from Scratch (Простейший шаблон) (нажата на рис. 1.31). С

ее помощью создается чертеж, не отличающийся от чертежа, созданного первым способом
(без использования окна начала работы) без выбора шаблона.

• Следующая кнопка – Use a Template (Использовать шаблон). Создание чертежа иден-
тично созданию нового файла без использования окна Startup (Запуск). Вы можете выбрать
шаблон документа из имеющихся или отказаться от шаблонов. При нажатии кнопки Browse
(Обзор) откроется диалоговое окно Select a template file (Выбор файла шаблона).

• Последняя кнопка – Use a Wizard (Использовать мастер). Она вызывает мастер созда-
ния чертежа, с помощью которого вы сами можете настроить параметры нового документа.
Мастер может работать в двух режимах: Advanced Setup (Детальная подготовка) и Quick
Setup (Быстрая подготовка). При выборе первого способа настраивается большее количе-
ство параметров.

Создадим новый чертеж с помощью мастера детальной подготовки.
1. В окне Startup (Запуск) нажмем кнопку Use a Wizard (Использовать мастер), в обла-

сти Select a Wizard (Выбрать мастер) выделим пункт Advanced Setup (Детальная подго-
товка) и нажмем кнопку OK (рис. 1.33).

 



А.  А.  Орлов.  «AutoCAD 2010»

44

Рис. 1.33. Вызов мастера создания нового чертежа
2. В первом окне мастера (рис. 1.34) предлагается выбрать единицы измерения чер-

тежа, а также, в раскрывающемся списке, точность значений (количество знаков после запя-
той). Настроив параметры, нажимаем кнопку Далее.

 

Рис. 1.34. Выбор единиц измерения
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3. Следующее окно позволяет выбрать единицы измерения углов, а также их точность.
Снова вводим свои значения и нажимаем кнопку Далее.

4. Затем указываем направление нулевого угла. Вы можете выбрать East (Восток),
North (Север), West (Запад), South (Юг) или указать произвольное значение (отсчет при
этом будет происходить от направления East (Восток)). Устанавливаем нужные значения и
нажимаем кнопку Далее.

5. После этого необходимо задать направление отсчета углов: против часовой стрелки
или в ее направлении. Делаем свой выбор и нажимаем кнопку Далее.

6. В последнем окне вы можете установить размер области, доступной для рисования.
Вводим соответствующие параметры и нажимаем кнопку Готово. Чертеж создан.

 
Сохранение и завершение работы

 
Для сохранения документа нажмите кнопку Save (Сохранить) на панели быстрого

доступа либо на панели инструментов Standard (Стандартная). Можно также выполнить
команду меню File → Save (Файл → Сохранить). На экране появится диалоговое окно Save
Drawing As (Сохранить чертеж как) (рис. 1.35).

 

Рис. 1.35. Окно сохранения чертежа
В нем вы можете выбрать каталог для сохранения, название файла, а также его тип:

DWG или DXF (тип файлов, который можно открыть в других приложениях, а не только
в AutoCAD). При этом вы можете указать версию формата, то есть, например, сохранить
чертеж в формате, совместимом с ранними версиями программы.

Если вы хотите сохранить файл под другим названием, щелкните на кнопке меню
с буквой «А» в левом верхнем углу окна программы и выполните команду Save As →
AutoCAD Drawing (Сохранить как → Чертеж AutoCAD). На экране появится то же диало-
говое окно Save Drawing As (Сохранить чертеж как), в котором можно ввести нужное имя.
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При этом будет создана копия файла, а то, что вы сделали до этого момента, будет сохранено
в прежнем месте под прежним названием.

Чтобы закрыть чертеж, щелкните на кнопке меню с буквой «А» и выполните команду
Close → Current Drawing (Закрыть → Текущий чертеж) либо нажмите кнопку с крестиком
в правом верхнем углу окна чертежа. Для завершения работы программы нажмите сочета-
ние клавиш Ctrl+Q либо вызовите меню кнопки с буквой «А» и щелкните на кнопке Exit
AutoCAD (Выйти из AutoCAD) в правом нижнем углу. Можно также нажать кнопку с кре-
стиком в правом верхнем углу окна программы.
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Работа со справочной системой AutoCAD

 
Справочная система программы AutoCAD реализована на основе стандартной справки

операционной системы Windows, с которой вы могли сталкиваться и ранее, при работе с дру-
гими приложениями. Система помощи содержит исчерпывающую информацию по работе
с AutoCAD. Предусмотрено несколько способов получения данных по интересующему вас
вопросу. Рассмотрим каждый из них.

 
Поиск нужной информации в

справочной системе программы
 

Наиболее простой способ вызова справочной системы AutoCAD – нажатие на клави-
атуре клавиши F1, которая является стандартной для вызова справки во всех приложениях
операционной системы Windows. Кроме того, можно воспользоваться командой меню Help
→ Help (Справка → Справка) или кнопкой

 

в правой части строки заголовка программы. Справка отобразится в отдельном окне
(рис. 1.36) и, таким образом, не будет мешать работе с программой.

 

Рис. 1.36. Окно справочной системы программы AutoCAD 2010
Данное окно разделено на две части. Левая часть служит для поиска нужной инфор-

мации, правая – для отображения выбранного раздела справочной системы.
Панель инструментов, расположенная в верхней части окна, содержит стандартные

кнопки:
• Скрыть – служит для скрытия области поиска информации;
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• Назад – предназначена для перехода на предыдущую просмотренную страницу
справки;

• Вперед – позволяет вернуться на страницу, которая просматривалась до нажатия
кнопки Назад;

• Домой – служит для перехода на начальную страницу справочной системы, которая
открывается при вызове справки;

• Печать – позволяет распечатать выделенный раздел;
• Параметры – открывает меню, которое содержит все перечисленные пункты, а также

некоторые дополнительные возможности, характерные для веб-браузеров.
В области поиска информации находятся три вкладки.
• Содержание – отображает содержание справки в виде стандартного дерева папок

Проводника.
Пользователь сам ищет нужную информацию в иерархической структуре справки.
• Указатель – позволяет искать информацию по ключевым словам, которые вводятся

с клавиатуры в специальное поле. По мере ввода ключевых слов в области, расположенной
ниже, отображается список найденных разделов (рис. 1.37).
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Рис. 1.37. Вкладка Указатель
При выборе раздела его содержимое отображается в правой части окна. Если раздел

является множественным, на экране появится диалоговое окно Найденные разделы, в кото-
ром вы можете уточнить свой выбор (рис. 1.38).

 

Рис. 1.38. Выбор раздела
• Search (Поиск) – служит для поиска по всей справочной системе на основе запроса,

сделанного в разговорной форме. Для поиска достаточно задать интересующий вас вопрос
и нажать клавишу Enter или щелкнуть на кнопке Search (Поиск). В результате в области
ниже появится перечень найденных разделов справки (рис. 1.39). Нажав кнопку со стрелкой
>, расположенную справа от поля ввода, можно задать условия поиска. В находящемся ниже
раскрывающемся списке можно выбрать разделы справки, в которых будет выполняться
поиск.

 

Рис. 1.39. Вкладка Search (Поиск)
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Семинар по новым возможностям

 
Как уже говорилось, семинар по новым возможностям – это мультимедийная презен-

тация, в которой пользователи могут познакомиться с новыми возможностями программы
AutoCAD. По умолчанию семинар запускается каждый раз при загрузке программы (см.
рис. 1.2). Вы также можете открыть его, щелкнув на стрелке кнопки

 

и выбрав пункт New Features Workshop (Семинар по новым возможностям).
 

Дополнительные ресурсы
 

Помимо использования справочной системы программы, пользователи AutoCAD
могут получить техническую поддержку через Интернет. При подключении к центру под-
писки становятся доступны такие сервисы, как интерактивные уроки или прямая техниче-
ская поддержка. Кроме того, вы можете просмотреть запросы других пользователей о тех-
нической поддержке и, возможно, найти ответы на свои вопросы.

В дополнение ко всему программа AutoCAD предоставляет прямые ссылки на сайты
компании Autodesk для получения полезной информации о программе. Такие ссылки рас-
положены в меню Help (Справка) и меню кнопки

 

 
Инфоцентр

 
Расположенные в правой части заголовка окна AutoCAD строка поиска и кнопки при-

надлежат инфоцентру (InfoCenter) – инструменту AutoCAD, позволяющему найти ответы
как в разделах справки, так и интерактивно, используя службу поддержки.

Совет
Если строка поиска не видна на экране, щелкните на кнопке с

треугольником
 

слева от кнопки с биноклем.
В строке поиска по умолчанию написано Type a keyword or phrase (Введите ключе-

вое слово или фразу). Введите в эту строку свой запрос и нажмите кнопку Search (Поиск)
или клавишу Enter. Через некоторое время вы увидите результаты поиска прямо в окне про-
граммы (рис. 1.40).

 



А.  А.  Орлов.  «AutoCAD 2010»

51

Рис. 1.40. Результаты поиска по запросу polygon
По умолчанию программа ищет ответ в разделах справки, однако при необходимости

вы можете добавлять собственные места поиска. В правой части заголовка области Search
(Поиск) расположена кнопка InfoCenter Settings (Настройки инфоцентра)

 

Она открывает окно InfoCenter Settings (Настройки инфоцентра) (рис. 1.41), в котором
вы можете указать свое местонахождение, место поиска ответов на вопросы, выбрать каналы
новостей и т. д. Кнопка Close (Закрыть)
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закрывает область Search (Поиск).
 

Рис. 1.41. Диалоговое окно InfoCenter Settings (Настройки инфоцентра)
Кнопка Communication Center (Коммуникационный центр)

 

на панели инфоцентра служит для представления пользователю информации о продук-
тах компании Autodesk. Коммуникационный центр обеспечивает доступ к последним ново-
стям и обновлениям Autodesk, новинкам службы технической поддержки, содержит ссылки
на свежие статьи и Советы на сайте компании.

Кнопка Favorites (Избранное)
 

открывает список избранных мест в справке инфоцентра.



А.  А.  Орлов.  «AutoCAD 2010»

53

 
Резюме

 
Конечно, глава 1 – это лишь первый шаг в изучении AutoCAD, однако без него невоз-

можно двигаться дальше. Познакомившись с интерфейсом AutoCAD, вы увидели, что,
несмотря на внешнюю сложность, эта программа очень удобна и способна легко адаптиро-
ваться для выполнения поставленных задач: пользователь может добавлять и удалять эле-
менты интерфейса, изменять их и даже создавать собственные. Гибкая система справки
позволяет в любой момент получить ответ на интересующий вопрос, не прерывая работу
над чертежом.

В следующей главе мы приступим непосредственно к черчению: создадим такие при-
митивные объекты, как отрезок, дуга, эллипс и др.
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Глава 2

Первые шаги: создание геометрических объектов
 

• Создание отрезков
• Методы задания координат
• Прямоугольник и многоугольник
• Прямая и луч
• Окружность
• Дуга
• Эллипс и эллиптическая дуга
• Кольца и точки
• Полилиния
• Сплайн
• Свойства объектов и слои
• Резюме
В предыдущей главе вы познакомились с интерфейсом программы, основными прин-

ципами ее функционирования и приемами работы с файлами чертежей. Теперь самое время
приступить непосредственно к черчению. Любой, даже очень сложный чертеж состоит из
множества простых геометрических объектов – отрезков, многоугольников, окружностей
и т. п. Такие объекты в терминологии AutoCAD называются примитивами. Данная глава
посвящена созданию объектов в двухмерных чертежах (на плоскости). Кроме того, быстро
познакомиться с выполнением этих задач вам помогут соответствующие видеоролики.

Чтобы приступить к созданию любого примитива, необходимо воспользоваться одним
из следующих способов.

Наверное, проще всего вызывать команды построения примитивов с помощью кно-
пок на вкладке Home (Основная) в группе Draw (Черчение) либо на панели инструментов
Draw (Черчение) (рис. 2.1), по умолчанию расположенной слева в вертикальном положении
(если вы работаете с классическим интерфейсом AutoCAD). Те же команды можно вызвать,
выбрав соответствующий пункт в меню Draw (Черчение).

 

Рис. 2.1. Панель инструментов Draw (Черчение)
Можно также строить примитивы, используя палитру Tool Palettes (Инструменталь-

ные палитры). Кнопки для вызова команд создания геометрических объектов расположены
на вкладке Draw (Черчение) (см. рис. 1.15).

Чтобы настроить рабочую область наиболее удобным способом для черчения двух-
мерных объектов, щелкните на кнопке Workspace Switching (Переключение рабочего про-
странства) в правой части строки состояния и выберите пункт 2D Drafting & Annotation
(Двухмерное черчение и аннотирование).

В процессе создания примитивов пользователю необходимо задавать точки, а про-
грамма, используя координаты этих точек, создает объекты. Например, чтобы получить
отрезок, необходимо указать координаты его начальной и конечной точек. Поэтому парал-
лельно с рассмотрением вопросов создания примитивов будем знакомиться с различными
способами задания координат.
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Создание отрезков

 
Начнем с вычерчивания одного из самых простых примитивов – отрезка. Отрезки явля-

ются наиболее часто используемыми объектами любого чертежа, поэтому команда LINE,
создающая их, применяется очень часто.

Итак, чтобы начертить отрезок, щелкните на кнопке Line (Отрезок) на вкладке Home
(Основная) в группе Draw (Черчение) ленты или на такой же кнопке на панели инструментов
Draw (Черчение), вызвав тем самым команду LINE.

В ответ на ваши действия программа выдаст запрос, предложив указать координаты
первой точки отрезка:

Specify first point:
Мы не будем строить линии каких-то определенных размеров, поэтому, чтобы задать

точку, просто щелкните кнопкой мыши в любом месте графического экрана.
На экране появится второй запрос:
Specify next point or [Undo]:
В ответ на него необходимо указать расположение второй точки отрезка. Подвигайте

мышью, не выводя указатель из графической области, – вы увидите, что от первой указанной
точки и до перекрестья протянулась «резиновая нить», которая растягивается или уменьша-
ется в зависимости от положения указателя (рис. 2.2). Так программа показывает конфигу-
рацию будущего отрезка. Поэтому, чтобы продолжить его построение, переместите указа-
тель в нужное место графического экрана и щелкните кнопкой мыши. В итоге между первой
и второй указанными точками будет создан отрезок. Если требуется построить только один
отрезок, нажмите клавишу Enter или Esc, чтобы завершить выполнение команды.

 

Рис. 2.2. Построение отрезка
Так как выполнение команды LINE можно повторять произвольное количество раз, на

экране повторно появится запрос, который позволяет задать координаты третьей точки:
Specify next point or [Undo]:
Так можно создать цепочку из двух отрезков, идущих друг за другом (рис. 2.3).
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Рис. 2.3. Ломаная линия из двух отрезков
Указывая расположение очередной точки, можно ошибиться. По этой причине, чтобы

не повторять все с самого начала, отмените построение последнего отрезка, воспользовав-
шись параметром Undo. Чтобы выбрать один из параметров, предлагаемых командой, необ-
ходимо набрать на клавиатуре букву (или несколько букв), выделенных в наименовании
параметра с помощью регистра (в данном случае это U), и нажать клавишу Enter. Таким
образом, выбирая параметр Undo несколько раз подряд, можно выполнить откат нескольких
действий внутри команды, вплоть до отмены самой команды.

Запрос, который вы увидите после указания координат третьей точки (то есть после
построения двух отрезков), и все последующие запросы выглядят несколько иначе:

Specify next point or [Close/Undo]:
Итак, появился дополнительный параметр – Close. Если выбрать его (рис. 2.4, вверху),

то программа автоматически завершит построение ломаной, создав отрезок, соединяющий
последнюю точку последовательности отрезков с самой первой указанной точкой (рис. 2.4,
внизу).

 

Рис. 2.4. Построение замкнутой ломаной линии
Сейчас, чтобы начать построение нового отрезка или ломаной, достаточно нажать кла-

вишу Enter, которая вызовет последнюю выполнявшуюся команду. В нашем случае это
команда LINE. В ответ на запрос командной строки Specify first point: достаточно опять
нажать клавишу Enter, чтобы программа в качестве первой точки нового отрезка приняла
конечную точку предыдущего построенного объекта. В данном случае это будет точка, в
которой было завершено построение ломаной.

Если же последним созданным примитивом была дуга, то построение отрезка начнется
из последней точки этой дуги и отрезок будет направлен по касательной к дуге. При этом
появится приглашение:

Length of line:
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В ответ на этот запрос необходимо указать длину нового отрезка – либо с помощью
клавиатуры ввести нужное числовое значение, либо, щелкнув кнопкой мыши, задать на чер-
теже точку, расстояние от которой до конечной точки дуги и будет принято в качестве длины
нового отрезка.

Если последним был построен объект, который не имеет конечной точки (например,
окружность), то программа обратится к предпоследнему построенному примитиву, и так до
тех пор, пока не будет найден подходящий объект. Если же такого объекта на чертеже не
окажется, то появится сообщение об ошибке:

No line or arc to continue.
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Методы задания координат

 
Тренируясь чертить отрезок в предыдущем разделе, вы научились задавать координаты

с помощью мыши.
Однако этот способ не является единственным: координаты можно вводить с клавиа-

туры, а можно по-прежнему с помощью мыши, но используя вспомогательные средства –
шаговую и объектную привязку.

 
Ввод с клавиатуры

 
Чаще всего эскиз модели (детали, здания) создается на бумаге, а уже в электронный

вариант переносится сформировавшаяся идея. Поэтому, работая над новым чертежом на
компьютере, необходимо указывать точные координаты элементов модели.

 
Абсолютные декартовы координаты

 
Мы привыкли определять координаты на плоскости, используя прямоугольную

систему координат, в которой положение точки определяется с помощью двух осей — X
и Y. Это декартова система координат. Точка, в которой пересекаются оси X и Y, называ-
ется началом координат. Смещение объекта относительно этой точки вдоль осей определяет
его координаты. В этом случае координаты записываются в формате X,Y, где X и Y – это
смещение точки относительно начала координат в направлении осей X и Y соответственно.
Например, запись 5.5,-7 означает, что точка смещена относительно начала координат на 5,5
единицы в положительном направлении оси X и на 7 единиц в отрицательном направлении
(обратите внимание на знак минуса перед семеркой) оси Y.

Примечание
Запомните, что точка является разделителем целой и дробной

частей, а в качестве разделителя между абсциссой и ординатой служит
запятая.

 
Относительные декартовы координаты

 
Чтобы задавать расположение точек предыдущим методом, необходимо знать коорди-

наты каждой указываемой точки. Но чаще всего априори такие данные неизвестны – обычно
инженер располагает только информацией о размерах объекта. В этом случае можно вос-
пользоваться более продуктивным методом указания расположения точек: задавать коор-
динаты относительно предыдущей указанной точки, а не относительно начала координат.
Форма записи в этом случае следующая: @X,Y. Например, запись @3,5 означает, что новая
точка будет расположена со смещением относительно предыдущей заданной точки на 3 еди-
ницы вдоль положительного направления оси X и на 5 единиц вдоль положительного напра-
вления оси Y. На тот факт, что используются относительные координаты, указывает символ
@ в начале записи.

Чтобы понять суть относительных координат, представьте, что началом координат вре-
менно становится предыдущая точка, и относительно ее уже задается расположение новой
точки.
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Полярные координаты

 
Бывают такие ситуации, когда известно направление (угол) и расстояние до точки.

Тогда лучше воспользоваться полярными координатами, которые также могут быть абсо-
лютными и относительными. Абсолютные полярные координаты используются гораздо
реже, чем относительные.

Абсолютные полярные координаты записываются в формате расстояние<угол, а при
использовании относительных добавляется символ @ – @расстояние<угол. Например,
запись @10<30 говорит о том, что новая точка расположена на расстоянии 10 единиц от
предыдущей, и при этом вектор, направленный из предыдущей точки к новой, образует с
положительным направлением оси X угол 30°. Заметим, что расстояние обязательно должно
выражаться положительным числом.

 
Ввод расстояний

 
Положение точки можно определить комбинированным способом – используя как кла-

виатуру, так и мышь. Чтобы указать положение очередной точки с помощью этого метода,
переместите мышь в нужном направлении, а затем введите с клавиатуры расстояние от пре-
дыдущей точки до новой и нажмите клавишу Enter. Данный способ удобно совмещать с
использованием ортогонального режима или полярной привязки.

 
Динамический ввод данных

 
В ранних версиях программы (до AutoCAD 2006) все запросы и приглашения для ввода

данных можно было увидеть только в командной строке. По этой причине при работе с про-
граммой приходилось постоянно переводить взгляд с графической области на командную
строку и обратно. Если учесть, что при этом приходится множество раз сосредотачиваться
то на одном объекте, то на другом, можно представить, сколько на это тратится времени.
Создатели AutoCAD попробовали решить данную проблему с помощью режима Dynamic
Input (Динамический ввод). Его суть состоит в том, что данные можно вводить рядом с кур-
сором, поэтому нет необходимости переключать внимание на другие области.

Чтобы включить динамический ввод данных, щелкните на кнопке Dynamic Input
(Динамический ввод)

 

в строке состояния. Теперь вводимая команда будет отображаться в окне подсказки
рядом с указателем мыши (см. рис. 2.2).

Когда вы наберете команду и нажмете клавишу Enter, рядом с указателем появится
запрос команды и, может быть, одно или два поля для ввода данных. Например, два поля
появляются, если требуется указать координаты точки: в первое поле следует ввести коор-
динату x, а во второе – координату y. Переключаться между окнами для ввода данных можно
с помощью клавиши Tab.

Если команда обладает набором параметров, то вы будете проинформированы об этом
с помощью небольшой кнопки со стрелкой, указывающей вниз (она появится рядом с запро-
сом). Теперь, чтобы выбрать нужный параметр, нажмите на клавиатуре клавишу управле-
ния курсором, указывающую вниз. Раскроется небольшое меню (рис. 2.5), из которого вы
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сможете выбрать нужный параметр, перемещаясь по нему с помощью клавиш управления
курсором.

 

Рис. 2.5. Запрос программы в режиме динамического ввода
Режим динамического ввода настраивается на вкладке Dynamic Input (Динамический

ввод) диалогового окна Drafting Settings (Режимы рисования), которое появляется после
выполнения команды Tools → Drafting Settings (Сервис → Режимы рисования). Это же окно
настройки можно вызвать, выбрав пункт Settings (Настройки) в контекстном меню, которое
появляется после щелчка правой кнопкой мыши на кнопке Dynamic Input (Динамический
ввод), расположенной в строке состояния. В последнем случае окно отображается открытым
на вкладке Dynamic Input (Динамический ввод), как на рис. 2.6.
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Рис. 2.6. Настройки режима Dynamic Input (Динамический ввод)
На вкладке Dynamic Input (Режимы рисования) по умолчанию установлены все

флажки, что делает режим динамического ввода максимально информативным. Напри-
мер, при установленном флажке Show command prompting and command input near the
crosshairs (Показывать подсказки командной строки и ввод команд возле перекрестья)
команды и их запросы будут выводиться в графическом окне рядом с указателем мыши.

В режиме Dynamic Input (Динамический ввод) положение точек можно задавать двумя
способами: непосредственным вводом координат точек и вводом расстояний, если это воз-
можно. Установите флажок Enable Pointer Input (Разрешить ввод точек), если необходимо
иметь возможность задания координат точек. Если при этом еще будет установлен флажок
Enable Dimension Input where possible (Разрешить ввод размеров, когда это возможно), то
расположение точек в динамическом режиме будет задаваться вводом направления (угла) и
расстояния до точки. Кнопки Settings (Настройки) позволяют изменить настройки соответ-
ствующего способа задания точек в динамическом режиме.

 
Полярная привязка

 
Для указания новой точки у пользователя есть возможность «привязаться» к опреде-

ленным углам, которые еще называются опорными. Когда указатель мыши будет находиться
рядом с одним из таких углов, программа как бы поможет установить нужный угол, про-
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информировав об этом с помощью пунктирной линии и соответствующей надписи в окне
подсказки (рис. 2.7).

 

Рис. 2.7. Использование полярной привязки
Чтобы потренироваться в использовании полярной привязки, создадим треугольник

из линейных сегментов произвольных размеров, повернутый на 33° относительно горизон-
тального направления (рис. 2.8).

 

Рис. 2.8. Фигура, которую мы будем создавать
Предварительно настроим опорные углы на вкладке Polar Tracking (Полярное отсле-

живание) диалогового окна Drafting Settings (Режимы рисования) (рис. 2.9).
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Рис. 2.9. Настройка опорных углов
Напомним, что это окно открывается после выполнения команды Tools → Drafting

Settings (Сервис → Режимы рисования). Если выбрать пункт Settings (Настройки) в кон-
текстном меню, которое появляется после щелчка правой кнопкой мыши на кнопке Polar
Tracking (Полярное отслеживание)

 

в строке состояния, окно Drafting Settings (Режимы рисования) открывается сразу на
вкладке Polar Tracking (Полярное отслеживание).

Включите режим полярной привязки, установив флажок Polar Tracking On (F10)
(Включить полярное отслеживание (F10)).

Примечание
В один момент времени может быть включен либо ортогональный

режим (в строке состояния нажата кнопка Ortho Mode (Ортогональный
режим)), либо режим полярной привязки (в строке состояния нажата
кнопка Polar Tracking (Полярное отслеживание)).

В раскрывающемся списке Increment angle (Приращение угла) можно выбрать одно
из присутствующих значений углов отслеживания. Установив флажок Additional angles
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(Дополнительные углы), вы сможете ввести значения новых опорных углов, щелкнув на
кнопке New (Новый). Правда, количество таких дополнительных углов ограничено десятью.
Кроме того, если углы, присутствующие в списке Increment angle (Приращение угла), про-
грамма воспринимает как шаг приращения (например, при выбранном значении угла 15°
опорными будут являться все углы, кратные 15: 15°, 30° и т. д.), то введенные дополнитель-
ные углы воспринимаются как абсолютные значения.

С помощью переключателя, расположенного в области Object Snap Tracking Settings
(Настройки объектного отслеживания), указывается, какие углы программа будет воспри-
нимать в качестве опорных: только ортогональные или все введенные. Кроме того, опорные
углы могут измеряться не только абсолютно, но и относительно последнего сформирован-
ного объекта, если установить переключатель в области Polar Angle measurement (Изме-
рение полярного угла) в положение Relative to last segment (Относительно последнего сег-
мента).

Далее выполните следующие действия.
1. Выберите в раскрывающемся списке Increment angle (Приращение угла) значение

90, что в последующем поможет вам создать прямой угол треугольника.
2. Установив флажок Additional angles (Дополнительные углы), щелкните на кнопке

New (Новый) и введите число 33.
3. Установите переключатель Object Snap Tracking Settings (Настройки объектного

отслеживания) в положение Track using all polar angle settings (По всем полярным углам),
чтобы «привязаться» к созданному ранее углу 33°. Переключатель Polar Angle measurement
(Измерение полярного угла) установите в положение Relative to last segment (Относительно
последнего сегмента), чтобы иметь возможность указать угол 90°. Для возврата в режим
черчения нажмите кнопку OK.

4. Запустите команду LINE, щелкнув на кнопке Line (Отрезок) на вкладке Home
(Основная) в группе Draw (Черчение) ленты или на кнопке Line (Отрезок) на панели инстру-
ментов Draw (Черчение). В ответ на запрос Specify first point: введите с клавиатуры коорди-
наты первой точки, например 50, 100, и нажмите клавишу Enter.

5. Переместите перекрестье вправо и вверх от первой указанной точки, чтобы на экране
появилась штриховая линия, а возле указателя мыши – подсказка, информирующая о при-
вязке к углу 33°. Можете подвигать мышь так, чтобы указатель перемещался вдоль линии.
Когда установите перекрестье в нужное положение, щелкните кнопкой мыши, чтобы завер-
шить создание первого катета треугольника.

6. Когда появится запрос Specify next point or [Undo]:, переместите указатель влево
и вверх, чтобы установить привязку к углу 90°. На этот раз задайте длину катета вводом
соответствующего числа, после чего нажмите клавишу Enter.

7. В ответ на запрос Specify next point or [Close/Undo]: выберите параметр Close, чтобы
завершить создание треугольника.

 
Объектная привязка

 
Методы задания координат точек с помощью клавиатуры не являются единственными.

Обычно гораздо удобнее задавать точки, если известно, как должны быть расположены
новые объекты относительно имеющихся. Например, если вы знаете, что создаваемый отре-
зок должен начинаться с середины существующего, то с помощью режима объектной при-
вязки можно легко указать расположение начала нового отрезка, даже не зная численные
значения координат этой точки.

Когда режим объектной привязки включен, при наведении указателя мыши на объект, к
которому он может быть привязан, точка привязки отмечается маркером, вид которого зави-
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сит от типа точки. Об этом же информирует возникающая рядом с указателем подсказка
с названием типа точки. Кроме того, указатель сам как бы притягивается к обозначенной
точке. Пользователю достаточно щелкнуть кнопкой мыши, и создаваемой точке будут при-
своены абсолютно такие же координаты, как у точки привязки.

Чтобы использовать режим объектной привязки максимально эффективно, его жела-
тельно настроить в соответствии со своими потребностями. Включить, отключить и настро-
ить объектную привязку можно на соответствующей вкладке диалогового окна Drafting
Settings (Режимы рисования) (рис. 2.10), которое появляется после выполнения команды
Tools → Drafting Settings (Сервис → Режимы рисования). На этой вкладке окно можно
открыть, выбрав пункт Settings (Настройки) в контекстном меню, которое появляется после
щелчка правой кнопкой мыши на кнопке Object Snap (Объектная привязка)

 

в строке состояния.
 

Рис. 2.10. Окно настройки объектной привязки
Флажок Object Snap On (F3) (Включить объектную привязку (F3)) позволяет включать

или отключать объектную привязку.
С помощью флажков, находящихся в области Object Snap modes (Режимы объ-

ектной привязки), устанавливают способ объектной привязки. Перечислим возможные
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методы объектной привязки, из названия которых понятно, к какой точке объекта они уста-
навливают привязку: Endpoint (Конечная точка), Midpoint (Середина), Center (Центр),
Node (Узел), Quadrant (Квадрант), Intersection (Пересечение), Extension (Продолжение),
Insertion (Точка вставки), Perpendicular (Перпендикуляр), Tangent (Касательная), Nearest
(Ближайшая), Apparent intersection (Кажущееся пересечение), Parallel (Параллельно).
Рядом с каждым элементом расположен небольшой рисунок, демонстрирующий, как будет
выглядеть маркер при включении данного режима объектной привязки.

Кнопки Select All (Выбрать все) и Clear All (Очистить все) позволяют соответственно
включить или отключить сразу все режимы объектной привязки.

В большинстве случаев объектная привязка значительно упрощает создание чертежей,
однако бывают такие ситуации, когда постоянное притягивание указателя к той или иной
точке лишь мешает работе над чертежом. Тогда лучше отключить привязку, нажав клавишу
F3 или щелкнув на кнопке Object Snap (Объектная привязка) в строке состояния. Если
все же изредка необходима привязка к точкам на чертеже, то можно использовать разовую
объектную привязку. Суть данного метода состоит в том, что вы включаете конкретный
режим объектной привязки только для того, чтобы указать с ее помощью расположение
одной точки. Когда программа предложит задать координаты очередной точки, щелкните
правой кнопкой мыши на графической области, удерживая нажатой клавишу Shift. На экране
появится контекстное меню (рис. 2.11), в котором можно выбрать нужный режим объектной
привязки для указания координат только одной точки.
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Рис. 2.11. Контекстное меню для выбора типа привязки
В этом меню есть режим Mid Between 2 Points (Между двумя точками), позволяющий

указать две точки и задать таким образом привязку к третьей точке, расположенной на оди-
наковом расстоянии от двух первых.

Чтобы лучше понять принцип работы объектной привязки, построим отрезок, один
конец которого будет совпадать с концом другого отрезка, а второй – с серединой еще одного,
третьего, отрезка.

1. Предварительно создайте два отрезка, расположив их произвольным образом.
2. Щелкните правой кнопкой мыши на кнопке Object Snap (Объектная привязка)

в строке состояния и выберите в появившемся меню пункт Settings (Настройки), чтобы
вызвать диалоговое окно Drafting Settings (Режимы рисования) (см. рис. 2.10). Проследите
за тем, чтобы был установлен флажок Endpoint (Конечная точка) и снят флажок Midpoint
(Середина).

3. Установите флажок Object Snap On (F3) (Включить объектную привязку (F3)),
чтобы включить объектную привязку, и закройте окно, нажав кнопку OK.

4. Вызовите команду LINE и в ответ на запрос Specify first point: наведите указатель на
конечную точку первого отрезка. Когда точка будет помечена оранжевым маркером в виде
квадрата, щелкните кнопкой мыши так, чтобы задать первую точку создаваемого отрезка.
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5. Нажмите клавишу Shift и, щелкнув правой кнопкой мыши, выберите режим Mid
Between 2 Points (Между двумя точками).

6. В командной строке появится запрос First point of mid:. Подведите указатель к
одному из концов второй линии и при появлении оранжевого квадрата щелкните кнопкой
мыши.

7. Теперь в ответ на запрос Second point of mid: нужно указать второй конец линии. В
результате щелчка на нем линия к середине этого отрезка будет построена.

 
Отслеживание объектной привязки

 
Режим объектного отслеживания позволяет создавать новые объекты, расположенные

в заданной позиции относительно уже имеющихся объектов. При использовании отслежива-
ния объектной привязки практически отпадает необходимость во вспомогательных постро-
ениях, так как новые точки задаются в интерактивном режиме исходя из расположения
выбранных объектов.

Чтобы включить режим отслеживания объектной привязки, необходимо нажать
кнопки Object Snap (Объектная привязка) и Object Snap Tracking (Объектное отслежива-
ние) в строке состояния. Настройка отслеживания объектной привязки выполняется в диа-
логовом окне Drafting Settings (Режимы рисования) (см. рис. 2.10).

На рис. 2.12 показано, как с помощью режима отслеживания объектной привязки
задать расположение точки, привязанной к концам двух отрезков.

 

Рис. 2.12. Использование режима объектного отслеживания
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Прямоугольник и многоугольник

 
Команда RECTANGLE позволяет создавать прямоугольники. Обычно для этого сле-

дует указать две противоположные угловые точки. Однако при необходимости прямоуголь-
ник можно создать и несколько иным способом, воспользовавшись дополнительными пара-
метрами.

Для созданя прямоугольника вызовите команду RECTANGLE, щелкнув на кнопке
Rectangle (Прямоугольник) на вкладке Home (Основная) в группе Draw (Черчение) ленты.
Можно также нажать эту кнопку на панели инструментов Draw (Черчение) или выполнить
команду меню Draw → Rectangle (Черчение → Прямоугольник), если вы работаете с клас-
сическим интерфейсом AutoCAD.

Если необходимо создать простой прямоугольник, укажите любым известным вам спо-
собом координаты первого угла в ответ на запрос:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:
Параметры, предоставляемые командой, позволяют создавать прямоугольники нестан-

дартной конфигурации.
• С помощью параметров Chamfer и Fillet можно создать прямоугольник с фаской или

скруглением (см. главу 6).
• Параметры Elevation и Thickness пригодятся, когда вы начнете работать в трехмерном

пространстве. С помощью параметра Elevation создается обычный прямоугольник, однако
он строится в плоскости, параллельной XY, на определенном расстоянии, которое и задается
с помощью параметра Elevation. Параметр Thickness позволяет задать толщину прямоуголь-
ника – размер по вертикали.

Примечание
Лучше понять суть параметров Elevation и Thickness вы сможете,

когда познакомитесь с трехмерным пространством.
• После выбора параметра Width появится запрос:
Specify line width for rectangles <0.0000>:
В ответ необходимо задать ширину линии прямоугольника.
После определения координат первого угла появится запрос:
Specify other corner point or [Area/Dimensions/Rotation]:
Указав расположение второй угловой точки, вы создадите прямоугольник (рис. 2.13).

 

Рис. 2.13. Создание прямоугольника
Кроме того, можно выбрать один из параметров.
• Параметр Area предназначен для создания прямоугольника заданной площади. При

его выборе появится запрос:
Enter area of rectangle in current units <100.0000>:



А.  А.  Орлов.  «AutoCAD 2010»

70

После ввода площади прямоугольника появится следующий запрос:
Calculate rectangle dimensions based on [Length/Width] <Length>:
Если вам известна длина стороны прямоугольника, нажмите клавишу Enter, а если

вы хотите в последующем указать ширину прямоугольника, выберите параметр Width. В
ответ на запрос Enter rectangle length <10.0000>: введите длину прямоугольника. Если же вы
выбрали параметр Width, то программа попросит указать не длину, а ширину прямоуголь-
ника. В любом случае после нажатия клавиши Enter прямоугольник будет сформирован –
размеры недостающей стороны программа подсчитает самостоятельно, исходя из данных,
указанных ранее.

• Параметр Dimensions позволяет создать прямоугольник, зная его линейные размеры.
При его выборе появляется запрос:

Specify length for rectangles <10.0000>:
После ввода длины прямоугольника появится следующий запрос:
Specify width for rectangles <10.0000>:
Задайте ширину прямоугольника. После нажатия клавиши Enter вам необходимо будет

задать одно из четырех возможных положений прямоугольника.
• Прежде чем окончательно сформировать прямоугольник, вы сможете задать угол его

поворота, воспользовавшись параметром Rotation. При этом появится запрос:
Specify rotation angle or [Pick points] <0>:
Введя значение угла поворота, нажмите клавишу Enter, чтобы вернуться к предыду-

щему запросу и задать размеры создаваемого прямоугольника.
Мы рассмотрели создание прямоугольника, который является частным случаем мно-

гоугольника. Многоугольник – это примитив, представляющий собой замкнутый контур.
Команда POLYGON позволяет создать правильный многоугольник (имеющий равные сто-
роны).

Чтобы начертить многоугольник, щелкните на кнопке Polygon (Многоугольник) на
вкладке Home (Основная) в группе Draw (Черчение) ленты. Можно также нажать одно-
именную кнопку на панели инструментов Draw (Черчение) или выполнить команду Draw
→ Polygon (Черчение → Многоугольник), если вы работаете с классическим интерфейсом
AutoCAD. В первую очередь программа предложит указать количество сторон правильного
многоугольника:

Enter number of sides <4>:
Введите нужное количество сторон (от 3 до 1024) или сразу нажмите клавишу Enter,

чтобы принять значение, предлагаемое по умолчанию. Появится запрос:
Specify center of polygon or [Edge]:
С помощью параметра Edge вы сможете создать многоугольник указанием координат

двух конечных точек одной из его сторон (соседних углов многоугольника). При выборе
данного параметра появится запрос:

Specify first endpoint of edge:
После определения координат угла команда выдаст следующий запрос:
Specify second endpoint of edge:
Задайте координаты второй точки, определив тем самым размеры и ориентацию мно-

гоугольника на чертеже.
После указания центра многоугольника программа попросит вас выбрать нужный

параметр:
Enter an option [Inscribed in circle/Circumscribed about circle] <I>:
• Параметр Inscribed in circle позволяет сформировать многоугольник, указав радиус

мнимой окружности, описанной около него, то есть окружности, проходящей через все вер-
шины многоугольника (рис. 2.14, а).
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• Выбрав параметр Circumscribed about circle, вы сможете создать многоугольник, ука-
зав радиус окружности, вписанной в многоугольник, для которой все стороны многоуголь-
ника будут являться касательными (рис. 2.14, б).

 

Рис. 2.14. Построение многоугольника и окружности, описанной около него (а) и впи-
санной в него (б)

Задайте радиус вспомогательной окружности в ответ на запрос:
Specify radius of circle:
Если ввести числовое значение радиуса с клавиатуры и нажать клавишу Enter, то мно-

гоугольник будет ориентирован так, что одна из его сторон будет параллельна оси X. Вос-
пользовавшись мышью, вы сможете не только задать радиус, но и сориентировать много-
угольник необходимым образом.
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Прямая и луч

 
Нередко для создания чертежа приходится строить прямые, называемые еще линиями

построения. Благодаря линиям построения можно увидеть соответствие между различными
проекциями одного и того же объекта (рис. 2.15), а точку пересечения линий построения
можно использовать для объектной привязки. Для этих же целей можно применять отрезки,
построение которых мы рассмотрели в начале главы, но основное преимущество прямых
состоит в том, что они имеют бесконечную длину. Если быть более точным, то длина прямых
в AutoCAD ограничена графической областью.

 

Рис. 2.15. Применение прямых для связи различных проекций одной детали
Вспомогательные прямые удобно создавать на отдельном слое, чтобы впоследствии

можно было манипулировать ими вместе, например быстро удалить после завершения
работы над чертежом.

Чтобы построить прямую, введите команду XLINE или щелкните на кнопке
Construction Line (Линия построения) на вкладке Home (Основная) в группе Draw (Черче-
ние) ленты либо нажмите эту же кнопку на панели инструментов Draw (Черчение).

Появится приглашение командной строки:
Specify a point or [Hor/Ver/Ang/Bisect/Offset]:
Укажите первую точку, через которую должна проходить прямая, или выберите один

из параметров.
• Параметры Hor и Ver предназначены для создания соответственно горизонтальной

и вертикальной прямых с наименьшими усилиями. После выбора одного из параметров
появится запрос:

Specify through point:
После указания точки, принадлежащей новой прямой, выполнение команды успешно

завершится.
• Параметр Ang позволяет построить прямую под определенным углом. После выбора

данного параметра появится запрос:
Enter angle of xline (0) or [Reference]:
Введите угол наклона создаваемой прямой. По умолчанию этот угол отсчитывается

от прямой X декартовой системы координат, однако с помощью параметра Reference можно
указать объект (линию, прямую, луч или полилинию), от которого будет вестись отсчет угла.
При выборе этого параметра команда выдаст запрос:

Select a line object:
Чтобы создать линию построения, задайте в ответ нужный объект.
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• Параметр Bisect служит для построения биссектрисы угла – прямой, делящей угол
пополам. Если вы выберете данный параметр, команда выдаст запрос:

Specify angle vertex point:
Необходимо задать любую точку, принадлежащую будущей прямой. Обычно удобнее

всего задавать вершину угла. Затем появится следующий запрос:
Specify angle start point:
Задайте точку, принадлежащую одной из сторон угла. Появится запрос:
Specify angle end point:
После указания точки, принадлежащей второй стороне угла, в ответ на данный запрос

биссектриса появится на чертеже. Продолжая указывать следующие точки, вы можете
построить биссектрисы различных углов, базой для которых послужит первая указанная
сторона угла.

• С помощью параметра Offset создаются линии построения, параллельные какому-
либо прямолинейному объекту чертежа. При этом можно за один прием создать несколько
прямых, параллельных различным объектам. При выборе этого параметра появится пригла-
шение:

Specify offset distance or [Through] <Through>:
В ответ задайте расстояние, на котором будет расположена параллельная прямая.

Выбрав параметр Through, можно указать на чертеже точку, через которую должна пройти
прямая.

Появится следующий запрос:
Select a line object:
Щелчком кнопкой мыши выберите объект, параллельно которому должна быть распо-

ложена создаваемая прямая. Команда выдаст запрос:
Specify through point:
Щелкните кнопкой мыши на нужной грани объекта, указав, в какую сторону от него

должна быть смещена создаваемая прямая.
Далее будет появляться запрос Select a line object:, в ответ на который вы сможете выби-

рать другие стороны объекта и строить прямые параллельно им.
Если вы не использовали ни один из перечисленных параметров, то после указания

первой точки, через которую должна проходить прямая, появится запрос:
Specify through point:
В ответ на него задайте вторую точку прямой, завершив ее построение. Вы можете

создать сколько угодно таких линий, задавая различные точки. Чтобы завершить выполнение
команды, нажмите клавишу Enter или Esc.

Кроме прямой, вы можете построить луч, который отличается от прямой тем, что имеет
точку, ограничивающую его длину с одной стороны. Использование лучей вместо прямых
помогает визуально разгрузить чертеж.

Чтобы создать луч, вызовите команду RAY, нажав кнопку Ray (Луч) на вкладке Home
(Основная) в группе Draw (Черчение) ленты или выполнив команду меню Draw → Ray
(Черчение → Луч). Появится запрос:

Specify start point:
Задайте начальную точку луча. Команда выдаст следующее приглашение:
Specify through point:
Укажите вторую произвольную точку, принадлежащую лучу. Вы можете построить

несколько лучей, выходящих из первой заданной точки. Завершите выполнение команды
нажатием клавиши Enter или Esc.

Примечание
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Хотя теоретически прямая является бесконечно длинным
объектом, она имеет так называемую концептуальную середину – это та
первая точка, которую вы указывали при создании прямой. Поэтому вы
смело можете привязываться к ней в будущем.

Луч не имеет середины, зато у него есть начальная точка, которую
вы также можете использовать при объектной привязке.
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Окружность

 
Окружность является криволинейным примитивом, который часто используется на

чертежах самого различного назначения.
Параметры, которые необходимо задать при построении окружности, показаны на

рис. 2.16.
 

Рис. 2.16. Параметры окружности
Для создания окружности используется команда CIRCLE, которую можно вызвать

щелчком на одноименной кнопке на вкладке Home (Основная) в группе Draw (Черчение)
ленты. Щелкнув на стрелке справа от кнопки, вы можете выбрать нужные параметры окруж-
ности (рис. 2.17).
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Рис. 2.17. Способы построения окружности
Активизировать инструмент Circle (Окружность) можно также на панели инструмен-

тов Draw (Черчение). Если вы работаете с классическим интерфейсом AutoCAD, выбрав
одну из команд в подменю Draw → Circle (Черчение → Окружность), вы начнете построе-
ние окружности с определенным параметром.

Появится приглашение команды:
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
Укажите центральную точку окружности или выберите один из предложенных пара-

метров.
• Однозначно задать конфигурацию окружности можно с помощью параметра 3P, ука-

зав три точки, принадлежащие ей. Последовательность задания точек не имеет значения.
Обратите внимание: чтобы выбрать данный параметр, его необходимо набрать полностью
– 3P.

• Параметр 2P позволяет создать окружность, задав расположение двух диаметрально
противоположных точек. При выборе этого варианта программа предложит указать распо-
ложение первой точки:

Specify first end point of circle's diameter:
Затем попросит задать вторую точку:
Specify second end point of circle's diameter:
В ответ следует ввести координаты второй точки окружности. Заметим, что нужно обя-

зательно задавать такие две точки окружности, через которые можно было бы провести диа-
метр.

• С помощью параметра Ttr можно создать окружность, определив две касательные к
ней и радиус. При выборе данного параметра появится запрос:

Specify point on object for first tangent of circle:
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Щелкните кнопкой мыши на том объекте, который послужит касательной к создавае-
мой окружности. Появится приглашение:

Specify point on object for second tangent of circle:
Задайте вторую касательную, после чего команда выдаст следующий запрос:
Specify radius of circle <10.0000>:
Введите радиус окружности.

Примечание
Команда CIRCLE имеет еще один параметр. Выбрав в меню

кнопки Circle (Окружность) команду Tan, Tan, Tan (см. рис. 2.17),
вы сможете построить окружность, касательную к трем объектам,
последовательно задав их с помощью указателя мыши (рис. 2.18).

 

Рис. 2.18. Использование команды Tan, Tan, Tan
Задайте радиус окружности в ответ на приглашение:
Specify radius of circle or [Diameter] <10.0000>:
При выборе параметра Diameter вы сможете построить окружность, указав ее диаметр.
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Дуга

 
Дуга представляет собой некоторую часть окружности. Следовательно, при построе-

нии дуги следует задать еще и ту часть окружности, которую нужно оставить.
В AutoCAD существует возможность создать дугу одним из множества способов, что

может запутать неискушенного пользователя. Однако, разобравшись в терминологии и сути
процесса, вы сможете выбрать наиболее подходящий способ вычерчивания дуги в каждой
конкретной ситуации. Разобраться с параметрами построения дуги вы сможете, взглянув на
рис. 2.19.

 

Рис. 2.19. Параметры, используемые при построении дуги
Чтобы вызвать команду построения дуги ARC, щелкните на одноименной кнопке на

вкладке Home (Основная) в группе Draw (Черчение) ленты. Щелкнув на стрелке справа от
кнопки, вы можете выбрать нужные параметры дуги (рис. 2.20).
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Рис. 2.20. Способы построения дуги
Активизировать инструмент Arc (Дуга) можно также на панели инструментов Draw

(Черчение). Если вы работаете с классическим интерфейсом AutoCAD, выбрав одну из
команд в подменю Draw → Arc (Черчение → Дуга), вы начнете построение дуги с конкрет-
ным параметром.

Уже на первом шаге программа предлагает выбрать один из двух принципиальных спо-
собов построения дуги:

Specify start point of arc or [Center]:
Нажав клавишу Enter, вы начнете формировать дугу с указания начальной точки, а

выбрав параметр Center, сможете создать часть окружности, определив координаты ее цен-
тра.

В качестве примера рассмотрим создание дуги с указанием ее центра – этот способ
является, наверное, одним из наиболее наглядных.
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1. В ответ на запрос о выборе способа построения дуги выберите параметр Center.
Появится приглашение:

Specify center point of arc:
2. Задайте координаты центральной точки окружности, частью которой является фор-

мируемая дуга. Появится запрос:
Specify start point of arc:
3. Задайте координаты первой граничной точки дуги. Команда выдаст следующий

запрос:
Specify end point of arc or [Angle/chord Length]:
4. Завершите построение дуги, указав расположение второй граничной точки, или

выберите один из параметров.
• Используйте параметр Angle, чтобы построить дугу с указанием угла приращения,

который следует задать в ответ на запрос:
Specify included angle:
• Параметр chord Length позволяет завершить создание дуги. При его выборе появится

приглашение:
Specify length of chord:
В ответ укажите длину хорды.
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Эллипс и эллиптическая дуга

 
Как и окружность, эллипс представляет собой криволинейный замкнутый примитив.

Только у эллипса можно выделить два взаимно перпендикулярных направления, в одном из
которых он имеет максимальный размер, а в другом – минимальный.

 
Вычерчивание эллипса

 
Чтобы создать эллипс (рис. 2.21), вызовите команду ELLIPSE, щелкнув на одноимен-

ной кнопке на вкладке Home (Основная) в группе Draw (Черчение) ленты. Можно также
активизировать эту кнопку на панели инструментов Draw (Черчение) либо выбрать нужный
пункт в подменю Draw → Ellipse (Черчение → Эллипс), если вы работаете с классическим
интерфейсом AutoCAD.

 

Рис. 2.21. Параметры, используемые при построении эллипса
Появится приглашение команды:
Specify axis endpoint of ellipse or [Arc/Center]:
Задайте первую конечную точку одной из осей эллипса – малой или большой. Кроме

того, вы можете выбрать один из параметров.
• Параметр Arc позволяет создать эллиптическую дугу, построение которой мы рас-

смотрим чуть ниже.
• Воспользовавшись параметром Center, можно начертить эллипс, зная координаты его

центра. При выборе данного параметра появится приглашение:
Specify center of ellipse:
Укажите расположение центральной точки эллипса. Дальнейшее построение эллипса

происходит точно так же, как если бы вы задали координаты первой граничной точки оси
эллипса.

Укажите расположение второй конечной точки оси эллипса, когда появится запрос:
Specify endpoint of axis:
Следующим шагом является задание длины второй оси эллипса. Появится запрос:
Specify distance to other axis or [Rotation]:
Введите числовое значение длины второй оси эллипса и нажмите клавишу Enter,

чтобы завершить вычерчивание эллипса.
Выберите параметр Rotation, чтобы создать малую ось эллипса путем задания угла вра-

щения окружности, радиус которой равен большой оси эллипса. Как известно, если смо-
треть на круглый объект не перпендикулярно, а под углом, то контуры такого предмета будут
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представлять собой эллипс. Основываясь на данном эффекте, можно построить эллипс и в
программе AutoCAD. При выборе параметра Rotation появится приглашение:

Specify rotation around major axis:
Введите значение угла поворота окружности вокруг большой оси эллипса в диапазоне

от 0 до 89,4°. При угле 0° будет создана окружность с диаметром, равным длине большой
оси эллипса, которую вы определили на предыдущем этапе. При угле 90° эллипс принял бы
вид отрезка, поэтому возможный диапазон углов и ограничен значением 89,4°.

 
Создание эллиптической дуги

 
Так же, как обычная дуга является частью окружности, эллиптическая дуга предста-

вляет собой часть эллипса. Поэтому процесс ее построения во многом аналогичен созданию
эллипса: сначала формируется сам эллипс, а затем указывается, какую его часть следует
оставить (рис. 2.22).

 

Рис. 2.22. Параметры, используемые при построении эллиптической дуги
Чтобы начертить эллиптическую дугу, на вкладке Home (Основная) в группе Draw

(Черчение) на ленте из меню кнопки Ellipse (Эллипс) выберите пункт Elliptical Arc (Элли-
птическая дуга). Можно также выполнить команду меню Draw → Ellipse → Arc (Черчение
→ Эллипс → Дуга), если вы работаете с классическим интерфейсом AutoCAD. Еще один
способ – ввести в командную строку ELLIPSE, а затем выбрать параметр Arc. Появится
запрос:

Specify axis endpoint of elliptical arc or [Center]
Как уже говорилось, сначала необходимо сформировать эллипс, определяющий кон-

фигурации будущей дуги. Поэтому в ответ на данный запрос задайте координаты первой
конечной точки одной из осей или выберите параметр Center, чтобы указать центральную
точку создаваемой эллиптической дуги. Появится приглашение:

Specify other endpoint of axis:
В ответ укажите координаты второй конечной точки оси. Команда выдаст запрос:
Specify distance to other axis or [Rotation]:
Задайте длину оси эллипса.
Далее вам предложат указать начальный угол дуги:
Specify start angle or [Parameter]:
Введите числовое значение угла или выберите параметр Parameter. Появится запрос:
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Specify end angle or [Parameter/Included angle]:
Укажите конечный угол, чтобы завершить формирование дуги.
При выборе параметра Included angle введите значение внутреннего угла в ответ на

запрос Specify included angle for arc <180>:, чтобы таким образом создать эллиптическую
дугу.

Примечание
Следует знать, что и начальный и конечный углы эллиптической

дуги отсчитываются от большой оси полного эллипса. Сначала это
может показаться непривычным, однако на практике использовать
данный способ гораздо удобнее, чем если бы углы были привязаны к
ПСК. А вот внутренний угол, естественно, отсчитывается от начального
угла.
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Кольца и точки

 
 

Кольцо
 

Кольцо представляет собой примитив, ограниченный двумя концентрическими окруж-
ностями различного диаметра (рис. 2.23).

 

Рис. 2.23. Параметры, используемые при построении кольца
Команда, создающая кольцо, имеет два наименования: DONUT и DOUGHNUT.

Поэтому, чтобы начертить кольцо, введите одну из команд или на вкладке Home (Основная)
в группе Draw (Черчение) ленты нажмите кнопку Donut (Кольцо). Можно также выполнить
команду меню Draw → Donut (Черчение → Кольцо). Появится запрос:

Specify inside diameter of donut <0.5000>:
Введите величину внутреннего диаметра кольца. Задав нулевой внутренний диаметр,

вы создадите заполненную окружность. Если же в ответ на это приглашение щелкнуть кноп-
кой мыши на графической области, то появится предложение ввести вторую точку:

Specify second point:
После определения второй точки программа сможет принять в качестве внутреннего

диаметра кольца расстояние между этими двумя точками. Появится запрос:
Specify outside diameter of donut <1.0000>:
Точно таким же образом укажите внешний диаметр кольца. Наконец, появится следу-

ющее приглашение:
Specify center of donut or <exit>:
В ответ задайте координаты центра кольца.



А.  А.  Орлов.  «AutoCAD 2010»

85

Вы можете расположить на чертеже несколько колец одинаковой конфигурации, пока
не завершите команду с помощью контекстного меню либо нажав клавишу Enter или Esc.

Настроить внешний вид кольца можно с помощью системной переменной FILLMODE.
По умолчанию ее значение равно 1, а кольца при этом заполняются сплошным цветом
(рис. 2.24, слева). Если этой переменной присвоить значение 0, то пространство кольца будет
заполнено радиальными линиями (рис. 2.24, справа).

 

Рис. 2.24. Вид кольца при различных значениях переменной FILLMODE
Чтобы отключить сплошную заливку, введите команду FILL. Появится приглашение:
Enter mode [ON/OFF] <ON>:
Выберите параметр OFF, что равносильно присвоению системной переменной значе-

ния 0.
 

Точка
 

В AutoCAD 2010 присутствует возможность задавать координаты точек различными
способами, в том числе используя такие вспомогательные методы, как объектная привязка.
Поэтому порой бывает необходимо создать вспомогательные объекты, к которым в после-
дующем можно было бы установить привязку. Иногда для этих целей используют точки.

В меню Draw → Point (Черчение → Точка) можно найти две команды: Single Point
(Единственная точка) и Multiple Point (Несколько точек). Первая из них позволяет создать
только одну точку, а вторая предлагает размещать точки до тех пор, пока вы не нажмете
клавишу Esc. Кроме того, разместить на чертеже одну точку можно, введя команду POINT
с клавиатуры.

Щелкнув на кнопке Multiple Points (Несколько точек) на вкладке Home (Основная)
в группе Draw (Черчение) ленты, вы сможете за один сеанс выполнения команды создать
несколько точечных объектов.

В любом случае, вы увидите приглашение:
Current point modes: PDMODE=0 PDSIZE=0.0000
Specify a point:
Задайте координаты точки с клавиатуры или укажите расположение точечного объекта

с помощью мыши.
Системная переменная PDMODE позволяет изменить стиль точки, а переменная

PDSIZE определяет размеры точки. В принципе, изменить значение этих системных пере-
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менных, а следовательно, и внешний вид точек можно также с помощью командной строки.
Однако для этих целей лучше воспользоваться диалоговым окном Point Style (Стиль точки)
(рис. 2.25), которое можно вызвать командой Format → Point Style (Формат → Стиль точки).

 

Рис. 2.25. Настройка внешнего вида точки
В этом окне можно выбрать один из 20 стилей точки. Для этого необходимо щелкнуть

кнопкой мыши на изображении, которое вам подходит.
Совет
Если необходимо вывести чертеж на печать без точек, то их не

обязательно удалять – достаточно выбрать второй рисунок в первом
ряду, что позволит спрятать точечные объекты. В будущем, выбрав
иной стиль, вы сможете вернуть точки на экран.

Введите размер точки в текстовое поле Point Size (Размер точки). Причем, установив
переключатель в положение Set Size in Absolute Units (Установка размера в абсолютных
единицах), вы сможете задать реальный размер точечного объекта, что сохранит соотноше-
ние размеров точки и других объектов при масштабировании, а также позволит управлять
размерами точки при выводе чертежа на печать. Если же оставить переключатель в поло-
жении Set Size Relative to Screen (Установка размера относительно экрана), то точка будет
сохранять постоянные размеры независимо от масштаба представления чертежа, что удобно,
если вы собираетесь использовать объектную привязку.

Чтобы завершить работу по настройке внешнего вида точек, нажмите кнопку OK.
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Полилиния

 
Полилиния представляет собой единый объект, который может состоять из произволь-

ного количества отрезков и дуг (рис. 2.26).
 

Рис. 2.26. Полилинии
Чтобы создать полилинию, запустите команду PLINE, щелкнув на кнопке Polyline

(Полилиния) на вкладке Home (Основная) в группе Draw (Черчение) ленты. Можете выпол-
нить команду меню Draw → Polyline (Черчение → Полилиния), если вы работаете с класси-
ческим интерфейсом AutoCAD. Программа попросит задать расположение точки, с которой
начнется построение полилинии:

Specify start point:
По умолчанию AutoCAD дает возможность создавать полилинии из прямолинейных

отрезков. Появится следующий запрос:
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:
Указав координаты второй точки в ответ на этот запрос, вы создадите первый прямо-

линейный сегмент полилинии. Кроме того, можно выбрать один из параметров.
• Как несложно догадаться из называния, параметр Arc позволяет создать дугу. При

его выборе появится запрос:
Specify endpoint of arc or [Angle/CEnter/Direction/Half-width/Line/Radius/Second pt/

Undo/Width]:
Используя различные параметры, вы можете сформировать дугу одним из множества

способов.
• Параметр Halfwidth дает возможность задать толщину полилинии, указав величину

половины ее толщины. Установив разные значения начальной толщины в ответ на запрос
Specify starting half-width <0.0000>: и конечной в ответ на приглашение командной строки
Specify ending half-width <0.0000>:, вы сможете в дальнейшем сформировать сужающийся
или расширяющийся сегмент полилинии.

• Выбрав параметр Length, вы сможете создать прямолинейный фрагмент полилинии,
лишь введя его длину. При этом отрезок будет направлен в ту же сторону, что и предыдущий
прямолинейный участок полилинии, или, если на предыдущем этапе была сформирована
дуга, отрезок пройдет по касательной к ней.
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• Параметр Undo, как обычно, отменяет формирование последнего участка.
• Воспользовавшись параметром Width, можно указать начальную и конечную тол-

щину следующих участков.
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Сплайн

 
Сплайн представляет собой гладкую кривую, которая в AutoCAD формируется на

основе заданных пользователем точек.
Вызовите команду SPLINE, щелкнув на кнопке Spline (Сплайн) на вкладке Home

(Основная) в группе Draw (Черчение) ленты. Команду Spline (Сплайн) можно также акти-
визировать на панели инструментов Draw (Черчение) или выполнив команду меню Draw →
Spline (Черчение → Сплайн). Программа попросит задать начальную точку сплайна:

Specify first point or [Object]:
Затем появится следующий запрос:
Specify next point:
В ответ укажите расположение второй точки.
Координаты третьей и последующих точек сплайна указываются в ответ на приглаше-

ние, позволяющее выбрать один из дополнительных параметров:
Specify next point or [Close/Fit tolerance] <start tangent>:
• Параметр Close создает замкнутый сплайн.
• С помощью параметра Fit tolerance определяется, насколько близко к заданным точ-

кам должен быть проведен сплайн. При выборе этого параметра появляется запрос:
Specify fit tolerance <0.0000>:
Как видно, по умолчанию это значение равно 0, то есть сплайн проходит строго через

указанные точки. Если же ввести какое-то другое число, программа сможет провести сплайн,
не выходя за указанное расстояние, чтобы линия была менее угловатой.

Задав все необходимые точки для построения сплайна, нажмите клавишу Enter, чтобы
выбрать параметр start tangent. Появится запрос:

Specify start tangent:
Укажите касательную к начальной точке сплайна. При этом конфигурация линии

сплайна будет изменяться в зависимости от положения указателя. Чтобы зафиксировать
результат, щелкните кнопкой мыши. Точно таким же образом измените конфигурацию
сплайна, задав направление касательной к его конечной точке в ответ на запрос:

Specify end tangent:
Если вы формируете замкнутый сплайн, то потребуется задать направление только

одной касательной:
Specify tangent:
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Свойства объектов и слои

 
До сих пор для создания объектов мы использовали линии одного типа и цвета. Но

чтобы чертеж «читался», лучше представлять объекты разными линиями. Например, на
архитектурных чертежах стены вычерчивают линиями одного цвета, а мебель и коммуника-
ции – другого, а в машиностроительных моделях различными цветами обычно обозначают
линии разных типов. Поэтому, чтобы как-то разгруппировать объекты, используют слои.
Слой подобен некой прозрачной поверхности, на которой происходит черчение. Каждый
объект чертежа принадлежит определенному слою, и при этом каждый слой имеет такие
характеристики, как цвет, тип и толщина линий.

В только что созданном чертеже всегда появляется слой 0. До сих пор построения всех
объектов происходили именно на слое 0, который присутствует во всех чертежах и который
нельзя удалить. Однако можно изменить свойства этого слоя, назначенные по умолчанию.
Кроме того, вы можете создать новые слои с заданными им свойствами.

 
Параметры слоя

 
Управлять слоями удобно на палитре Layer Properties Manager (Менеджер свойств

слоя) (рис. 2.27), которая открывается после щелчка на кнопке Layer Properties (Свойства
слоя) на вкладке Home (Основная) в группе Layers (Слои) ленты или после выполнения
команды Format → Layer (Формат → Слой).

 

Рис. 2.27. Палитра Layer Properties Manager (Менеджер свойств слоя), вызываемая в
режиме Model (Модель)

Как видите, данная палитра состоит из двух частей: слева находится список фильтров
слоев, а справа перечислены сами слои. Так как мы еще не создали ни одного слоя, в этом
списке присутствует только слой 0.

Создать новый слой очень просто: достаточно щелкнуть на кнопке New Layer (Новый
слой)

 

или нажать сочетание клавиш Alt+N. При этом программа предложит ввести имя
нового слоя: по умолчанию это Layer1 (Слой 1), но лучше задать какое-либо значимое назва-
ние, чтобы в будущем можно было легко ориентироваться в списке слоев.

Рассмотрим свойства, которые можно назначить слою.
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• В столбце Status (Статус) отображается статус слоя: рядом с текущим слоем стоит
галочка, используемый слой отображается с помощью синего листа, а неиспользуемый –
серого. В списке также может присутствовать фильтр слоев, представленный в виде стопки
листов.

• У вас может не получиться с первой попытки изменить имя слоя. Дело в том, что
щелчок на слове в столбце Name (Имя) просто выделяет его. Чтобы назначить слою новое
имя, нужно нажать клавишу F2.

• Если для слоя установлено свойство On (Вкл.), то он отображается на экране. В про-
тивном случае, когда присвоено значение Off (Выкл.), объекты данного слоя не видны на
экране и не выводятся на печать.

• Свойство Freeze (Замороженный), подобно Off (Выкл.), делает слой невидимым и
недоступным для печати. Кроме того, объекты замороженного слоя нельзя удалить. Слой со
статусом Thaw (Размороженный) имеет противоположные свойства.

• Когда слою присвоено свойство Lock (Заблокированный), он остается видимым
на экране, но все его объекты не поддаются редактированию. Данную настройку полезно
использовать, когда вы хотите обезопасить себя от случайных изменений объектов слоя.

• Чтобы изменить цвет слоя, щелкните кнопкой мыши на цветном квадратике в столбце
Color (Цвет). На экране появится диалоговое окно Select Color (Выбор цвета) (рис. 2.28).

 

Рис. 2.28. Диалоговое окно Select Color (Выбор цвета)
На первой вкладке – Index Color (Номер цвета) – можно выбрать один из 256 стандарт-

ных цветов AutoCAD. Для этого достаточно щелкнуть на соответствующем образце цвета.
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При перемещении указателя мыши по вариантам цветов для сравнения отображается как
предыдущий цвет (в черной рамке), так и цвет, над которым находится указатель (в белой
рамке).

Если этих 256 цветов недостаточно, то на вкладке True Color (Вся палитра) можно
настроить цвет с помощью цветовой модели HSL или RGB. На вкладке Color Books (Книги
цветов) можно выбрать оттенок на палитре планшетных цветов.

• После щелчка на значении в столбце Linetype (Тип линии) открывается диалоговое
окно Select Linetype (Выбор типа линии) (рис. 2.29), в котором по умолчанию присутствует
всего один шаблон линии – Continuous (Сплошная).

 

Рис. 2.29. Диалоговое окно Select Linetype (Выбор типа линии)
Чтобы загрузить дополнительные типы линий, нажмите кнопку Load (Загрузить). На

экране появится диалоговое окно Load or Reload Linetypes (Загрузить или перезагрузить
типы линий) (рис. 2.30).
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Рис. 2.30. Диалоговое окно Load or Reload Linetypes (Загрузить или перезагрузить типы
линий)

• Щелчок на значении в столбце Lineweight (Толщина линии) вызывает одноименное
диалоговое окно (рис. 2.31), где можно назначить слою определенную толщину линии.
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Рис. 2.31. Диалоговое окно Lineweight (Толщина линии)
• Столбец Plot Style (Стиль печати) служит для назначения слою стиля печати (см.

главу 8).
• Если вы не хотите печатать объекты какого-либо слоя, щелкните кнопкой мыши на

столбце Plot (Печать), чтобы значок принтера стал перечеркнутым.
• Обратите внимание на столбец New VP Freeze (Заморозить на новом плавающем

видовом экране), который позволяет сделать слой замороженным на всех вновь создаваемых
видовых экранах в пространстве листа. Щелкнув в этом столбце напротив нужного слоя, вы
сделаете его невидимым и недоступным для печати на всех плавающих видовых экранах,
которые будут созданы в будущем. При этом на существующие видовые экраны изменение
этого свойства не повлияет.

• Наконец, в столбце Description (Описание) можно ввести пояснение для конкретного
слоя. Для этого щелкните на строке нужного слоя, а затем нажмите клавишу F2.

Кроме палитры Layer Properties Manager (Менеджер свойств слоя), слоями можно
управлять с помощью кнопок, расположенных на вкладке Home (Основная) в группе Layers
(Слои) на ленте, либо используя панель инструментов Layers (Слои) (рис. 2.32).

 

Рис. 2.32. Панель инструментов для управления слоями
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В частности, с помощью раскрывающегося списка можно сделать какой-либо слой
текущим.

 
Палитра свойств

 
Как уже говорилось, объекты чертежа имеют три свойства: цвет, тип и толщину линий.

По умолчанию данные свойства присваиваются объекту в зависимости от того, на каком
слое он находится. Однако каждому объекту можно назначить и индивидуальные свойства.

Чтобы изменить свойства объекта, его необходимо предварительно выделить секущей
рамкой или щелчком кнопкой мыши (более подробно выделение объектов рассматривается
в следующей главе). Затем необходимо вызвать контекстное меню, щелкнув правой кнопкой
мыши, и выбрать в нем пункт Properties (Свойства), тем самым вызвав палитру свойств
(рис. 2.33).
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Рис. 2.33. Палитра свойств
На данной палитре можно изменять свойства выбранного объекта путем настройки

нужных параметров.
Кроме того, доступ к основным свойствам объекта можно получить с помощью панели

кратких свойств (Quick Properties) (рис. 2.34), которая появляется рядом с объектом при
его выделении. По умолчанию панель открывается в обычном виде, а при наведении на нее
указателя мыши становится развернутой.
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Рис. 2.34. Панель кратких свойств в обычном (слева) и развернутом (справа) виде
Настроить параметры панели кратких свойств можно в диалоговом окне Drafting

Settings (Режимы рисования) на вкладке Quick Properties (Краткие свойства) (рис. 2.35).
 

Рис. 2.35. Окно настройки панели кратких свойств
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Резюме

 
Прочитав эту главу, вы усвоили основные приемы создания часто используемых объ-

ектов (отрезок, окружность, прямоугольник) и достаточно экзотических (эллипс, сплайн и
т. п.).

Кроме того, из этой главы вы узнали о том, что все объекты в зависимости от их свойств
лучше группировать на различных слоях, чтобы в дальнейшем было лучше управлять ими.
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Глава 3

Выделение, перемещение и копирование объектов
 

• Выделение объектов
• Добавление и удаление объектов из набора
• Выделение объектов с помощью фильтров
• Перемещение объектов
• Копирование объектов
• Резюме
Целью данной главы является дальнейшее освоение базовой техники работы c объек-

тами в системе AutoCAD 2010. Прочитав ее, вы должны освоить различные способы выде-
ления одного объекта или группы, а также перемещение и копирование объектов.
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Выделение объектов

 
Многообразие инструментов быстрого редактирования и трансформации объектов с

минимальными усилиями является одним из ключевых средств повышения продуктивности
при работе в AutoCAD 2010.

В предыдущей главе мы говорили о создании новых объектов. Однако при формиро-
вании примитивов можно запросто ошибиться, например задав не те координаты, и поэтому
нередко возникает необходимость видоизменить существующую модель. Если при традици-
онном черчении вы должны были стереть линию и затем нарисовать заново в нужном месте,
то в AutoCAD достаточно просто отредактировать существующую графическую информа-
цию.

Чтобы изменить какой-либо объект (группу объектов), мы должны указать их, то
есть выделить примитивы, которые нуждаются в редактировании. Выделение примитивов в
большинстве случаев интуитивно понятно и не вызывает затруднений. Но, кроме простей-
ших методов выделения, в AutoCAD существует много других способов выбора объектов.
Нередко бывает так, что воспользоваться, например, таким инструментом, как фильтр выде-
ления, намного проще, чем множество раз щелкать на нужных примитивах, чтобы добавить
их в набор выделения.

Рассмотрим различные способы выделения объектов в контексте их редактирова-
ния. Все основные инструменты редактирования находятся на вкладке Home (Основная) в
группе Modify (Редактирование) ленты (рис. 3.1), а также в меню Modify (Редактирование)
и на панели инструментов Modify (Редактирование).

 

Рис. 3.1. Группа Modify (Редактирование) вкладки Home (Основная) ленты
Существуют два подхода к редактированию объектов:
• запуск команды редактирования и последующее выделение объектов, которые вы

хотите изменить (метод verb/noun (глагол/существительное));
• выбор объектов для изменения и последующий запуск команды редактирования

(метод noun/verb (существительное/глагол)).
Терминология noun/verb (существительное/глагол) может сначала показаться слегка

обескураживающей, но если вы будете считать, что существительные представляют объекты
(линии, круги, текст и т. д.), а глаголы – действия (перемещать, копировать, вращать и т. п.),
то она приобретет следующий смысл:

• noun – начерченный объект;
• verb – команда редактирования.
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Выбором режима noun/verb (существительное/глагол) и другими свойствами выделе-
ния объектов можно управлять на вкладке Selection (Выделение) диалогового окна Options
(Параметры), показанного на рис. 3.2.

 

Рис. 3.2. Вкладка Selection (Выделение) окна Options (Параметры)
Диалоговое окно Options (Параметры) вы можете открыть следующими способами:
• щелкнув на кнопке с буквой «А» и нажав кнопку Options (Параметры) в правом ниж-

нем углу появившегося меню;
• щелкнув правой кнопкой мыши на области командной строки и выбрав в контекстном

меню пункт Options (Параметры);
• щелкнув правой кнопкой мыши на графическом экране при отсутствии выделенных

объектов и выбрав в контекстном меню пункт Options (Параметры).
При использовании метода verb/noun (глагол/существительное), когда сначала вызы-

вается команда редактирования, требуется набор выделения, для указания которого про-
грамма AutoCAD выводит в командной области следующее приглашение:

Select objects:
Теперь ваша очередь начать выделение объектов для редактирования на чертеже.

AutoCAD повторяет приглашение Select objects:, пока вы не завершите выделение, нажав
клавишу Enter. Такой подход позволяет создать набор выделенных объектов, используя раз-
нообразные методы выделения, – от выбора отдельных объектов с помощью мыши до раз-
личных вариантов группового выделения.

В режиме выделения программа AutoCAD заменяет перекрестье указателя мыши
маленьким квадратиком, который называется отборочной рамкой (Pickbox). Отборочная
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рамка, размер которой регулируется в настройках, помогает выбрать объект одним щелчком,
не прибегая к точным манипуляциям.

Совет
Вы можете управлять размером отборочной рамки с помощью

ползунка Pickbox size (Размер отборочной рамки), расположенного на
вкладке Selection (Выделение) диалогового окна Options (Параметры),
которое показано на рис. 3.2.

При выборе одного или более объектов программа обычно выделяет их пунктирными
линиями. Группа объектов, выбранная для работы, называется выбранным множеством,
или набором выделения.

Операции выделения можно разделить на индивидуальные (выделение одного объ-
екта) и групповые, или множественные (выделение сразу целой совокупности объектов).
Для индивидуального выделения достаточно простого щелчка кнопкой мыши на объекте.

Рассмотрим основные способы группового выделения объектов для дальнейшей обра-
ботки в ответ на приглашение Select objects: в командной области. Варианты выделения объ-
ектов включают следующие режимы:

• Window (Рамка);
• Crossing (Пересечение);
• Window Polygon (Рамка-многоугольник);
• Crossing Polygon (Пересечение с многоугольником);
• Fence (Линия выбора);
• Previous (Предыдущий);
• Last (Последний);
• All (Все);
• Multiple (Несколько).

 
Window (Рамка)

 
Этот режим служит для выделения объектов, полностью попадающих внутрь прямо-

угольной рамки. Рамку определяют указанием начальной точки в любом месте области рисо-
вания и перемещением указателя мыши вправо. При этом в командном окне выводится при-
глашение указать противоположный угол:

Specify opposite corner:
Направление, в котором вы перемещаете указатель мыши (влево или вправо) для ука-

зания второго угла, играет существенную роль. Так вот, чтобы воспользоваться режимом
выделения Window (Рамка), необходимо задать второй угол правее первого. Обратите вни-
мание на то, что в этом режиме выделения рамка имеет синий цвет.

Если какой-нибудь объект выделяемого набора не полностью находится внутри пря-
моугольной области, то он не будет включен в набор выделения. Выбирать можно только
отображаемые на экране объекты. На рис. 3.3 в набор выделения попадут только треуголь-
ник и отрезок, а окружность и пятиугольник останутся невыделенными, поскольку части
этих двух фигур находятся за пределами прямоугольной рамки.
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Рис. 3.3. Выделение объектов с использованием режима Window (Рамка)
В результате выделения получится набор, изображенный на рис. 3.4. Обратите внима-

ние на то, что выделились только примитивы, полностью попавшие в рамку.
 

Рис. 3.4. Результат выделения в режиме Window (Рамка)
 

Crossing (Пересечение)
 

Как и предыдущий, этот режим позволяет выделять все объекты, полностью находя-
щиеся внутри прямоугольной рамки, а также объекты, которые рамка пересекает. Рамка,
имеющая зеленый цвет (он символизирует режим выделения Crossing (Пересечение)), опре-
деляется расположением первой угловой точки в нужном месте и перемещением указателя
мыши влево от первой точки. В этом случае AutoCAD также выводит приглашение указать
противоположный угол:

Specify opposite corner:
На рис. 3.5 в набор выделения входят окружность, треугольник, отрезок и пятиуголь-

ник, хотя каждая фигура лишь частично попадает в прямоугольную рамку.
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Рис. 3.5. Выделение объектов с использованием режима Crossing (Пересечение)
В результате выделения получится набор, изображенный на рис. 3.6. Выделенными

оказались все объекты, которые хоть как-то были затронуты рамкой.
 

Рис. 3.6. Результат выделения в режиме Crossing (Пересечение)
 

Window Polygon (Рамка-многоугольник)
 

Этот режим подобен Window (Рамка), но в отличие от него позволяет указывать
область в виде многоугольника. Многоугольник формируется путем последовательного
выбора точек около объектов, которые вы хотите выделить. Форма многоугольника может
быть произвольной, но его стороны не должны пересекаться между собой (рис. 3.7). Если
все точки, определяющие многоугольник, выбраны, нажмите клавишу Enter. В результате
выделятся только те объекты, которые полностью находятся внутри многоугольника.
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Рис. 3.7. Выделение объектов с использованием режима Window Polygon (Рамка-мно-
гоугольник)

Для выбора режима Window Polygon (Рамка-многоугольник) в ответ на приглашение
Select objects: введите команду WP и нажмите клавишу Enter. Параметр Undo в запросе
Specify endpoint of line or [Undo]: позволяет отменить выбор самой последней точки много-
угольника.

 
Crossing Polygon (Пересечение с многоугольником)

 
Данный режим похож на Window Polygon (Рамка-многоугольник), но выделяет все

объекты, находящиеся внутри или имеющие пересечение с границей многоугольника. То
есть если часть объекта находится внутри области многоугольника, то весь объект включа-
ется в набор выделения.

Для выбора режима Crossing Polygon (Пересечение с многоугольником) в ответ на
приглашение командной строки Select objects: введите команду СP и нажмите клавишу
Enter. Параметр Undo позволяет отменить выбор самой последней точки многоугольника.

Совет
Все варианты группового выделения объектов, которые

опираются на множество точек, располагают параметром Undo,
позволяющим отменить только что выбранные точки, поэтому вы
можете переставить ошибочную точку, не отменяя и не повторяя выбор
правильных точек. Для использования возможности Undo введите
команду U в ответ на приглашение ввести следующую точку, и
последняя выбранная точка будет удалена из набора выделения.

 
Fence (Линия выбора)

 
Режим Fence (Линия выбора) напоминает режим Crossing Polygon (Пересечение с

многоугольником), но в отличие от него последнее звено ломаной линии, замыкающей гра-
ницу многоугольника, отсутствует. В этом режиме выделяются только те объекты, которые
пересекаются линией выбора (рис. 3.8).
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Рис. 3.8. Выделение объектов с использованием режима Fence (Линия выбора)
В отличие от режимов Window Polygon (Рамка-многоугольник) и Crossing Polygon

(Пересечение с многоугольником) линия выбора может пересекаться сама с собой и иметь
совпадающие участки.

Для выбора режима Fence (Линия выбора) в ответ на запрос Select objects: введите
команду F и нажмите клавишу Enter.

В результате выделения получится набор, изображенный на рис. 3.9.
 

Рис. 3.9. Результат выделения в режиме Fence (Линия выбора)
 

Previous (Предыдущий)
 

Программа AutoCAD запоминает последний набор выделения и позволяет использо-
вать его повторно с помощью режима Previous (Предыдущий). То есть режим предоста-
вляет возможность выполнения нескольких операций над одним и тем же набором объек-
тов. Например, если вы скопировали набор объектов и теперь хотите еще переместить их
куда-нибудь, нужно вызвать команду MOVE и в ответ на приглашение Select objects: ввести
команду P, чтобы снова использовать тот же набор выделения.

 
Last (Последний)

 
Этот режим является простым способом выделения последнего созданного объекта,

видимого в данный момент. Если в режиме Last (Последний) в процессе выделения был
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включен более чем один объект, применение команды Undo удалит из набора выделения все
объекты, которые были выбраны в этом режиме.

Для выбора режима Last (Последний) в ответ на приглашение Select objects: введите
команду L и нажмите клавишу Enter.

 
All (Все)

 
Данный режим выделяет все объекты рисунка, в том числе находящиеся на выключен-

ных слоях.
Для выбора режима All (Все) в ответ на запрос Select objects: введите команду ALL и

нажмите клавишу Enter. Команда All (Все) должна быть введена полностью, без сокраще-
ний, в отличие от команд других режимов выделения. Кроме того, чтобы выделить все объ-
екты, вы можете воспользоваться сочетанием клавиш Ctrl+A, как и в других приложениях
Windows.

 
Multiple (Несколько)

 
Программа AutoCAD выполняет полное сканирование экрана каждый раз, когда про-

исходит выделение объекта. Режим Multiple (Несколько) позволяет выделить несколько объ-
ектов без задержки, и при нажатии клавиши Enter все точки будут выбраны за одно скани-
рование экрана.

Если рисунок достаточно загроможден, выделение одного или более объектов может
быть затруднительным. Часто это невозможно сделать с помощью перечисленных режимов.
Например, при тесном взаимном расположении двух объектов программа выделяет только
один объект при многократном выборе точки, касающейся обоих объектов. Режим Multiple
(Несколько) исключает повторное выделение объекта, уже включенного в набор выделе-
ния. Во многих случаях использование режима Multiple (Несколько) является оптимальным
вариантом.

Для включения режима Multiple (Несколько) в ответ на приглашение командной обла-
сти Select objects: введите команду M и нажмите клавишу Enter.



А.  А.  Орлов.  «AutoCAD 2010»

108

 
Добавление и удаление объектов из набора

 
Выбирая новые объекты каким-либо способом в ответ на приглашение Select objects:,

мы добавляем их к уже выделенным. Так происходит, пока не будет нажата клавиша Enter.
Однако кроме добавления объектов в набор выделения мы можем исключить ошибочно
выделенные объекты из набора.

Существует возможность переключения между режимами добавления и удаления объ-
ектов из набора выделения с помощью команд A (Add) и R (Remove). Если вы введете
команду R и нажмете клавишу Enter в ответ на запрос

Select objects:
AutoCAD перейдет в режим удаления объектов и запрос примет вид:
Remove objects:
После этого выделяемые объекты будут удаляться из набора выделения, поэтому при-

знаки их выделения будут исчезать.
Программа AutoCAD остается в режиме удаления, пока вы не введете команду A и не

нажмете клавишу Enter в ответ на запрос
Remove objects:
для переключения в режим добавления объектов в набор выделения. При этом запрос

примет обычный вид:
Select objects:
При выделении отдельных объектов существует возможность так изменить режим

выделения, чтобы использовать клавишу Shift для добавления объектов в существующий
набор выделения. Если вы установите флажок Use Shift to add to selection (Использовать
клавишу Shift для добавления к выделению) в области Selection modes (Режимы выделения)
на вкладке Selection (Выделение) диалогового окна Options (Параметры) (см. рис. 3.2), то
для выделения более одного объекта нужно будет удерживать нажатой клавишу Shift.

Выделение предыдущих объектов отменяется, если вы пытаетесь выделить несколько
объектов без использования клавиши Shift при установленном флажке Use Shift to add to
selection (Использовать клавишу Shift для добавления к выделению). По умолчанию данный
флажок снят.

Вы можете выделять объекты, которые находятся друг поверх друга, удерживая нажа-
тыми клавиши Shift+Пробел перед выбором объекта в ответ на запрос Select objects:. После
выбора одного объекта следует отпустить клавиши Shift+Пробел и начать работу в цикличе-
ском режиме (щелкать кнопкой мыши), позволяющем быстро выбирать одно и то же место,
прокручивая различные объекты, которые перекрывают друг друга, и выделяя каждый объ-
ект в отдельности. Во время циклического режима программа AutoCAD выдает следующий
запрос:

Select objects: <Cycle on>
Когда объект, который вы хотите выбрать, выделен, нажмите клавишу Enter для

выхода из циклического режима. Появится следующее приглашение:
Select objects: <Cycle off>
Это вернет вас в обычный режим выделения, поэтому необходимо нажать клавишу

Enter еще один раз для подтверждения набора выделения.
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Выделение объектов с помощью фильтров

 
Одним из способов выделения является применение фильтров. Используя команду

filter или кнопку Quick Select (Быстрый выбор)
 

из группы Utilities (Утилиты) на вкладке Home (Основная) ленты, вы можете отфиль-
тровать наборы выделения по свойствам (например, по цвету) и по типам объектов. Так, вы
можете выбрать все красные круги на рисунке, не затрагивая никакие другие объекты, или
все объекты, кроме красных кругов.

Команда FILTER открывает диалоговое окно Object Selection Filters (Фильтры выде-
ления объектов), изображенное на рис. 3.10. С его помощью вы можете дать фильтрам имена
и сохранить их для последующего использования. Команда FILTER создает список требо-
ваний, которым должен отвечать объект до его выделения. Вы можете ввести эту команду
в ответ на запрос, чтобы создать списки фильтрации для дальнейшего использования. Вы
можете также использовать команду FILTER явно, запустив ее в ответ на приглашение Select
objects: для использования в текущей команде.

 

Рис. 3.10. Диалоговое окно Object Selection Filters (Фильтры выделения объектов)
Команда FILTER ищет объекты по свойствам только в том случае, если вы присво-

или эти свойства объекту непосредственно. Если объекты принимают свойства от слоя, на
котором они размещаются, то для их выделения необходимо указывать значение параметра
ByLayer (По слою). Допустим, слою присвоен зеленый цвет и объекты, размещенные на
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этом слое, наследуют цвет от него. Если вы захотите выделить эти объекты, указав их цвет,
то следует задать и цвет ByLayer (По слою). Указав зеленый цвет напрямую, вы не добье-
тесь нужного выделения.

С помощью кнопки Quick Select (Быстрый выбор) из группы Utilities (Утилиты) на
вкладке Home (Основная) ленты вы можете быстро определить набор выделения, основан-
ный на указанных вами критериях фильтрации. Команда Quick Select (Быстрый выбор) и
ее аналог QSELECT (или _QSELECT) вызывают диалоговое окно Quick Select (Быстрый
выбор) (рис. 3.11).

 

Рис. 3.11. Окно Quick Select (Быстрый выбор)
Примечание
Вы можете вызвать окно Quick Select (Быстрый выбор), щелкнув

правой кнопкой мыши в области рисунка и выбрав в контекстном меню
пункт Quick Select (Быстрый выбор).
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Команда QSELECT создает набор выделения, который включает или исключает все
объекты, соответствующие определенному типу и критериям свойств объекта, которые вы
определяете. Вы можете применить команду QSELECT ко всему рисунку или к существу-
ющему набору выделения, а также определить, заменяет ли набор выделения, созданный
командой QSELECT, текущий набор выделения или добавляет объекты к нему. Если вы
частично открыли рисунок, команда не рассматривает объекты, которые вы не загрузили.

Для создания набора выделения с помощью команды Quick Select (Быстрый выбор)
выполните следующие действия.

1. В группе Utilities (Утилиты) на вкладке Home (Основная) ленты нажмите кнопку
Quick Select (Быстрый выбор) либо выполните команду меню Tools → Quick Select (Сервис
→ Быстрый выбор).

2. В раскрывающемся списке Apply to (Применить к) окна Quick Select (Быстрый
выбор) выберите значение Entire drawing (Весь чертеж).

3. В списке Object type (Тип объекта) выберите значение Multiple (Несколько).
4. В поле Properties (Свойства) щелкните на пункте Color (Цвет).
5. В раскрывающемся списке Operator (Оператор) выберите значение = Equals

(Равно).
6. В списке Value (Значение) выберите Red (Красный).
7. Переключатель How to apply (Способ применения) установите в положение Include

in new selection set (Включить в новый набор выделения).
8. Нажмите кнопку OK.
Программа AutoCAD выберет все красные объекты на рисунке и закроет окно Quick

Select (Быстрый выбор).
Вы можете исключить объекты из текущего набора выделения, установив переключа-

тель How to apply (Способ применения) в положение Exclude from new selection set (Исклю-
чить из нового набора выделения).

Рассмотрим пример исключения всех кругов с радиусом более 10 из набора выделен-
ных объектов.

Чтобы исключить объекты из набора выделения, выполните следующие действия.
1. В группе Utilities (Утилиты) на вкладке Home (Основная) ленты нажмите кнопку

Quick Select (Быстрый выбор) либо выполните команду меню Tools → Quick Select (Сервис
→ Быстрый выбор).

2. В раскрывающемся списке Apply to (Применить к) окна Quick Select (Быстрый
выбор) выберите значение Current selection (Текущее выделение).

3. В списке Object type (Тип объекта) выберите значение Circle (Круг).
4. В поле Properties (Свойства) щелкните на строке Radius (Радиус).
5. Из раскрывающегося списка Operator (Оператор) выберите вариант > Greater than

(Больше чем).
6. Параметру Value (Значение) присвойте значение 10.
7. Переключатель How to apply (Способ применения) установите в положение Exclude

from new selection set (Исключить из нового набора выделения).
В результате окно Quick Select (Быстрый выбор) должно принять вид, представленный

на рис. 3.12.
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Рис. 3.12. Настройки для исключения из набора выделения всех кругов с радиусом
более 10

8. Щелкните на кнопке OK.
Программа удалит все круги с радиусом более 10 из набора выделения и закроет диа-

логовое окно Quick Select (Быстрый выбор).
Вы можете также использовать Quick Select (Быстрый выбор), чтобы добавить объ-

екты к текущему набору выделения. Рассмотрим пример сохранения текущего набора выде-
ления с добавлением всех объектов рисунка, которые содержат гиперссылки, начинающиеся
с подстроки bld1_.

Для добавления объектов к набору выделения выполните следующие действия.
1. В группе Utilities (Утилиты) на вкладке Home (Основная) ленты нажмите кнопку

Quick Select (Быстрый выбор) либо выполните команду меню Tools → Quick Select (Сервис
→ Быстрый выбор).

2. В диалоговом окне Quick Select (Быстрый выбор) установите флажок Append to
current selection set (Добавить к текущему набору выделения).

3. В списке Object type (Тип объекта) выберите значение Multiple (Несколько).
4. В поле Properties (Свойства) выберите значение Hyperlink (Гиперссылка).
5. В раскрывающемся списке Operator (Оператор) выберите значение * Wildcard

Match (Соответствие по маске).
6. В поле Value (Значение) введите bld1_*.



А.  А.  Орлов.  «AutoCAD 2010»

113

7. Переключатель How to apply (Способ применения) установите в положение Include
in new selection set (Включить в новый набор выделения).

8. Нажмите кнопку OK.
Связанная с данным окном команда FILTER присваивает имена, сохраняет фильтры

и обеспечивает варианты для более сложного фильтрования. Чтобы назвать и сохранить
отфильтрованный список, выполните следующие действия.

1. В командную строку введите FILTER.
2. В окне Object Selection Filters (Фильтры выделения объектов) (см. рис. 3.10) из

раскрывающегося списка в области Select Filter (Выбрать фильтр) выберите значение Line
(Отрезок).

3. Щелкните на кнопке Add to List (Добавить к списку).
4. В текстовое поле Save As (Сохранить как) введите имя фильтра типа Linefilter.
5. Нажмите кнопку Save As (Сохранить как).
6. Щелкните на кнопке Apply (Применить).
Программа AutoCAD применяет фильтр таким образом, что вы можете выбрать на

рисунке только линии. Если вы выделяете объекты с помощью рамки, AutoCAD применяет
фильтр ко всем объектам в рамке.

Для восстановления сохраненного набора вы можете выбрать имя фильтра в раскры-
вающемся списке Current (Текущий) в области Named Filters (Именованные фильтры) диа-
логового окна Object Selection Filters (Фильтры выделения объектов).
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Перемещение объектов

 
Теперь, когда вам привычны различные способы выделения объектов, настало время

некоторых действий.
Команда MOVE перемещает объекты на расстояние и угол, предложенные пользова-

телем.
При запуске команды MOVE в области командной строки AutoCAD появляется при-

глашение выбрать объекты для перемещения. Сделав это, нажмите клавишу Enter для при-
нятия набора выделения.

Затем программа выдаст запрос:
Specify base point or [Displacement] <Displacement>:
Вы можете выбрать один из трех вариантов действия:
• назначить опорную точку;
• выбрать параметр Displacement;
• ввести расстояние смещения, используя декартовы координаты.
При выборе первого варианта укажите опорную точку, используя функцию Object

Snap (Объектная привязка) в строке состояния. Затем появится приглашение:
Specify second point or <use first point as displacement>:
Выберите точку назначения, после чего выделенные объекты переместятся в новое

место (рис. 3.13).
 

Рис. 3.13. Перемещение объектов с помощью выбранных точек
Вы также можете использовать ввод направленного расстояния для размещения второй

точки. При использовании этого способа следует просто указать с помощью мыши напра-
вление, в котором вы хотите переместить выделенные объекты, и ввести с клавиатуры зна-
чение расстояния, на которое вы хотите их передвинуть.

Параметр Displacement позволяет назначить расстояние смещения в командной строке,
используя декартовы или полярные координаты. Значение координаты, вводимое вами, все-
гда является относительным расстоянием, на которое будут перемещены выделенные объ-
екты, даже если вы не поставите знак @.

После выбора параметра Displacement появится запрос:
Specify displacement <0.0000, 0.0000, 0.0000>:
Вы можете ввести расстояние смещения, используя декартовы (X,Y) или полярные

(@Distance<Angle) координаты (рис. 3.14).
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Рис. 3.14. Перемещение объекта с использованием параметра Displacement
Существует также возможность ввести расстояние смещения в декартовых координа-

тах непосредственно в ответ на первый запрос:
Specify base point or [Displacement] <Displacement>:
Ввод расстояния X,Y и нажатие клавиши Enter вызывает стандартный запрос указать

вторую точку:
Specify second point or <use first point as displacement>:
Нажатие клавиши Enter выбирает вариант по умолчанию (<use first point as

displacement>), поэтому введенное расстояние X,Y используется как расстояние смещения.
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Копирование объектов

 
Команда COPY перемещает объекты на расстояние и угол, предложенные пользовате-

лем. Ее употребление сходно с использованием команды MOVE за исключением того, что
COPY сохраняет выделенные объекты в первоначальном месте.

После запуска команды COPY появится запрос:
Select objects:
Выделите объекты, которые вы хотите скопировать, и нажмите клавишу Enter для под-

тверждения набора выделения. Появится следующий запрос:
Specify base point or [Displacement/mOde] <Displacement>:
Как и при запуске команды MOVE, у вас есть четыре варианта действия:
• назначить опорную точку;
• выбрать параметр Displacement;
• выбрать параметр mOde;
• ввести расстояние смещения, используя декартовы координаты.
При использовании первого варианта следует выбрать опорную точку, используя функ-

цию Object Snap (Объектная привязка) в строке состояния. Затем программа выдаст при-
глашение указать вторую точку:

Specify second point or <use first point as displacement>:
После выбора точки назначения выделенные объекты будут скопированы в новое

место.
Как и при работе с командой MOVE, вы можете положиться на ввод направленного

расстояния для расположения второй точки. При этом следует просто указать с помощью
мыши направление копирования выделенных объектов и ввести с клавиатуры значение рас-
стояния, на которое их нужно скопировать.

Совет
AutoCAD запоминает введенное расстояние смещения, поэтому

при последующем использовании команды MOVE или COPY это
расстояние берется по умолчанию, а вам достаточно всего лишь нажать
клавишу Enter, чтобы опять переместить или скопировать объекты на
то же расстояние.

Применение параметра Displacement для команды COPY ничем не отличается от
использования этого параметра при работе с командой MOVE.

Если вы используете параметр mOde, то появляется запрос:
Enter a copy mode option [Single/Multiple] <Multiple>:
С помощью параметра Multiple вы можете делать многократные копии, сколько угодно

раз указывая точки назначения. Программа каждый раз будет выдавать запрос об указании
второй точки:

Specify second point or [Exit/Undo] <Exit>:
Так будет происходить, пока вы не выполните команду контекстного меню Exit

(Выход), или не введете команду E в командную строку, или не нажмете клавишу Esc, чтобы
завершить выполнение команды COPY (рис. 3.15).
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Рис. 3.15. Многократное копирование объекта
Последний вариант также практически не отличается от подобного способа при работе

с командой MOVE. Вы можете ввести расстояние смещения в декартовых координатах в
ответ на первый запрос:

Specify base point or [Displacement/mOde] <Displacement>:
Примечание
Команды перемещения и копирования вы можете также вызвать

с помощью кнопок Move (Переместить)
 

и Сору (Копировать)
 

на панели инструментов Modify (Редактирование) (рис. 3.16).
 

Рис. 3.16. Панель инструментов Modify (Редактирование)
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Резюме

 
Изучив данную главу, вы, без сомнения, приблизились к постижению разнообразных

возможностей AutoCAD 2010, приобрели знания и практические навыки в следующих обла-
стях:

• подходы к выделению объектов;
• настройка наборов выделения в диалоговых окнах;
• основные режимы группового выделения объектов;
• понятие и основные приемы фильтрации;
• способы перемещения и копирования объектов.
Необходимость этих знаний вы осознаете при создании и редактировании сложных

чертежей, схем, планов, где тот или иной метод будет оптимальным средством, повыша-
ющим производительность труда конструктора или дизайнера. Владение разнообразными
техниками позволит не задерживаться на рутинных операциях и даст возможность получить
творческое удовлетворение в процессе работы.
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Глава 4

Текст и таблицы
 

• Работа с текстом
• Создание и изменение таблиц
• Резюме
Цель этой главы – освоение принципов работы c текстом и таблицами в AutoCAD 2010.

В ней рассмотрены следующие основные понятия: создание и редактирование одностроч-
ного и многострочного текста, управление отображением текста с помощью стилей и шриф-
тов, а также создание и редактирование таблиц.

Говорят, что изображение стоит тысячи слов. Линии, дуги и круги на чертеже могут
передать много графической информации, однако в конце работы вам нужно снабдить
рисунки примечаниями, чтобы полностью передать замысел.

Текст на рисунке соотносится с многими различными фигурами, размерами и фор-
мами. Он используется в блоке заголовка рисунка, чтобы сказать читателям, кто и когда его
создавал. Текст блока заголовка может также представлять информацию о том, кто прове-
рил рисунок или на какую ревизию чертежа вы смотрите, – два очень важных информаци-
онных момента. Конечно, есть также текст, который создается непосредственно на рисунке
в форме примечаний, меток и выносок с определенными конструкторскими инструкциями,
ссылками на другие рисунки, номера частей и спецификации. Таблицы со строками и столб-
цами используются, чтобы создать списки частей, иногда называемые ведомостями матери-
алов, такие как описи дверей и окон на архитектурной схеме, которые перечисляют их типы
и размеры.

Аннотирование рисунка вручную на чертежной доске было утомительной и отнима-
ющей много времени задачей. Фактически некоторые считали это формой искусства из-за
навыка и ловкости, необходимых для снабжения рисунка подобными примечаниями.

Эти дни давно прошли. Программа AutoCAD предоставляет множество инструмен-
тальных средств, которые позволяют вам с минимумом усилий аннотировать рисунки в
манере, отвечающей промышленным чертежным стандартам. Вы можете добавить множе-
ство строк текста, просто определяя граничную область, которую он должен заполнить.
Поэтому, когда вы вводите текст, программа AutoCAD автоматически форматирует его соот-
ветствующим образом. Таблицы можно вставить путем определения количества строк и
столбцов. Можно также добавить текст типа «поле», который будет автоматически изме-
няться в соответствии с текущей датой, названием файла чертежа или свойствами объекта
на рисунке.

В этой главе мы рассмотрим инструментальные средства программы AutoCAD, обес-
печивающие аннотирование вашего рисунка, а также исследуем средства, используемые для
редактирования свойств текста. Программа AutoCAD делает изменение информации, одна-
жды созданной для рисунка, таким быстрым и легким, что исправление текста и таблиц
является таким же простым, как двойной щелчок кнопкой мыши.
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Работа с текстом

 
В AutoCAD можно создавать текст двух видов:
• команды DTEXT и TEXT позволяют сформировать однострочный текст;
• с помощью команды MTEXT создается многострочный текст, представляющий

собой текстовый блок, состоящий из произвольного количества строк и абзацев. Фактически
данная команда позволяет работать почти так же, как в текстовом редакторе.

 
Создание однострочного текста

 
Однострочный текст предназначен для формирования одной или более не связан-

ных между собой строк текста. Однострочный текст – первоначальный текстовый тип в
AutoCAD, предшествовавший более сложному и богатому возможностями многострочному
тексту, который мы рассмотрим в следующем подразделе. В однострочном тексте каждая
строка – независимый объект, с которым можно работать отдельно.

Однострочный текст можно ввести в рамку в один прием (рис. 4.1).
 

Рис. 4.1. Создание однострочного текста
Как уже говорилось, для создания однострочного текста можно использовать команды

DTEXT и TEXT. Для вызова команды DTEXT с помощью ленты необходимо на вкладке
Home (Основная) в группе Annotation (Аннотационные объекты) ленты выбрать вариант
Single Line (Однострочный). Если вы работаете с классическим интерфейсом AutoCAD,
можете выполнить команду Draw → Text → Single Line Text (Черчение → Текст → Одно-
строчный текст). При выполнении одной из этих операций в командной строке отобража-
ются установленные в данный момент текстовый стиль и высота:

Current text style: «Standard» Text height: 2.5000 Annotative: No
Specify start point of text or [Justify/Style]:
В ответ на последнее приглашение выберите точку, которая будет служить началом

вводимого текста, с помощью мыши или введите ее координаты с клавиатуры. Кроме того,
вы можете воспользоваться дополнительными параметрами.

• Параметр Justify позволяет задать выравнивание текста. После его выбора появится
запрос:

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]:
Вы можете указать, как текст будет выравниваться относительно положения курсора.

В отличие от такого же параметра для многострочного текста, выравнивание однострочного
текста затрагивает только одну строку текста, а не весь абзац.

За исключением первых двух вариантов, Align и Fit, большинство значений достаточно
очевидны. Варианты выравнивания Align и Fit позволяют задавать расположение текста,
используя две точки для определения его ширины и угла наклона. Оба варианта вынуждают
текст приспосабливаться к двум указанным точкам, хотя и различными методами: Align
изменяет высоту текста, а Fit регулирует его ширину.

После выбора параметра Align появится приглашение:
Specify first endpoint of text baseline:
Выберите отправную точку для текста. Затем AutoCAD выдаст следующий запрос:
Specify second endpoint of text baseline:
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Эта точка определяет как угол, так и окончательную полную ширину текста. Помните,
что параметр Align изменяет высоту текста, чтобы подогнать ее между двумя точками. Из-
за этого при вводе текста рамка оперативного однострочного редактора текста становится
выше и короче.

Выбрав параметр Fit, вы вызовете следующий запрос:
Specify first endpoint of text baseline:
Выберите начальную точку для текста. Появится следующий вопрос:
Specify second endpoint of text baseline:
Эта точка определяет как угол, так и окончательную полную ширину текста. Пара-

метр Fit изменяет ширину текста, заставляя его умещаться между двумя точками. Вследствие
этого в командной строке появится запрос об указании высоты:

Specify height <2.5000>:
После ввода требуемой высоты появится рамка встроенного однострочного редактора,

и вы можете начинать вводить текст. По мере ввода текст расширяется или сжимается,
приспосабливаясь к расстоянию между указанными точками, но его высота сохраняется
(рис. 4.2).

 

Рис. 4.2. Использование выравнивания текста Fit
• Параметр Style служит для определения стиля текста. После его выбора появится

запрос:
Enter style name or [?] <Standard>:
По умолчанию в программе присутствуют два стиля: Standard и Annotative.
Вы можете изменить выравнивание текста и текстовый стиль с помощью параметров

Justify и Style соответственно, хотя значительно проще использовать для этого инструменты,
расположенные на вкладке Text Editor (Редактор текста) ленты (рис. 4.3). Другие параме-
тры, расположенные на данной вкладке, мы разберем более подробно, когда будем говорить
о многострочном тексте.

 

Рис. 4.3. Вкладка Text Editor (Редактор текста) ленты
После определения места начальной точки текста AutoCAD выдаст запрос:
Specify height <2.5000>:
Задайте требуемую высоту текста и нажмите клавишу Enter. Введенная высота будет

значением по умолчанию до следующего создания однострочного текста. Затем появится
следующий запрос:

Specify rotation angle of text <0>:
Введите требуемый угол наклона текста или нажмите клавишу Enter для использова-

ния значения по умолчанию.
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После ввода угла в графической области появится простейший встроенный одностроч-
ный текстовый редактор, который чаще всего представляет собой рамку изменяющегося раз-
мера, становящуюся по мере ввода символов длиннее (см. рис. 4.1).

Используя команды создания однострочного текста, можно вводить множество строк
текста, однако каждую строку вам придется заканчивать вручную нажатием клавиши Enter,
после чего можно продолжать ввод (рис. 4.4).

 

Рис. 4.4. Ввод группы строк однострочного текста
Примечание
Межстрочный интервал, используемый для однострочного текста,

равен 1,5 величины высоты текста от основания одной строки текста до
основания следующей строки.

Вы можете продолжать добавлять строки текста, пока не нажмете клавишу Enter два-
жды. Для завершения команды вы также можете выбрать с помощью мыши точку вне поля
редактирования. Помните, что впоследствии каждая строка текста будет отдельным объек-
том, даже если текст введен в один прием (рис. 4.5).

 

Рис. 4.5. Каждая строка многострочного текста является отдельным объектом
Совет
Если TEXT или DTEXT – последняя команда, которую вы ввели,

то при создании нового однострочного текста вы можете просто нажать
клавишу Enter в ответ на приглашение командной строки Specify
start point of text or [Justify/Style]: и пропустить запросы о вводе
высоты текста и угла поворота. AutoCAD автоматически отображает
встроенный однострочный текстовый редактор непосредственно под
последней созданной строкой текста, используя те же высоту, угол
поворота и выравнивание, поэтому вы можете просто начать ввод
текста.

 
Контекстное меню

 
Редактор однострочного текста имеет контекстное меню, открывающееся щелчком

правой кнопкой мыши и обеспечивающее дополнительные возможности (рис. 4.6).
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Рис. 4.6. Контекстное меню оперативного редактора однострочного текста
Рассмотрим некоторые команды данного меню:
• Undo (Отмена) – позволяет отменить одно или более действий в текстовом редакторе;
• Redo (Восстановление) – возвращает одно или более действий, которые были отме-

нены с помощью команды Undo (Отмена);
• Cut (Вырезать) – помещает текст в буфер обмена
• Copy (Копировать) – копирует текст в буфер обмена, так что вы можете вставить его

позже;
• Paste (Вставить) – вставляет текст, который в настоящее время находится в буфере

обмена;
• Editor Settings (Настройки редактора) – предоставляет некоторые дополнительные

инструменты, например такие, как проверка орфографии и цвет фона;
• Insert Field (Вставить поле) – позволяет вставлять поле, используя диалоговое окно

Field (Поле) (его мы рассмотрим далее в этой главе);
• Find and Replace (Найти и заменить) – открывает диалоговое окно Find and Replace

(Найти и заменить), с помощью которого можно искать и заменять текст;
• Select All (Выделить все) – выделяет весь текст в однострочном редакторе;
• Change Case (Изменить регистр) – позволяет переводить выбранный текст в верхний

или нижний регистр.
 

Вставка специальных символов в однострочный текст
 

По сравнению с многострочным текстовым редактором здесь ваши действия несколько
ограничены. Символы необходимо вводить с использованием соответствующего упра-
вляющего кода AutoCAD %% или Unicode. Существуют следующие управляющие коды
AutoCAD:

• %%C – символ диаметра (0);
• %%D – символ градуса (°);
• %%O – надчеркивание и его отмена;
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• %%P – символ допуска (±);
• %%U – подчеркивание и его отмена;
• %%% – знак процента (%).
При вводе управляющие коды немедленно преобразуются в соответствующие им сим-

волы. Например, ввод %%P30 %%D в однострочном текстовом редакторе вставляет строку
±30°.

Управляющие коды символов надчеркивания (%%O) и подчеркивания (%%U) – свое-
образные переключатели, которые могут быть включены и выключены (рис. 4.7).

 

Рис. 4.7. Использование управляющих кодов %%O и %%U для текста
Совет
Если вам нужно использовать символ евро (€), а на клавиатуре

нет соответствующей клавиши, введите 0128 на цифровом блоке
клавиатуры, удерживая нажатой клавишу Alt.

 
Текстовые поля

 
Поле – это интеллектуальный текст, предназначенный для вставки в рисунок и дина-

мически изменяющийся согласно данным, на которых он основан и/или которые он пред-
ставляет. Классический пример – поле Date (Дата), которое будет автоматически изменяться
для отображения текущей даты и даже времени с использованием различных форматов:

• 11/6/2009;
• четверг, июня 11, 2009;
• 2009-06-11;
• 11-июнь-09;
• 11.06.2009 15:43:58.
Поля могут быть созданы автономно или вставлены в любой вид текста, свойство или

определение свойства. Поле использует тот же самый стиль текста, что и текстовый объект,
в который оно вставлено, и отображается на светлосером фоне, который не виден на распе-
чатке.

Когда поле изменяется, отображаются последние данные. Можно настроить автомати-
ческую модификацию поля при выполнении одного или всех условий:

• открытие графического файла;
• сохранение файла чертежа;
• печать графического файла;
• запуск команды eTransmit.
• восстановление чертежа.
Кроме того, можно выключить функцию автоматического обновления, при этом вы

должны будете вручную изменять любые поля на чертеже. Вы можете управлять модифи-
кацией полей и затем выключить или включить отображение фона полей в области Fields
(Поля) на вкладке User Preferences (Пользовательские установки) окна Options (Параме-
тры) (рис. 4.8).
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Рис. 4.8. Вкладка User Preferences (Пользовательские установки) окна Options (Пара-
метры)

Снятие флажка Display background of fields (Отображать фон полей) выключает све-
тло-серый фон. Щелчком на кнопке Field Update Settings (Настройки обновления полей)
можно открыть одноименное диалоговое окно, показанное на рис. 4.9.

 

Рис. 4.9. Диалоговое окно Field Update Settings (Настройки обновления полей)
В этом окне можно указать, при каких действиях или событиях будут автоматически

модифицироваться поля. По умолчанию все флажки установлены. Если вы снимете их, поля
нужно будет изменять вручную.
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Существует несколько различных способов вставить поле. Чтобы создать отдельное
автономное поле, следует использовать команду FIELD. Чтобы вставить поле в одностроч-
ный текст, необходимо выбрать пункт Insert Field (Вставить поле) в контекстном меню одно-
строчного редактора.

В любом случае на экране появится диалоговое окно Field (Поле) (рис. 4.10).
 

Рис. 4.10. Диалоговое окно Field (Поле)
Раскрывающийся список Field category (Категория поля) содержит различные типы

полей:
• All (Все) – все поля;
• Date & Time (Дата и время) – поля, относящиеся к дате и времени (создаваемые,

сохраняемые, печатаемые);
• Document (Документ) – поля, относящиеся к файлу (имя файла, размер, кем сохра-

нен);
• Linked (Связано с) – информация о гиперссылке;
• Objects (Объекты) – информация об объектах (формулы, имена блоков, свойства для

прорисовки объектов);
• Other (Прочее) – разная информация (сложные выражения, значения системных

переменных);
• Plot (Схема распечатки) – информация о распечатке (устройство печати, размер

бумаги, масштаб);
• SheetSet (Параметры страницы) – данные о параметрах настройки страницы распе-

чатки.
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Значения, отображаемые в списке Field names (Имена полей), зависят от выбранной
категории. Остальные настройки в окне Field (Поле) изменяются на основе категории и
имени активного поля.

Например, выбор категории Date & Time (Дата и время) отображает список следую-
щих связанных с датой имен полей:

• CreateDate (Создание даты);
• Date (Дата);
• PlotDate (Печать даты);
• SaveDate (Сохранение даты).
Все поля даты позволяют вам определить ее формат в текстовом поле Date format

(Формат даты) и управлять появлением даты на рисунке. Вы можете ввести собственный
формат, используя управляющие коды клавиатуры, показанные в области Hints (Подсказки)
в правой части окна Field (Поле), или, что еще проще, выбрать предопределенный формат
из списка Examples (Примеры) (рис. 4.11).

 

Рис. 4.11. Диалоговое окно Field (Поле) с настройками даты
В области Field expression (Выражение для поля) отображается фактическое выраже-

ние, которое лежит в основе поля и не может быть отредактировано. Это выражение можно
использовать в качестве руководства для создания собственного выражения в текстовом поле
Date format (Формат даты).

После выбора желаемого имени поля и настройки нужных параметров форматирова-
ния следует щелкнуть на кнопке OK, чтобы вставить поле. На рис. 4.12 показано поле Date
(Дата), вставленное в текстовый объект.
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Рис. 4.12. Поле Date (Дата) в текстовом объекте
Примечание
Другие типы полей рассматривать в этой книге не будем. Для

получения подробной информации о поле можно воспользоваться
справкой, но обычно назначение поля понятно из его названия.

Текстовое поле является частью однострочного текстового объекта, поэтому для его
редактирования нужно использовать те же самые средства, какие вы используете, чтобы
редактировать однострочный текст. Выбрав поле, вы можете воспользоваться для его редак-
тирования командой контекстного меню Edit Field (Редактировать поле). Кроме того, вы
можете дважды щелкнуть кнопкой мыши на поле, чтобы отобразить диалоговое окно Field
(Поле) и произвести необходимые настройки в нем. Любые изменения применятся ко всему
тексту в поле.

Совет
Если вы больше не хотите обновлять поле, можно сохранить

значение, которое отображается в данный момент, преобразовав
поле в текст. Для этого предназначен пункт Convert Field To Text
(Преобразовать поле в текст) контекстного меню.

 
Создание многострочного текста

 
Многострочный текст – это сложный объект, состоящий из множества строк, которые

вы вводите в форме абзаца. При этом используется оперативный редактор, напоминающий
обычный текстовый редактор.

Текст автоматически форматируется, чтобы поместиться в ограниченную прямоуголь-
ником область, которую вы определяете с помощью двух угловых точек перед появлением
текстового редактора. AutoCAD автоматически определяет горизонтальную длину строки
текста, вставляя программный возврат подобно текстовому процессору. Высота многостроч-
ного текстового объекта зависит от количества строк в тексте, а не от высоты ограничиваю-
щей рамки (рис. 4.13).

 

Рис. 4.13. Многострочный текст
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Оперативный текстовый редактор предназначен для создания и редактирования текста
в выбранном месте. Благодаря прозрачности фона вы будете видеть направляющую линию
под областью редактора и соответственно определять местонахождение текста. Многостроч-
ный текст обладает такими особенностями, как:

• способность делать текстовый граничный фон непрозрачным и задавать для него
цвет;

• установка сдвигов и отступов;
• автоматическая вставка полей;
• импортирование внешних текстовых файлов в формате ASCII или RTF;
• расширенная вставка обычных и специальных символов;
• создание маркированных и нумерованных списков;
• создание сложных дробей и геометрических допусков;
• изменение граничной области текста с помощью управляющих маркеров и автомати-

ческое переформатирование длины строки текста;
• изменение регистра выбранного текста щелчком кнопкой мыши.
Итак, чтобы приступить к созданию многострочного текста, запустите команду

MTEXT: введите ее в командную строку либо на вкладке Home (Основная) в группе
Annotation (Аннотационные объекты) ленты щелкните на кнопке Multiline Text (Многос-
трочный текст). Если вы работаете с классическим интерфейсом AutoCAD, можно выпол-
нить команду Draw → Text → Multiline Text (Черчение → Текст → Многострочный текст).
В результате программа отобразит в командной строке текущий стиль и высоту текста и
выдаст запрос об определении угла:

Current text style: «Standard» Text height: 2.5 Annotative: No
Specify first corner:
Выберите первый угол прямоугольной области, которую вы хотите использовать для

создания текста. Появится следующий запрос:
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width/Columns]:
В графической области появится прямоугольная рамка, для которой следует подобрать

размер (рис. 4.14). Задайте координаты второй угловой точки или выберите один из параме-
тров, чтобы более тонко настроить текст.

 

Рис. 4.14. Граничная область многострочного текста
Стрелка внизу прямоугольника указывает, что текстовый поток направлен сверху вниз.

Это происходит потому, что заданное по умолчанию выравнивание для многострочного тек-
ста настроено по левому верхнему углу.

• С помощью параметра Justify можно изменить выравнивание текста. Выбирая раз-
личные варианты выравнивания, обратите внимание, как изменяются стрелки, указывающие
на направление текстового потока.

Примечание
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Существует также возможность изменить выравнивание после
ввода текста, используя инструменты вкладки Text Editor (Редактор
текста), которые мы рассмотрим далее в этой главе.

• Параметр Line spacing позволяет изменять межстрочный интервал (расстояние между
основаниями двух соседних строк текста) для многострочного текста. Значение по умолча-
нию для однострочного интервала составляет 1,66 высоты текста. Вы можете изменить меж-
строчный интервал путем ввода команды L и нажатия клавиши Enter или, если вы исполь-
зуете динамический ввод, с помощью клавиш управления курсором.

Вариант At least автоматически увеличивает такой межстрочный интервал, чтобы при-
способить к размещению символы, которые являются слишком большими, в то время как
вариант межстрочного интервала Exactly поддерживает постоянное значение. Оба варианта
позволяют вам устанавливать межстрочное расстояние, кратное интервалу однострочного
текста, или абсолютное расстояние. Чтобы определить кратность, введите множитель, сле-
дующий за символом x, иначе указанное значение будет абсолютным расстоянием.

• Параметр Rotation позволяет определить угол для целого многострочного текстового
объекта так, чтобы весь абзац текста поворачивался на угол, который вы определяете. После
выбора этого параметра AutoCAD выдаст запрос:

Specify rotation angle <0>:
Вы можете ввести угол с клавиатуры или определить его, указав точку на рисунке (пер-

вая угловая точка считается опорной).
Высоту, стиль и ширину текста можно также установить в оперативном текстовом

редакторе после выбора второй угловой точки, в то время как межстрочный интервал и угол
поворота должны быть указаны перед выбором второй угловой точки.

После того как вы выберете вторую точку, на ленте появится вкладка Text Editor
(Редактор текста) (см. рис. 4.3), и вы можете набирать текст.

По окончании ввода текста выйти из многострочного режима с созданием текстового
блока вы можете следующими способами:

• нажав кнопку Close Text Editor (Закрыть текстовый редактор) на вкладке Text Editor
(Редактор текста);

• щелкнув кнопкой мыши вне области текстового редактора;
• нажав клавишу Enter, удерживая Ctrl.
Для закрытия текстового редактора без сохранения текста или любых изменений

нажмите клавишу Esc.
Внимание
В предыдущих версиях программы при создании многострочного

текста использовалась панель Text Formatting (Форматирование
текста), которая в текущей версии заменена аналогичными
инструментами вкладки Text Editor (Редактор текста). Тем не менее
в AutoCAD 2010 она по-прежнему присутствует (рис. 4.15), только по
умолчанию скрыта от глаз пользователя. Вызвать ее можно с помощью
команды Editor Settings → Show Toolbar (Настройки редактора →
Показывать панель инструментов) контекстного меню многострочного
текста.

 

Рис. 4.15. Панель Text Formatting (Форматирование текста)
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Редактирование многострочного текста

 
Как вы уже знаете, работа с текстом в области ввода происходит как в большинстве

текстовых редакторов. Когда набираемый текст достигает границы области, AutoCAD авто-
матически делает «мягкий» перенос, обрывая строку. При желании можно также расставить
собственные «жесткие» переносы, нажимая клавишу Enter. Вы можете использовать стан-
дартные клавиши и сочетания клавиш, представленные в табл. 4.1, для управления текстом:
выделения, копирования, вставки, удаления и редактирования.

 
Таблица 4.1. Клавиши для работы с текстом в AutoCAD

 
 

Совет
Вы можете использовать буфер обмена, чтобы копировать и

вставлять текст из других приложений Windows в AutoCAD и наоборот.
Линейка показывает ширину текста в установленных единицах измерения (рис. 4.16).

 

Рис. 4.16. Текстовая линейка
Чтобы установить отступ для первой строки абзаца, следует щелкнуть на стрелке, рас-

положенной на верхней границе линейки, и переместить ее в требуемое место (рис. 4.17).
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Рис. 4.17. Установка отступа для первой строки абзаца
Для того чтобы задать отступ для целого абзаца, следует щелкнуть на стрелке, распо-

ложенной на нижней границе линейки, и переместить ее на нужное расстояние (рис. 4.18).
 

Рис. 4.18. Установка отступа для всего абзаца
Вы можете создать один или более табуляторов, для чего нужно щелкнуть на том месте

линейки, где вы хотите определить местонахождение табулятора. Созданные табуляторы
можно перемещать с помощью мыши. Для удаления табулятора просто щелкните на нем и
перетащите за границы линейки.

Вкладка Text Editor (Редактор текста) ленты, показанная на рис. 4.3, используется для
управления всеми параметрами текста – от стиля и шрифта до высоты и выравнивания. Она
содержит следующие группы:

• Style (Стиль) – выбор текущего стиля текста;
• Formatting (Форматирование) – настройка шрифта текста и дополнительных пара-

метров его отображения;
• Paragraph (Абзац) – выбор расположения текста;
• Insert (Вставка) – вставка колонок, дополнительных символов и текстовых полей;
• Spell Check (Проверка правописания) – проверка ошибок и доступ к словарям про-

граммы;
• Tools (Сервис) – поиск, замена и импорт текста;
• Options (Параметры) – настройки текста и линейки;
• Close (Закрыть) – завершение редактирования текста.
Различные настройки этой панели можно применять как к новому, так и к существую-

щему тексту (при этом он должен быть выделен).
Совет
Помните, что обычно изменение большинства параметров текста

происходит путем использования текстовых стилей, так как это
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обеспечивает централизованное управление форматированием текста,
облегчая его обновление. Применение к тексту различных вариантов
форматирования непосредственно на вкладке Text Editor (Редактор
текста) считается перекрытием стиля текста. Этого по-возможности
следует избегать.

Рассмотрим более подробно некоторые элементы вкладки Text Editor (Редактор тек-
ста).

• Группа Style (Стиль) позволяет задать текстовый стиль и размер для нового текста
или меняет для любого выделенного. О текстовых стилях и их использовании мы поговорим
далее в этой главе.

С помощью списка Text Height (Высота текста) можно установить высоту символов
для нового текста или выделенного фрагмента. Объект с многострочным текстом может
содержать символы разной высоты. Если желаемой высоты нет в списке, вы должны щелк-
нуть на поле Text Height (Высота текста) и ввести нужное значение. Набранное число станет
частью списка, и в следующий раз вы сможете его выбрать.

Совет
Если высота текущего стиля текста равна 0.0, вы можете

изменить высоту многострочного текста по умолчанию, отображенную
в списке Text Height (Высота текста), с помощью системной переменной
TEXTSIZE.

• Группа Formatting (Форматирование) определяет шрифт нового или выделенного
текста. В списке Font (Шрифт) перечислены одновременно шрифты TrueType и AutoCAD
SHX. Существует возможность смешивать различные шрифты внутри одного абзаца мно-
гострочного текста.

Раскрывающийся список Text Editor Color Gallery (Цветовая галерея редактора тек-
ста) определяет цвет текста. Вы можете выбрать из списка нужный цвет или пункт Select
Colors (Выбор цветов) для отображения диалогового окна Select Color (Выбор цвета).

Кнопка Bold (Полужирный)
 

включает и выключает полужирное начертание для нового или выделенного текста.
Эта настройка доступна только для символов, использующих шрифты TrueType.

С помощью кнопки Italic (Курсив)
 

можно включить и выключить курсивное начертание шрифта. Эта настройка также
доступна только для символов, использующих шрифты TrueType.

Кнопка Underline (Подчеркивание)
 

задает подчеркивание текста.
С помощью кнопки Make Uppercase (Сделать верхний регистр)

 

назначить для выделенного текста верхний регистр.
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Кнопка Make Lowercase (Сделать нижний регистр)
 

задает для текста нижний регистр.
Если щелкнуть кнопкой мыши на нижней границе группы Formatting (Форматирова-

ние), откроется панель, содержащая еще три элемента управления.
• Поле Oblique Angle (Угол наклона) управляет углом наклона текста (рис. 4.19).

Введенный угол измеряется начиная с 90° по вертикали, поэтому положительное значение
наклоняет текст вправо, а отрицательное – влево. Вы можете ввести в поле число от -85° до
85° или выбрать нужный угол с помощью стрелок.

 

Рис. 4.19. Курсивный и наклонный текст
• В поле Tracking (Интервал) можно уменьшить или увеличить промежуток между

символами текста. Вы можете ввести значение в поле или указать его с помощью стрелок.
• Поле Width Factor (Коэффициент ширины) управляет шириной текстового символа.

Заданная по умолчанию ширина – 1. Ввод больших значений раздвигает текст так, что он
становится шире, меньших – сжимается (рис. 4.20).

 

Рис. 4.20. Различные значения параметра Width Factor (Коэффициент ширины)
• Группа Paragraph (Абзац) предлагает пользователю различные варианты выравни-

вания текста, а также создания списков и изменения межстрочного расстояния.
Кнопка Justification (Выключка) открывает доступ к способам выравнивания текста

(все эти параметры также доступны посредством динамического ввода):
· Top Left TL (Верх лево ВЛ) – текст выравнивается по левой верхней точке;
· Top Center TC (Верх центр ВЦ) – текст выравнивается по центральной верхней точке;
· Top Right TR (Верх право ВП) – текст выравнивается по правой верхней точке;
· Middle Left ML (Середина лево СЛ) – текст выравнивается по точке, в которой будет

находиться середина прописных букв (при этом текст прижимается к левому краю);
· Middle Center MC (Середина центр СЦ) – текст выравнивается по точке, в которой

будет находиться середина прописных букв (при этом текст центрируется по горизонтали);
· Middle Right MR (Середина право СП) – текст выравнивается по точке, в которой

будет находиться середина прописных букв (при этом текст прижимается к правому краю);
· Bottom Left BL (Низ лево НЛ) – текст выравнивается по левой нижней точке;
· Bottom Center BC (Низ центр НЦ) – текст выравнивается по центральной нижней

точке;
· Bottom Right BR (Низ право НП) – текст выравнивается по правой нижней точке.
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Кнопка Bullets and Numbering (Маркеры и нумерация) предназначена для создания
списков. При щелчке на ней появляется меню, в котором можно выбрать нужный тип списка.

· Numbered (Нумерованный) – номера выравниваются по левому краю, а текст –
с использованием отступа абзаца, который можно откорректировать с помощью линейки
(рис. 4.21).

 

Рис. 4.21. Нумерованный список
· Bulleted (Маркированный) – выравнивание элементов не отличается от нумерован-

ного списка (рис. 4.22).
 

Рис. 4.22. Маркированный список
· Lettered (C буквами) – список, в котором в качестве маркеров используются буквы:

строчные (Lowercase) или прописные (Uppercase) (рис. 4.23).
 

Рис. 4.23. Маркированный список с прописными буквами
Примечание
В AutoCAD 2010 присутствует функция Auto-list (Автосписок).

Благодаря ей текст, вводимый в многострочном текстовом редакторе
в виде списка, автоматически преобразуется в нумерованный или
маркированный список. Включить или отключить данную функцию
можно соответственно установкой или снятием флажка Allow Auto-
list (Использовать автосписок) в меню кнопки Bullets and Numbering
(Маркеры и нумерация).

Нажатие кнопки Line Spacing (Межстрочное расстояние) открывает список с различ-
ными значениями межстрочного расстояния.

Кнопки Left (По левому краю)
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Center (По центру)
 

Right (По правому краю)
 

и Justify (По ширине)
 

задают горизонтальное выравнивание многострочного текста. Изначально устано-
влено выравнивание Default (По умолчанию)

 

Если щелкнуть на нижней границе группы Paragraph (Абзац), то можно получить
доступ еще к одной кнопке – Combine Paragraphs (Объединить абзацы). С ее помощью
можно объединить множество абзацев выделенного текста, удаляя любые переносы строк
так, что выделенный текст станет одним абзацем. Первоначальные свойства текста будут
сохранены.

• Группа Insert (Вставка) содержит кнопки для создания колонок, вставки в документ
специальных символов и текстовых полей.

Для разбиения текста на колонки нажмите кнопку Columns (Колонки) и с помощью
открывшегося меню укажите параметры разбиения.

· No Columns (Колонок нет) – разбиение на колонки отсутствует.
· Dynamic Columns (Динамические колонки) – создание динамических колонок, рас-

пределение текста в которых происходит автоматически.
· Static Columns (Статические колонки) – создание статических колонок, для которых

вы можете самостоятельно указать высоту, ширину и количество.
· Insert Column Break (Вставка разрыва между колонками) – позволяет вручную вста-

вить разрыв между колонками.
· Column Settings (Настройки колонок) – вызывает одноименное диалоговое окно

(рис. 4.24). В нем можно задать различные параметры разбиения текста на колонки. В обла-
сти Column Type (Тип колонок) с помощью пере ключателя можно выбрать требуемый тип
колонок. Поля Column Number (Количество колонок) и Height (Высота) служат для указа-
ния количества и высоты колонок. В области Width (Ширина) с помощью полей Column
(Колонка), Gutter (Расстояние между колонками) и Total (Всего) можно установить ширину
колонок, расстояние между ними, а также общую ширину текста. Следует помнить, что при
изменении значения одного поля в соответствии с ним автоматически меняются значения
в двух других.
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Рис. 4.24. Окно Column Settings (Настройки колонок)
Нажатие кнопки Symbol (Символ) приводит к отображению меню, которое позволяет

вставлять символ или неразрывный пробел в место нахождения курсора. Некоторые наибо-
лее часто используемые символы перечислены в меню с управляющим кодом AutoCAD %
% или значением Unicode (рис. 4.25).
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Рис. 4.25. Меню вставки управляющих символов
Выбор в данном меню пункта Other (Другой) приводит к появлению диалогового окна

Таблица символов (рис. 4.26). В этом окне можно выбрать знаки, которые не включены в
меню. Здесь отображается полный набор символов для каждого доступного шрифта. Чтобы
вставить символ, следует его выделить и щелкнуть на кнопке Выбрать, чтобы он поме-
стился в поле Для копирования, после чего нажать кнопку Копировать. При этом символ
будет скопирован в буфер обмена. Затем вы можете переключиться назад, в многострочный
редактор, и вставить выбранный символ в требуемое место.
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Рис. 4.26. Диалоговое окно Таблица символов
Примечание
Таблица символов фактически является отдельной программой,

которая при открытии появляется на Панели задач Windows, поэтому
после работы ее следует закрыть.

Нажатие кнопки Field (Поле) открывает диалоговое окно Field (Поле), предназначен-
ное для вставки в текст поля (см. рис. 4.10).

• Группа Spell Check (Проверка правописания) включает в себя две кнопки, предна-
значенные для проверки орфографии в документе и доступа к словарям программы.

Редактирование любого текста невозможно представить без исправления ошибок.
AutoCAD имеет встроенные средства проверки правописания, которые помогают испра-
вить некоторые очевидные ошибки, например опечатки. Чтобы включить режим проверки,
нажмите кнопку Spell Check (Проверка правописания).

Для проверки правописания во всем документе выполните команду Tools → Spelling
(Сервис → Правописание). После ее вызова на экране появится окно Check Spelling (Про-
верка правописания) (рис. 4.27). Используя его, вы можете просматривать каждую найден-
ную ошибку и принимать решение о ее исправлении. Для запуска проверки нажмите кнопку
Start (Пуск).
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Рис. 4.27. Окно Check Spelling (Проверка правописания)
В раскрывающемся списке Where to check (Где проверять) укажите область проверки:
• Entire drawing (Чертеж полностью) – проверка правописания по всему чертежу;
• Current space/layout (Текущее пространство/лист) – проверка в текущем простран-

стве модели или на листе;
• Selected objects (Выбранные объекты) – при указании этого пункта становится

доступной кнопка выбора объектов, для которых требуется выполнить проверку орфогра-
фии.

В области Not in dictionary (Отсутствует в словаре) отобразится слово, которое про-
грамма не смогла найти в подключаемом словаре. В списке Suggestions (Предположения)
отобразятся похожие слова из словаря. Одним из них программа предлагает заменить ненай-
денное слово. Для замены выберите подходящее слово в этом списке и нажмите кнопку
Change (Заменить). Для игнорирования ошибки и перехода к следующему слову нажмите
кнопку Ignore (Игнорировать). Для добавления слова в словарь нажмите кнопку Add to
Dictionary (Добавить в словарь). Для игнорирования всех таких же слов, встречающихся
в тексте, нажмите кнопку Ignore All (Игнорировать все). Для замены слова выбранным
нажмите кнопку Change All (Заменить все).

Для выбора словаря, который будет использоваться для проверки, нажмите кнопку
Dictionaries (Словари). В списке Current main dictionary (Текущий главный словарь)
открывшегося окна Dictionaries (Словари) (рис. 4.28) можно указать один из доступных
словарей. Список Current custom dictionary (Текущий настраиваемый словарь) позво-
ляет задать используемый настраиваемый словарь. С помощью поля Content (Содержимое)
можно добавлять слова в настраиваемый словарь, удалять введенные ранее и импортировать
их из файла.
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Рис. 4.28. Окно Dictionaries (Словари)
С помощью кнопки Settings (Настройки) в окне Check Spelling (Проверка правопи-

сания) можно открыть окно Check Spelling Settings (Настройки проверки правописания) и
задать необходимые параметры (рис. 4.29).
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Рис. 4.29. Окно Check Spelling Settings (Настройки проверки правописания)
Кнопка Undo (Отмена) в окне Check Spelling (Проверка правописания) позволяет

отменять ошибочные действия предыдущих операций проверки орфографии.
• При нажатии кнопки Find & Replace (Найти и заменить) в группе Tools (Сервис)

появляется диалоговое окно Find and Replace (Найти и заменить) (рис. 4.30). С его помощью
можно искать определенные строки текста и заменять их новыми.

 

Рис. 4.30. Окно поиска и замены
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В поле Find what (Заменить что) следует ввести текст, который вы хотите найти, а
в поле Replace with (Заменить чем) – текст замены. С помощью флажков, расположенных
ниже, можно задать условия поиска. После задания критериев выберите одно из трех дей-
ствий:

· нажмите кнопку Find Next (Найти далее), чтобы найти и выделить следующее вхо-
ждение искомого текста;

· щелкните на кнопке Replace (Заменить), чтобы заменить текст, найденный в многос-
трочном текстовом редакторе, фрагментом, который введен в поле Replace with (Заменить
чем);

· нажмите кнопку Replace All (Заменить все), чтобы найти и заменить все вхождения
заданного текста. После такой замены на экране появится окно с информацией о том, сколько
фрагментов было заменено.

• Далее на вкладке Text Editor (Редактор текста) расположена группа Options (Пара-
метры). Рассмотрим ее содержимое.

Нажатие кнопки More (Больше) приводит к появлению меню с дополнительными
параметрами многострочного текста.

Кнопка Ruler (Линейка) предназначена для включения и выключения отображения
линейки в области редактирования.

Нажатие кнопки Undo (Отмена)
 

отменяет одно или более действий, выполненных в текстовом редакторе.
Щелчок на кнопке Redo (Восстановление)

 

возвращает действия, отмененные кнопкой Undo (Отмена).
• В группе Close (Закрыть) находится всего одна кнопка – Close Text Editor (Закрыть

текстовый редактор).
Меню, которое появляется после нажатия кнопки More (Больше) в группе Options

(Параметры), и контекстное меню, открывающееся после щелчка правой кнопкой мыши на
области редактора, позволяют настроить дополнительные параметры многострочного тек-
ста (рис. 4.31). Некоторые пункты в этих меню идентичны, однако контекстное меню предо-
ставляет доступ к специфическим командам редактирования текста, таким как Cut (Выре-
зать), Copy (Копировать) и Paste (Вставить).
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Рис. 4.31. Контекстное меню многострочного редактора
Пункт Import Text (Импорт текста) контекстного меню позволяет импортировать тек-

стовый файл TXT или RTF в многострочный текстовый редактор. Выбор этого пункта при-
водит к открытию диалогового окна Select File (Выбор файла), в котором можно выбрать
необходимый текстовый файл для импорта.

Пункт меню Paragraph (Абзац) отображает одноименное диалоговое окно, показан-
ное на рис. 4.32. В этом окне можно определять отступы и табуляции, вводя их с клавиатуры
(если вы не хотите использовать для этого линейку редактора). Табуляторы настраиваются
вводом значений в области Tab (Табуляция) и щелчком на кнопке Add (Добавить). Позиция
табуляции отображается в списке непосредственно под текстовым полем. Вы можете убрать
установленные позиции, выбирая их в списке и щелкая на кнопке Remove (Удалить). Для
определения отступов первой строки и абзацев просто введите расстояния в соответствую-
щие текстовые поля в областях Left Indent (Отступ слева) и Right Indent (Отступ справа).
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Рис. 4.32. Окно Paragraph (Абзац)
При выборе пункта Bullets and Lists (Маркеры и списки) появляется подменю, содер-

жащее все варианты списков, доступных на вкладке Text Editor (Редактор текста), и предо-
ставляющее некоторые дополнительные возможности:

• Off (Выключить) – удаляет буквы, номера и маркеры из выделенного текста, не изме-
няя отступы;

• Restart (Начать заново) – начинает новую нумерованную или обозначенную буквами
последовательность;

• Continue (Продолжить) – добавляет выбранный текст к имеющемуся списку и про-
должает нумерованную или обозначенную буквами последовательность.

Пункт контекстного меню Change Case (Изменить регистр) содержит подменю с пунк-
тами UPPERCASE (Верхний регистр) и lowercase (нижний регистр), предназначенными
для изменения регистра всего выделенного текста.

Щелчком на строке AutoCAPS (Автоматические заглавные буквы) можно включить и
выключить набор большими буквами. Эта функция блокирует клавиатуру таким образом,
что вы можете вводить только заглавные буквы, как при нажатии клавиши Caps Lock. Такую
блокировку удобно использовать при работе с чертежом, так как большинство примечаний
необходимо представлять в верхнем регистре согласно промышленным стандартам.

Подменю Character Set (Набор символов) (рис. 4.33) можно использовать для замены
применяемого набора символов, чтобы текст корректно отображался на других языках.
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Рис. 4.33. Различные наборы символов
Примечание
Набор символов – это комплект числовых кодов, используемый

компьютерной системой для представления символов (букв, чисел,
знаков препинания и т. д.) определенной страны или местности.

Команда Remove Formatting (Удалить форматирование) отменяет все форматирова-
ние выделенного текста, оставляя только свойства назначенного данному фрагменту стиля.

Щелчок на пункте меню Background Mask (Фоновая маска) открывает диалоговое
окно, представленное на рис. 4.34. Это окно позволяет сделать фон ограничивающей рамки
текста непрозрачным и задать его цвет. Флажок Use background mask (Использовать маску
фона) включает и выключает фон. Параметр Border offset factor (Коэффициент смещения
границы) позволяет расширить область фона вне первоначальной граничной области мно-
гострочного текста.

 

Рис. 4.34. Окно Background Mask (Фоновая маска)
Вы можете применить цвет заливки к фоновой области, используя список цветов в

области Fill Color (Цвет заливки), или задать использование цвета фона рисунка, устано-
вив флажок Use drawing background color (Использовать цвет фона чертежа). Использова-
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ние цвета фона позволяет помещать рабочую строку под областью многострочного текста,
чтобы вы не могли ее видеть.

Пункт Editor Settings (Настройки редактора) контекстного меню дает возможность
управлять отображением следующих элементов многострочного текстового редактора
(установленный флажок означает отображение элемента):

• Show Toolbar (Показывать панель инструментов) – панели форматирования текста;
• Show Options (Показывать параметры) – нижней части панели форматирования тек-

ста;
• Show Ruler (Показывать линейку) – линейки.
С помощью специальных символов компоновки выделенный текст можно преобразо-

вать в горизонтальную дробь, диагональную дробь или допуск (рис. 4.35):
• ^ – выровненные по левому краю значения допуска;
• / – выровненная по центру дробь с горизонтальной чертой;
• # – дробь с косой чертой высотой в две текстовые строки.

 

Рис. 4.35. Варианты компоновки
При их вводе на экране появляется диалоговое окно AutoStack Properties (Свойства

автокомпоновки) (рис. 4.36). В этом окне вы можете определить специфические свойства
компоновки текста, которые будут применяться автоматически.

 

Рис. 4.36. Окно настройки свойств автокомпоновки
Флажок Enable AutoStacking (Включить автокомпоновку) предоставляет возмож-

ность включать и выключать функцию автокомпоновки. Если он установлен, текст компо-
нуется автоматически при вводе числа, сопровождаемого специальным символом.
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Флажок Remove leading blank (Удалить следующий пробел) предназначен для автома-
тического удаления любого промежутка между целым числом и дробью, если он установлен.

Вы можете указать, как должна выглядеть преобразованная дробь с символом /. Для
этого предназначен переключатель Specify how «x/y» should stack (Определить, как будет
компоноваться выражение x/y). Если он установлен в положение Convert it to a diagonal
fraction (Преобразовывать в дробь с косой чертой), образуются дроби с косой чертой, а если
в положение Convert it to a horizontal fraction (Преобразовывать в дробь с горизонтальной
чертой) – дроби с горизонтальной чертой.

Совет
Если вы установите флажок Don't show this dialog again; always

use these settings (Больше не показывать это окно; всегда использовать
данные настройки), то, когда вы снова захотите открыть окно AutoStack
Properties (Свойства автокомпоновки), нужно будет выделить дробь в
многострочном текстовом редакторе, щелкнуть правой кнопкой мыши
и выбрать в контекстном меню пункт Stack Properties (Свойства
компоновки). Появится окно Stack Properties (Свойства компоновки)
(рис. 4.37). Нажав в данном окне кнопку AutoStack (Автокомпоновка),
вы откроете требуемое окно настройки свойств автокомпоновки.

 

Рис. 4.37. Диалоговое окно Stack Properties (Свойства компоновки)
Диалоговое окно Stack Properties (Свойства компоновки) предназначено для редак-

тирования содержимого, расположения, выравнивания и размера скомпонованного текста.
Рассмотрим параметры, доступные в этом окне.

• В полях Upper (Верхнее) и Lower (Нижнее) области Text (Текст) можно изменить
верхнее и нижнее значения, скомпонованные в виде дроби.

• Элементы, расположенные в области Appearance (Вид), предназначены для редак-
тирования стиля, положения или текстового размера дроби.

· Раскрывающийся список Style (Стиль) позволяет переключаться между стилями ото-
бражения: в виде горизонтальной дроби, дроби с косой чертой и допуском.

· Из раскрывающегося списка Position (Положение) можно выбрать способ выравни-
вания текста: Top (По верху) – вершина дроби располагается на одном уровне с вершиной
предыдущего текста, Center (По центру) – дробь центрируется вертикально в соответствии
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с центром предыдущего текста, Bottom (По низу) – основание дроби выравнивается по пре-
дыдущему тексту.

• Список Text size (Размер текста) управляет размером скомпонованного текста в про-
центном отношении к высоте числового текста. Допустимые значения находятся между 25
и 125 %, по умолчанию установлено значение 70 %.

• Кнопка Defaults (Значения по умолчанию) позволяет восстановить значения по умол-
чанию свойств компоновки текста или сохранить текущие свойства компоновки как новые
значения по умолчанию.

 
Стиль текста

 
Шрифтом, высотой и другими характеристиками, которые влияют на вид текста,

можно управлять с помощью текстовых стилей. С любым текстом на рисунке связан опре-
деленный стиль. При добавлении нового текста используются настройки стиля, заданные
в данный момент. Текущий стиль текста можно указать, выбрав его из списка на панели
инструментов Styles (Стили) (рис. 4.38) или на вкладке Text Editor (Редактор текста) ленты.
При создании однострочного текста стиль можно задать с помощью параметра Style.

 

Рис. 4.38. Панель инструментов Styles (Стили)
Стиль текста, установленный по умолчанию, – Standard (Стандартный) – назначен для

обобщенного шрифта Arial с высотой текста 0.0000. Текстовый стиль Standard (Стандарт-
ный) можно изменить, а можно создать один или несколько новых стилей с определенными
именами, задав для каждого требуемый шрифт, высоту и другие свойства.

Использование стилей текста предоставляет множество дополнительных возможно-
стей. Стили облегчают изменение вида текста в случае необходимости. Например, если
изменились требования к шрифту для определенного текста, вам нужно обновить только
соответствующий текстовый стиль. Если же вы не используете эту функцию, то вам при-
дется найти на чертеже каждое вхождение текста, в котором используется старый шрифт, и
изменить его вручную.

Применение стилей для управления отображением текста также позволяет использо-
вать чертежные стандарты, придавая последовательный вид всему проекту или всем проек-
там конкретной организации.

Совет
Если вы будете создавать все стандартные стили текста в

файле шаблона, то впоследствии сможете использовать эти стили
при создании нового рисунка. Кроме того, используя возможности
DesignCenter (Центр управления), вы сможете копировать текстовые
стили из другого рисунка перетаскиванием с помощью мыши (работа с
палитрой DesignCenter (Центр управления) рассмотрена в главе 7).

Диалоговое окно Text Style (Стиль текста) (рис. 4.39), открываемое при нажатии
кнопки Text Style (Стиль текста)

 

на панели Styles (Стили) позволяет контролировать и управлять стилями текста:
• устанавливать текущий стиль текста;
• добавлять, удалять и переименовывать стили текста;
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• назначать или изменять шрифт;
• устанавливать высоту текста;
• применять различные текстовые эффекты, которые заставляют текст читаться инвер-

тированно, в обратном направлении или даже вертикально;
• изменять ширину текста так, чтобы он становился разреженным или сжатым;
• наклонять текст под назначенным углом вперед или назад.

 

Рис. 4.39. Диалоговое окно настройки стиля текста
Открыть это окно можно также, щелкнув на кнопке Text Style (Стиль текста) на

вкладке Home (Основная) в группе Annotation (Аннотационные объекты) ленты. Кроме
того, можно выполнить команду меню Format → Text Style (Формат → Стиль текста). Еще
один способ – ввести с клавиатуры команду STYLE или ST.

В списке Styles (Стили) показаны все стили текста, которые используются на чер-
теже. Чтобы изменить текущий стиль, вы можете выбрать другой стиль из списка или
нажать кнопку New (Новый) для создания нового стиля. При нажатии этой кнопки на экране
появится окно New Text Style (Новый стиль текста) (рис. 4.40).

 

Рис. 4.40. Окно создания нового стиля текста
По умолчанию задано имя стиля style, сопровождаемое номером (style1, style2, style3 и

т. д.). Чаще всего пользователи хотят указать для стиля другое имя, например совпадающее с
названием связанного с ним шрифта. Если вы собираетесь назначить шрифт SIMPLEX.SHX,
то можете назвать стиль текста именем Simplex. Создав новый стиль, нажмите кнопку OK.

Кнопка Delete (Удалить) позволяет удалить выбранный стиль текста.
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Внимание!
Из списка можно удалить только неиспользуемые текстовые

стили. В рисунке не должно быть текста, использующего стиль,
который вы хотите удалить, иначе кнопка Delete (Удалить) будет
неактивной.

В области Font (Шрифт) диалогового окна Text Style (Стиль текста) можно изменить
название шрифта и его стиль.

Раскрывающийся список Font Name (Имя шрифта) содержит перечень всех зареги-
стрированных графических шрифтов TrueType и AutoCAD SHX. Шрифтам TrueType пред-
шествует значок

 

в то время как шрифты SHX сопровождаются значком
 

Внимание!
Изменение шрифта стиля текста автоматически изменит шрифт

всех текстовых фрагментов в чертеже, использующих данный стиль.
Фактически это серьезная причина использовать стили текста для
управления шрифтами: так задавать вид текста гораздо удобнее.

С помощью списка Font Style (Стиль шрифта) определяют курсивное, полужирное или
обычное начертание для шрифтов TrueType. Этот список заблокирован, если выбран тип
шрифта AutoCAD SHX. Когда установлен флажок Use Big Font (Использовать расширенный
шрифт), список Font Style (Стиль шрифта) заменяется на Big Font (Расширенный шрифт),
который предназначен для выбора имени файла расширенного шрифта. Такие файлы обес-
печивают расширенный набор символов, необходимый для многих азиатских языков.

В поле Height (Высота) области Size (Размер) вводят желаемую высоту текста, создан-
ного с использованием выбранного стиля. Напомним, что, если вы используете значение по
умолчанию (0.0000), AutoCAD запрашивает высоту текста каждый раз, когда вы добавляете
текст, и выбранный стиль текста является текущим. Установка значения больше, чем 0.0000,
задает высоту текста для этого стиля так, что программа не запрашивает ее каждый раз при
добавлении текста. Некоторые шрифты TrueType могут отображаться с меньшей высотой,
чем шрифты AutoCAD SHX с тем же значением высоты.

Совет
Существует общее соглашение – называть стиль текста так, чтобы

он отображал текстовую высоту, если ее значение отлично от 0.0000.
Например, стиль текста, присвоенный шрифту SIMPLEX.SHX при
высоте 0.125, можно было бы назвать Romans.125 или Romans_125.
Таким образом, при установке текущего стиля текста вы уже будете
знать его шрифт и высоту.

Область Effects (Эффекты) диалогового окна Text Style (Стиль текста) предназна-
чена для настройки применения различных шрифтовых эффектов. Установка флажка Upside
down (Перевернуть) переворачивает текст, а параметр Backwards (В обратном порядке)
задает отображение текста задом наперед (рис. 4.41).
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Рис. 4.41. К тексту применены эффекты переворачивания и обратного порядка в обла-
сти просмотра окна Text Style (Стиль текста)

Установка флажка Vertical (Вертикально) размещает текст вертикально. Эта функция
доступна, только если выбранный шрифт поддерживает двойную ориентацию.

Внимание!
Установка флажков Upside down (Перевернуть) и Backwards (В

обратном порядке) влияет только на однострочный текст. На новый и
существующий многострочный текст эти настройки не действуют.

Параметр Width Factor (Коэффициент ширины) задает межсимвольный интервал. В
поле Oblique Angle (Угол наклона) можно ввести угол наклона текста.

Область предварительного просмотра обеспечивает динамический предварительный
просмотр различных параметров стиля текста во время их изменения, поэтому вы заранее
можете представить, как будет выглядеть надпись.

Примечание
Некоторые шрифты TrueType с примененными эффектами

могут показаться рельефными. Не слишком увлекайтесь эффектами,
поскольку они не будут выглядеть так в распечатанном виде.

Нажав кнопку Apply (Применить), вы примените изменения, заданные в окне Text
Style (Стиль текста), ко всему тексту выбранного стиля.

Кнопка Cancel (Отмена) предназначена для отмены от любых изменений и выхода из
окна Text Style (Стиль текста). Эта кнопка изменяется на Close (Закрыть) всякий раз, когда
производится изменение любой из настроек в области Styles (Стили). Создание, переимено-
вание или удаление стиля текста – это все те действия, которые не могут быть отменены.
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Создание и изменение таблиц

 
Таблица представляет собой объект, который состоит из данных в виде строк и столб-

цов. Многие общие возможности электронной таблицы можно использовать в сочетании с
таблицами AutoCAD.

 
Создание таблиц

 
Команда TABLE создает табличный объект: вставляет пустую таблицу в рисунок, начи-

ная с указанной точки, или в определенную область с использованием стиля таблицы, коли-
чества строк, столбцов и размеров, которые вы назначаете.

После запуска команды TABLE отображается диалоговое окно Insert Table (Вставить
таблицу), показанное на рис. 4.42. Область Table style (Стиль таблицы) используется для
управления видом таблицы. С помощью стилей таблиц вы настраиваете текстовые и гранич-
ные свойства для ячеек данных, названий столбцов и заголовков.

 

Рис. 4.42. Диалоговое окно Insert Table (Вставить таблицу)
Примечание
Ячейка – это пересечение строки и столбца таблицы. В ней могут

находиться данные в виде текста, полей, блоков или формул.
Раскрывающийся список в области Table style (Стиль таблицы) позволяет задать теку-

щий стиль таблицы. По умолчанию установлен стиль Standard (Стандартный). Как видно
в области предварительного просмотра (Preview), этот стиль предусматривает наличие как
строки заголовка, так и строки с названиями столбцов. Отображение этих строк можно
отключить в диалоговом окне Table Style (Стиль таблицы), которое мы рассмотрим позже.
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Примечание
Вы можете установить текущий стиль таблицы, используя панель

инструментов Styles (Стили).
Данные таблицы AutoCAD могут ссылаться на данные таблицы Microsoft Excel.

Ссылки могут указывать на целые рабочие листы, отдельные ячейки или диапазоны ячеек.
Для создания новой ссылки на данные таблицы Microsoft Excel выполните следующие дей-
ствия.

1. В области Insert options (Параметры вставки) окна Insert Table (Вставить таблицу)
установите переключатель в положение From a data link (По ссылке на данные).

2. Из раскрывающегося списка From a data link (По ссылке на данные) выберите зна-
чение Launch Data Link Manager (Запустить менеджер присоединения данных) или щелк-
ните кнопкой мыши на кнопке рядом со списком.

3. В результате откроется окно Select a Data Link (Выбор ссылки на данные). Щелк-
ните в нем на строке Create a new Excel Data Link (Создать новую ссылку на данные Excel).
Появится диалоговое окно Enter Data Link Name (Ввод имени связи с данными).

4. Введите имя новой связи с данными, например newlink, и нажмите кнопку OK.
Откроется диалоговое окно New Excel Data Link: newlink (Новая ссылка на данные Excel:
newlink).

5. Из раскрывающегося списка Use an existing Excel file or browse for a new one
(Использовать существующий файл Excel или найти новый) выберите пункт Browse for a
file (Найти файл) или щелкните на кнопке, расположенной справа от списка.

6. В появившемся стандартном окне выбора файла найдите нужный файл Excel, после
чего нажмите кнопку Open (Открыть). Окно New Excel Data Link: newlink (Новая ссылка на
данные Excel: newlink) примет вид, представленный на рис. 4.43. В раскрывающемся списке
появится пункт, соответствующий новой ссылке.
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Рис. 4.43. Вид окна New Excel Data Link: newlink (Новая ссылка на данные Excel:
newlink) после создания ссылки
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7. В области Link options (Параметры ссылок) в списке Select Excel sheet to link to
(Выбрать лист Excel для связи) выберите определенный лист из присоединенной рабочей
книги Excel. Установите переключатель в одно из имеющихся положений:

• Link entire sheet (Присоединить весь лист);
• Link to a named range (Ссылка на именованный диапазон);
• Link to range (Ссылка на диапазон). Рядом с данным положением переключателя

расположено текстовое поле для ввода одного из принятых стандартных обозначений диа-
пазона ячеек, а также кнопка Preview (Предварительный просмотр), позволяющая увидеть
в нижней части окна создаваемую таблицу.

Кроме того, справа внизу в диалоговом окне New Excel Data Link: newlink (Новая
ссылка на данные Excel: newlink) есть кнопка More options (Дополнительные параметры)

 

при нажатии которой окно расширяется и открываются дополнительные настройки
содержимого ячеек и его форматирования.

Примечание
Данные, полученные по ссылке, и таблицы Excel могут

обновляться синхронно. Изменения, выполненные в Excel, сразу же
загружаются по заданным ссылкам. И наоборот, если вы изменяете
данные в связанной таблице чертежа, то можете легко обновить
оригинал.

В области Insertion behavior (Режим вставки) окна Insert Table (Вставить таблицу)
можно выбрать, как вы хотите определять местонахождение таблицы: используя точку ввода
или определяя ограничивающую область.

• Установив переключатель в положение Specify insertion point (Назначить точку
ввода), вы можете определить местоположение левого верхнего угла таблицы. Точку можно
выбрать с помощью мыши или задать ее абсолютные координаты с клавиатуры.

• Если переключатель установлен в положение Specify window (Определить окно), вы
можете определить местонахождение и установить размеры таблицы, задав прямоугольную
область (ее можно указать с помощью мыши или ввести абсолютные координаты с клавиа-
туры). Заданная ширина столбца и окончательное количество строк таблицы зависят от раз-
мера ограничивающей области.

Размеры таблицы можно установить в области Column & row settings (Настройки
столбца и строки).

• В поле Columns (Столбцы) определяется количество столбцов: вы можете ввести
значение с клавиатуры или выбрать нужный вариант, используя стрелки справа от поля.

• В поле Column width (Ширина столбца) задается ширина столбцов. Можно ввести
значение непосредственно с клавиатуры или выбрать с помощью стрелок.

• Поле Data rows (Строки данных) используется для определения количества строк.
Стиль таблицы со строкой заголовка и строкой названий столбцов должен располагать как
минимум тремя строками.

• В поле Row height (Высота строки) определяют высоту текстовых строк. Высота
строки основывается на высоте текста и параметрах поля ячейки, заданных для используе-
мого табличного стиля. Минимальная высота строки таблицы – одна строка текста.

Щелчок на кнопке OK закрывает диалоговое окно, и в командной строке появляется
запрос, предлагающий определить точку вставки:

Specify insertion point:
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Вы можете выбрать точку с помощью мыши или ввести абсолютное координатное зна-
чение, используя клавиатуру. После вставки таблицы вы перейдете в режим редактирования
и курсор будет находиться в первой ячейке, готовой ко вводу данных.

Примечание
Если для определения местонахождения таблицы вы используете

настройку Specify window (Определить окно) и указываете общие
ширину и высоту, то можете назначить количество строк и столбцов так,
что ширина столбца и высота строки будут установлены автоматически,
или указать ширину столбца и высоту строки, при этом количество
строк и столбцов будет задано автоматически.

 
Ввод данных в таблицу

 
После вставки пустой таблицы вы переходите в режим редактирования, на экране ото-

бражается вкладка Text Editor (Редактор текста) и выделяется первая ячейка, так что вы
можете начать ввод данных. Для передвижения к смежной ячейке в той же строке вы можете
использовать клавиши управления курсором, для перехода в ячейку справа – клавишу Tab.
Чтобы переместиться к смежной ячейке в том же столбце, следует использовать клавиши
управления курсором, а чтобы перейти в ячейку, расположенную ниже текущей в этом же
столбце, – клавишу Enter.

Примечание
Указанная высота строки ячейки может увеличиваться,

приспосабливаясь к количеству строк текста в ней.
Вы можете использовать любые возможности и настройки, которые рассмотрены в раз-

деле, посвященном многострочному тексту, чтобы форматировать текст в каждой ячейке.
Во время редактирования текста клавиши управления курсором служат для передвижения
текстового курсора, а не для перемещения между ячейками таблицы.

Чтобы выйти из режима редактирования текста с сохранением изменений, следует
щелкнуть вне таблицы или нажать клавишу Enter, удерживая при этом Ctrl.

Совет
По умолчанию, если ячейка таблицы выбрана для

редактирования, вы увидите буквы столбцов и номера строк. Для
включения и выключения этой функции используйте системную
переменную TABLEINDICATOR.

Чтобы установить новый цвет фона, выделите таблицу, вызовите
ее контекстное меню и выберите в нем пункт Table Indicator Color (Цвет
индикации таблицы).

 
Редактирование на уровне таблицы

 
Существуют два уровня редактирования таблицы: уровень таблицы и уровень ячейки.

В обоих случаях необходимо использовать управляющие маркеры. Вы можете просто щелк-
нуть на любой линии таблицы, чтобы отобразились маркеры управления на уровне таблицы
(рис. 4.44).
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Рис. 4.44. Маркеры управления на уровне таблицы
С помощью этих маркеров можно изменить размеры таблицы, перетягивая любой угол,

кроме угловой точки вставки. Точка вставки перемещает всю таблицу. Когда вы изменяете
высоту или ширину таблицы, используя маркеры управления, строки и столбцы увеличива-
ются или уменьшаются пропорционально.

Чтобы изменить ширину столбца, можно выбрать маркер на его верхней линии и пере-
тянуть его в нужное место. Если вы изменяете ширину столбцов с использованием управля-
ющих маркеров, таблица может расширяться и сужаться.

Все другие настройки редактирования на уровне таблицы представлены в контекстном
меню, вызываемом щелчком правой кнопкой мыши на выделенной таблице (рис. 4.45).
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Рис. 4.45. Контекстное меню редактирования на уровне таблицы
Рассмотрим основные команды данного меню.
• Size Columns Equally (Равный размер столбцов) – изменяет размер всех столбцов

одинаково.
• Size Rows Equally (Равный размер строк) – изменяет размер всех строк одинаково.
• Remove All Property Overrides (Удалить все наложенные свойства) – позволяет вер-

нуть таблице формат, заданный по умолчанию.
• Export (Экспорт) – открывает окно Export Data (Экспорт данных), предназначенное

для экспорта таблицы в файл данных, разграниченных запятыми.
Примечание
Для экспорта таблицы в файл данных, разграниченных запятыми,

вы можете также использовать команду TABLEEXPORT.
• Table Indicator Color (Цвет индикатора таблицы) – изменяет цвет индикаторов строк/

столбцов в редакторе таблицы, используя стандартное окно AutoCAD Select Color (Выбор
цвета).

• Update Table Data Links (Обновить ссылки на данные таблицы) – обновляет таблицу,
внося необходимые изменения.

 
Изменение ячеек таблицы

 
Чтобы изменить ячейку таблицы, вы должны щелкнуть на ней кнопкой мыши. При

этом отобразятся маркеры управления (рис. 4.46).
 

Рис. 4.46. Выделенная ячейка таблицы
Перемещая указатель при нажатой кнопке мыши, вы можете выделить группу ячеек.

Можно также выделить диапазон ячеек, щелкнув на первой и затем на последней ячейке
диапазона, удерживая нажатой клавишу Shift. При этом выделятся все ячейки, расположен-
ные между выбранными.

Четыре управляющих маркера ячейки можно использовать для изменения размеров
строки или столбца, для чего следует выбрать соответствующий маркер и переместить его
в нужное место.

Контекстное меню, вызываемое щелчком правой кнопкой мыши на выделенной
ячейке, показано на рис. 4.47.
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Рис. 4.47. Контекстное меню редактирования на уровне ячейки
Пункты данного меню предоставляют следующие возможности.
• Подменю Alignment (Выравнивание) содержит возможные варианты выравнивания

текста ячейки.
• Команда Borders (Границы) вызывает диалоговое окно Cell Border Properties (Свой-

ства границ ячейки), в котором можно изменить толщину, тип и цвет границ ячейки
(рис. 4.48).
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Рис. 4.48. Окно управления свойствами границ ячейки
• Команда Match Cell (Привести в соответствие ячейку) позволяет копировать выбран-

ные свойства ячейки в одну или более дополнительных ячеек.
• Выбрав в меню пункт Remove All Property Overrides (Удалить все наложенные свой-

ства), можно восстановить формат ячейки, заданный по умолчанию.
• Подменю Insert (Вставить) предназначено для вставки в таблицу различных объек-

тов:
· при выборе пункта Block (Блок) на экране появляется диалоговое окно Insert a Block

in a Table Cell (Вставить блок в ячейку таблицы) (рис. 4.49), в котором можно задать пара-
метры вставки блока в таблицу;
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Рис. 4.49. Диалоговое окно вставки блока
· щелчком на пункте Field (Поле) можно вызвать окно Field (Поле) (см. рис. 4.10) и

вставить в таблицу автоматизированное текстовое поле;
· команда Formula (Формула) позволяет вставить в таблицу формулу, использующую

в вычислениях значения других ячеек (подробно о вставке формул поговорим далее).
• Щелчок на пункте Edit Text (Редактировать текст) приводит к отображению вкладки

Text Editor (Редактор текста) ленты, с помощью которой можно редактировать текст ячейки.
• Команда Delete All Contents (Удалить все содержимое) удаляет содержимое выде-

ленных ячеек.
• Подменю Columns (Столбцы) предназначено для работы со столбцами таблицы:
· Insert Left (Вставить слева), Insert Right (Вставить справа) – команды, позволяющие

вставить новый столбец соответственно слева или справа от текущей ячейки;
· Delete (Удалить) – удаляет столбец, в котором находится выделенная ячейка (если

выделено несколько ячеек в разных столбцах, то команда удаляет все эти столбцы);
· Size Equally (Равный размер) – позволяет изменять размер группы столбцов так,

чтобы они были равными по ширине. Этот пункт меню становится активным, когда выбрано
несколько столбцов.

• Подменю Rows (Строки) содержит команды для работы со строками таблицы:
· Insert Above (Вставить выше), Insert Below (Вставить ниже) – вставляет новую

строку соответственно выше или ниже текущей ячейки;
· Delete (Удалить) – удаляет одну или более строк, в которых находятся выделенные

ячейки;
· Size Equally (Равный размер) – позволяет сделать выделенные строки равными по

высоте.
• Подменю Merge (Слияние) позволяет объединить две или более ячейки в один блок,

строку или столбец.
• Команда Unmerge (Разделить) превращает объединенные ячейки в индивидуальные.
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• Пункт меню Properties (Свойства) отображает палитру Properties (Свойства) со
свойствами ячейки (рис. 4.50). На этой палитре вы можете при необходимости изменять
любые параметры.

 

Рис. 4.50. Палитра Properties (Свойства) с параметрами ячейки
Ячейки в таблицах могут содержать формулы. AutoCAD предоставляет следующие

функции, обычно доступные в электронных таблицах:
• =Sum(A1:A10) – суммирует значения в первых десяти строках столбца A;
• =Average(A10:E10) – подсчитывает среднее арифметическое значений первых пяти

столбцов строки 10;
• =Count(A1:D100) – отображает общее количество ячеек в блоке от столбца A до

столбца D и от строки 1 до строки 100;
• =A1+D1 – складывает значения ячеек A1 и D1;
• =A1-D1 – вычитает значение ячейки D1 из значения ячейки A1;
• =A1*D1 – перемножает значения ячеек A1 и D1;
• =A1/D1 – делит значение в ячейке A1 на значение в ячейке D1;
• =A1^2 – вычисляет квадрат значения в ячейке A1 (число после символа ^является

экспонентой).
Все формулы начинаются со знака =, содержат ссылки на определенные столбцы и

строки и/или неизменные значения. Ссылка на левую верхнюю ячейку таблицы выглядит
как A1, а ссылка на диапазон ячеек состоит из ссылок на первую и последнюю ячейки, раз-
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деленных двоеточием. Например, A1:D10 ссылается на ячейки в строках от 1 до 10 и столб-
цах от A до D. Объединенные ячейки используют символ и номер левой верхней ячейки.

Когда вы копируете формулу из одной ячейки в другую, вид ссылки изменяется в соот-
ветствии с ее новым расположением. Например, если формула в ячейке A11 суммирует зна-
чения ячеек от A1 до A10, то при копировании ее в ячейку B11 диапазон, указанный в ссылке,
изменяется так, чтобы формула суммировала значения ячеек от B1 до B10.

Совет
Вы можете создать абсолютный адрес ячейки, который не будет

изменяться при копировании. Для этого перед номером строки и буквой
столбца следует ввести знак $. Например, в ссылке $A$1 столбец и
строка будут всегда оставаться такими независимо от ее расположения.

Формулу можно также вставить, используя контекстное меню редактирования ячейки,
а также кнопку Formula (Формула) в группе Insert (Вставка) на вкладке Table Cell (Ячейка
таблицы) ленты (рис. 4.51).

 

Рис. 4.51. Вкладка Table Cell (Ячейка таблицы) ленты
Вкладка Table Cell (Ячейка таблицы) появляется на ленте при выделении ячеек

таблицы и содержит различные возможности по работе с таблицей.
 

Работа с текстом в таблицах
 

Работа с текстом в ячейках таблицы включает в себя управление стилями и редакти-
рование. Управление стилями опирается на табличные стили.

Вы можете изменить заданный по умолчанию стиль таблицы (Standard) или создать
новый. Для этого предназначена команда TABLESTYLE. Когда вы ее запускаете, на экране
появляется диалоговое окно Table Style (Стиль таблицы) (рис. 4.52).
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Рис. 4.52. Диалоговое окно Table Style (Стиль таблицы)
Для создания стиля таблицы следует нажать кнопку New (Новый) и в появившемся

окне Create New Table Style (Создать новый стиль таблицы) ввести имя нового стиля. Вы
можете задать в качестве отправной точки существующий стиль таблицы, для чего следует
выбрать его из списка Start With (Начать с).

После нажатия кнопки Continue (Продолжить) появляется диалоговое окно New Table
Style (Новый стиль таблицы) (рис. 4.53).
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Рис. 4.53. Окно настройки нового стиля таблицы
Примечание
Если в окне Table Style (Стиль таблицы) (см. рис. 4.52) нажать

кнопку Modify (Изменить), появится окно Modify Table Style (Изменить
стиль таблицы), содержащее такие же параметры, что и окно New Table
Style (Новый стиль таблицы).

В правой части окна, в области Cell styles (Стили ячейки), расположен раскрываю-
щийся список. В зависимости от выбранного в нем пункта на вкладках ниже отображаются
настройки строк различных типов:

• Data (Данные) – строки с данными;
• Header (Заголовок) – заголовки столбцов;
• Title (Название) – название таблицы.

 
Извлечение данных из объектов с
помощью специального мастера

 
Рассмотрим порядок работы с мастером извлечения данных.
1. Запустите команду вставки таблицы (допустим, что документ содержит некоторые

объекты, атрибуты которых вы хотели бы внести в эту таблицу (рис. 4.54)). Откроется диа-
логовое окно Insert Table (Вставить таблицу).
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Рис. 4.54. Исходные объекты, свойства которых необходимо извлечь в таблицу
2. В области Insert options (Параметры вставки) установите переключатель в положе-

ние From object data in the drawing (Data Extraction) (Из данных объектов чертежа (Извле-
чение данных)) и щелкните на кнопке OK.

3. В первом окне появившегося мастера установите переключатель в положение Create
a new data extraction (Создать новое извлечение данных). Нажмите кнопку Next (Далее),
в появившемся окне задайте имя для сохраняемого файла с данными и при необходимости
измените его расположение.

4. В следующем окне мастера установите переключатель в положение Select objects in
the current drawing (Выбрать объекты в текущем чертеже) и нажмите находящуюся рядом
кнопку. Выделите интересующие вас объекты и нажмите клавишу Enter. В окне мастера
нажмите кнопку Next (Далее).

5. На третьем шаге мастера вы увидите список выделенных объектов, который при
необходимости можно скорректировать. Нажмите Next (Далее).

6. В следующем окне с помощью флажков выберите свойства выделенных объектов,
которые вы хотите извлечь в таблицу, например Area (Площадь). Щелкните на кнопке Next
(Далее).

7. В пятом окне мастера вы увидите сформированную таблицу (рис. 4.55). Здесь можно
упорядочить и отфильтровать данные, добавить вычисляемые поля, создать внешние ссылки
(для этого следует нажать кнопку Link External Data (Присоединение внешних данных),
которая приведет к открытию одноименного окна). Выполнив необходимые настройки,
нажмите кнопку Next (Далее).
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Рис. 4.55. Пятый шаг мастера извлечения данных
8. В шестом окне мастера установите флажок Insert data extraction table into drawing

(Вставить таблицу извлеченных данных в чертеж), после чего нажмите Next (Далее).
9. Мастер позволит вам откорректировать стиль, форматирование и структуру

таблицы. Выполнив необходимые изменения, щелкните на кнопке Next (Далее).
10. После нажатия в заключительном окне мастера кнопки Finish (Готово) укажите

расположение таблицы на рисунке. В итоге получится таблица, подобная представленной
на рис. 4.56.

 

Рис. 4.56. Таблица извлеченных из рисунка площадей объектов
Примечание
Чтобы узнать о дополнительных возможностях мастера

извлечения данных, можно самостоятельно исследовать его шаги
или воспользоваться командой меню Help → New Features Workshop
(Справка → Семинар по новым возможностям).
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Резюме

 
Прочитав эту главу, вы научились редактировать текст и создавать таблицы в AutoCAD

2010.
Напомним, что в AutoCAD существует текст двух видов: однострочный и многостроч-

ный. Каждый из них служит своим целям. При создании коротких примечаний, заголовков
и пометок вы можете положиться на однострочный текст. В других случаях можно восполь-
зоваться преимуществами многострочного текста, который позволяет, например, вставлять
специальные символы из меню, создавать нумерованные, маркированные и буквенные
списки.

Вы можете вставить в свои рисунки текстовые поля, а также автоматически обновляе-
мые поля с датой, названием файла и даже вашим именем.

Таблицы можно использовать для различных целей, например для оформления неко-
торых списков. Вставив непосредственно в ячейки таблицы интеллектуальные поля, вы
можете значительно оживить чертеж.

Графическая информация, безусловно, является приоритетной. Это основная причина
возникновения систем проектирования, подобных программе AutoCAD. Однако существо-
вание промышленных стандартов, сложность чертежей и схем, необходимость документи-
рования и недостаточность графической информации делают текст необходимым элементом
чертежей.
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Глава 5

Проставление размеров
 

• Линейный размер
• Проставление размеров для окружности и дуги
• Измерение углов
• Базовые и связанные размеры
• Стиль размера
• Резюме
Проставление размеров на рисунках – возможно, один из наиболее спорных аспектов в

работе с программой AutoCAD. В то время как создать размеры довольно просто, управле-
ние их видом и поведением может оказаться достаточно сложным занятием. Причина этого
– существование множества различных типов размеров и большого количества переменных,
которые управляют их вешним видом.

Кроме того, способы работы с размерами, их вид и поведение могут очень различаться
в зависимости от отрасли промышленности, в которой вы работаете (механическое проек-
тирование, атомная энергетика, электроника и т. д.). В этой главе вы узнаете, как размещать
размеры, а также как использовать стили размера, чтобы управлять их видом и поведением.

Команды управления размерами можно запустить с помощью соответствующих кно-
пок на вкладке Annotate (Аннотация) в группе Dimensions (Размеры) ленты (рис. 5.1).

 

Рис. 5.1. Группа Dimensions (Размеры)
Существует много типов размеров, доступных в AutoCAD. Чаще всего используют

линейные размеры, радиус, диаметр и угловые размеры.
Размеры связаны с объектами и при внесении в чертеж каких-либо изменений обно-

вляются автоматически.
В первую очередь следует выбрать тип размера, который вы хотите создать, а затем

указать точки, которые определяют его размещение. В указанных местах AutoCAD создает
точечные объекты, затем измеряет расстояние между этими определяющими точками и
использует это расстояние как заданное по умолчанию текстовое значение размера.

Например, для измерения линии вы создаете линейный размер и затем указываете две
крайние точки линии. Программа создает в этих местах определяющие точки и измеряет
расстояние между ними. После этого вы выбираете место для размещения значения размера.

Определяющие точки управляют ассоциативностью размера. Когда их положение
изменяется, связанный с ними размер обновляется и перемещается, следуя за ними. Во
время простановки размеров AutoCAD автоматически создает уровень или слой, названный
Defpoints (Определяющие точки). Все определяющие точки помещаются на этот слой.

Примечание
Слой Defpoints (Определяющие точки) создается, когда вы

запускаете команду ввода размера. Он уникален тем, что не выводится
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на печать независимо от настройки «печатать/не печатать». Однажды
созданный слой Defpoints (Определяющие точки) невозможно удалить
командой PURGE или нажатием кнопки Delete Layer (Удалить слой).
Вы можете переименовать этот слой, но в таком случае AutoCAD просто
создаст новый слой Defpoints (Определяющие точки) при создании
нового размера или обновлении существующего.

Совет
Поскольку слой Defpoints (Определяющие точки) не выводится

на печать, его можно использовать для создания объектов, которые
вы не хотите показывать на чертеже. Например, это могут быть
пометки, границы просмотра и замечания для других пользователей,
работающих с чертежом.

Фактически для размера существует три уровня ассоциативности. Системная перемен-
ная DIMASSOC указывает, какой уровень ассоциативности используется в данный момент.

Системной переменной DIMASSOC может быть присвоено значение 0, 1 или 2. Если
задано значение 2 (это состояние переменной по умолчанию), определяющие точки размера
связаны с объектами рисунка. Например, если вы указываете расстояние между двумя край-
ними точками линии, AutoCAD создаст там определяющие точки, которые будут связаны
с объектом – линией. При перемещении линии размер будет двигаться вместе с ней. Если
изменяется положение крайней точки линии (линия растягивается, укорачивается, изменяет
направление и т. д.), определяющая точка, связанная с ней, будет также двигаться, а размер
будет обновляться.

Когда значение переменной DIMASSOC равно 1, AutoCAD все еще создает ассоциа-
тивные размеры, но определяющие точки не связываются ни с какой специфической геоме-
трией. Чтобы изменить размер, вы должны переместить определяющие точки, связанные с
размером явно. Например, если вы указываете размер линии, когда переменной DIMASSOC
задано значение 1, AutoCAD создаст определяющие точки на концах линии. Но если вы
перемещаете линию, размер не будет следовать за ней. Вы должны выделить и переместить
размер вместе с линией, чтобы они отображались вместе. Если вы перемещаете конец линии
(перетаскивая, подстраивая, продляя и т. д.), следует также переместить и определяющую
точку, чтобы обновить размер.

Если переменной DIMASSOC задано значение 0, AutoCAD создает обособленные раз-
меры без ассоциативности и определяющих точек. Каждая часть размерной выноски (линии
и значение) воспринимается как отдельный объект.

Совет
Хотя можно создать обособленные размеры, в большинстве

рабочих сред автоматизированного проектирования это считается
плохой практикой. Обособленные размеры трудноуправляемы, и их
обновление может привести к небрежности и неточности в рисунках.

Вы можете изменять значения переменной DIMASSOC с помощью флажка в области
Associative Dimensioning (Связанная простановка размеров) на вкладке User Preferences
(Пользовательские установки) окна Options (Параметры) (см. рис. 4.8). Если этот флажок
установлен, значение переменной DIMASSOC равно 2. Если же он снят, переменной задано
значение 1.
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Линейный размер

 
Для создания вертикальных и горизонтальных размеров предназначена одна команда –

DIMLINEAR. Она измеряет расстояние между двумя определяющими точками и позволяет
вам выбрать расположение размерной линии.

Есть два способа создать линейный размер: указать определяющие точки или выбрать
объект для измерения. Используя метод указания точек, вы выбираете на рисунке две точки
и затем задаете местонахождения размерной линии. В зависимости от направления текста
размер получается вертикальным или горизонтальным. Если вы размещаете значение выше
или ниже точек, AutoCAD создает горизонтальный размер, если же слева или справа – вер-
тикальный (рис. 5.2).

 

Рис. 5.2. Проставление размеров методом указания определяющих точек
Вы можете также создать линейный размер, выбрав линию, дугу или круг. После

запуска команды DIMLINEAR AutoCAD выдаст запрос:
Specify first extension line origin or <select object>:
Нажмите клавишу Enter, чтобы выбрать линию, дугу или круг. Когда вы с помощью

мыши укажете нужный объект, программа создаст две определяющие точки. На рис. 5.3
показаны результаты выбора различных объектов.

 

Рис. 5.3. Проставление размеров с помощью выбора объектов
Примечание
Для проставления размеров вы можете выбрать только линию,

дугу или круг. Нельзя таким образом выбрать эллипс, текстовый
элемент или кривую сплайнов. При выборе полилинейного объекта
AutoCAD проставит размеры линейного или дугового участка
полилинии возле выделенной вами точки.
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Рассмотрим типичную последовательность создания линейных размеров.
1. Убедитесь, что включен режим объектной привязки и указана привязка к крайним

точкам и центру объектов. Для этого введите команду DSETTINGS и в появившемся диа-
логовом окне Drafting Settings (Режимы рисования) откройте вкладку Object Snap (Захват
объектов). На ней должны быть установлены флажки Object Snap On (F3) (Включить объ-
ектную привязку (F3)), Endpoint (Конечная точка) и Center (Центр).

2. Создайте или откройте простое изображение для простановки размеров (пример
приведен на рис. 5.4).

 

Рис. 5.4. Исходное простое изображение
3. Запустите команду DIMLINEAR. Программа попросит вас определить начало пер-

вой выносной линии:
Specify first extension line origin or <select object>:
4. Щелкните на левой нижней точке объекта. Появится запрос об указании начала вто-

рой выносной линии:
Specify second extension line origin:
5. Щелкните на правом конце нижнего наклонного отрезка. Появится запрос:
Specify dimension line location or [Mtext/Text/Angle/Horizontal/Vertical/Rotated]:
В ответ на него вы можете определить местоположение линии размера, перетаскивая

ее с помощью мыши.
6. Разместите размерную линию так, как показано на рис. 5.5. После этого AutoCAD

завершит выполнение команды DIMLINEAR.
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Рис. 5.5. Горизонтальный размер, созданный с помощью указания определяющих
точек

7. Еще раз запустите команду DIMLINEAR. Появится запрос:
Specify first extension line origin or <select object>:
8. Нажмите клавишу Enter. AutoCAD предложит выбрать объект для проставления

размера:
Select object to dimension:
9. Щелкните на верхнем наклонном отрезке. Программа разместит определяющие

точки на концах отрезка и выдаст запрос об определении местоположения размерной линии:
Specify dimension line location or [Mtext/Text/Angle/Horizontal/Vertical/Rotated]:
10. Разместите размерную линию так, как показано на рис. 5.6. После этого AutoCAD

завершит выполнение команды DIMLINEAR.
 

Рис. 5.6. Вертикальный размер, созданный с помощью выбора объекта
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Параметры команды DIMLINEAR

 
После того как вы выберете определяющие точки, AutoCAD предложит множество

настроек для создания и размещения размеров. Эти настройки представлены в табл. 5.1.
 

Таблица 5.1. Параметры команды DIMLINEAR
 
 

Команда DIMLINEAR обладает двумя текстовыми настройками – Mtext и Text. Эти
параметры позволяют изменять текст, связанный с размером. По умолчанию AutoCAD раз-
мещает численное значение расстояния между двумя определяющими точками в виде значе-
ния размера. Используя параметры Mtext и Text, можно изменить этот текст и даже отменить
его отображение. Например, при желании вы можете включить отображение примечания
или другого дополнительного текста наряду с размерным или напечатать определенный раз-
мер вместо того, чтобы использовать вычисленное значение размера.

 
Принудительное проставление
фактического размера объекта

 
При выборе параметра Mtext AutoCAD отображает многострочный текстовый редак-

тор с выделенным значением размера. Заданное по умолчанию значение представляет собой
измеренное расстояние между определяющими точками. Вы можете ввести любой текст до
или после имеющегося или удалить его, но изменить значение выделенного текста нельзя.
Если вы удалили заданный по умолчанию текст, AutoCAD будет игнорировать измеренное
расстояние и отображать только текст, который вы ввели.

Если вы удалили заданное по умолчанию значение размера, можно вернуть его, набрав
символы <>. Программа заменит эти скобки измеренным расстоянием между определяю-
щими точками.

Вы можете использовать такие же скобки и при работе с параметром Text. После его
выбора AutoCAD отобразит измеренный размер как значение по умолчанию и предложит
ввести одну строку текста. Вы можете набрать любой текст, используя скобки <> вместо
измеренного расстояния между определяющими точками.

Совет
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Для редактирования значения размера вы можете также
использовать команду DDEDIT.

Рассмотрим порядок изменения значения размера.
1. Откройте ранее созданный чертеж или постройте объекты, содержащие отрезки пря-

мых линий.
2. Запустите команду DIMLINEAR. Появится запрос об определении начала первой

выносной линии:
Specify first extension line origin or <select object>:
3. Нажмите клавишу Enter. AutoCAD предложит выбрать объект для проставления

размера:
Select object to dimension:
4. Выберите линию. Программа создаст на ее концах определяющие точки и выдаст

запрос:
Specify dimension line location or [Mtext/Text/Angle/ Horizontal/Vertical/Rotated]:
5. Выберите параметр Mtext. На ленте появится вкладка Text Editor (Редактор текста),

и будет выделено значение размера, заданного по умолчанию. Удалите этот текст и введите
значение 1,00.

6. Щелкните кнопкой мыши за пределами поля ввода, чтобы закрыть редактор.
AutoCAD отобразит размер как 1,00.

7. Выберите линию, для которой вы только что проставили размер, чтобы активизиро-
вать ее маркеры. Выберите маркер в одной крайней точке и перетащите его в новое место.
AutoCAD изменяет длину линии, и размерная линия движется вместе с ней, но значение
размера не обновляется.

8. Запустите команду DDEDIT и выделите значение размера 1,00. Удалите значение
1,00 и введите <>. AutoCAD заменяет скобки фактической длиной линии.

9. Выберите линию, чтобы активизировать ее маркеры, и возвратите крайнюю точку
в ее первоначальное положение. AutoCAD изменяет длину линии, и размерная линия дви-
жется с ней. Значение размера обновляется, отображая изменения.

Кроме того, если реальное значение размера не соответствует расстоянию между
выносными линиями, вы можете добавить к линейному размеру зигзаг с помощью команды
DIMJOGLINE. Зигзагообразные размерные линии обычно используются, если измеряемый
объект показан в размерах, которые меньше реальных. Применение этих возможностей
представлено на рис. 5.7.
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Рис. 5.7. Использование зигзагообразных размеров
 

Создание выровненных размеров
 

Выровненный размер – другой тип линейного размера. В то время как горизонтальный
и вертикальный размеры измеряют расстояния по оси X или Y соответственно, выровненный
размер показывает истинное расстояние между любыми двумя точками. Значение размера
помещается параллельно прямой линии, соединяющей две определяющие точки.

Для создания выровненных размеров предназначена команда DIMALIGNED. При ее
использовании вы можете выбрать две определяющие точки или линию, дугу либо круг. Как
только вы зададите определяющие точки, станут доступными параметры Mtext, Text и Angle.
Их значения идентичны соответствующим параметрам команды DIMLINEAR.

Рассмотрим порядок создания выровненных размеров.
1. Откройте или создайте рисунок, содержащий линию, дугу или окружность.
2. Запустите команду DIMALIGNED. Появится приглашение:
Specify first extension line origin or <select object>:
3. Нажмите клавишу Enter. AutoCAD попросит вас выбрать объект для проставления

размера:
Select object to dimension:
4. Выберите объект. AutoCAD разместит определяющие точки на концах отрезка и

предложит определить местоположение размерной линии:
Specify dimension line location or [Mtext/Text/Angle]:
5. Разместите размерную линию так, как показано на рис. 5.8.

 



А.  А.  Орлов.  «AutoCAD 2010»

179

Рис. 5.8. Выровненный размер
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Проставление размеров для окружности и дуги

 
Для окружностей и дуг обычно измеряют радиус или диаметр, а для дуги также ее

длину. AutoCAD позволяет проставить все эти размеры.
 

Измерение радиуса
 

Для измерения радиуса предназначена команда DIMRADIUS. После ее запуска
AutoCAD предлагает выбрать дугу или окружность. Когда вы это сделаете, AutoCAD изме-
рит радиус дуги и выдаст запрос о расположении текстового значения размера (внутри или
снаружи дуги). Перпендикулярно к дуге будет создана ведущая линия, проходящая через
указанную точку, а в центре окружности или дуги – центральная метка. Когда вы будете раз-
мещать текстовое значение, AutoCAD автоматически поставит префикс R перед измерен-
ным значением радиуса (рис. 5.9).

 

Рис. 5.9. Вставка радиуса
Подобно командам DIMLINEAR и DIMALIGNED, команда DIMRADIUS располагает

параметрами Mtext, Text и Angle, предназначенными для изменения текстового значения
размера.

При использовании команды DIMRADIUS ведущая линия всегда будет располагаться
перпендикулярно к кругу или участку дуги. Начальная точка ведущей линии всегда будет на
одной линии с центральной точкой дуги. «Извилистый» радиус отличается от обычного тем,
что его ведущая линия имеет встроенный в нее зигзаг смещения (рис. 5.10), что позволяет
вам определить другую центральную точку для ведущей линии. Это может быть полезно,
например, при указании больших радиусов, центральная точка которых находится вне види-
мой области рисунка. «Извилистый» размер радиуса можно создать с помощью команды
DIMJOGGED.
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Рис. 5.10. «Извилистый» радиус
Когда вы запускаете команду DIMJOGGED, AutoCAD предлагает выбрать окружность

или дугу. Как только вы выберете объект, появится запрос об определении нового местопо-
ложения центра:

Specify center location override:
В ответ следует указать расположение отправной точки ведущей линии (конца без

стрелки). Ведущая линия протянется от этой точки к точке на окружности или дуге. Затем
программа попросит определить место текстового значения размера, после чего можно будет
корректировать положение зигзагообразного участка.

 
Определение диаметра

 
Диаметр можно проставить с помощью команды DIMDIAMETER. Эта команда дей-

ствует точно так же, как DIMRADIUS, только измеряет и проставляет не радиус, а диаметр
и соответственно размещает перед значением символ диаметра (рис. 5.11).

 

Рис. 5.11. Вставка диаметра
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Рассмотрим вставку радиуса и диаметра.
1. Откройте или создайте рисунок, содержащий окружность и дугу.
2. Запустите команду DIMRADIUS. Появится приглашение:
Select arc or circle:
3. Выберите дугу. AutoCAD разместит определяющие точки в центре дуги и в выбран-

ной точке, после чего выдаст запрос об определении местоположения линии размера:
Specify dimension line location or [Mtext/Text/Angle]:
4. Выберите параметр Mtext и введите typ после заданного по умолчанию значения

размера. Щелкните на кнопке Close Text Editor (Закрыть текстовый редактор) на вкладке
Text Editor (Редактор текста).

5. Разместите размерную линию в подходящем месте.
6. Запустите команду DIMDIAMETER. AutoCAD выдаст запрос:
Select arc or circle:
7. Выберите окружность. AutoCAD разместит определяющие точки в центре окруж-

ности и в точке, которую вы выбрали на окружности. Затем появится запрос об определении
местоположения линии размера:

Specify dimension line location or [Mtext/Text/Angle]:
8. Разместите размерную линию.

 
Проставление длины дуги

 
Подобно линейным размерам, AutoCAD может проставлять длину дуги, для чего

используется команда DIMARC. По умолчанию программа измеряет полную длину дуги,
от одной крайней точки до другой, но вы можете выбрать измерение длины части дуги.
Кроме Mtext, Text и Angle, данная команда располагает параметром Partial, который позво-
ляет выбрать на дуге начальную и конечную точки и измерить длину только указанного
участка. Когда вы размещаете размер длины дуги, AutoCAD автоматически вставляет сим-
вол дуги перед значением размера.

Проставим на чертеже длину дуги.
1. Создайте в области рисования дугу или дуговую полилинию.
2. Запустите команду DIMARC. AutoCAD попросит выбрать дугу или участок дуговой

полилинии:
Select arc or polyline arc segment:
3. Выберите дугу. AutoCAD создаст определяющие точки в центре дуги и в выбранной

на дуге точке. Затем появится запрос об указании расположения размерной линии:
Specify arc length dimension location, or [Mtext/Text/Angle/Partial/Leader]:
4. Разместите размерную линию. Чертеж примет приблизительно такой вид, как на

рис. 5.12.
 

Рис. 5.12. Вставка длины дуги
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Создание центральных меток

 
При проставлении размеров дуг и окружностей AutoCAD ставит метки в центрах изме-

ряемых объектов. Вам может понадобиться разместить центральные метки для дуг и окруж-
ностей, которые не измеряются. В AutoCAD существуют разные способы сделать это. Один
вариант – просто рисовать центральные метки с помощью команды LINE или PLINE. Дру-
гой – использовать команду DIMCENTER.

Команда DIMCENTER размещает перекрещенные отрезки в центре окружности или
дугового участка. Когда вы запускаете эту команду, AutoCAD предлагает вам выбрать дугу
или окружность и затем ставит перекрестье центральной метки.
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Измерение углов

 
Для определения линейного размера AutoCAD должен располагать двумя опре деля-

ющими точками. При проставлении значений углов следует указать три точки для опреде-
ления углового размера: вершину и две конечные точки. Угловые размеры проставляются с
помощью команды DIMANGULAR. При использовании этой команды у вас есть три вари-
анта, чтобы определить угловой размер: выбор дуги или окружности, выбор двух пересека-
ющихся линий и выбор трех точек (вершины и двух конечных) (рис. 5.13).

 

Рис. 5.13. Различные варианты вставки угловых размеров
Когда вы запускаете команду DIMANGULAR, AutoCAD предлагает выбрать дугу,

окружность, линию или определить вершину:
Select arc, circle, line, or <specify vertex>:
Если вы выберете дугу, AutoCAD будет использовать центр и концы дуги, чтобы опре-

делить угловые размеры. Если окружность – выбранная точка будет использоваться в каче-
стве одной крайней точки угла, а центр окружности – в качестве вершины. В таком случае
AutoCAD запросит у вас вторую крайнюю точку и позволит разместить текст размера.

Если выбран отрезок, AutoCAD попросит выбрать еще один отрезок и будет измерять
угол, ориентируясь на их крайние точки, ближайшие к выбранной точке на линии.

Примечание
Если вы выберете две параллельные линии, появится

приглашение Lines are parallel. После этого выполнение команды
закончится. Если в качестве второй линии вы выберете не отрезок, а
что-то другое, AutoCAD сообщит об этом и еще раз предложит выбрать
вторую линию.

Чтобы задать вершину и угловые крайние точки, нажмите клавишу Enter в ответ на
запрос:

Select arc, circle, line, or <specify vertex>:
Программа попросит задать точку вершины и затем указать две крайние точки.
Потренируемся создавать угловой размер.
1. Нарисуйте угол или линии, расположенные непараллельно.
2. Запустите команду DIMANGULAR. AutoCAD выдаст запрос:
Select arc, circle, line, or <specify vertex>
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3. Выберите линию. Программа попросит указать вторую линию:
Select second line:
4. Выберите вторую линию. Появится запрос:
Specify dimension arc line location or [Mtext/Text/Angle/Quadrant]:
5. Разместите размерную линию. Обратите внимание, что значение угла изменяется в

зависимости от местоположения указателя мыши.
Кроме того, можно управлять расположением текстового значения угловых размеров

вне измеряемого угла: если значение указывается в стороне от угла, то для него создается
выносная размерная дуга (рис. 5.14).

 

Рис. 5.14. Применение новых возможностей проставления размеров
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Базовые и связанные размеры

 
Базовые и связанные размеры относятся к линейным, которые совместно используют

общие выносные линии. Базовый размер также называют размером с базовой линией, так
как многие его свойства измеряются относительно общей характерной черты. Связанные
размеры называют продленными, так как линейные размеры продлены от одного конца до
другого.

 
Размер с базовой линией

 
Базовые размеры определяются от выносной линии существующего линейного или

углового размера. Каждый базовый размер откладывается от этой выносной линии, и раз-
мерные линии располагаются на предопределенном расстоянии. Для создания базовых раз-
меров предназначена команда DIMBASELINE.

Для работы команде DIMBASELINE требуется существующий линейный или угловой
размер. По умолчанию AutoCAD использует первую выносную линию последнего линей-
ного или углового размера в качестве базовой. Если вы хотите взять за основу другую
выносную линию, можете нажать клавишу Enter. Если программа не сможет найти линию
последнего размера, она предложит вам самостоятельно выбрать нужную.

Как только вы определите, какая линия будет использоваться в качестве базовой,
появится приглашение выбрать определяющую точку для следующей выносной линии.
Команда DIMBASELINE будет продолжать размещать размеры с базовой линией, пока вы
не остановите ее выполнение с помощью параметра Undo.

 
Продленный размер

 
Продленный размер подобен базовому: для его создания необходим существующий

линейный или угловой размер, и вы можете разместить множество размерных линий с помо-
щью одной команды. Единственное различие состоит в том, что, в то время как размеры с
базовой линией откладываются от общей выносной линии, продленные основываются на
последней созданной размерной линии. Результат представляет собой цепочку размеров, в
которой каждый отсчитывается относительно предыдущего. Для создания продленных (или
цепных) размеров предназначена команда DIMCONTINUE.

После запуска команды DIMCONTINUE AutoCAD разместит размерную линию возле
второй выносной линии последнего созданного линейного или углового размера. Если вы
хотите продолжить проставление подобных размеров, следует нажать клавишу Enter, чтобы
выбрать другую выносную линию. Подобно команде DIMBASELINE запросы команды
DIMCONTINUE будут повторяться, пока вы не закончите ее выполнение. Для завершения
работы команды следует выбрать параметр Undo, для указания другой выносной линии в
качестве базовой – Select.

Рассмотрим процесс создания базовых и цепных размеров.
1. Начертите примерно такую деталь, как на рис. 5.15.
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Рис. 5.15. Исходная деталь
2. Запустите команду DIMLINEAR и проставьте горизонтальный размер возле левого

края детали.
3. Запустите команду DIMCONTINUE. AutoCAD протянет размерную линию от пре-

дыдущего размера и выдаст запрос об определении начала второй выносной линии:
Specify a second extension line origin or [Undo/Select] <Select>:
4. Разместите размеры так, как показано на рис. 5.16. Нажмите клавишу Esc для того,

чтобы закончить выполнение команды DIMCONTINUE.
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Рис. 5.16. Продленный размер
5. Запустите команду DIMBASELINE. AutoCAD начнет протягивать размерную линию

от предыдущей и попросит определить начало второй выносной линии:
Specify a second extension line origin or [Undo/Select] <Select>:
6. Нажмите клавишу Enter для выбора параметра Select. Появится приглашение

выбрать базовый размер:
Select base dimension:
7. Выберите выносную линию у крайней левой точки фигуры. AutoCAD выдаст запрос

об определении начала второй выносной линии:
Specify a second extension line origin or [Undo/Select] <Select>:
8. Выберите крайнюю правую точку фигуры. AutoCAD автоматически расположит

базовый размер выше остальных. Ваш чертеж будет примерно таким, как изображенный на
рис. 5.17.
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Рис. 5.17. Вставка базового размера
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Стиль размера

 
Мы рассмотрели, как создавать и размещать размеры на чертеже. Однако это только

часть процесса. Из данного раздела вы узнаете, как управлять видом размерных объектов,
используя стили размера.

Стиль размера – это совокупность параметров, хранящихся под определенным име-
нем и применяющихся к размерам в качестве настроек. Стили размера управляют видом
и поведением размерного объекта: используемой стрелки-указателя, стиля текста, допусти-
мых значений и форматирования, а также общего масштаба размера.

Стили размера функционируют подобно стилям текста или слоя: вы устанавлива-
ете определенный стиль текущим, и любые новые объекты создаются с использованием
настроек, содержащихся в этом стиле. Размерными стилями управляют с помощью команды
DIMSTYLE.

Когда вы запускаете команду DIMSTYLE, открывается диалоговое окно Dimension
Style Manager (Менеджер стиля размера) (рис. 5.18). В этом окне вы можете создать и изме-
нить размерный стиль.

 

Рис. 5.18. Окно менеджера стиля размера
В поле Styles (Стили) отображаются стили размеров. Раскрывающийся список List

(Список) позволяет указать, какие стили следует показывать в поле Styles (Стили). Вы
можете выбрать отображение всех стилей или только использующихся в рисунке.

Кроме того, с помощью флажка Don't list styles in Xrefs (Не перечислять стили в Xref)
можно выбрать, показывать или скрывать стили размеров, содержащиеся во внешних ссыл-
ках (Xref).

В области Preview of (Предварительный просмотр) отображается пример использова-
ния выбранного в данный момент стиля размера. Кнопки, расположенные в правой части
окна, позволяют создавать, изменять, отменять и сравнивать стили размеров.
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Создание размерного стиля

 
AutoCAD поставляется с предопределенным стилем размера, заданным по умолча-

нию, – ISO-25. Его можно изменить, переименовать и даже удалить, если он не указан теку-
щим. Параметры стиля ISO-25 определены в файле шаблона, используемого для создания
рисунка.

Чтобы создать новый стиль размера, щелкните на кнопке New (Новый) в диалого-
вом окне Dimension Style Manager (Менеджер стиля размера). В результате появится окно
Create New Dimension Style (Создать новый стиль размера) (рис. 5.19).

 

Рис. 5.19. Диалоговое окно создания нового стиля размера
Когда вы создаете новый стиль размера, AutoCAD делает копию существующего стиля

в качестве отправной точки. В окне Create New Dimension Style (Создать новый стиль раз-
мера) следует задать имя для нового стиля размера и указать, какой стиль нужно скопировать
для использования в качестве основы. Вы можете также создать стиль, который будет при-
меняться только к размерам определенного типа. Например, вам может понадобиться, чтобы
все текстовые значения размеров выравнивались по размерным линиям, однако текстовые
значения размеров радиуса и диаметра размещались горизонтально. В подобных случаях
используются так называемые дочерние стили, которые возникают как подстили основного
размерного стиля.

Примечание
Если в диалоговом окне Create New Dimension Style (Создать

новый стиль размера) вы выбираете дочерний стиль размера, в
окне Dimension Style Manager (Менеджер стиля размера) в области
Preview of (Предварительный просмотр) отображаются только те
параметры размерного стиля, которые отличаются от родительского. В
области Description (Описание) при этом приводятся различия между
родительским и дочерним стилями.

Создадим новый стиль размера и применим его к чертежу, представленному на
рис. 5.20.
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Рис. 5.20. Исходный чертеж
1. Запустите команду DDIM. Появится диалоговое окно Dimension Style Manager

(Менеджер стиля размера). Щелкните на кнопке New (Новый), чтобы открылось окно Create
New Dimension Style (Создать новый стиль размера).

2. Введите название Mech в поле New Style Name (Имя нового стиля) и убедитесь, что
в списке Start With (Начать с) выбран стиль ISO-25, а в списке Use for (Использовать для) –
значение All dimensions (Все размеры). Нажмите кнопку Continue (Продолжить). На экране
появится окно New Dimension Style (Новый стиль размера).

3. Измените, например, на вкладке Text (Текст) положение переключателя Text align
ment (Выравнивание текста) на Horizontal (Горизонтально).

4. Щелкните на кнопке OK, чтобы принять изменение настроек. Вы снова увидите
окно Dimension Style Manager (Менеджер стиля размера). Новый стиль размера отобра-
зится в поле Styles (Стили).

5. Нажмите кнопку Close (Закрыть), чтобы закончить выполнение команды
DIMSTYLE.

6. Разместите линейные размеры. Ваш чертеж при этом должен выглядеть примерно
так, как показано на рис. 5.21.

 



А.  А.  Орлов.  «AutoCAD 2010»

193

Рис. 5.21. Результат применения нового стиля размера
 

Настройка существующего размерного стиля
 

Чтобы изменить параметры стиля размера, выберите его имя в окне Dimension Style
Manager (Менеджер стиля размера) и щелкните на кнопке Modify (Изменить). Откроется
окно Modify Dimension Style (Изменить стиль размера), содержащее семь вкладок, на кото-
рых расположены настройки для различных аспектов размеров.

 
Параметры линий

 
Вкладка Lines (Линии) предназначена для управления размерными и выносными

линиями (рис. 5.22).
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Рис. 5.22. Параметры размерных линий
Область Dimension lines (Линии размера) позволяет устанавливать цвет (Color), тип

(Linetype) и толщину (Lineweight) размерных линий, а также интервал между ними, исполь-
зующийся при создании базовых размеров. Поле Extend beyond ticks (Выход за пре-
делы меток) доступно только тогда, когда указаны определенные типы стрелок-указателей.
Например, если используется архитектурная метка, параметр Extend beyond ticks (Выход
за пределы меток) указывает, насколько линия размера будет продлена за пределы меток. Вы
можете также сделать невидимой размерную линию с любой стороны от текстового значе-
ния (для этого предназначены флажки Dim line 1 и Dim line 2). Это удобно при проставле-
нии размеров в загроможденных областях, где линии часто вытесняют текстовое значение
размера.

Область Extension lines (Выносные линии) содержит подобные параметры для вынос-
ных линий. Вы можете задать цвет, тип и толщину выносных линий, настроить их длину
и указать промежуток между выносной линией и объектом, для которого вы проставляете
размеры.

 
Настройки символов и стрелок

 
Вкладка Symbols and Arrows (Символы и стрелки) позволяет устанавливать размер и

тип используемых стрелок-указателей (рис. 5.23).
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Рис. 5.23. Параметры символов и стрелок
Вы можете установить различные стрелки-указатели для первой и второй размерных

линий, а также отдельную стрелку для указательных линий (Leader). Область Center marks
(Центральные метки) предназначена для определения размера и типа центральных меток.
Здесь можно указать, как будут отображаться центральные метки в размерах радиуса и диа-
метра, а также настроить создание линий центральных меток командой DIMCENTER.

Вы можете разорвать размер или выносные линии в месте пересечения с геометриче-
скими объектами или другими размерами. Хотя это не является рекомендуемой чертежной
практикой, иногда такие разрывы бывают необходимы, поэтому в области Dimension Break
(Разрыв размера) присутствует возможность задать величину такого разрыва.

Параметры в области Arc length symbol (Символ длины дуги) отвечают за место ото-
бражения символа длины дуги при использовании команды DIMARC. В поле Jog angle (Угол
зигзага) указывают угол зигзагообразного участка линии, используемого при выполнении
команды DIMJOGGED.

 
Настройки текста

 
Вкладка Text (Текст) управляет размещением и видом текста (рис. 5.24). В области Text

appearance (Вид текста) можно устанавливать используемый стиль текста. Нажатие кнопки
с многоточием приводит к появлению диалогового окна Text Style (Стиль текста), в котором
можно создавать и изменять стили текста. Кроме того, на данной вкладке можно настроить
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цвет и фон текста, а также задать отображение рамки вокруг текста, установив флажок Draw
frame around text (Рисовать рамку вокруг текста).

 

Рис. 5.24. Параметры текста
Параметры Text height (Высота текста) и Fraction height scale (Масштаб высоты

дроби) управляют высотой текста. Коэффициент Fraction height scale (Масштаб высоты
дроби) применяется к тексту числителя и знаменателя в дроби. Например, если задано зна-
чение текстовой высоты 0.12 5, а масштаб высоты дроби – 0.5, то высота числителя и зна-
менателя должна быть 0.0625, чтобы вместе они уложились в общую высоту дроби.

В области Text placement (Размещение текста) можно задать размещение текста отно-
сительно размерных и выносных линий. В раскрывающемся списке Vertical (Вертикально)
можно выбрать положение текстового значения относительно размерной линии: выше, ниже
или по центру. Если вы выберете значение JIS, текстовый размер будет расположен в
соответствии с японским индустриальным стандартом. Список Horizontal (Горизонтально)
задает размещение текста относительно выносных линий: вы можете разместить текст возле
первых или вторых выносных линий либо протянуть его поверх какой-либо выносной
линии. Из списка View Direction (Направление просмотра) можно выбрать направление тек-
ста: слева направо или справа налево. В поле Offset from dim line (Смещение от линии раз-
мера) задают промежуток между линией и текстовым значением размера.
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Параметры подгонки и масштаба

 
Вкладка Fit (Подгонка) управляет поведением и масштабом размеров (рис. 5.25). Здесь

можно указать, что будет происходить с размерами, если AutoCAD не может разместить
одновременно размерные линии и текстовое значение между выносными линиями.

 

Рис. 5.25. Параметры подгонки и масштаба размеров
С помощью настроек, расположенных в области Text placement (Размещение текста),

можно определить, где будет размещаться текст, если он не находится в заданном по умол-
чанию положении.

Например, если чертеж нужно печатать в масштабе 1/8"=1'–0", вы должны масшта-
бировать все аннотации вашего чертежа с коэффициентом 96. Поскольку рисунок сокращен
для печати, это гарантирует, что аннотация будет правильного размера. Переключатель Scale
for dimension features (Масштаб для свойств размера) управляет общим масштабом анно-
таций объектов размера.

Внимание!
Важно отметить, что параметр Scale for dimension features

(Масштаб для свойств размера) влияет только на размер самих
размерных объектов (линий, текста), а не на значения размеров.
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Use overall scale of (Использовать общий масштаб) – это масштабный коэффициент,
который применяется ко всем свойствам размера. Например, если текстовые значения и
стрелки-указатели имеют высоту 0.125, а значение общего масштаба – 2, AutoCAD будет
отображать текст и стрелки-указатели в масштабе 0.25.

Общий масштаб (положение переключателя Use overall scale of (Использовать пол-
ный масштаб)) чаще всего используется, когда размеры помещаются в пространство моде-
лирования (область рисования) и вы выводите в этом пространстве вид чертежа. Если же
вы выводите чертеж из пространства макета (листа), то можете установить переключатель в
положение Scale dimensions to layout (Масштабировать размеры для макета). В этом случае
AutoCAD автоматически масштабирует все свойства размеров в соответствии с масштабом
области просмотра макета. Это полезно, когда один рисунок содержит множество видов и
графических масштабов.

В области Fine tuning (Тонкая настройка) можно задать некоторые дополнительные
параметры вида размера. Если установлен флажок Place text manually (Помещать текст
вручную), при создании размеров появляется дополнительная подсказка, что позволяет вам
определять местоположение текстового значения размера после того, как вы определите
местонахождение размерной линии.

Установленный флажок Draw dim line between ext lines (Рисовать линию размера
между выносными линиями) вынудит размерную линию разместиться между выносными
линиями независимо от местоположения текстового значения.

 
Определение основных единиц

 
Параметры вкладки Primary Units (Основные единицы) предназначены для формати-

рования текстового значения размера (рис. 5.26). В области Linear dimensions (Линейные
размеры) можно указать, как будут отображаться единицы измерения, а в области Angular
dimensions (Угловые размеры) – как будут выглядеть угловые размеры.
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Рис. 5.26. Параметры форматирования текстового значения размера
Параметр Unit format (Формат единиц) устанавливает формат единиц измерения для

размеров всех типов, кроме угловых. Обычно его настраивают для согласования единиц
измерения рисунка. В дополнение к стандартным настройкам вы можете также выбрать
единицы Рабочего стола Windows, которые используют параметры, расположенные в окне
Язык и региональные стандарты (рис. 5.27).
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Рис. 5.27. Окно настройки региональных параметров Windows
Это окно можно вызвать, выполнив команду Пуск → Панель управления и щелкнув

в открывшемся окне на значке Язык и региональные стандарты.
С помощью списка Units format (Формат единиц) в области Angular dimensions (Угло-

вые размеры) можно управлять отображением угловых размеров: Decimal Degrees (Деся-
тичные градусы), Degrees Minutes Seconds (Градусы, минуты, секунды), Gradians (Грады)
или Radians (Радианы).

Параметр Precision (Точность) контролирует количество десятичных разрядов в тек-
сте размера. Он влияет только на отображение текстового значения, не изменяя геометрию
рисунка и не затрагивая фактическое измеренное значение размера.

В раскрывающемся списке Fraction format (Формат дроби) можно выбрать вариант
отображения дробей. Эта настройка доступна, только когда в списке Unit format (Формат
единиц) выбран пункт Architectural (Архитектурный) или Fractional (Дробный). Данный
параметр используется в сочетании с Fractional height scale (Масштаб высоты дроби) на
вкладке Text (Текст).
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Если в списке Unit format (Формат единиц) выбрано значение Decimal (Десятичный),
то в раскрывающемся списке Decimal separator (Десятичный разделитель) можно устано-
вить символ, используемый в качестве десятичного разделителя.

В поле Round off (Округление) задают правило округления для размеров всех типов,
кроме углового. Если вы введете 0.25, все расстояния округлятся к самому близкому значе-
нию 0.25 от единицы измерения. Если вы введете 1.0, все измеренные расстояния округлятся
к самому близкому целому числу. Количество цифр, отображаемых после десятичной точки,
зависит от значения параметра Precision (Точность).

В поле Prefix (Префикс) можно задать префикс для текстового значения размера. Ука-
занный текст будет помещаться перед заданным по умолчанию значением. Вы можете вве-
сти в данное поле любой текст или использовать управляющие коды, чтобы отобразить спе-
циальные символы. Например, управляющий код %%C отвечает за отображение символа
диаметра.

В поле Suffix (Суффикс) также можно задать дополнительный текст, однако в этом
случае он будет помещаться после заданного по умолчанию значения. Например, можно
ввести символ дюйма ("), и программа будет вставлять его после каждого значения размера.

Область Measurement scale (Масштаб измерений) содержит параметры, позволяющие
определить коэффициент масштаба для значений размера, заданных по умолчанию. Пара-
метр Scale factor (Коэффициент масштаба) определяет коэффициент масштаба для измере-
ний линейных размеров. Значение любого линейного размера умножается на этот коэффи-
циент, и окончательное значение используется как заданный по умолчанию текст. Например,
если вы установите коэффициент масштаба размера равным 2, то текстовое значение раз-
мера для линии в 1 дюйм будет отображается как 2 дюйма. Значение не применяется к угло-
вым измерениям и к округлению, а также к положительным или отрицательным допускам.

Если установлен флажок Apply to layout dimensions only (Применять только к разме-
рам макетов), значение масштабированного размера будет применяться только к размерам,
созданным в макетах (пространстве листов просмотра).

Настройки в области Zero suppression (Подавление нулей) управляют отображением
ведущих и конечных нулей в текстовых значениях размеров. Например, при использовании
десятичных единиц измерения установка флажка Leading (Ведущие) означает, что значение
0.5000 будет отображаться как.5000. При установленном флажке Trailing (Конечные) размер
12.5000 будет выглядеть как 12.5.

С помощью полей Sub-units factor (Субразмерный фактор) и Sub-units suffix (Субраз-
мерный суффикс) можно указать субразмерный фактор и суффикс. Например, если единица
измерения 1 м, вы можете указать субразмерный фактор 100 и субразмерный суффикс см.
В этом случае, когда величина размера меньше 1, например 0.45, будет отображаться 45 см,
а не 0.45 м.

Флажки 0 feet (0 в футах) и 0 inches (0 в дюймах) управляют отображением нулей
в значениях размеров, выраженных в футах и дюймах. Например, если флажок 0 feet (0 в
футах) установлен, значение 0' 8" будет отображать как 8". При установленном флажке 0
inches (0 в дюймах) значение 12' 0" будет отображаться как 12'.

 
Альтернативные единицы измерения

 
Вкладка Alternate Units (Альтернативные единицы) позволяет показывать размеры в

двух различных форматах (рис. 5.28). Типичный пример – отображение размеров одновре-
менно в миллиметрах и дюймах, например 2.00 [50.8mm]. Вкладка Alternate Units (Альтер-
нативные единицы) содержит параметры, подобные настройкам на вкладке Primary Units
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(Основные единицы). Чтобы разрешить использование альтернативных единиц, установите
флажок Display alternate units (Отображать альтернативные единицы).

 

Рис. 5.28. Параметры альтернативных единиц
Значение параметров Unit format (Формат единиц) и Precision (Точность) не отлича-

ется от аналогичных настроек на вкладке Primary Units (Основные единицы). При исполь-
зовании форматов дробных единиц (архитектурного и дробного) вы можете выбрать между
скомпонованным и нескомпонованным видами дроби.

Настройки Multiplier for alt units (Множитель для альтернативных единиц) и Round
distances to (Округлять расстояния до) определяют переходной коэффициент между первич-
ными и альтернативными единицами. Например, для преобразования дюймов в миллиме-
тры задайте множитель 25.4. Это значение не влияет на угловые размеры. Настройка Round
distances to (Округлять расстояния до) позволяет применять округленные значения к аль-
тернативным размерам. Это округленное значение не зависит от первичного значения окру-
гления единиц измерения.

Параметры Prefix (Префикс), Suffix (Суффикс) и флажки в области Zero supression
(Подавление нулей) настраиваются так же, как для основных единиц. Например, чтобы раз-
местить после альтернативных единиц запись мм, введите в поле Suffix (Суффикс) соответ-
ствующее значение.

С помощью переключателя Placement (Размещение) можно выбрать, где будут отобра-
жаться альтернативные единицы: после основного значения (After primary value) или под
ним (Below primary value).
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Настройки допусков

 
Вкладка Tolerances (Допуски) предназначена для управления отображением и значе-

ниями допусков как для основных, так и для альтернативных единиц (рис. 5.29). Настройка
Method (Метод) управляет отображением допусков. Параметр Precision (Точность) и
флажки в областях Zero supression (Подавление нулей) работают таким же образом, как на
вкладках Primary Units (Основные единицы) и Alternate Units (Альтернативные единицы),
но только управляют значениями допусков.

 

Рис. 5.29. Параметры допусков
В полях Upper value (Верхняя граница) и Lower value (Нижняя граница) можно задать

верхний и нижний пределы значений параметров допусков.
Используя поле Scaling for height (Масштабирование для высоты), можно установить

относительный размер текстового значения допуска. Это коэффициент масштаба, умножен-
ный на высоту текста основной единицы. Например, если вы задаете значение 0.5, текст
допуска будет равен половине размера основной единицы.

В списке Vertical position (Вертикальное положение) выбирают вертикальное распо-
ложение основного текстового значения размера по отношению к тексту допуска: Bottom
(Снизу), Middle (Посередине) или Top (Сверху).

Рассмотрим порядок изменения существующего стиля размера.
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1. Запустите команду DIMSTYLE, чтобы вызвать диалоговое окно Dimension Style
Manager (Менеджер стиля размера).

2. Выберите созданный ранее стиль размера Mech и щелкните на кнопке Modify (Изме-
нить). Появится диалоговое окно Modify Dimension Style (Изменить стиль размера).

3. На вкладке Symbols and Arrows (Символы и стрелки) задайте для параметра Arrow
size (Размер стрелки) значение 0.125.

4. На вкладке Text (Текст) нажмите кнопку с многоточием, расположенную рядом со
списком Text style (Стиль текста). Появится диалоговое окно Text Style (Стиль текста).
Нажмите в нем кнопку New (Новый) и создайте стиль текста с именем DIM, используя
шрифт romans.shx. Нажмите кнопку Apply (Применить), а затем Close (Закрыть), чтобы вер-
нуться в окно Modify Dimension Style (Изменить стиль размера).

5. Выберите в списке Text style (Стиль текста) стиль текста DIM, который вы только
что создали, и задайте параметр Text height (Высота текста) равным 0.125.

6. Нажмите кнопку OK, чтобы сохранить изменения стиля размера и возвратиться в
окно Dimension Style Manager (Менеджер стиля размера). Выберите стиль размера Mech
и щелкните на кнопке Set Current (Установить текущим), чтобы установить данный стиль
размера в качестве текущего. Нажмите кнопку Close (Закрыть), чтобы завершить выполне-
ние команды DIMSTYLE. Размеры, связанные с этим стилем, будут обновлены.
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Резюме

 
Любой чертеж в AutoCAD содержит различного рода размеры, являющиеся неотъ-

емлемой частью графической информации для работников производства, строительства,
управления и многих других отраслей деятельности. В этой главе мы рассмотрели основ-
ные команды и элементы интерфейса AutoCAD, служащие для вставки и редактирования
линейных и угловых размеров.

AutoCAD предоставляет пользователю разнообразные инструменты для создания,
изменения и обновления размерных объектов. Эффективное применение размерных стилей
и умение правильно настроить параметры размеров – ключ к вашим успехам при работе в
AutoCAD.
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Глава 6

Редактирование объектов
 

• Копирование объектов
• Создание зеркальной копии объектов
• Создание массивов
• Поворот объектов
• Масштабирование объектов
• Разрыв объекта
• Создание фаски
• Резюме
Редактирование объектов является обязательной частью работы в системе AutoCAD.

На практике редактирование рисунков применяется не только в связи с необходимостью
изменений, уточнений или исправления ошибок, но и непосредственно в процессе первона-
чального создания рисунков. Часто бывает так, что нужно создать какие-то симметричные
или однотипные элементы, подобные части чертежа и т. д., и при поиске оптимального пути
их построения используются приемы редактирования.
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Копирование объектов

 
С командой COPY вы познакомились в главе 3 (см. также видеоролик «Урок 3.3. Копи-

рование, вставка и удаление объектов»). Повторим основные моменты, связанные с копиро-
ванием объектов в AutoCAD с указанием базовой точки.

1. Создайте простой объект или откройте чертеж, содержащий такой объект.
2. Вызовите команду COPY, введя ее в командную строку или нажав кнопку Copy

(Копировать) на вкладке Home (Основная) в группе Modify (Редактирование) ленты. Можно
также нажать кнопку Copy (Копировать) на панели инструментов Modify (Редактирова-
ние) или воспользоваться командой меню Modify → Copy (Редактирование → Копировать).
Появится запрос:

Select objects:
Выберите объект. Появится приглашение:
Select objects:
Нажмите клавишу Enter или Пробел. AutoCAD выдаст запрос об указании базовой

точки:
Specify base point or [Displacement/mOde] <Displacement>:
3. Щелчком на области рисования выберите базовую точку и переместите мышь, ука-

зывая вектор переноса копии объекта. При этом программа попросит указать вторую точку:
Specify second point or <use first point as displacements
4. Щелчком кнопки мыши вставьте копию. AutoCAD выдаст запрос:
Specify second point or [Exit/Undo] <Exit>:
Продолжайте вставлять точки, создавая множество копий, как показано на рис. 3.15.
5. Для завершения работы команды нажмите клавишу Enter, выберите параметр Exit

или введите букву Е в командную строку.
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Создание зеркальной копии объектов

 
Команда MIRROR создает зеркальное (симметричное) отражение объектов относи-

тельно оси симметрии, определенной двумя выбранными крайними точками.
После запуска команды MIRROR AutoCAD выдаст приглашение:
Select objects:
Выберите объекты, которые вы хотите отразить, и нажмите клавишу Enter, чтобы при-

нять набор выделения. Затем AutoCAD предложит вам определить две крайние точки линии,
относительно которой должны отразиться выбранные объекты, как показано на рис. 6.1.

 

Рис. 6.1. Выбор осевой линии для зеркального отражения объектов
После выбора второй точки программа спросит вас, нужно ли удалять первоначально

выбранные объекты:
Erase source objects? [Yes/No] <N>:
У вас есть выбор: оставить исходные объекты на чертеже вместе с их копиями или

оставить только отраженные объекты, а первоначальные удалить. По умолчанию предлага-
ется не стирать исходные объекты, поэтому при выборе этого варианта достаточно нажать
клавишу Enter. Чтобы стереть оригиналы объектов, вы можете выбрать параметр Yes или
ввести команду Y c последующим нажатием клавиши Enter. В любом случае, каким бы ни
был ваш выбор, выполнение команды завершается зеркальным отражением объекта.

Обычно, когда вы зеркально отражаете объект с текстом, необходимо, чтобы текст
сохранил свою первоначальную ориентацию – слева направо (рис. 6.2).

 

Рис. 6.2. Сохранение ориентации текста при зеркальном отражении объекта
Системная переменная AutoCAD MIRRTEXT контролирует ориентацию текста при

зеркальном отражении. Присвоение этой переменной значения 1 заставит текст полностью
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обратиться, как показано на рис. 6.3. Если же переменной MIRRTEXT задано значение 0, то
текст сохранит первоначальную ориентацию.

 

Рис. 6.3. Обращение текста при зеркальном отражении
По умолчанию системной переменной MIRRTEXT присвоено значение 0.

Совет
Для изменения этого значения введите MIRRTEXT в командную

строку. В ответ на приглашение Enter new value for MIRRTEXT <0>:
следует ввести необходимое значение (0 либо 1).

Рассмотрим порядок выполнения зеркального отражения объектов.
1. Откройте существующий чертеж или создайте новый, содержащий простой объект.
2. Вызовите команду MIRROR, нажав соответствующую кнопку на вкладке Home

(Основная) в группе Modify (Редактирование) ленты или на панели инструментов Modify
(Редактирование). Можно также выполнить команду меню Modify → Mirror (Редактирова-
ние → Отобразить). Еще один способ – ввод команды MIRROR в командную строку.

3. Выберите объект, который нужно отразить. Программа попросит указать первую
точку зеркальной оси:

Specify first point of mirror line:
4. Выберите первую точку оси. Далее потребуется указать вторую точку оси:
Specify second point of mirror line:
5. Включите Ortho Mode (Ортогональный режим), нажав соответствующую кнопку

внизу окна программы (если она в данный момент не нажата).
6. Выберите вторую точку ниже первой, используя режим помощи Ortho Mode (Орто-

гональный режим) (рис. 6.4). Программа отобразит объект и выдаст запрос:
Erase source objects? [Yes/No] <N>:

 



А.  А.  Орлов.  «AutoCAD 2010»

210

Рис. 6.4. Создание зеркального отражения объекта
7. Нажмите клавишу Enter, чтобы принять значение по умолчанию и сохранить пер-

воначальный объект.
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Создание массивов

 
Массивом называют множество однородных предметов, образующих единое целое.

Массивы программы AutoCAD – это совокупность копий одного объекта, расположенных
на равном расстоянии друг от друга. Так как массивы связаны со смещением координат,
они могут быть прямоугольными и полярными. В прямоугольных массивах объекты смеща-
ются по осям координат, и такие массивы представляют собой прямоугольные структуры.
В полярных массивах копирование происходит вокруг одной точки, в результате чего такие
совокупности имеют форму окружности.

Для создания массива используется команда ARRAY. Ее можно вызвать, нажав одно-
именную кнопку на вкладке Home (Основная) в группе Modify (Редактирование) ленты или
на панели инструментов Modify (Редактирование). Можно также воспользоваться командой
меню Modify → Array (Редактирование → Массив) или ввести ARRAY в командную строку.

После запуска команды появится диалоговое окно Array (Массив) (рис. 6.5).
 

Рис. 6.5. Диалоговое окно Array (Массив)
В верхней части окна расположен переключатель, позволяющий выбрать тип массива:

прямоугольный или полярный. Справа от него находится кнопка Select objects (Выбор объ-
ектов), нажав которую можно выбрать объекты для копирования. Содержимое центральной
части окна изменяется в зависимости от выбранного типа массива. Здесь можно указать раз-
личные параметры копирования. Справа находится область предварительного просмотра.
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Прямоугольный массив

 
Для создания прямоугольного массива установите переключатель в окне Array (Мас-

сив) в положение Rectangular Array (Прямоугольный массив). При этом станут доступны
следующие параметры.

• Для изменения количества строк и столбцов используют поля Rows (Строки) и
Columns (Столбцы). При изменении количества строк и столбцов изображение в области
предварительного просмотра будет обновляться.

• Поля Row offset (Смещение между строками) и Column offset (Смещение между
столбцами) служат для изменения расстояния между строками и столбцами. При положи-
тельном значении параметра Row offset (Смещение между строками) строки создаются в
положительном направлении оси Y (вверх), при отрицательном – в обратном направлении.
Отрицательное значение в поле Column offset (Смещение между столбцами) означает, что
столбцы будут создаваться слева. Обратите внимание на значения этих параметров и изо-
бражение в области предварительного просмотра на рис. 6.6.

 

Рис. 6.6. Указание смещения столбцов и строк
Вы можете определить смещение строк и столбцов независимо, вводя значения в тек-

стовые поля. Кроме того, справа от полей находится объединенная кнопка, которая позво-
ляет выбирать смещение строк и столбцов, определяя два противоположных угла прямо-
угольника. Длина (x) прямоугольника – смещение столбцов, ширина (у) – смещение строк.

• Для указания общего угла массива служит поле Angle of array (Угол массива). Вы
можете указать численное значение угла в данном поле или, нажав кнопку Pick Angle of
Array (Указать угол массива), расположенную справа от поля, выбрать две точки на чертеже.
Программа AutoCAD измерит угол наклона линии между этими двумя точками и использует
его в качестве угла наклона массива (рис. 6.7). По умолчанию задан угол 0°.
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Рис. 6.7. Настройка общего угла прямоугольного массива
Когда вы изменяете каждое из этих значений, изображение в области предваритель-

ного просмотра обновляется, чтобы показать вам, как будет выглядеть итоговый массив. Для
представления фактических объектов здесь используются абстрактные блоки. Чтобы уви-
деть, как будет выглядеть ваш массив на чертеже, щелкните на кнопке Preview (Предвари-
тельный просмотр). AutoCAD временно скроет диалоговое окно Array (Массив) и пока-
жет массив с использованием выбранных вами объектов. Кнопка Preview (Предварительный
просмотр) будет доступна только после того, как вы выберете объекты.

Закрепите навыки создания прямоугольного массива, выполнив следующие действия.
1. Нарисуйте объект, например эллипс.
2. Вызовите команду ARRAY. На экране отобразится диалоговое окно Array (Массив).
3. Установите переключатель в положение Rectangular Array (Прямоугольный мас-

сив) и щелкните на кнопке Select objects (Выбор объектов). Выберите эллипс и нажмите
клавишу Enter для возвращения в окно Array (Массив).

4. Введите следующие значения параметров: Rows (Строки) – 4, Columns (Столбцы) –
6, Row offset (Смещение между строками) – 2 4 0, Column offset (Смещение между столб-
цами) – 2 8 0, Angle of array (Угол массива) – 10.

5. Щелкните на кнопке Preview (Предварительный просмотр). На экране появится
предварительное изображение массива. Если окно Array (Массив) мешает вам увидеть мас-
сив, просто перетащите это окно за строку заголовка.

6. Щелкните на кнопке Accept (Принять) для завершения выполнения команды
ARRAY. Чертеж должен напоминать показанный на рис. 6.8.
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Рис. 6.8. Прямоугольный массив эллипсов под углом 10°
 

Полярный массив
 

Для создания полярного массива установите переключатель в окне Array (Массив) в
положение Polar Array (Полярный массив) (рис. 6.9).
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Рис. 6.9. Окно создания полярного массива
При этом становятся доступны следующие параметры.
• Поля X и Y служат для указания центра окружности, по которой будут располагаться

элементы массива. Центр также можно задать, нажав кнопку Pick Center Point (Указать
центральную точку), расположенную справа от полей, и указав его на чертеже с помощью
мыши.

• Полярный массив характеризуется тремя параметрами: количеством создаваемых
элементов (Total number of items), общим углом, заполняемым массивом (Angle to fill), и
углом между элементами (Angle between items). Для создания массива необходимо задать
два параметра, для чего в раскрывающемся списке Method (Метод) следует выбрать, какие
параметры будут использоваться.

Примечание
При определении угла заполнения или угла между элементами

положительное значение будет копировать элементы в направлении
против часовой стрелки, а отрицательное – по часовой стрелке.

• В нижней части окна находится флажок, который позволяет указать, следует ли пово-
рачивать отдельные объекты в массиве. При снятом флажке объекты сохраняют свой перво-
начальный угол, а при установленном каждый элемент при выстраивании его по окружно-
сти вращается вокруг базовой точки.

При нажатии кнопки More (Больше) отобразятся дополнительные настройки враще-
ния объектов (рис. 6.10). По умолчанию объекты вращаются характерным для них образом.
Линейные объекты (линии, полилинии, лучи и т. д.) – относительно их начальной точки.
Окружности, дуги и эллипсы – относительно своих центральных точек. Блоки и текст вра-
щаются относительно их точки ввода, а прямые – относительно середины. Для того чтобы
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они вращались относительно базовой точки, необходимо снять флажок Set to object's default
(Настройки по умолчанию) и в полях X и Y указать координаты точки.

 

Рис. 6.10. Параметры вращения объектов
Рассмотрим процесс создания полярного массива.
1. Нарисуйте фигуру, подобную показанной на рис. 6.11.

 

Рис. 6.11. Исходная фигура для полярного массива
2. Вызовите команду ARRAY. На экране отобразится диалоговое окно Array (Массив).
3. Установите переключатель в положение Polar Array (Полярный массив) и щелкните

на кнопке Select objects (Выбор объектов). Выберите исходную фигуру и нажмите клавишу
Enter для возвращения к окну Array (Массив).

4. Щелкните на кнопке Pick Center Point (Указать центральную точку) и задайте в
качестве центра массива точку, расположенную ниже фигуры, на ее осевой линии.

5. В раскрывающемся списке Method (Метод) выберите пункт Total number of items
& Angle to fill (Общее количество элементов и угол заполнения).

6. Задайте параметру Total number of items (Общее количество элементов) значение
8, а параметру Angle to fill (Угол заполнения) – 3 6 0.

7. Нажмите кнопку OK. Ваш чертеж должен напоминать представленный на рис. 6.12.
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Рис. 6.12. Полярный массив
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Поворот объектов

 
Для поворота объектов используют команду ROTATE. С ее помощью можно повора-

чивать объекты под определенным углом и вокруг указанной точки.
Для запуска команды ROTATE следует нажать кнопку Rotate (Поворот) на вкладке

Home (Основная) в группе Modify (Редактирование) ленты или на панели инструментов
Modify (Редактирование). Можно также выполнить команду меню Modify → Rotate (Редак-
тирование → Поворот) или ввести ROTATE в командную строку.

После запуска команды появится запрос:
Select objects:
Выделите объекты, которые необходимо повернуть, и нажмите клавишу Enter или

Пробел для принятия набора выделения. Программа выдаст следующий запрос:
Specify base point:
В ответ с помощью мыши задайте точку, вокруг которой будет происходить вращение,

после чего появится последний запрос – об указании угла вращения:
Specify rotation angle or [Copy/Reference] <0>:
Угол вращения можно указать одним из трех способов:
• с помощью мыши, используя базовую точку в качестве вершины угла;
• вводом значения угла с клавиатуры;
• используя параметр Reference, задать начальный угол и затем новый.

Примечание
Существует также возможность указать базовую точку с помощью

декартовых координат в поле возле указателя или в командной строке.
Например, чтобы повернуть объект с использованием в качестве
базовой точки начала координат рисунка, вы можете ввести 0.0 и
нажать клавишу Enter в ответ на приглашение Specify base point:.

Чтобы задать угол поворота с помощью мыши, просто перемещайте указатель вокруг
базовой точки, пока объект не примет требуемое положение (рис. 6.13).

 

Рис. 6.13. Предварительный вид объекта после поворота
Совет
Вы можете использовать Ortho Mode (Ортогональный режим) или

вспомогательные средства полярного отслеживания, чтобы быстро и
точно поворачивать объекты на требуемые углы.

Значение угла поворота можно просто ввести с клавиатуры. Для измерения углов
используются текущий базовый угол и направление. Заданный по умолчанию базовый угол
– 0° (восток) с направлением измерения против часовой стрелки. В момент выполнения
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команды текущее направление и базовый угол отображаются в командной строке следую-
щим образом:

Current positive angle in UCS: ANGDIR=counterclockwise ANG– BASE=0
Ввод значения угла и нажатие клавиши Enter поворачивают выбранный объект на ука-

занный угол.
Примечание
Можно ввести отрицательный угол и вращать объекты в

противоположном направлении. Например, ввод значения -45°
эквивалентен вводу значения 315°: объект примет одно и то же
положение в результате поворота в разных направлениях.

Параметр Reference позволяет вращать объекты, определяя направление или началь-
ный угол и затем указывая новый, абсолютный угол поворота. AutoCAD повернет объект,
вычислив разницу между углом направления и новым углом.

Данный параметр неоценим, если вы не знаете существующий угол поворота объекта.
Используя функцию захвата, вы можете зафиксировать на объектах две точки, которые опре-
деляют текущий угол. Затем в ответ на запрос:

Specify the new angle or [Points] <0>:
необходимо ввести угол с клавиатуры либо, воспользовавшись параметром Points,

выбрать две точки для определения нового угла (рис. 6.14).
 

Рис. 6.14. Вращение с применением параметра Reference
С помощью параметра Copy команды ROTATE можно не только вращать объекты, но

и создавать их копии. При выборе этого параметра в ответ на запрос Specify rotation angle or
[Copy/Reference] <0>: появится следующий запрос:

Rotating a copy of the selected objects.
Specify rotation angle or [Copy/Reference] <0>:
Угол вращения можно задать с помощью любого метода, описанного ранее. На

рис. 6.15 показан результат использования параметра Copy при выполнении команды
ROTATE.
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Рис. 6.15. Результат поворота объектов с копированием
Для тренировки полученных знаний выполните следующие действия.
1. Вызовите команду ROTATE и выберите на чертеже объект, который необходимо

повернуть. Появится первый запрос:
Specify base point:
2. Укажите центр вращения, и программа выдаст запрос об определении угла враще-

ния:
Specify rotation angle or [Copy/Reference] <0>:
3. С помощью мыши поверните объект на любой угол.
4. Чтобы вернуть объект в исходное положение, нажмите клавишу Esc. Можно также

нажать кнопку Undo (Отмена) на панели быстрого доступа или на панели инструментов
Standard (Стандартная).

5. Повторно вызовите команду ROTATE и выберите на чертеже объект, который необ-
ходимо повернуть. Появится запрос:

Specify base point:
6. Укажите центр вращения. Появится следующий запрос об определении угла пово-

рота:
Specify rotation angle or [Copy/Reference] <0>:
7. Введите значение 4 5 и нажмите клавишу Enter. Объект будет повернут на 45°.
8. Введите команду U и нажмите клавишу Enter или Пробел, чтобы отменить изме-

нения.
9. Снова вызовите команду ROTATE и выберите на чертеже объект. После этого про-

грамма выдаст запрос об указании базовой точки:
Specify base point:
10. Укажите центр вращения. Появится приглашение:
Specify rotation angle or [Copy/Reference] <0>:
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11. Выберите параметр Copy, используя клавиши управления курсором или введя C в
командную строку и нажав клавишу Enter.

12. Введите значение 6 0 и нажмите клавишу Enter. Объект будет повернут и скопи-
рован.
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Масштабирование объектов

 
Для изменения размеров объектов в AutoCAD используется команда SCALE (см. также

видеоролик «Урок 6.1. Поворот и масштабирование объектов»).
Чтобы запустить команду SCALE, следует нажать кнопку Scale (Масштаб) на вкладке

Home (Основная) в группе Modify (Редактирование) ленты или на панели инструментов
Modify (Редактирование). Можно также выполнить команду меню Modify → Scale (Редак-
тирование → Масштаб) или ввести SCALE в командную строку.

После вызова команды SCALE программа выдаст запрос о выборе объектов:
Select objects:
Укажите объекты, масштаб которых следует изменить, и нажмите клавишу Enter или

Пробел, чтобы принять набор выделения. В следующем запросе требуется указать базовую
точку, относительно которой будет происходить изменение масштаба:

Specify base point:
Далее необходимо указать коэффициент масштабирования:
Specify scale factor or [Copy/Reference] <1.0000>:
Коэффициент масштабирования можно указать одним из трех способов:
• с помощью мыши, используя базовую точку как вершину;
• вводом коэффициента с клавиатуры;
• используя параметр Reference, задать начальный размер (длину), а затем новый. Сде-

лать это можно как с клавиатуры, так и указывая точки на чертеже.
При использовании мыши вы просто перемещаете указатель, выбирая на чертеже

точку, чтобы указать желаемый коэффициент масштаба. При этом отображается предвари-
тельный вид объекта (рис. 6.16).

 

Рис. 6.16. Изменение масштаба объекта
Примечание
Существует также возможность ввести декартовы координаты

базовой точки в поле возле указателя или в командную строку.
Например, чтобы масштабировать объект, используя начало координат
рисунка в качестве базовой точки, вы можете ввести значение 0.0 и
нажать клавишу Enter в ответ на приглашение Specify base point:.
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Значение масштаба можно также ввести с клавиатуры. При коэффициенте масштаби-
рования, большем чем 1, объекты увеличиваются, а при меньшем их размер уменьшается.
Коэффициент масштабирования всегда должен быть больше нуля.

Параметр Reference позволяет масштабировать объекты, определяя начальную длину,
а затем новую, абсолютную. AutoCAD определяет необходимый коэффициент масштаба,
вычисляя разницу между начальной и новой длиной. Вы можете ввести длину с клавиатуры
или выбрать на рисунке две точки, которые определяют относительную длину. Параметр
Reference просто необходим, если вы не знаете длину существующего объекта, а располага-
ете лишь требуемой. Используя функцию захвата, вы можете зафиксировать на объекте две
точки, которые определяют его длину. Затем AutoCAD предложит задать новую длину:

Specify new length or [Points] <1.0000>:
Вы можете ввести длину с клавиатуры или использовать параметр Points, чтобы

выбрать две точки для указания новой длины.
С помощью параметра Copy команды SCALE можно не только изменять масштаб объ-

ектов, но и создавать их копии. При выборе данного параметра в ответ на запрос Specify
scale factor or [Copy/Reference] <1.0000>: появится следующее приглашение:

Scaling a copy of the selected objects.
Specify scale factor or [Copy/Reference] <1.0000>:
Вы можете использовать любой метод, чтобы определить коэффициент масштаба.

Пример изменения размеров с копированием объекта представлен на рис. 6.17.
 

Рис. 6.17. Результат изменения масштаба с копированием объекта
Закрепите пройденный материал, выполнив следующее упражнение.
1. Вызовите команду SCALE и выберите объект. На экране появится запрос об опре-

делении базовой точки:
Specify base point:
2. Обозначьте базовую точку. Программа попросит определить коэффициент мас-

штаба:
Specify scale factor or [Copy/Reference] <1.0000>:
3. Масштабируйте объект в любом отношении, используя точку, выбранную указате-

лем мыши.
4. Введите букву U в командную строку или нажмите кнопку Undo (Отмена) на панели

быстрого доступа, чтобы вернуть объекту первоначальный размер.
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5. Повторно вызовите команду SCALE и выберите объект. На экране появится запрос:
Specify base point:
6. Обозначьте базовую точку, после чего появится запрос об определении коэффици-

ента масштаба:
Specify scale factor or [Copy/Reference] <1.0000>:
7. Введите значение 2 и нажмите клавишу Enter или Пробел. Объект будет увеличен

в два раза.
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Разрыв объекта

 
Команда BREAK позволяет удалять части объекта или разбивать его на два. Для ее

запуска следует нажать кнопку Break (Разрыв) на вкладке Home (Основная) в группе Modify
(Редактирование) ленты или на панели инструментов Modify (Редактирование). Можно
также выполнить команду меню Modify → Break (Редактирование → Разрыв) или ввести
BREAK в командную строку.

После вызова команды BREAK программа предложит вам выбрать объект. Одновре-
менно с выбором объекта вы указываете первую точку разрыва. Если вы хотите ее изменить,
необходимо в ответ на запрос команды Specify second break point or [First point]: выбрать
параметр First point, чтобы повторно указать первую точку. Затем, после указания первой
точки, в ответ на запрос программы укажите вторую точку, и разрыв будет создан.

• Если вам необходимо разбить один объект на два, не нарушая при этом его геометрию,
просто используйте символ @, чтобы определить вторую точку. В этом случае программа
разместит вторую точку в тех же координатах, где находится первая. В итоге будут созданы
два объекта, вместе составляющие исходный.

• Иногда тип новых объектов, созданных при разбиении, может отличаться от исход-
ного. Когда вы обрываете линию, AutoCAD просто создает две линии, однако, когда вы обры-
ваете окружность, программа преобразует ее в дугу. Порядок выбора точек определяет, какая
часть круга будет сохранена. AutoCAD удалит часть, первую в направлении против часовой
стрелки.

При выборе второй точки разрыва следует иметь в виду некоторые особенности. Во-
первых, если вы выберете вторую точку где-нибудь вне объекта, AutoCAD спроектирует
точку обрыва по линии, перпендикулярной объекту и проходящей через выбранную точку.
Во-вторых, если вторая точка разрыва лежит за границами объекта, AutoCAD просто удалит
все, что находится между первой точкой и границей объекта.

Для создания разрыва объекта следует выполнить следующие действия.
1. Вызовите команду BREAK и выберите на объекте (например, окружности) точку,

которая будет служить первой точкой разрыва. AutoCAD попросит указать вторую точку:
Specify second break point or [First point]:
2. Укажите вторую точку где-либо возле окружности, чтобы разорвать окружность и

получить ее часть в виде дуги. Результат должен выглядеть примерно так, как показано на
рис. 6.18.

 

Рис. 6.18. Результат разрыва окружности
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Создание фаски

 
Объекты чертежа можно соединять, строя фаски (скошенные линии). «Снять фаску»

на языке металлообработки означает сделать скос на прямоугольной грани детали. Наличие
такой функции в AutoCAD вызвано тем, что во многих случаях изображение этих частей
чертежа неудобно создавать с помощью базовых инструментов редактирования.

Для создания фаски (скошенного угла) между двумя пересекающимися объектами
используется команда CHAMFER. Ее можно вызвать щелчком на кнопке Chamfer (Фаска)
на вкладке Home (Основная) в группе Modify (Редактирование) ленты или на панели
инструментов Modify (Редактирование). Можно также выполнить команду меню Modify →
Chamfer (Редактирование → Фаска).

При использовании команды CHAMFER нужно задать два расстояния (от точки пере-
сечения до каждого объекта) или расстояние и угол для фаски. Параметр mEthod позволяет
выбрать, какой способ создания фасок использовать.

 
Метод задания расстояний

 
С помощью данного метода вы определяете расстояние от пересечения до объекта

вдоль каждой линии. Программа вычисляет расстояния от точки пересечения до первого и
второго объектов и затем рисует линию между этими двумя точками.

Параметр Distance позволяет настроить длины фаски. Первая длина применяется для
первого выбранного объекта, вторая – для второго.

Если длины фаски равны, рисуется фаска в 45°. Когда вы устанавливаете первое рас-
стояние, AutoCAD присваивает это значение, заданное по умолчанию, второму расстоянию.
Чтобы принять это, просто нажмите клавишу Enter в ответ на запрос программы о вводе
второго расстояния фаски.

 
Метод задания угла

 
Метод задания угла использует расстояние и угол для определения линии фаски. Рас-

стояние отнимается от первого выбранного объекта для определения начальной точки, и
линия фаски рисуется под определенным углом, пока не пересекается со вторым объектом.
По умолчанию угол измеряется в направлении против часовой стрелки от первого объекта.

При создании фаски для полилинии с помощью параметра Polyline первый и вто-
рой объекты определяются в том порядке, в котором была нарисована полилиния. Если вы
сомневаетесь или не получаете ожидаемых результатов, лучшим способом, возможно, будет
не использовать параметр Polyline, а просто нанести фаски на участки полилинии отдельно.

Рассмотрим порядок создания фаски.
1. Нарисуйте две линии, расположенные перпендикулярно друг к другу (рис. 6.19).
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Рис. 6.19. Исходные линии для нанесения фаски
2. Запустите команду CHAMFER и выберите параметр Angle. На экране появится

запрос об определении длины фаски на первой линии:
Specify chamfer length on the first line <0.0000>:
3. Введите значение 90 и нажмите клавишу Enter или Пробел, чтобы установить

длину. Появится запрос об указании угла фаски:
Specify chamfer angle from the first line <0>:
4. Введите значение 65 и нажмите клавишу Enter или Пробел для установки угла

фаски. Программа попросит выбрать первую линию:
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:
5. Затем укажите вторую линию в ответ на запрос:
Select second line or shift-select to apply corner:
AutoCAD скосит угол. Обратите внимание, что расстояние 90 отмеряется от выбранной

вами первой линии. Результат должен выглядеть примерно так, как показано на рис. 6.20.
 

Рис. 6.20. Создание фаски методом ввода одного расстояния и угла
6. Введите команду U, чтобы отменить нанесение последней фаски.
7. Вновь запустите команду CHAMFER и выберите параметр Distance. Задайте первое

расстояние равным 110.
8. AutoCAD устанавливает для второго расстояния значение по умолчанию, соот-

ветствующее первому расстоянию. Нажмите клавишу Enter, чтобы принять это значение.
AutoCAD выдаст запрос о выборе первой линии:

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:
Выберите одну из линий в качестве первой.
9. В ответ на следующий запрос укажите вторую линию:
Select second line or shift-select to apply corner:
10. AutoCAD нанесет фаску, и чертеж примет вид, подобный показанному на рис. 6.21.
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Рис. 6.21. Фаска, созданная методом ввода двух расстояний



А.  А.  Орлов.  «AutoCAD 2010»

229

 
Резюме

 
Вы познакомились с основами редактирования объектов в AutoCAD, освоили такие

базовые приемы, как копирование, зеркальное отражение, поворот, изменение размеров объ-
ектов, а также более специфические средства – создание массива объектов, разрыва и фаски.

Знание и уверенное владение приемами редактирования позволяет оптимизировать
процесс создания чертежей, схем, планов и т. д. Вы сможете выделять опорные структурные
элементы объектов, находить симметрию и подобие. Так AutoCAD дает вам больше возмож-
ностей для творчества, принимая на себя большую часть рутинной работы.
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Глава 7

Штриховка и градиент
 

• Выбор шаблона штриховки
• Выбор градиента
• Определение границ штриховки и градиента
• Перетаскивание штриховки
• Редактирование штриховки и градиента
• Резюме
Штриховкой называется рисунок, заполняющий область или замкнутый контур.

Штриховка используется в чертежах самого различного назначения. Например, в машино-
строительных чертежах штриховка может применяться для обозначения разреза и типа мате-
риала конструкции. Кроме того, в AutoCAD можно выделять области закрашиванием, то
есть с помощью так называемых градиентных заливок. Работа со штриховкой во многом
схожа с работой с градиентом, поэтому практически все написанное в этой главе о штри-
ховке относится и к градиентным заливкам.

Процесс создания штриховки в AutoCAD максимально автоматизирован. Пользова-
телю нет необходимости вычерчивать все линии по отдельности. По большому счету для
нанесения штриховки достаточно выбрать шаблон и определить границы заштриховывае-
мой области. Объектами, ограничивающими область штриховки, могут быть линии, окруж-
ности, дуги, полилинии, трехмерные грани и видовые экраны. Причем вся штриховка в этом
случае представляет собой один объект, то есть является блоком.

Еще одним важным свойством штриховки является ее ассоциативность: штриховка
привязывается к границам заштриховываемой области и в случае изменения этой области
также принимает новые размеры. На практике это означает, что, если понадобится под-
корректировать размеры заштрихованного изображения детали, необходимости в создании
новой штриховки не будет, так как штриховка автоматически «подстроится» под новые очер-
тания контура.

Шаблоном штриховки называется рисунок, заполняющий заштриховываемую
область. Шаблоны штриховки хранятся в файлах acad.pat и acadiso.pat. Кроме того, у поль-
зователей есть возможность создавать собственные шаблоны штриховки, которые следует
сохранять в файлах с произвольным именем и расширением PAT.

Совет
Штриховку лучше всего создавать на отдельном слое, так как

это позволяет впоследствии редактировать все шаблоны штриховки
за один прием. Например, можно убрать всю штриховку с экрана или
присвоить ей отдельный цвет.

Рассмотрим этапы создания штриховки и градиента более подробно.
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Выбор шаблона штриховки

 
Чтобы приступить непосредственно к созданию штриховки, щелкните на кнопке

Hatch (Штриховка) на вкладке Home (Основная) в группе Draw (Черчение) ленты или на
панели инструментов Draw (Черчение), запустив тем самым выполнение команды BHATCH.

Примечание
В AutoCAD присутствуют две команды для нанесения штриховки

– BHATCH и HATCH. В более ранних версиях программы эти команды
имели немного разные функции, а в AutoCAD 2010 их запуск приводит
к одному результату.

После запуска команды BHATCH на экране появляется диалоговое окно Hatch and
Gradient (Штриховка и градиент) (рис. 7.1). В этом окне производятся все действия, связан-
ные с выбором и нанесением штриховки и градиента.
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Рис. 7.1. Диалоговое окно Hatch and Gradient (Штриховка и градиент)
В раскрывающемся списке Type (Тип) можно выбрать один из трех вариантов шаблона

штриховки:
• Predefined (Стандартный) – позволяет выбрать шаблон штриховки из списка;
• User defined (Из линий) – дает возможность задать свой шаблон штриховки;
• Custom (Пользовательский) – позволяет выбрать шаблон штриховки из ранее создан-

ных пользователем.
В AutoCAD присутствует достаточно большой набор штриховок. Если в списке Type

(Тип) выбрано значение Predefined (Стандартный), то нужный шаблон штриховки можно
указать в поле Pattern (Шаблон). При этом выбранная штриховка демонстрируется в поле
Swatch (Образец). Однако есть и более удобный способ задания шаблона штриховки: щелк-
ните на кнопке с многоточием, расположенной возле поля Pattern (Шаблон). На экране
появится диалоговое окно Hatch Pattern Palette (Палитра шаблонов штриховки) (рис. 7.2).
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Рис. 7.2. Диалоговое окно Hatch Pattern Palette (Палитра шаблонов штриховки)
В этом окне есть четыре вкладки, содержащие различные шаблоны штриховки, изо-

браженные в виде небольших рисунков с названиями. На вкладках ANSI и ISO расположены
шаблоны штриховки стандартов ANSI и ISO соответственно. Вкладка Other Predefined
(Другие стандартные) содержит самые разнообразные шаблоны штриховки, поддерживае-
мые программой. На вкладке Custom (Пользовательский) находятся шаблоны, созданные
пользователями и хранящиеся в файлах с расширением PAT. Если вы ранее не создавали
собственные штриховки, то эта вкладка будет пустой.

Чтобы выбрать штриховку, щелкните кнопкой мыши на соответствующем изображе-
нии, а затем нажмите кнопку OK. Вы вернетесь в диалоговое окно Hatch and Gradient
(Штриховка и градиент), где можно будет изменить другие параметры.

Из раскрывающегося списка Angle (Угол) выбирают угол наклона линий штриховки.
Это значение прибавляется к тому углу, который уже присутствует в выбранном шаблоне
штриховки. Например, если выбран шаблон, в котором линии проведены под углом 45°, и вы
укажете такое же значение в списке Angle (Угол), то на чертеже получите линии штриховки,
проведенные вертикально.
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С помощью раскрывающегося списка Scale (Масштаб) задают коэффициент масшта-
бирования штриховки. При значении 1, которое выбрано по умолчанию, штриховка вычер-
чивается так, как определена в шаблоне. Обычно коэффициент масштабирования выбирают
пропорционально размерам чертежа. При слишком малом коэффициенте масштабирования
область штриховки почти полностью закрашивается, а при чрезмерно большом линии штри-
ховки могут быть не видны.

Флажок Relative to paper space (Относительно пространства листа) позволяет масшта-
бировать рисунок штриховки пропорционально единицам пространства листа. Этот пара-
метр доступен, только если вы запускаете команду штриховки, находясь на вкладке Layout
(Лист). Установкой флажка Relative to paper space (Относительно пространства листа)
изменяется значение переменной HPSCALE.

Раскрывающийся список ISO pen widht (Толщина пера ISO) становится активным,
если выбран шаблон штриховки стандарта ISO. При указании в этом списке какой-либо тол-
щины линии такое же значение автоматически подставляется и в список Scale (Масштаб).

Некоторыми особенностями выделяется шаблон штриховки SOLID (Сплошная), нахо-
дящийся на вкладке Other Predefined (Другие стандартные) диалогового окна Hatch
Pattern Palette (Палитра шаблонов штриховки). Этот шаблон заполняет область сплошной
заливкой определенного цвета. При выбранном шаблоне SOLID (Сплошная) не доступен
ни один из элементов в области Angle and scale (Угол и масштаб) окна Hatch and Gradient
(Штриховка и градиент), а в раскрывающемся списке Swatch (Образец) можно указать цвет
заливки. По умолчанию выбрано значение ByLayer (По слою).

Выбрав в раскрывающемся списке Type (Тип шаблона) пункт User defined (Из
линий), можно определить свой рисунок штриховки. В этом случае штриховка будет

создана на основе линий, находящихся на определенном расстоянии и с заданным интер-
валом и углом наклона. Значение угла наклона линий штриховки выбирают в раскрываю-
щемся списке Angle (Угол), а расстояние между линиями задают в поле Spacing (Интервал).
При желании можно установить флажок Double (Крест-накрест), и тогда изображение будет
дополнено пересекающимися линиями.

При выборе из списка Type (Тип шаблона) пункта Custom (Пользовательский) ста-
новится активным список Custom pattern (Настраиваемый шаблон). Здесь можно выбрать
шаблоны штриховки, хранящиеся в файлах, отличных от acad.pat и acadiso.pat. Кроме того,
в этом случае можно задать угол наклона и коэффициент масштабирования.

Нередко, кроме шаблона штриховки, необходимо задать исходную точку, с которой
начнет вычерчиваться штриховка. Задать расположение такой точки можно в области Hatch
origin (Исходная точка штриховки).

Если переключатель установлен в положение Use current origin (Использовать теку-
щую исходную точку), в качестве начальной будет использоваться точка, заданная систем-
ной переменной (по умолчанию это точка с координатами (0; 0)). Установка переключа-
теля в положение Specified origin (Указанная исходная точка) позволяет задать начальную
точку самостоятельно. После нажатия кнопки Click to set new origin (Щелкните, чтобы
задать новую исходную точку) становится активным поле чертежа, где можно щелчком ука-
зать исходную точку шаблона штриховки. Установив флажок Default to boundary extents
(По умолчанию до контура), можно активизировать раскрывающийся список, в котором
выбирают расположение исходной точки относительно контура заштриховываемого объ-
екта: вверху, внизу, слева, справа или по центру. Положение точки демонстрируется с помо-
щью голубого крестика на небольшом рисунке справа.

Пример того, как будет выглядеть штриховка AR-BRSTD в зависимости от положения
исходной точки, показан на рис. 7.3.
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Рис. 7.3. Штриховка при различных положениях исходной точки
Установка флажка Store as default origin (Исходная точка по умолчанию) позволяет

сохранить измененные параметры в качестве настроек по умолчанию, так что они будут
применяться ко всем создаваемым штриховкам.
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Выбор градиента

 
При заполнении градиентом область закрашивается плавно изменяющимся цветом.

Градиент позволяет создавать на двухмерном чертеже эффект падающего на поверхность
света, тем самым имитируя трехмерность объекта (рис. 7.4).

 

Рис. 7.4. Градиентная заливка создает иллюзию освещенного трехмерного объекта
Параметры градиентной заливки устанавливают на вкладке Gradient (Градиент) диа-

логового окна Hatch and Gradient (Штриховка и градиент) (рис. 7.5). Чтобы вызвать это
диалоговое окно с открытой вкладкой Gradient (Градиент), следует щелкнуть на кнопке
Gradient (Градиент) на вкладке Home (Основная) в группе Draw (Черчение) ленты или на
панели инструментов Draw (Черчение), запустив тем самым команду GRADIENT.
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Рис. 7.5. Вкладка Gradient (Градиент) окна Hatch and Gradient (Штриховка и градиент)
Чтобы выбрать цвет градиентной заливки, необходимо щелкнуть на кнопке с много-

точием. Откроется диалоговое окно Select Color (Выбор цвета), в котором можно указать
необходимый цвет градиентной заливки.

По умолчанию переключатель в окне Hatch and Gradient (Штриховка и градиент)
установлен в положение One color (Один цвет), что позволяет закрашивать область одним
цветом, плавно переходящим либо в светлое (ползунок Shade/ Tint (Темнее/Светлее) уста-
новлен в крайнее правое положение), либо в темное (ползунок установлен в крайнее левое
положение) пятно. Перемещением ползунка Shade/Tint (Темнее/Светлее) в центр можно
добиться равномерного закрашивания области одним цветом.

Чтобы определить двухцветный градиент, установите переключатель в положение Two
color (Два цвета). Область Color (Цвет) приобретет несколько иной вид – появится допол-
нительное поле для выбора второго цвета.
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При установленном флажке Centered (По центру) градиент располагается симме-
трично. При снятии этого флажка градиентная заливка смещается влево и вверх. Как и в слу-
чае со штриховкой, в раскрывающемся списке Angle (Угол) задается угол наклона заливки.

Рассмотрим более подробно, как определить параметры сине-желтой градиентной
заливки.

1. Откройте вкладку Gradient (Градиент) диалогового окна Hatch and Gradient
(Штриховка и градиент).

2. Установите переключатель в положение Two color (Два цвета). По умолчанию в
списке Color 1 (Цвет 1) выбран синий цвет, а в списке Color 2 (Цвет 2) – желтый. Оставьте
эти настройки без изменений.

3. Щелкнув на одном из девяти квадратов, выберите образец градиентной заливки.
Например, выберите первый квадрат слева во втором ряду, если в дальнейшем вы собирае-
тесь придать «объем» окружности.

4. Снимите флажок Centered (По центру), чтобы придать эффект света, падающего
слева сверху. При необходимости измените значение в поле Angle (Угол).
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Определение границ штриховки и градиента

 
После того как вы определились с видом штриховки, необходимо указать границы

заштриховываемой области. Выбрать такую область можно двумя методами:
• указать любую точку, принадлежащую заштриховываемой области;
• задать контур, предназначенный для штриховки, путем выбора составляющих его

объектов.
Нередко штриховку требуется нанести на область чертежа достаточно простой кон-

фигурации: например, необходимо полностью заштриховать прямоугольник, представля-
ющий собой один объект. В этом случае нет принципиальных отличий, каким способом
задавать заштриховываемую область: указанием точки внутри области или же заданием
контура. Однако внутри заштриховываемого объекта могут находиться замкнутые обла-
сти (островки), которые штриховать не требуется. Тогда определение границ штриховки
несколько усложняется.

 
Указание внутренней точки

 
Чтобы определить контур указанием внутренней точки, нужно щелкнуть в окне Hatch

and Gradient (Штриховка и градиент) на кнопке Add: Pick points (Добавить: указание
точек), после чего диалоговое окно скроется и вам необходимо будет указать точку, принад-
лежащую заштриховываемой области. Особенность этого метода определения границ штри-
ховки состоит в том, что после указания внутренней точки программа автоматически опре-
деляет и выделяет контур штриховки.

При использовании данного метода контур штриховки обязательно должен быть
замкнутым и полностью отображаться на экране, иначе при попытке заштриховать неза-
мкнутую область появится сообщение об ошибке (рис. 7.6). При этом программа пытается
показать место, где возникает проблема. Конечные точки в этом месте обводятся красными
окружностями.

 

Рис. 7.6. Программа не может определить границы штриховки
Следует отметить, что обойти данное ограничение можно, указав допустимый зазор

в области Gap tolerance (Допустимый зазор) (чтобы получить доступ к этому параметру,
щелкните на кнопке More Options (Дополнительные параметры)

 

расположенной в правом нижнем углу окна Hatch and Gradient (Штриховка и гради-
ент)).
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После щелчка на кнопке Add: Pick points (Добавить: указание точек) диалоговое окно
исчезнет с экрана и программа выдаст следующий запрос:

Pick internal point or [Select objects/remove Boundaries]: Selecting everything…
Selecting everything visible…
Analyzing the selected data…
Analyzing internal islands…
Выберите области, которые необходимо заштриховать. Отменить выделение послед-

ней выбранной области можно вводом команды U с клавиатуры. Чтобы завершить выбор
областей, предназначенных для нанесения штриховки, нажмите клавишу Enter, после чего
вы вернетесь в диалоговое окно Hatch and Gradient (Штриховка и градиент).

Когда область штриховки задается указанием внутренней точки, отдельно определять
островки нет необходимости, так как в этом случае программа находит все внутренние
области автоматически. Если же необходимо проигнорировать какие-либо островки, то есть
заштриховать их принудительно, можно исключить эти области вручную с помощью кнопки
Remove boundaries (Удаление контуров), которая становится активной после указания вну-
тренней точки заштриховываемой области.

 
Определение контуров объектов

 
Еще один метод позволяет определить границы штриховки, выбирая объекты вручную.

Для этого необходимо щелкнуть на кнопке Add: Select objects (Добавить: выбор объектов).
Диалоговое окно свернется, и в командной строке появится запрос:

Select objects or [picK internal point/remove Boundaries]:
Программа предоставляет возможность указать объекты, составляющие контур. После

того как вы выберете следующий объект, нажмите клавишу Enter, чтобы вернуться в диа-
логовое окно.

Несложно заметить, что в этом случае контур не создается программой автоматически,
а указывается пользователем. Поэтому применять этот метод целесообразнее, если граница
состоит из отдельного объекта. Кроме того, нужно следить за тем, чтобы контур был замкну-
тым и образующие его объекты не пересекались, иначе программа может некорректно опре-
делить границы штриховки (рис. 7.7).

 

Рис. 7.7. Некорректное определение границ штриховки
В случае определения границ штриховки путем указания внешнего контура все содер-

жащиеся внутри этого контура островки также заштриховываются. Если же необходимо
отказаться от штриховки каких-либо областей, то помимо внешнего контура следует указы-
вать и эти внутренние области. Тогда вид полученной штриховки будет зависеть от настроек
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в области Islands (Островки) диалогового окна Hatch and Gradient (Штриховка и градиент).
Чтобы получить доступ к этим параметрам, щелкните на кнопке More Options (Дополни-
тельные параметры)

 

расположенной в правом нижнем углу.
 

Правка границ
 

Кроме двух кнопок, с помощью которых можно определить границы штриховки, в
области Boundaries (Контуры) присутствует еще несколько параметров, позволяющих изме-
нять контуры штриховки.

Кнопка Remove boundaries (Удаление контуров) позволяет принудительно удалять
островки. При определении границ путем указания внутренней точки островки, так же как и
внешний контур, обнаруживаются автоматически, и впоследствии решение о том, заштри-
ховывать эти внутренние области или нет, программа принимает на основании настроек в
области Islands (Островки). Если же необходимо заштриховать какие-либо островки при-
нудительно, то есть независимо от указанных настроек, то следует нажать кнопку Remove
boundaries (Удаление контуров) и выделить эти островки вручную. Если таким способом
выбрать все области, находящиеся внутри заштриховываемого контура, то результат штри-
ховки будет таким же, как если бы переключатель в области Islands (Островки) был устано-
влен в положение Ignore (Игнорировать) – будет заштрихована вся внешняя область.

Кнопка Recreate boundary (Восстановить контур) восстанавливает контур вокруг
штриховки, то есть создает и ассоциирует с выбранной штриховкой полилинию или область.

После щелчка на кнопке View Selections (Просмотр выделенного) диалоговое окно
Hatch and Gradient (Штриховка и градиент) исчезает с экрана, что позволяет просмотреть
выделенные на чертеже контуры штриховки. Эта кнопка недоступна, если на рисунке не
выбран ни один контур.

Кроме рассмотренных, в диалоговом окне Hatch and Gradient (Штриховка и градиент)
находятся следующие параметры.

• Установите флажок Annotative (Аннотационный) в области Options (Параметры),
чтобы штриховка была аннотационной. Впоследствии вы сможете регулировать вид такой
штриховки с помощью масштаба аннотации. Если захотите больше узнать о свойстве анно-
тации, щелкните на кнопке

 

• Как уже отмечалось, в AutoCAD по умолчанию создается ассоциативная штриховка,
которая привязывается к тем объектам, к которым она была применена, что в большинстве
случаев очень удобно. Если же необходимо создать не ассоциативную штриховку, следует
снять флажок Associative (Ассоциативный). Если установить флажок Annotative (Аннота-
ционный), то отключить свойство ассоциативности вы уже не сможете.

• Установка флажка Create separate hatches (Создание раздельных штриховок) озна-
чает, что штриховка каждой несвязанной области будет представлять собой отдельный объ-
ект. Редактировать штриховку таких областей можно по отдельности.

• Раскрывающийся список Draw order (Порядок черчения) позволяет выбрать способ
вывода штриховки: на заднем плане, на переднем плане, позади границ, впереди границ или
в неопределенном порядке. По умолчанию штриховка размещается позади границ, то есть
при щелчке на контуре штриховки выделяется именно контур, а не штриховка.
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• Полезной функцией является копирование настроек шаблона штриховки. После
щелчка на кнопке Inherit Properties (Копирование свойств) диалоговое окно временно исче-
зает с экрана, а указатель мыши приобретает вид кисточки. Чтобы скопировать тип, угол
наклона, масштаб и шаг понравившегося шаблона штриховки, щелкните на нем кнопкой
мыши. После этого вновь появится окно Hatch and Gradient (Штриховка и градиент) с
заданными параметрами выбранной штриховки.

Перед тем как окончательно заштриховать какой-либо объект, иногда полезно узнать,
как будет выглядеть штриховка на чертеже. Для этого выполните следующие действия.

1. Щелкните на кнопке Preview (Просмотр), расположенной в левом нижнем углу диа-
логового окна Hatch and Gradient (Штриховка и градиент). Программа отобразит область
чертежа с нанесенной, но еще не зафиксированной штриховкой.

2. Если полученные результаты вас устраивают, щелкните правой кнопкой мыши,
чтобы окончательно нанести штриховку, или нажмите клавишу Esc, если необходимо изме-
нить какие-либо настройки. На экране вновь появится диалоговое окно Hatch and Gradient
(Штриховка и градиент).

3. После внесения необходимых изменений нажмите кнопку OK, чтобы заштриховать
объект, или кнопку Cancel (Отмена), чтобы отказаться от размещения штриховки и закрыть
диалоговое окно.

 
Дополнительные параметры

 
Чтобы получить доступ к дополнительным настройкам, необходимо щелкнуть на

кнопке More Options (Дополнительные параметры)
 

расположенной в правом нижнем углу окна Hatch and Gradient (Штриховка и гради-
ент) (рис. 7.8).
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Рис. 7.8. Дополнительные параметры штриховки и градиента
Как уже говорилось, островками называются замкнутые области, находящиеся внутри

заштриховываемого контура. В области Islands (Островки) можно определить, каким обра-
зом будут заштриховываться эти внутренние объекты. Состояние флажка Island detection
(Обнаружение островков) определяет, будет ли вообще программа искать островки. Если
этот флажок установлен, с помощью переключателя Island display style (Тип обнаружения
островков) можно определить вид заштрихованного изображения:

• Normal (Обычный) – в этом случае внутренние области заштриховываются через
одну: внешняя область заштриховывается, следующая за ней внутренняя область – нет, сле-
дующая область заполняется штриховкой и т. д.;

• Outer (Внешний) – заштриховывается только внешняя область, а все внутренние
островки остаются незаштрихованными;

• Ignore (Игнорировать) – наличие внутренних островков игнорируется, заштриховы-
вается вся выделенная область, независимо от того, как выделяются объекты.

Совет
Текст, находящийся внутри заштриховываемой области, также

является островком, поэтому, если вам нужно, чтобы линии штриховки
«обходили» текст, его следует создавать до нанесения штриховки.
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При определении контура путем указания внутренней точки вокруг штриховки авто-
матически создается замкнутый контур в виде полилинии, который впоследствии удаляется.
Если установить флажок Retain boundaries (Сохранение контуров), то этот контур будет
сохранен, то есть, кроме самой штриховки, на чертеже появится еще и ее контур. В раскры-
вающемся списке Object type (Тип объекта) выбирают вид создаваемого для контура объ-
екта – полилиния или область.

По умолчанию при использовании кнопки Add: Pick points (Добавить: указание точек)
для определения границ штриховки программа анализирует все объекты, находящиеся на
текущем видовом экране, чтобы обозначить границы штриховки. На больших чертежах это
может занять много времени, но у вас есть возможность создать новый набор объектов,
который будет анализироваться при обнаружении контуров. Для этого необходимо нажать
кнопку New (Новый), расположенную в области Boundary set (Установка границы). При
этом диалоговое окно временно исчезнет с экрана и у вас появится возможность выбрать
объекты, которые необходимо включить в новый набор контуров.

Изменение настроек в области Gap tolerance (Допустимый зазор) позволяет заштрихо-
вать незамкнутые области. По умолчанию параметру Tolerance (Зазор) присвоено значение
0 – в этом случае заштриховать можно только замкнутый контур. Однако это значение можно
изменять в пределах от 0 до 50 0 0 в единицах чертежа, что задает максимальную величину
зазора между объектами, при которой контур будет считаться замкнутым. Ввод значения в
поле Tolerance (Зазор) эквивалентен такому же изменению переменной HPGAPTOL.

В области Inherit options (Наследовать параметры) можно определить, что следует
использовать при копировании свойств штриховки: текущую исходную точку или исходную
точку штриховки.

Разобравшись с параметрами штриховки, присутствующими в окне Hatch and
Gradient (Штриховка и градиент), приступим к практическим действиям по созданию штри-
ховки.

1. Откройте файл 0 7_01.dwg, имеющийся на компакт-диске, прилагаемом к книге, и
сохраните его в своей рабочей папке.

2. Нажмите кнопку Hatch (Штриховка) на вкладке Home (Основная) в группе Draw
(Черчение) ленты или на панели инструментов Draw (Черчение), вызвав тем самым команду
BHATCH. Можно также выполнить команду меню Draw → Hatch (Черчение → Штриховка).
На экране появится диалоговое окно Hatch and Gradient (Штриховка и градиент).

3. Щелкните на кнопке с тремя точками возле поля Pattern (Шаблон). Откроется окно
Hatch Pattern Palette (Палитра шаблонов штриховки).

4. Перейдите на вкладку ANSI и выберите шаблон штриховки ANSI31. Нажмите
кнопку OK, чтобы вернуться в предыдущее окно.

5. В раскрывающемся списке Scale (Масштаб) выберите значение 2. Щелкните на
кнопке More Options (Дополнительные параметры), чтобы получить доступ к дополнитель-
ным настройкам. Установите переключатель Island display style (Тип обнаружения остров-
ков) в положение Normal (Обычный).

6. Нажмите кнопку Add: Pick points (Добавить: указание точек): временно активизи-
руется графическая область. Щелкните кнопкой мыши внутри левой части детали, а затем
нажмите клавишу Enter, чтобы завершить выделение области.

7. В диалоговом окне Hatch and Gradient (Штриховка и градиент) нажмите кнопку
Preview (Просмотр), чтобы увидеть, как будет выглядеть штриховка: две внутренние окруж-
ности должны быть незакрашены. Затем нажмите клавишу Esc, чтобы вернуться в диалого-
вое окно, и в случае необходимости измените настройки штриховки.

8. Примените штриховку, щелкнув на кнопке OK (рис. 7.9).
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Рис. 7.9. Результат нанесения штриховки
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Перетаскивание штриховки

 
Нанести штриховку на чертеж можно и другим способом – перетаскиванием готового

шаблона штриховки в замкнутую область на чертеже. Перетащить штриховку можно с пали-
тры Tool Palettes (Инструментальные палитры) либо DesignCenter (Центр управления).

С помощью палитры DesignCenter (Центр управления) можно открыть любой файл
PAT, содержащий шаблон штриховки, выполнить предварительный просмотр и перетащить
нужный шаблон на чертеж, то есть нанести штриховку. Центр управления следует исполь-
зовать, когда у вас есть шаблоны штриховки, хранящиеся в собственных файлах PAT. Рас-
смотрим более подробно, как заштриховать объект таким способом.

Чтобы вызвать палитру DesignCenter (Центр управления) (рис. 7.10), щелкните кноп-
кой мыши на одноименной кнопке

 

на панели инструментов Standard (Стандартная) или нажмите сочетание клавиш Ctrl
+2.

 

Рис. 7.10. Палитра DesignCenter (Центр управления) с шаблонами штриховки
На вкладке Folders (Папки) укажите расположение файла, содержащего нужный

шаблон штриховки, то есть файла с расширением PAT. В правой части окна появятся мини-
атюрные изображения всех шаблонов штриховки, находящихся в выбранном файле.

Примечание
Узнать точное расположение файлов acad.pat и acadiso.pat можно

в нижней части палитры DesignCenter (Центр управления), где
указывается абсолютный путь к выделенному файлу.

Перетащите штриховку из правой части палитры DesignCenter (Центр управления) в
замкнутую область на чертеже.

Однако еще проще наносить штриховку и градиентную заливку, воспользовавшись
палитрой Tool Palettes (Инструментальные палитры) (рис. 7.11), на которой уже присут-
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ствуют готовые шаблоны. Чтобы ее вызвать, нажмите кнопку Tool Palettes Window (Окно
инструментальных палитр)

 

на панели инструментов Standard (Стандартная) или нажмите сочетание клавиш Ctrl
+3.
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Рис. 7.11. Вкладка Hatches and Fills (Штриховки и заливки) инструментальной палитры
Перейдите на вкладку Hatches and Fills (Штриховки и заливки) и перетащите понра-

вившийся шаблон штриховки или градиента в замкнутый объект на чертеже.



А.  А.  Орлов.  «AutoCAD 2010»

249

Если вы собираетесь часто использовать какой-либо шаблон штриховки, отсутствую-
щий на инструментальной палитре, перетащите его сюда с палитры DesignCenter (Центр
управления).

Конечно, во многих случаях использование центра управления и инструментальной
палитры значительно экономит время при нанесении штриховки. Однако таким образом
можно изменить меньшее количество настроек, чем при использовании диалогового окна
Hatch and Gradient (Штриховка и градиент). Доступ к настройкам можно получить с помо-
щью панели Quick Properties (Краткие свойства) (рис. 7.12), которая должна появиться
сразу после выделения штриховки на чертеже. Если этого не произошло, то, выделив штри-
ховку, щелкните правой кнопкой мыши и выберите пункт Quick Properties (Краткие свой-
ства).

 

Рис. 7.12. Панель Quick Properties (Краткие свойства) с настройками штриховки
Если предоставляемых свойств окажется недостаточно, то после выделения штри-

ховки, выбрав в контекстном меню пункт Properties (Свойства), вы откроете палитру, содер-
жащую большее количество настроек (рис. 7.13).
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Рис. 7.13. Палитра Properties (Свойства) с настройками штриховки
В принципе, способ нанесения штриховки существенной роли не играет, так как в

дальнейшем созданную штриховку можно легко отредактировать.
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Редактирование штриховки и градиента

 
Чтобы приступить к редактированию штриховки, выполните команду меню Modify →

Object → Hatch (Редактирование → Объект → Штриховка), запустив тем самым команду
HATCHEDIT. После появления запроса Select hatch object: выберите штриховку для редак-
тирования, щелкнув на одной из ее линий. Откроется диалоговое окно Hatch Edit (Редак-
тирование штриховки) (рис. 7.14). Его можно также вызвать, дважды щелкнув на рисунке
штриховки либо выбрав пункт Hatch Edit (Редактирование штриховки) в контекстном меню
штриховки.

 

Рис. 7.14. Диалоговое окно Hatch Edit (Редактирование штриховки)
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Диалоговое окно Hatch Edit (Редактирование штриховки) отличается от окна Hatch
and Gradient (Штриховка и градиент) только несколькими параметрами. Поэтому, если вы
научились наносить штриховку, то ее редактирование не составит труда.

В окне Hatch Edit (Редактирование штриховки) можно изменять любые настройки
штриховки: масштаб, угол наклона линий, рисунок и пр., то есть все параметры, которые
задавались при ее создании.

Кроме того, можно изменять контуры штриховки, и вследствие своей ассоциативно-
сти она будет принимать новые очертания. Однако при удалении и подрезании контура или,
например, перемещении штриховки отдельно от контура штриховка теряет свою ассоциа-
тивность. И об этом не следует забывать.

Однако существует способ, при котором штриховку можно редактировать вместе с
контуром. По умолчанию программа настроена так, что при выделении штриховки контур
заштрихованного объекта не выделяется и наоборот – при выделении контура выделяется
только он, но не штриховка. Однако можно сделать так, что штриховка и ее граница будут
рассматриваться как единый объект.

Щелкните правой кнопкой мыши на свободном месте чертежа и выберите в контекст-
ном меню пункт Options (Параметры). В открывшемся диалоговом окне Options (Параме-
тры) перейдите на вкладку Selection (Выделение) и установите флажок Associative Hatch
(Ассоциативная штриховка).

После этого штриховку и границу можно будет редактировать одновременно. Однако
помните, что теперь при удалении, например, штриховки контур также исчезнет с чертежа,
так как эти два объекта всегда будут выделяться вместе. Установка флажка Associative Hatch
(Ассоциативная штриховка) присваивает переменной PICKSTYLE значение 2.

Кроме того, штриховку можно подрезать. В качестве режущей грани может выступать
любой объект, пересекающий штриховку. После подрезания штриховка остается ассоциа-
тивным объектом.

Чтобы изменить настройки градиента, в диалоговом окне Hatch Edit (Редактирование
штриховки) перейдите на вкладку Gradient (Градиент) и измените параметры по своему
усмотрению. Как и в случае со штриховкой, в изменении настроек градиента нет ничего
сложного – такие же параметры задаются и при его создании.
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Резюме

 
Создание штриховки в AutoCAD максимально упрощено. Фактически все, что требу-

ется от пользователя, – указать шаблон штриховки и правильно определить границы заштри-
ховываемой области. При этом присутствует возможность изменения большого количество
параметров для гибкой настройки штриховки. Кроме того, область можно заполнить не
только штриховкой, но и градиентной заливкой. Причем изменить настройки штриховки и
градиентной заливки можно как в процессе их создания, так и путем редактирования суще-
ствующих объектов.
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Глава 8

Работа с листами и печать
 

• Создание и редактирование листов
• Печать
• Резюме
Вы уже научились создавать несложные двухмерные чертежи. Однако в большинстве

случаев работа на этом не заканчивается, так как результаты ваших трудов необходимо под-
готовить к печати и вывести на бумагу. Как это сделать, рассмотрим далее в этой главе.

Работая с программой AutoCAD, вы наверняка уже обратили внимание на то, что внизу
графической области чертежа обычно выбрана вкладка Model (Модель) (рис. 8.1).

 

Рис. 8.1. План здания в пространстве модели
Данная вкладка обеспечивает работу в пространстве модели, где вычерчиваются

и редактируются все объекты чертежа. Рядом с вкладкой Model (Модель) расположены
вкладки Layout (Лист) (по умолчанию их две), активизировав которые мы переключимся
в пространство листа. Пространство листа – это среда, предназначенная для размещения
различных видов конструкции, вычерченной в пространстве модели. Чертеж плана этажа в
пространстве листа показан на рис. 8.2.
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Рис. 8.2. План здания в пространстве листа
Пространство листа используется для размещения на одном чертеже нескольких видов

построенной модели. Работа в пространстве листа аналогична работе конструктора за куль-
маном, так как любая вкладка листа имитирует бумажный лист.

На вкладке пространства модели можно выделить несколько различных элементов. Во-
первых, это сам виртуальный лист бумаги, который имеет белый цвет. Во-вторых, штрихо-
вым контуром изображена граница области печати. Наличие этой области обусловлено тем,
что большинство печатающих устройств не могут печатать вблизи границы листа. Кроме
того, по умолчанию на листе создается один плавающий видовой экран. Повторим, что видо-
вые экраны в пространстве листа необходимы для отображения вида модели.

Как отмечалось ранее, по умолчанию при создании нового чертежа внизу графической
зоны появляются две вкладки пространства листа – Layout1 (Лист 1) и Layout2 (Лист 2).
Однако таких вкладок может быть и меньше, а при желании вы можете также создать новые
листы. При этом для каждого листа задаются индивидуальные настройки: размеры и ориен-
тация, печатающее устройство по умолчанию, конфигурация плавающих видовых экранов
и др.
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Создание и редактирование листов

 
Наиболее просто создать новый лист можно с помощью Layout Wizard (Мастер ком-

поновки). Чтобы его вызвать, выполните одну из команд меню: либо Insert → Layout
→ Create Layout Wizard (Вставка → Лист → Создать мастер компоновки), либо Tools
→ Wizards → Create Layout (Сервис → Мастера → Создание компоновки). Команду
LAYOUTWIZARD можно также активизировать с помощью командной строки. В любом
случае на экране появится первое окно мастера компоновки (рис. 8.3).

 

Рис. 8.3. Первое окно мастера компоновки
В этом окне нужно ввести имя создаваемого листа, которое в дальнейшем будет ото-

бражаться на соответствующей вкладке. Программа предлагает порядковый номер нового
листа – в нашем случае это Layout3 (Лист 3). Чтобы лучше ориентироваться в листах с ком-
поновками, введите в это поле какое-нибудь значащее имя, которое отражало бы суть чер-
тежа, содержащегося на данном листе.

Нажмите кнопку Далее, чтобы открыть следующее окно мастера компоновки
(рис. 8.4). Оно предназначено для выбора печатающего устройства для создаваемого листа
(конфигурирование принтеров и плоттеров рассмотрено далее в этой главе). Выберите нуж-
ное устройство, щелкнув на соответствующей строке. Если выбрать пункт None (Нет), печа-
тающее устройство по умолчанию не будет задано.
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Рис. 8.4. Окно настройки принтера мастера компоновки
Щелкните на кнопке Далее, чтобы запустить следующее окно мастера (рис. 8.5). В

нем выбирается формат бумаги, на которой будет распечатан документ, а также единицы
измерения чертежа.

 

Рис. 8.5. Окно настройки бумаги мастера компоновки
Щелкните на кнопке Далее, чтобы перейти к следующему окну мастера. Здесь можно

выбрать ориентацию чертежа на листе бумаги – Portrait (Книжная) или Landscape (Аль-
бомная).
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В следующем окне (рис. 8.6) выбирают тип основной надписи из списка файлов. В
области Preview (Просмотр) схематично показывается внешний вид выбранного штампа.
Элемент None (Нет) означает отсутствие основной надписи. Штамп основной надписи
можно включить в чертеж в качестве блока, установив переключатель в положение Block
(Блок), или в качестве ссылки, установив переключатель в положение Xref. Лучше выбрать
положение Block (Блок), так как в этом случае основная надпись будет сохранена в чертеже.

 

Рис. 8.6. Окно настройки основной надписи
Совет
Заметим, что в предложенном списке нет штампов,

соответствующих ГОСТ. Поэтому рекомендуем один раз затратить
время на создание нужной основной надписи, чтобы в дальнейшем
просто вставлять ее в свои чертежи. Начертив свой штамп, сохраните
его в файл с расширением DWG в каталоге <Системный_диск>:
\Documents and Settings\<Ваш_профиль>\Application Data\Autodesk\
AutoCAD 2010\R18.0\enu\Template\.

Следующее окно мастера предназначено для определения количества видовых экранов
на листе (рис. 8.7). С помощью переключателя Viewport setup (Установки видового экрана)
можно выбрать один из следующих вариантов компоновки.
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Рис. 8.7. Окно настройки параметров видовых экранов
• None (Нет) – установите переключатель в это положение, если не хотите создавать

видовой экран в пространстве листа. Впоследствии вы сможете определить видовые экраны
вручную.

• Single (Один) – создается один прямоугольный видовой экран.
• Std. 3D Engineering Views (Стандартный трехмерный вид) – создание четырех видо-

вых экранов. Предполагается, что на трех из них будут расположены фронтальная, профиль-
ная и горизонтальная проекции, а четвертый экран необходим для изометрического пред-
ставления модели.

• Array (Массив) – после установки переключателя в это положение становятся
доступными поля в нижней части окна. Здесь можно задать количество строк и столбцов
видовых экранов, а также расстояние между ними.

В следующем окне мастера присутствует всего одна кнопка – Select location (Выбор
позиции). После щелчка на ней окно мастера временно скрывается, и вы возвращаетесь в
пространство листа, где необходимо путем указания противоположных углов определить
размер области, которую займут все видовые экраны. Если не нажимать кнопку Select
location (Выбор позиции), то видовые экраны заполнят всю область печати.

В последнем окне мастера компоновки щелкните на кнопке Готово, чтобы завершить
работу по созданию нового листа.

После окончания работы мастера вы окажетесь в пространстве только что созданного
листа компоновки.

 
Редактирование листа

 
Щелкните правой кнопкой мыши на корешке редактируемой вкладки. Откроется кон-

текстное меню (рис. 8.8).
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Рис. 8.8. Контекстное меню вкладки листа
Данное меню содержит следующие параметры.
• New layout (Новый лист) – создает вкладку нового листа на основе параметров

устройства печати и размера бумаги, выбранных по умолчанию. Новое имя листу присваи-
вается автоматически: например, при создании четвертой вкладки листа это будет Layout4
(Лист 4).

• From template (По шаблону) – позволяет создать новый лист на основе существую-
щего чертежа или шаблона. После выбора этого пункта на экране появляется диалоговое
окно Select Template From File (Выбор шаблона из файла), в котором следует указать рас-
положение файла с расширением DWG или DWT. После нажатия кнопки Open (Открыть)
текущее окно закрывается, а на экране появляется диалоговое окно Insert Layout(s) (Вставка
листа(-ов)), где можно выбрать конкретный лист данного чертежа. В результате выполне-
ния такой операции на новый лист будут перенесены все элементы выбранного листа: блок
штампа, видовые экраны и т. п. Однако объекты вкладки Model (Модель) на новый лист
импортироваться не будут.

• Delete (Удалить) – позволяет удалить выбранный лист. Перед удалением программа
обязательно выведет предупреждающее окно. Лист будет удален после нажатия кнопки OK.

• Rename (Переименовать) – после выбора данного пункта имя листа на его корешке
будет выделено. Чтобы переименовать лист, необходимо ввести новое название и нажать
клавишу Enter.

• Move or Copy (Переместить или скопировать) – выбор этой команды вызывает одно-
именное диалоговое окно, позволяющее создать копию текущего листа или переместить его.
Для перемещения листа укажите в поле Before layout (Перед листом) имя другого листа
компоновки, слева от вкладки которого необходимо поместить текущий лист. Выбрав пункт
move to end (переместить в конец), вы перенесете лист в крайнее правое положение. Уста-
новка флажка Create a copy (Создать копию) создает новую копию выбранного листа, при-
чем в скобках имени этого листа будет отображаться номер сделанной копии.

• Select All Layouts (Выбрать все листы) – выделяет все листы, имеющиеся в чертеже.
После этого с ними можно выполнять групповые операции редактирования, например уда-
ление.
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• Пункты Activate Previous Layout (Активизировать предыдущий лист) и Activate
Model Tab (Активизировать вкладку модели) делают активным предыдущий лист или про-
странство модели соответственно.

• Page Setup Manager (Менеджер параметров страницы) – вызывает одноименное диа-
логовое окно, предназначенное для управления параметрами страницы.

• Plot (Печать) – вызывает диалоговое окно Plot (Печать), в котором производятся
настройки печати.

• Import Layout as Sheet (Импортировать компоновку как лист) – позволяет добавить
созданную компоновку в набор листов.

• Export Layout to Model (Экспортировать лист в модель) – позволяет экспортировать
все видимые объекты с текущего листа в пространство модели нового рисунка.

• Hide Layouts and Model tabs (Скрыть вкладки листов и модели) – скрывает вкладки
пространства листа и модели, что позволяет несколько увеличить графическую область.
Теперь переключаться между изображением модели и ее компоновкой на листе можно с
помощью кнопки Model (Модель)

 

и кнопки с именем листа компоновки
 

находящихся в строке состояния. Щелкнув на кнопке Quick View Layouts (Быстрый
просмотр листов)

 

, можно указать, какой конкретно лист необходимо вывести на экран (рис. 8.9).
 

Рис. 8.9. Быстрый просмотр листов
Щелкнув правой кнопкой мыши на одной из этих кнопок и выбрав пункт Display

Layout and Model Tabs (Отображать вкладки листа и модели), вы вернете вкладки на преж-
ние места.

Совет
Нажимая сочетание клавиш Ctrl+Page Up, можно переключаться

между вкладками листов и вкладкой модели справа налево, а клавиши
Ctrl+Page Down переключают вкладки слева направо.
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Следующим шагом после создания листа является изменение его настроек. Чтобы
вызвать диалоговое окно Page Setup Manager (Менеджер параметров страницы) (рис. 8.10),
выберите пункт Page Setup Manager (Менеджер параметров страницы) в контекстном меню
листа либо выполните команду File → Page Setup Manager (Файл → Менеджер параметров
страницы). Интересно, что для одного листа можно создать несколько наборов параметров.

 

Рис. 8.10. Диалоговое окно Page Setup Manager (Менеджер параметров страницы)
В этом окне отображаются параметры листов, имеющихся в данном чертеже. Устано-

вив флажок Display when creating a new layout (Отображать при создании нового листа),
можно добиться того, что при первом обращении к созданному листу на экране будет авто-
матически появляться диалоговое окно Page Setup Manager (Менеджер параметров стра-
ницы).

Кнопка New (Новый) позволяет создать новый набор параметров. В окне New Page
Setup (Новые параметры страницы), которое появляется после щелчка на данной кнопке,
нужно ввести имя создаваемого набора параметров. Кроме того, из списка, расположенного
ниже, необходимо выбрать имя имеющегося набора параметров, настройки которого наибо-
лее подходят для создаваемого. После щелчка на кнопке OK открывается диалоговое окно
Page Setup (Параметры страницы) (рис. 8.11).
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Рис. 8.11. Диалоговое окно Page Setup (Параметры страницы)
Кроме создания нового набора параметров, вы можете импортировать существующий

из другого чертежа, щелкнув в окне Page Setup Manager (Менеджер параметров страницы)
на кнопке Import (Импортировать). Нажатие кнопки Modify (Изменить) приводит к откры-
тию окна Page Setup (Параметры страницы), в котором можно изменить некоторые параме-
тры текущего листа.

Из списка Name (Имя), находящегося в области Printer/plotter (Принтер/ плоттер)
окна Page Setup (Параметры страницы) выбирается имя печатающего устройства, заданного
по умолчанию.

Раскрывающийся список Paper size (Размер бумаги) предназначен для выбора разме-
ров бумаги, доступных для данного принтера или плоттера. При этом размеры и ориентация
листа демонстрируется на небольшом рисунке рядом.

В области Plot area (Область печати) указывают область печати. По умолчанию в рас-
крывающемся списке стоит значение Layout (Лист), однако можно выбрать также печать по
границам чертежа, печать текущего экрана или печать по заданной рамке.

По умолчанию при печати чертеж максимально смещается в левый верхний угол.
Однако можно задать смещение чертежа по осям X и Y, введя нужные значения в соответ-
ствующие поля. Флажок Center the plot (Центрировать печать) позволяет расположить печа-
таемый объект по центру листа.

Масштаб можно настроить в области Plot scale (Масштаб печати). В частности, из
раскрывающегося списка Scale (Масштаб) выбирают один из масштабных коэффициентов.
В полях, расположенных ниже, можно явно указать коэффициент масштабирования. Уста-
новив флажок Scale linewieghts (Масштабировать толщину линий), можно задать масштаб
представления толщины линий. Так как обычно масштаб указывается индивидуально для
каждого видового экрана, печать из пространства листа обычно выполняется в масштабе 1:1.
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В области Plot style table (Таблица стилей печати) указывают имя файла с таблицей
стилей печати.

Если вы вызвали окно, находясь в пространстве листа, то в области Shaded viewport
options (Параметры раскрашивания видового экрана) будет активен только список Quality
(Качество), в котором указывают качество изображения. Если в этом списке выбрать пункт
Custom (Пользовательский), то станет доступным поле DPI, в котором можно ввести раз-
решение в точках на дюйм.

Рассмотрим параметры, содержащиеся в области Plot options (Параметры печати).
Если установлен флажок Plot object lineweights (Учитывать толщину линий объектов), то
при печати будет учитываться толщина линий чертежа. Если некоторым объектам или слоям
чертежа присвоен стиль печати и установлен флажок Plot with plot styles (Учитывать стили
печати), то эти объекты будут распечатаны с учетом присвоенного им стиля. Флажок Plot
paperspace last (Печатать пространство листа последним) определяет порядок печати объ-
ектов, находящихся в пространстве листа и в пространстве модели. Если установлен фла-
жок Hide paperspace objects (Скрывать объекты листа), то невидимые линии при печати из
пространства листа не будут вычерчиваться.

В области Drawing orientation (Ориентация чертежа) с помощью переключателя
выбирают ориентацию чертежа на листе бумаги: Portrait (Книжная) или Landscape (Аль-
бомная). При установленном флажке Plot upside-down (Печатать вверх ногами) чертеж
будет выводиться на бумагу в перевернутом виде.

Сохраните все настройки, нажав кнопку OK. Программа вернется в диалоговое окно
Page Setup Manager (Менеджер параметров страницы). При необходимости сделайте дан-
ный набор настроек текущим, выделив его и нажав кнопку Set Current (Сделать текущим).
Щелкните на кнопке Close (Закрыть), чтобы вернуться в пространство листа.

 
Видовые экраны в пространстве листа

 
Чтобы просмотреть чертеж в пространстве листа, необходимо создать видовые экраны.

По умолчанию на существующих листах уже присутствует по одному видовому экрану.
Обычно одного видового экрана не хватает для точного представления модели, так как для
этого необходимо показать несколько различных видов конструкции или один и тот же вид,
но с разной детализацией. Например, в технических чертежах трехмерные детали или узлы
обычно изображают в виде трех проекций. Кроме того, на одном листе можно разместить
сразу несколько чертежей, а значит, создать несколько плавающих видовых экранов, распо-
ложив на них различные виды.

Примечание
В AutoCAD существуют два типа видовых экранов:

неперекрывающиеся и перекрывающиеся. Неперекрывающиеся
видовые экраны можно создать только в пространстве модели. В этой
главе речь идет только о перекрывающихся (плавающих) видовых
экранах, которые формируются в пространстве листа.

Плавающие видовые экраны являются реальными объектами, которые поддаются
редактированию.

Совет
Так как обычно нет необходимости в печати границ плавающих

видовых экранов, их следует создавать на отдельном слое. В
последующем отключение данного слоя позволит убрать границы
видовых экранов с листа. Объекты пространства модели при этом
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остаются на месте. Но даже если вы планируете сохранить границы, все
равно создайте отдельный слой для видовых экранов – это предоставит
возможность для группового редактирования плавающих видовых
экранов. Например, можно быстро задать всем границам один цвет,
назначив его данному слою.

Большинство операций по созданию и редактированию плавающих видовых экранов
выполняется с помощью группы Viewports (Видовые экраны), расположенной на вкладке
View (Отображение) ленты, или на панели инструментов Viewports (Видовые экраны)
(рис. 8.12).

 

Рис. 8.12. Панель инструментов Viewports (Видовые экраны)
 

Создание плавающих видовых экранов
 

Чтобы вызвать диалоговое окно Viewports (Видовые экраны) (рис. 8.13), находясь в
пространстве листа, щелкните на кнопке New (Новый) в группе Viewports (Видовые экраны)
на вкладке View (Отображение) ленты или на кнопке Display Viewports Dialog (Отобразить
диалоговое окно видовых экранов) на панели инструментов Viewports (Видовые экраны).
Можно также набрать команду VPORTS. Того же результата можно добиться, выполнив
команду меню View → Viewports → New Viewports (Вид → Видовые экраны → Новые
видовые экраны).
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Рис. 8.13. Диалоговое окно Viewports (Видовые экраны)
Список Standard viewports (Стандартные видовые экраны) позволяет выбрать коли-

чество плавающих видовых экранов и их расположение на листе. При этом в области
Preview (Просмотр) схематично показывается будущее расположение видовых экранов и
имя каждого из них. При выбранном режиме 2D в списке Setup (Режим) в каждом видовом
экране устанавливается вид всей модели. Если задать режим 3D, то в видовых экранах будут
создаваться стандартные виды модели.

В раскрывающемся списке Change view to (Сменить вид на) задают вид в конкретном
видовом экране. Например, при выбранном режиме 3D из этого списка можно выбрать один
из стандартных видов или задать изометрическое отображение модели.

В поле Viewport Spacing (Расстояние) указывают расстояние, на котором будут распо-
ложены видовые экраны друг от друга на листе. Понятно, что это поле становится активным
только при создании двух и более плавающих видовых экранов.

Выполнив все необходимые настройки, нажмите кнопку OK. При этом диалоговое
окно закроется, а в командной строке появится запрос:

Specify first corner or [Fit] <Fit>:
В ответ задайте первую угловую точку с помощью мыши или нажмите клавишу Enter,

чтобы видовые экраны заняли всю печатаемую область листа. Если вы установили первую
точку, то в командной строке появится следующее приглашение:

Specify opposite corner:
Укажите противоположный угол прямоугольной области, в которую будут вписаны все

видовые экраны. Указанный контур будет заполнен плавающими видовыми экранами.
 

Создание плавающего видового экрана сложной формы
 

Вы уже знаете, как создать один или сразу несколько плавающих видовых экранов пря-
моугольной формы. Однако AutoCAD позволяет создать экраны неправильной формы, для
чего необходимо щелкнуть на кнопке Create Polygonal (Создать многоугольный) в группе
Viewports (Видовые экраны) на вкладке View (Отображение) ленты или на кнопке Polygonal
Viewport (Многоугольный видовой экран) на панели инструментов Viewports (Видовые
экраны). Можно также выполнить команду меню View → Viewports → Polygonal Viewport
(Вид → Видовые экраны → Многоугольный видовой экран). В этом случае граница плава-
ющего видового экрана будет создана из прямолинейных и дуговых сегментов.

После запуска команды появится приглашение:
Specify start point:
Задайте первую точку. После этого появится новый запрос:
Specify next point or [Arc/Length/Undo]:
Продолжайте указывать точки или выберите один из предлагаемых параметров:
• при выборе параметра Arc появляется возможность добавлять дуговые сегменты;
• если выбрать параметр Length, то будет вычерчиваться линейный сегмент заданных

длины и направления;
• параметр Undo удаляет последний созданный фрагмент.
Указав последнюю точку, нажмите клавишу Enter, чтобы завершить создание границ

видового экрана. Понятно, что контур видового экрана должен быть замкнутым, поэтому
если последняя указанная точка не будет совпадать с начальной, программа автоматически
проведет линейный сегмент, чтобы получить замкнутый объект.
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Создание плавающего видового экрана из объекта

 
AutoCAD позволяет создавать плавающие видовые экраны из любых замкнутых объ-

ектов. Чтобы преобразовать замкнутую полилинию, эллипс, сплайн, область или круг в
видовой экран, выполните команду меню View → Viewports → Object (Вид → Видовые
экраны → Объект) или щелкните на кнопке Create from Object (Создать из объекта) в
группе Viewports (Видовые экраны) на вкладке View (Отображение) ленты либо на кнопке
Convert Object to Viewport (Преобразовать объект в видовой экран) на панели инструмен-
тов Viewports (Видовые экраны). Появится запрос:

Select object to clip viewport:
Выделите подходящий замкнутый объект. Он тут же будет преобразован в плавающий

видовой экран, в котором появится изображение модели.
 

Редактирование плавающих видовых экранов
 

Созданный плавающий видовой экран можно переместить, изменить его размеры или
удалить, предварительно выделив его.

Как и другие объекты, плавающие видовые экраны можно редактировать с помощью
ручек. Однако наиболее интересной возможностью является переопределение границ видо-
вого экрана с использованием команды VCLIP. Данная команда вызывается щелчком на
кнопке Clip existing viewport (Подрезать существующий видовой экран) на панели инстру-
ментов Viewports (Видовые экраны). При этом появляется возможность изменять форму
плавающего видового экрана в соответствии с новыми границами. Чтобы обрезать видовой
экран, следует либо указать существующий замкнутый контур, либо создать его в процессе
выполнения команды.

Выделите плавающий видовой экран, который собираетесь обрезать, а затем запустите
команду VPCLIP, или сначала запустите команду VPCLIP, а затем, в ответ на запрос:

Select clipping object or [Polygonal/Delete] <Polygonal>:
укажите замкнутый объект, который будет выступать в качестве границы подрезки.
Если в ответ на данное приглашение нажать Enter (то есть выбрать параметр

Polygonal), то появится возможность создать границу подрезки вручную. Как и при созда-
нии видового экрана сложной формы, в данном случае отсекающая граница формируется из
прямолинейных и дуговых сегментов.

Удалить некоторую отсекающую замкнутую область можно с помощью параметра
Delete, который доступен лишь в том случае, если выбранный плавающий видовой экран
является подрезанным.

 
Работа с моделью в видовом экране

 
После создания и правки плавающих видовых экранов в каждом из них будет отобра-

жаться один и тот же вид модели. Однако в каждом видовом экране необходимо настроить
нужный вид. Для этого следует переключиться из пространства листа в видовой экран, что
можно сделать двумя способами.

• Дважды щелкнуть кнопкой мыши на видовом экране, который нужно выбрать.
• Щелкнуть на кнопке PAPER (Бумага), расположенной в строке состояния. При этом

кнопка изменит свое название на MODEL (Модель), а в графической области будет акти-
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визирован один из плавающих видовых экранов. Чтобы переключиться в нужный видовой
экран, щелкните на нем кнопкой мыши.

Совет
Для последовательного переключения между активизированными

видовыми экранами нажимайте сочетание клавиш Ctrl+R.
Граница активизированного видового экрана выделяется толстой линией.
Переключившись в один из плавающих видовых экранов, мы фактически оказываемся

в пространстве модели. Здесь можно редактировать или создавать новые объекты, как будто
находясь на вкладке Model (Модель), и поэтому изменения будут отображаться во всех видо-
вых экранах.

Рассмотрим команды, которые предоставляет контекстное меню видового экрана.
Выделите плавающий видовой экран (его границы отобразятся в виде штриховой линии), а
затем щелкните правой кнопкой мыши, чтобы вызвать контекстное меню (рис. 8.14).
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Рис. 8.14. Контекстное меню видового экрана
Если на листе расположено несколько видовых экранов, то, скорее всего, они имеют

небольшие размеры и работать с моделью в таких маленьких окнах не очень удобно. Однако
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можно временно раздвинуть один плавающий видовой экран на всю графическую зону. Для
этого необходимо выбрать пункт Maximize Viewport (Развернуть видовой экран) в контекст-
ном меню или просто дважды щелкнуть на рамке неактивного видового экрана. Увеличен-
ный видовой экран с красной окантовкой займет всю графическую область. Здесь вы можете
выполнять все действия, что и на вкладке Model (Модель), однако команды масштабирова-
ния и панорамирования не изменят отображения объектов в видовом экране. Чтобы свернуть
экран, вызовите контекстное меню и выберите в нем пункт Minimize Viewport (Свернуть
видовой экран).

Максимизировать видовой экран можно, запустив команду VPMAX, а минимизиро-
вать – VPMIN. Кроме того, в строке состояния присутствует кнопка Maximize Viewport
(Развернуть видовой экран)

 

раздвигающая границы экрана, а свернуть экран можно с помощью кнопки Minimize
Viewport (Свернуть видовой экран)

 

которая появляется на ее месте.
Команда Display Viewport Objects (Отображение объектов на видовых экранах) кон-

текстного меню предоставляет возможность включить или отключить видимость объектов
на видовом экране. Выбрав пункт No (Нет), мы уберем с экрана все объекты, содержащи-
еся в текущем видовом экране. Такая операция может быть полезной, если необходимо зри-
тельно разгрузить пространство листа. Чтобы вернуть объекты на свое место, установите
флажок Yes (Да).

Команда контекстного меню Display Locked (Отображать блокированные) позволяет
фиксировать масштаб видового экрана. По умолчанию масштаб каждого видового экрана
можно изменять отдельно, однако если установить флажок Yes (Да), то при попытке мас-
штабировать изображение в видовом экране будет изменяться масштаб отображения всего
пространства листа.

Чтобы переключиться обратно в пространство листа, дважды щелкните кнопкой мыши
на области, не занятой видовыми экранами, или нажмите кнопку MODEL (Модель), распо-
ложенную в строке состояния.

 
Масштабирование видового экрана

 
Обычно печать из пространства листа происходит в масштабе 1:1. Поэтому, чтобы

добиться правильной компоновки чертежа, необходимо отдельно установить масштабы
каждого видового экрана. Чтобы точно подобрать масштаб чертежа, следует указать мас-
штаб видового экрана по отношению к пространству листа. Данный масштабный коэф-
фициент определяют путем деления единиц пространства листа на единицы пространства
модели. Точно задать масштаб можно с помощью параметра XP команды ZOOM. Напри-
мер, чтобы задать изображению масштаб 1:10, необходимо ввести 1/10XP в ответ на запрос
команды ZOOM.

Указать масштаб конкретного видового экрана можно также с помощью раскрывающе-
гося списка панели инструментов Viewports (Видовые экраны). После установки масштаба
изображения на видовом экране следует заблокировать этот масштабный коэффициент от
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случайных изменений. Для этого необходимо выполнить команду Display Locked → Yes
(Отображать блокированные → Да) в контекстном меню плавающего видового экрана.

 
Управление видимостью объектов внутри видового экрана

 
В каждом видовом экране можно отдельно настроить видимость слоев. Например,

таким образом можно скрыть штриховку или повторяющийся на нескольких видовых экра-
нах текст.

Дважды щелкните в области нужного видового экрана, чтобы сделать его активным.
Нажмите кнопку Layer Properties (Свойства слоя)

 

в группе Layers (Слои) на вкладке Home (Основная) ленты или такую же кнопку на
панели инструментов Layers (Слои). Откроется палитра Layer Properties Manager (Мене-
джер свойств слоя) (рис. 8.15).

 

Рис. 8.15. Палитра Layer Properties Manager (Менеджер свойств слоя), вызываемая в
режиме Layout (Лист)

Обратите внимание на то, что данное окно несколько отличается от аналогичного,
вызываемого из пространства модели (см. рис. 2.27). В частности, появились новые столбцы,
отвечающие за свойства объектов внутри редактируемого видового экрана: VP Freeze (Замо-
роженный в ПВЭ), VP Color (Цвет в ПВЭ), VP Linetype (Тип линии в ПВЭ), VP Lineweight
(Толщина линии в ПВЭ) и VP Plot Style (Стиль печати в ПВЭ). Назначение этих столбцов
не отличается от аналогичных без дополнения VP, с той лишь поправкой, что их изменение
ограничивается редактируемым плавающим видовым экраном.

Например, чтобы сделать все объекты какого-либо слоя невидимыми, щелкните напро-
тив названия этого слоя в столбце VP Freeze (Замороженный в ПВЭ), или, например, чтобы
изменить цвет объектов слоя внутри видового экрана, воспользуйтесь столбцом VP Color
(Цвет в ПВЭ).

Подготовку листа к выводу на печать на этом этапе можно считать завершенной. Рас-
смотрим сам процесс печати.
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Печать

 
Закончив работу по созданию и компоновке чертежа, можно приступить к настройке

печати. Вид распечатанного чертежа будет зависеть от нескольких составляющих: настроек
листа, рассмотренных выше, присоединенной таблицы печати и, конечно же, конфигура-
ции самого печатающего устройства. Поэтому, прежде чем обращаться к выводу чертежа на
печать, рассмотрим работу со стилями печати и конфигурирование печатающих устройств.

 
Стили печати

 
Стиль печати представляет собой свойство объекта, определяющее, как он будет рас-

печатан на бумаге. Стиль печати объединяет набор параметров объекта, таких как цвет, тип и
толщина линии и т. п. В отличие от других свойств, стиль печати может и не использоваться,
и в таком случае программа напечатает объект в соответствии с другими свойствами.

Использование стилей печати позволяет более гибко управлять изображением объек-
тов на экране и бумаге. Например, на мониторе линия изображена одним цветом, а при
использовании стиля печати и выводе чертежа на бумагу цвет линии может быть уже совсем
иным. При этом использование стилей печати не влияет на отображение объектов на мони-
торе.

Стили печати можно объединять в таблицы стилей печати, которые хранятся в спе-
циальных файлах.

 
Цветозависимые и именованные стили печати

 
В AutoCAD используются две разновидности стилей печати.
• Цветозависимые стили печати унаследованы из предыдущих версий программы. При

их использовании внешний вид объекта зависит от его цвета, то есть с каждым определен-
ным цветом связаны конкретные настройки. Существенным недостатком такого способа
является то, что объекты одного цвета на бумаге будут выглядеть одинаково. Например, вы
не сможете сделать так, чтобы все объекты одного цвета имели различный тип линий. Цве-
тозависимые таблицы стилей печати хранятся в файлах с расширением CTB.

• При использовании именованных стилей печати вид объекта на бумаге не зависит
от его цвета. Каждому объекту может быть присвоен произвольный стиль печати. Таблицы
именованных стилей печати хранятся в файлах с расширением STB.

Одновременно в программе может использоваться только один тип таблицы стилей
печати – либо цветозивисимый, либо именованный. Тип стиля печати можно выбрать на
вкладке Plot and Publish (Печать и публикация) диалогового окна Options (Параметры)
(рис. 8.16), которое можно вызвать, выбрав в контекстном меню программы пункт Options
(Параметры).

 



А.  А.  Орлов.  «AutoCAD 2010»

273

Рис. 8.16. Вкладка Plot and Publish (Печать и публикация) диалогового окна Options
(Параметры)

Щелчок на кнопке Plot Style Table Settings (Настройки таблицы стилей печати) при-
водит к открытию одноименного диалогового окна (рис. 8.17).
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Рис. 8.17. Диалоговое окно настройки стилей печати
В этом окне переключатель по умолчанию установлен в положение Use color

dependent plot styles (Использовать цветозависимые стили печати). При этом в области
Current plot style table settings (Текущие настройки таблицы стилей печати) доступен
только один раскрывающийся список – Default plot style table (Таблица стилей печати,
заданная по умолчанию), в котором можно указать файл с цветозависимой таблицей стилей
печати, используемой по умолчанию.

После установки переключателя Default plot style behavior for new drawings (Стили
печати, заданные по умолчанию для новых чертежей) в положение Use named plot styles
(Использовать именованные стили печати) станут доступными остальные раскрывающиеся
списки. В данном случае в списке Default plot style table (Таблица стилей печати, задан-
ная по умолчанию) присутствуют только файлы с расширением STB, из которых можно
выбрать таблицу именованных стилей печати, используемую по умолчанию. В раскрываю-
щемся списке Default plot style for layer 0 (Стиль печати по умолчанию для слоя 0) ука-
зывают стиль для слоя 0 в новых чертежах. По умолчанию присутствует только значение
Normal (Обычный). Стиль печати, присваиваемый по умолчанию создаваемым объектам,
выбирают из списка Default plot style for objects (Стиль печати, заданный по умолчанию для
объектов), который содержит значения ByLayer (По слою), ByBlock (По блоку) и Normal
(Обычный).

Заметим, что параметры, измененные в окне Plot Style Table Settings (Настройки
таблицы стилей печати), будут применяться только к новым чертежам или к открываемым
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документам, созданным в программе 14-й и более ранних версий, то есть на текущий чертеж
эти параметры не окажут никакого воздействия. Поэтому выбирать тип стиля печати необ-
ходимо перед созданием нового чертежа.

 
Создание таблицы стилей печати

 
В AutoCAD изначально присутствует некоторый набор как цветозависимых, так и име-

нованных стилей печати. Однако при желании вы можете создать собственную таблицу сти-
лей, причем каждая созданная таблица стилей печати будет являться отдельным файлом.
Новый набор стилей печати создают с помощью мастера Add Plot Style Table (Добавить
таблицу стилей печати), который можно вызвать с помощью команды меню Tools → Wizards
→ Add Plot Style Table (Сервис → Мастера → Добавить таблицу стилей печати) либо File →
Plot Style Manager (Файл → Менеджер стилей печати) и дважды щелкнув в открывшемся
окне на значке Add-A-Plot Style Table Wizard (Мастер добавления таблицы стилей печати).

Создадим с помощью данного мастера новую таблицу стилей печати.
1. Из первого окна мастера можно почерпнуть информацию о его назначении и о табли-

цах стилей печати в целом. Щелкните на кнопке Далее, чтобы начать работу. Откроется
окно, в котором необходимо выбрать способ создания новой таблицы (рис. 8.18).

 

Рис. 8.18. Первое окно мастера добавления таблицы стилей печати
2. Установите переключатель в положение Start from scratch (С самого начала), чтобы

создать таблицу стилей печати с чистого листа. Положение переключателя Use an existing
plot style table (Использовать уже существующую таблицу стилей печати) позволяет вос-
пользоваться существующей таблицей для создания новой. Можно также установить пере-
ключатель в положение Use My R14 Plotter Configuration (CFG) (Использовать CFG-файл
конфигурации AutoCAD) или Use a PCP or PC2 file (Использовать импортируемые параме-
тры перьев из PCP– или PCP2-файла). Перейдите к следующему окну (рис. 8.19), щелкнув
на кнопке Далее.
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Рис. 8.19. Окно выбора способа создания новой таблицы
3. Установите переключатель в положение Color-Dependent Plot Style Table (Цвето-

зависимая таблица стилей печати), чтобы создать цветозависимую таблицу. Выбрав вариант
Named Plot Style Table (Именованная таблица стилей печати), вы создадите именованную
таблицу стилей. Перейдите к следующему окну мастера (рис. 8.20).

 

Рис. 8.20. Окно определения имени файла
4. Введите имя создаваемой таблицы стилей в поле File name (Имя файла) и запустите

последнее окно (рис. 8.21), щелкнув на кнопке Далее.
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Рис. 8.21. Заключительное окно мастера
5. В последнем окне находится только один флажок Use this plot style table for new and

pre-AutoCAD 2010 drawings (Использовать эту таблицу стилей печати для новых черте-
жей и чертежей версий ранее AutoCAD 2010), после установки которого создаваемый стиль
печати будет по умолчанию подключаться ко всем новым чертежам. Щелкнув на кнопке Plot
Style Table Editor (Редактор таблиц стилей печати), вы вызовете одноименное окно, позво-
ляющее отредактировать еще не созданную таблицу стилей.

6. Завершите работу мастера нажатием кнопки Готово.
 

Редактирование таблицы стилей печати
 

Редактирование таблицы стилей печати заключается в добавлении или удалении сти-
лей, в их переименовании или изменении параметров (цвет, тип, толщина и т. п.). Для
редактирования таблицы предназначено диалоговое окно Plot Style Table Editor (Редактор
таблиц стилей печати), которое вызывают щелчком на одноименной кнопке в последнем
окне мастера Add Plot Style Table (Добавить таблицу стилей печати) или на кнопке Edit
(Правка)

 

в окне Page Setup (Параметры страницы). Это же окно можно запустить, дважды щелк-
нув на названии нужного стиля в окне Plot Styles (Стили печати).

В диалоговом окне Plot Style Table Editor (Редактор таблиц стилей печати) для редак-
тирования стилей печати предназначены две вкладки: Table View (Таблица) и Form View
(Карточка). Обе вкладки предоставляют одни и те же параметры для редактирования, но
в разной форме. Вид окна будет различаться лишь для разных стилей печати. Как выгля-
дит вкладка Table View (Таблица) при редактировании именованной таблицы стилей печати
acad.stb, показано на рис. 8.22.
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Рис. 8.22. Вкладка Table View (Таблица) диалогового окна Plot Style Table Editor (Редак-
тор таблиц стилей печати)

Нетрудно заметить, что данная таблица содержит два стиля печати: Normal (Обычный)
и Style 1 (Стиль 1). Стиль Normal (Обычный) присутствует во всех именованных таблицах
стилей и не поддается редактированию. Следует отметить, что стиль печати Style 1 (Стиль
1) появится, только когда вы нажмете кнопку Add Style (Добавить стиль). Каждое следу-
ющее нажатие этой кнопки создает новые стили (следующим будет Style 2 (Стиль 2)) с
параметрами по умолчанию. Чтобы изменить какой-либо параметр стиля, щелкните на соот-
ветствующей строке, а затем выберите нужное значение в раскрывающемся списке. Чтобы
удалить лишний стиль печати, выделите соответствующий столбец и щелкните на кнопке
Delete Style (Удалить стиль).

Просмотр стилей в табличном виде удобен тем, что можно легко сравнить одноимен-
ные параметры различных стилей. Однако если вы редактируете один стиль, то вам, воз-
можно, больше понравится работать на вкладке Form View (Карточка). Вид данной вкладки
при редактировании цветозависимой таблицы стилей печати acad.ctb показан на рис. 8.23.
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Рис. 8.23. Вкладка Form View (Карточка) диалогового окна Plot Style Table Editor
(Редактор таблиц стилей печати)

Как видите, почти все параметры, присутствующие на предыдущей вкладке, есть и
здесь, только в несколько ином виде. В поле Plot styles (Стили печати) перечислены все
цветозависимые стили (всего их 255 – по количеству цветов). Обратите внимание на то,
что кнопки Add Style (Добавить стиль) и Delete Style (Удалить стиль) неактивны, так как
цветозависимые таблицы не поддерживают создание и удаление стилей печати. Кроме того,
отсутствует возможность переименования стиля.

После изменения необходимых параметров щелкните на кнопке Save As (Сохра-
нить как), чтобы сохранить таблицу стилей под новым именем. Если вы хотите сохранить
настройки в текущем файле, нажмите кнопку Save & Close (Сохранить и закрыть).
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Подключение таблицы стилей печати к чертежу

 
Завершающим этапом использования таблицы стилей печати является ее подключение

к чертежу. Точнее, таблицу стилей можно назначить пространству моделей или любому про-
странству листа.

1. Откройте чертеж и перейдите на нужную вкладку графической области.
2. Щелкните правой кнопкой мыши на корешке вкладки и в открывшемся контекстном

меню выберите пункт Page Setup Manager (Менеджер параметров страницы). В появив-
шемся окне щелкните на кнопке Modify (Изменить). Откроется окно Page Setup (Параме-
тры страницы).

3. В раскрывающемся списке Plot style table (pen assignments) (Таблица стилей печати
(присвоение перьев)) выберите таблицу стилей печати. Если вы выбрали вкладку Model
(Модель), то на вопрос Assign this plot style table to all layouts? (Применить указанную
таблицу стилей печати ко всем листам?) ответьте Да или Нет нажатием соответствую-
щей кнопки. Если же вы находитесь в пространстве листа, то установите флажок Display
plot styles (Показать стили печати), чтобы просмотреть стили печати, не выводя чертеж на
бумагу.

 
Присоединение стиля печати к слою или объекту

 
Присоединить стиль печати к слою или объекту можно, только если применяется име-

нованная таблица стилей печати. В случае же использования цветозависимой таблицы сти-
лей невозможно самостоятельно назначить какому-либо объекту или слою стиль печати, так
как при этом стили печати присваиваются автоматически в зависимости от цвета объекта.
Поэтому, чтобы подключить конкретный стиль печати к объекту или слою, предварительно
необходимо в настройках программы назначить применение именованных стилей печати.
Для этого в диалоговом окне Plot Style Table Settings (Настройки таблиц стилей печати) (см.
рис. 8.17) установите переключатель в положение Use named plot styles (Использовать име-
нованные стили печати) и нажмите кнопку OK, а затем создайте новый чертеж, в котором
собираетесь использовать именованные стили печати.

Обычно стили печати назначаются не каждому объекту в отдельности, а слою, на кото-
ром данные объекты находятся. Чтобы применить именованный стиль печати к слою, выпол-
ните следующие действия.

1. Вызовите диалоговое окно Layer Properties Manager (Менеджер свойств слоев),
щелкнув на одноименной кнопке на панели инструментов Layers (Слои) или на кнопке
Layer Properties (Свойства слоя) в группе Layers (Слои) на вкладке Home (Основная) ленты
либо выполнив команду меню Format → Layer (Формат → Слои).

2. Щелкните на значении столбца Plot Style (Стиль печати) нужного слоя. На экране
появится диалоговое окно Select Plot Style (Выбор стиля печати) (рис. 8.24).
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Рис. 8.24. Окно выбора стиля печати
3. В раскрывающемся списке Active plot style table (Активная таблица стилей печати)

необходимо указать присоединяемую таблицу стилей. При этом в области Plot styles (Стили
печати) отобразятся все стили, содержащиеся в данной таблице. В случае необходимости
можно отредактировать выбранную таблицу стилей, щелкнув на кнопке Editor (Редактор).

4. Выберите нужный стиль в окне Select Plot Style (Выбор стиля печати). Затем
нажмите кнопку OK, чтобы закрыть окно.

Если необходимо назначить стиль печати одному объекту, это можно сделать с помо-
щью палитры свойств.

1. Выделите нужный объект любым известным вам способом. Затем щелкните правой
кнопкой мыши и в контекстном меню выберите пункт Properties (Свойства).

2. На открывшейся палитре Properties (Свойства) найдите раскрывающийся список
Plot style (Стиль печати) и выберите в нем элемент Other (Другой). Вновь появится диа-
логовое окно Select Plot Style (Выбор стиля печати) (см. рис. 8.24), в котором необходимо
определить стиль печати выбранного объекта.
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Таким же образом можно назначить стиль печати всему видовому экрану, так как он
также является объектом.

 
Конфигурирование печатающих устройств

 
Все принтеры и плоттеры, установленные в Windows, можно использовать для печати

в AutoCAD. Однако если вы собираетесь печатать не на настольном принтере, а на плот-
тере, то лучше воспользоваться специальными драйверами, входящими в состав программы.
Такие драйверы позволяют использовать все возможности плоттеров большого формата.

 
Добавление печатающего устройства

 
Для конфигурации печатающего устройства служит мастер добавления плоттера, кото-

рый можно вызвать одним из следующих способов:
• выполнив команду Tools → Wizards → Add Plotter (Сервис → Мастера → Добавить

плоттер);
• выполнив команду File → Plotter Manager (Файл → Менеджер плоттеров) и дважды

щелкнув в открывшемся окне на значке Add-A-Plotter Wizard (Мастер установки плоттера).
В любом случае перед вами появится окно мастера добавления печатающего устрой-

ства – Add Plotter (Добавить плоттер). Первое окно мастера расскажет о его назначении и
о тех шагах, которые придется пройти в процессе добавления нового плоттера. Щелкнув на
кнопке Далее, вы сможете начать процесс добавления печатающего устройства (рис. 8.25).

 

Рис. 8.25. Начало установки плоттера
Установите переключатель в положение My Computer (Мой компьютер) и нажмите

кнопку Далее, чтобы открыть окно Plotter Model (Модель плоттера) (рис. 8.26).
 



А.  А.  Орлов.  «AutoCAD 2010»

283

Рис. 8.26. Окно выбора модели плоттера
В списке слева выберите производителя печатающего устройства, а справа – конкрет-

ную модель плоттера, после чего с помощью кнопки Далее перейдите в следующее окно.
Если у вас есть файл конфигурации плоттера, сделанный в старых версиях программы (такие
файлы имеют расширение PCP или PC2), то на данном этапе вы можете импортировать эту
информацию в формат PC3.

В следующем окне мастер предложит выбрать порт, посредством которого плоттер
подключается к компьютеру. Щелкните на кнопке Далее, чтобы открыть новое окно.

Введите нужное имя плоттера в поле Plotter Name (Имя плоттера) и откройте послед-
нее окно мастера конфигурации плоттера (рис. 8.27), щелкнув на кнопке Далее.
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Рис. 8.27. Окно Finish (Готово) мастера установки плоттера
Последнее окно мастера содержит кнопки, предназначенные для редактирования кон-

фигурации и калибровки плоттера. Щелкните на кнопке Готово, чтобы завершить работу
по созданию файла конфигурации плоттера. Данный файл можно увидеть в окне Plotters
(Плоттеры), которое появляется после выполнения команды File → Plotter Manager (Файл
→ Менеджер плоттеров).

 
Редактирование конфигурации

 
Приступить к редактированию конфигурации плоттера можно, щелкнув на кнопке Edit

Plotter Configuration (Редактировать конфигурацию плоттера) в последнем окне мастера
установки плоттера (см. рис. 8.27). Если вы этого не сделали, то дважды щелкните кнопкой
мыши на файле конфигурации нужного плоттера в окне Plotters (Плоттеры). Откроется диа-
логовое окно Plotter Configuration Editior (Редактор конфигурации плоттера) (рис. 8.28).
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Рис. 8.28. Диалоговое окно Plotter Configuration Editor (Редактор конфигурации плот-
тера)

Данное окно содержит три вкладки, на которых находятся различные параметры редак-
тируемого плоттера. На вкладке General (Общие) можно только просмотреть информацию и
при необходимости добавить в поле Description (Описание) дополнительную информацию.
Вкладка Ports (Порты) предназначена для определения портов для связи плоттера с компью-
тером. Вкладку Device and Document Settings (Настройки устройства и документа) можно
назвать основной, так как здесь расположено большинство параметров плоттера. Данный
набор параметров зависит от модели печатающего устройства, при этом вид нижней части
данной вкладки зависит от выбранного элемента в списке сверху.

Щелкнув на кнопке OK, вы сохраните изменения в редактируемом файле и закроете
окно. Если хотите создать файл с новым именем, щелкните на кнопке Save As (Сохранить
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как). Так можно создать несколько конфигураций для одного печатающего устройства под
различными именами. Щелчок на кнопке Defaults (По умолчанию) отменяет все выполнен-
ные и несохраненные изменения.

 
Печать чертежа

 
Прежде чем приступать к печати, необходимо удостовериться в том, что принтер или

плоттер включен и подсоединен к компьютеру. Проверьте также, что в него заправлена
бумага.

Печать выполняется из диалогового окна Plot (Печать) (рис. 8.29), которое запуска-
ется при нажатии кнопки Plot (Печать) в группе Plot (Печать) на вкладке Output (Вывод)
ленты или с помощью команды File → Plot (Файл → Печать), а также стандартного сочета-
ния клавиш Ctrl+P. Чтобы получить доступ к дополнительным настройкам или, наоборот,
скрыть их, щелкните на кнопке More Options (Дополнительные параметры) с изображением
стрелки в правом нижнем углу.

 

Рис. 8.29. Диалоговое окно Plot (Печать)
Несложно заметить, что данное диалоговое окно практически идентично окну Page

Setup (Параметры страницы) (см. рис. 8.11), поэтому если вы установили настройки печати
в процессе компоновки листа, то все они появятся и в окне Plot (Печать). Однако вывести
чертеж на печать можно только из окна Plot (Печать).

В большинстве случаев печать следует производить из пространства листа. Вкладку
Model (Модель) можно использовать для черновой печати.

Может случиться так, что ваш чертеж на бумаге будет выглядеть не так, как на экране.
Поэтому рекомендуется выполнять предварительный просмотр. В обоих диалоговых окнах
присутствует кнопка Preview (Просмотр), нажав которую можно увидеть, как будет выгля-
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деть чертеж на бумаге. Кроме того, в группе Plot (Печать) на вкладке Output (Вывод) ленты
есть кнопка Preview (Просмотр), которая выполняет аналогичную функцию. Из контекст-
ного меню, которое вызывается щелчком правой кнопки мыши в режиме просмотра, можно
вызвать команды печати, панорамирования, масштабирования и выхода из режима предва-
рительного просмотра.

Удостоверившись в правильности настроек и в том, что принтер готов к печати, щелк-
ните на кнопке OK, чтобы распечатать чертеж.
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Резюме

 
В предыдущих главах все работы с чертежом вы выполняли в пространстве модели, а в

этой главе научились выполнять компоновку чертежа в пространстве листа, тем самым под-
готавливая его к печати. Кроме того, вы познакомились с богатыми возможностями печати,
которые предоставляет программа AutoCAD.
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Глава 9

Трехмерное моделирование
 

• Пространство для трехмерного моделирования
• Просмотр трехмерных чертежей
• Трехмерные координаты
• Резюме
Материал прошлых глав был посвящен работе с чертежами в двухмерном простран-

стве. В этой главе вы познакомитесь с трехмерным моделированием.
В AutoCAD можно создавать три типа трехмерных моделей: каркасные, поверхност-

ные и объемные.
• Каркасные модели, как следует из названия, отображаются в виде ребер и не имеют

объема. Например, линия, начерченная в трехмерном пространстве, уже может считаться
каркасной моделью.

• Поверхностные модели, в отличие от каркасных, содержат еще информацию о
поверхностях, формирующих объект, поэтому они обеспечивают более точное описание
объектов.

• Твердотельные модели представляют собой точные копии реальных объектов, так
как, кроме всего прочего, содержат информацию об объеме, занимаемом этими объектами.



А.  А.  Орлов.  «AutoCAD 2010»

290

 
Пространство для трехмерного моделирования

 
Чтобы воспользоваться всеми возможностями трехмерного черчения, предоставляе-

мыми программой, следует переключиться из пространства AutoCAD Classic (Классиче-
ский AutoCAD) или 2D Drafting & Annotation (Двухмерное черчение и аннотирование) в 3D
Modeling (Трехмерное моделирование). При переходе в пространство 3D Modeling (Трех-
мерное моделирование) рабочее окно программы AutoCAD приобретает несколько иной вид
(рис. 9.1).

 

Рис. 9.1. Окно AutoCAD в пространстве трехмерного моделирования
Как видите, изменился состав групп на вкладках ленты в главном окне программы и

инструментов на Tool Palettes (Инструментальные палитры). Например, если до этого вы
работали в пространстве AutoCAD Classic (Классический AutoCAD), то с экрана исчезли
панели инструментов рисования и редактирования, расположенные ранее по бокам.

В AutoCAD 2010 при переходе в пространство 3D Modeling (Трехмерное моделиро-
вание) на ленте появляются вкладки Mesh Modeling (Моделирование поверхностями) и
Render (Тонирование). Некоторые возможности первой мы рассмотрим в главе 10. Вторая
же вкладка по умолчанию содержит шесть групп (рис. 9.2):

• Visual Styles (Стили визуализации) – определение внешнего вида поверхностей и
ребер трехмерной модели;

• Edge Effects (Эффекты края) – управление отображением эффектов границ;
• Lights (Освещение) – создание и редактирование источников света;
• Sun & Location (Солнце и местоположение) – создание и редактирование погодных

условий, координат места нахождения, а также времени суток;
• Materials (Материалы) – создание, редактирование и присвоение материалов объек-

там чертежа;
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• Render (Тонирование) – выбор качества и запуск процесса визуализации изображе-
ния.

 

Рис. 9.2. Вкладка Render (Тонирование) ленты
Несмотря на все перечисленные особенности пространства 3D Modeling (Трехмерное

моделирование), принципы работы с программой при трехмерном моделировании остаются
теми же, что и в рабочем пространстве AutoCAD Classic (Классический AutoCAD) или 2D
Drafting & Annotation (Двухмерное черчение и аннотирование).
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Просмотр трехмерных чертежей

 
До сих пор, работая с двухмерными чертежами, мы видели модель только в одной плос-

кости XY. Однако в трех измерениях не обойтись без просмотра модели с различных точек
обзора.

Основным способом является так называемый вид в плане – это тот вид, который мы
привыкли видеть на двухмерных чертежах. Модель в этом случае изображается так, как если
бы мы смотрели на нее сверху.

 
Типовые проекции

 
Использование типовых проекций значительно упрощает просмотр трехмерных объ-

ектов. Направление проецирования можно выбрать с помощью команд группы меню Views
(Виды) на вкладке View (Отображение) ленты. Программа предлагает выбрать шесть типо-
вых проекций и четыре изометрических вида (рис. 9.3).

 

Рис. 9.3. Раскрытый список кнопки Views (Виды) на вкладке View (Отображение)
ленты

Примечание
При запуске выбранной команды не только выводится на

экран соответствующая проекция, но и автоматически выполняется
масштабирование по границам.

Итак, можно выбрать один из следующих типовых видов.
• Top (Верх) – точка зрения в этом случае находится над моделью. Это основной вид

– вид в плане.
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• Bottom (Низ) – объект отображается так, как если бы вы смотрели на него снизу.
• Left (Слева) – модель показывается с левой стороны.
• Right (Справа) – модель показывается с правой стороны.
• Front (Спереди) – в этом случае модель отображается спереди. Данный вид соответ-

ствует фронтальной проекции на технических чертежах.
• Back (Сзади) – модель изображается так, как если бы на нее смотрели сзади.
• SW Isometric (Ю-З изометрический) – юго-западный изометрический вид. При

использовании различных изометрических видов чертеж всегда изображается сверху, только
в различных видах пользователь смотрит на модель при разном повороте вокруг вертикаль-
ной оси. В данном случае видны левая, передняя и верхняя стороны модели. Так как в изо-
метрических видах изображаются три измерения, а не два, как раньше, при этом можно уви-
деть гораздо больше деталей.

Примечание
Как вы уже, наверное, заметили, при обозначении изометрических

видов используются географические термины. При этом направление
оси X в МСК совпадает с направлением на восток. Однако
географическая ориентация на вашем чертеже может быть не связана с
названием изометрического вида.

• SE Isometric (Ю-В изометрический) – в этом случае модель также показывается в
трех измерениях. Пользователю видны правая, передняя и верхняя стороны модели.

• NE Isometric (С-В изометрический) – северо-восточный изометрический вид позво-
ляет увидеть правую, заднюю и верхнюю стороны модели.

• NW Isometric (С-З изометрический) – северо-западный изометрический вид прибли-
жает к пользователю левую, заднюю и верхнюю стороны конструкции.

При всем многообразии типовых проекций и изометрических видов может возник-
нуть необходимость выбрать произвольную точку обзора. Например, при использовании
стандартных изометрических видов в правильных фигурах, таких как куб, некоторые ребра
могут накладываться друг на друга. Описанная проблема решается смещением точки обзора
в произвольное место.

 
Дополнительные виды

 
Одним из способов получить нестандартный вид модели является использование

команды DDVPOINT, которая запускается из меню View → 3D Views → Viewpoint Presets
(Вид → Трехмерные виды → Установка точки зрения). На экране отобразится диалоговое
окно Viewpoint Presets (Установка точки зрения) (рис. 9.4).
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Рис. 9.4. Диалоговое окно Viewpoint Presets (Установка точки зрения)
В поле X Axis (С осью X) вводится угол между осью X и проекцией вектора наблюде-

ния на плоскость XY. Такой угол обычно называют азимутом. В текстовом поле XY Plane
(С плоскостью XY) диалогового окна задается угол наклона между вектором направления на
точку обзора и ее проекцией.

Эти же углы можно указать и в графической зоне, расположенной сверху. Чтобы задать
один из стандартных азимутов, следует щелкнуть кнопкой мыши внутри одного из секторов
с нужным значением угла. При этом, зная, например, что угол 270° соответствует виду спе-
реди, легко догадаться о соответствии углов и типовых видов.

В правой части окна указывается вертикальное направление вектора наблюдения. Угол
0° задает один из боковых видов, а угол 90° соответствует виду сверху, то есть типовому виду,
к которому мы привыкли при работе с двухмерными чертежами. В типовых изометрических
видах этот угол равен 35,3°. Например установив азимут равным 225°, а вертикальный угол
35,3°, мы получим типовой юго-западный изометрический вид (спереди и слева).

Если переключатель установлен в положение Absolute to WCS (Абсолютно в МСК), то
направление просмотра задается относительно мировой системы координат (МСК). Чтобы
указать угол зрения относительно ПСК, установите переключатель в положение Relative to
UCS (Относительно ПСК).

Щелчок на кнопке Set to Plan View (Вид в плане), расположенной в нижней части окна,
быстро устанавливает все настройки для просмотра вида в плане.
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Трехгранник осей и компас

 
Еще одно средство установки нужного вида – трехгранник осей и компас. Чтобы

воспользоваться данной возможностью, выполните команду меню View → 3D Views →
Viewpoint (Вид → Трехмерные виды → Точка зрения). Можете также ввести команду
VPOINT с клавиатуры. При этом в командной строке появятся следующие сообщения:

Current view direction: VIEWDIR=0.0000,0.0000,1.0000
Specify a view point or [Rotate] <display compass and tripod>:
Числа в первой строке указывают координаты текущей точки зрения. В ответ на при-

глашение программы нажмите клавишу Enter. При этом графическая зона примет вид, пока-
занный на рис. 9.5.

 

Рис. 9.5. Вид трехгранника осей и компаса
Попробуйте подвигать мышью, и вы увидите, как перемещается маленькое перекре-

стье в правом верхнем углу и при этом вращается пиктограмма системы координат. Рису-
нок, расположенный в углу, называется компасом. Чтобы понять, как задать точку зрения
с помощью данного инструмента, постарайтесь подключить свое воображение и предста-
вить, что данный компас – это развернутый на плоскости глобус, причем центр окружностей
представляет собой северный полюс. Находясь в этой точке, вы смотрите на модель сверху.
Внутренняя окружность – это экватор (вид сбоку), а вся внешняя окружность – это южный
полюс (вид снизу). Таким образом, вертикальное положение точки зрения задается переме-
щением указателя мыши от центра к краю или наоборот.

Значение азимута зависит от того, в каком сегменте окружности находится указатель.
Например, если переместить его в правый нижний сегмент окружности, то вы увидите
модель слева спереди. Если при этом указатель будет находиться во внутренней окружно-
сти, то, ко всему прочему, будет продемонстрирована верхняя сторона. А если он будет в
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положении между внутренней и внешней окружностями, то будет показана нижняя сторона
модели.

Возможно, вы обратили внимание на то, что указание точки зрения с помощью диа-
логового окна Viewpoint Presets (Установка точки зрения) (см. рис. 9.4) во многом схоже
с использованием трехгранника осей и компаса: в обоих случаях угол зрения определяется
путем задания азимута (угла между осью X и проекцией вектора наблюдения на горизон-
тальную плоскость) и вертикального угла. Однако при использовании компаса отсутствует
возможность точного определения углов.

На первом этапе применение трехгранника осей и компаса может показаться затрудни-
тельным, однако, освоив данный инструментарий, вы сможете быстро задавать положение
точки зрения – многим этот метод кажется наиболее удобным.

Чтобы выбрать нужный вид, установите указатель в выбранную позицию и щелкните
левой кнопкой мыши. Теперь модель отобразится на экране с учетом положения указателя
в компасе (рис. 9.6).

 

Рис. 9.6. Отображение модели с учетом положения указателя в компасе
 

Отображение модели
 

В AutoCAD 2010 применяется такой подход к отображению моделей, при котором
можно использовать стили визуализации. Под стилем визуализации понимается сохранен-
ный набор параметров внешнего вида модели, включающий в себя вид граней и ребер
модели, цвет фона, световые блики и многое другое. Поэтому можно однажды настроить
отображение модели и сохранить эти настройки в виде стиля визуализации, чтобы затем при
необходимости быстро возвращаться к нужному отображению модели.

Чтобы изменить внешний вид объекта, следует запустить команду VSCURRENT. Сде-
лать это можно, выбрав один из пунктов в подменю View → Visual Styles (Вид → Стили
визуализации) либо щелкнув на одном из значков в списке, который расположен в группе
Visual Styles (Стили визуализации) на вкладке Render (Тонирование) ленты (рис. 9.7) либо
на панели инструментов Visual Styles (Стили визуализации) (рис. 9.8).
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Рис. 9.7. Раскрытый список кнопки Visual Styles (Стили визуализации) на вкладке
Render (Тонирование) ленты

 

Рис. 9.8. Панель инструментов Visual Styles (Стили визуализации)
По умолчанию в программе имеются пять различных стилей визуализации.
• 2D Wireframe (Двухмерный каркас) – объекты отображаются в виде отрезков и кри-

вых, с учетом типов и весов линий. Этот режим обычно используется для представления
двухмерных объектов.

• 3D Wireframe (Трехмерный каркас) – объекты также отображаются в виде отрезков
и кривых, но без учета типов и весов линий. Данный режим наиболее удобно использовать
при редактировании, так как видны все ребра модели.

• 3D Hidden (Трехмерное сокрытие) – как и в предыдущем случае, модель отобража-
ется в каркасном виде, однако грани, скрытые поверхностями, показываться не будут. Дан-
ный режим можно считать эквивалентом выполнения команды HIDE.

• Realistic (Реалистичный) – объекты раскрашиваются с учетом присвоенного им цвета
или типа материала.

• Conceptual (Концептуальный) – объекты также заливаются с учетом присвоенного
им цвета или типа материала. Кроме того, в этом случае реалистичность вида достигается
за счет сглаженности поверхностей и плавности цветовых переходов.

Внешний вид шестерни в стиле визуализации Conceptual (Концептуальный) показан
на рис. 9.9. Запомните, что каждому видовому экрану может быть назначен свой стиль визу-
ализации.
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Рис. 9.9. Вид шестерни в стиле визуализации Conceptual (Концептуальный)
Поэкспериментируйте с отображением модели при различных стилях визуализации,

чтобы подобрать наиболее подходящий.
 

Режим Orbit (Орбита)
 

Режим Orbit (Орбита) служит для просмотра модели и установки точки зрения. При
использовании данного инструмента пользователь как бы вращается вокруг пространствен-
ной модели, что позволяет рассмотреть ее под различными углами. В режиме Orbit (Орбита)
нельзя использовать другие команды для редактирования модели.

В AutoCAD 2010 используются три разновидности данного инструмента. Кроме
режима Free Orbit (Свободная орбита), который присутствовал в более старых версиях про-
граммы, имеются два других режима: Constrained Orbit (Ограниченная орбита), который
запускается по умолчанию, и Continuous Orbit (Непрерывная орбита).

Выбрать один из режимов Orbit (Орбита) можно с помощью кнопок в группе Navigate
(Навигация) на вкладке View (Отображение) ленты или из меню View → Orbit (Вид →
Орбита). Можно также воспользоваться панелью инструментов Orbit (Орбита).

Производительность компьютера в режиме Orbit (Орбита) напрямую зависит от коли-
чества вращающихся объектов. Поэтому сначала выделите только те объекты, которые необ-
ходимо просмотреть в режиме вращения, а затем уже запустите команду. При этом с экрана
исчезнут все невыделенные объекты. Они появятся вновь, как только вы завершите про-
смотр модели.

 
Свободное вращение

 
После выбора режима Free Orbit (Свободная орбита) на экране появляется окруж-

ность, показанная на рис. 9.10.
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Рис. 9.10. Вид модели при включенном режиме Free Orbit (Свободная орбита)
Данная окружность делит графическую зону на несколько областей. При перемеще-

нии указателя из одной области в другую он изменяет свой внешний вид. Таким образом
AutoCAD извещает пользователя о том, что изменился способ вращения модели, то есть
программа будет по-разному реагировать на движения указателя мыши в зависимости от
того, в какой области он находится.

Рассмотрим различные способы вращения модели.
Поворот в режиме круговой стрелки. Выведите указатель за внешний контур

орбиты. Он примет вид круговой стрелки с точкой в центре
 

Если теперь перемещать указатель, удерживая нажатой левую кнопку мыши, то объ-
екты, находящиеся на экране, будут вращаться вокруг воображаемой оси, проходящей через
центр окружности перпендикулярно плоскости чертежа. Отпустив кнопку мыши, вы зафик-
сируете полученный вид модели.

Поворот в режиме сферы с линиями. Если переместить указатель внутрь окружно-
сти, то он приобретет вид двух эллипсов со стрелками, расположенных в перпендикулярных
плоскостях
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Теперь, перемещая указатель при нажатой кнопке мыши, вы добьетесь вращения
модели вокруг оси, лежащей в плоскости экрана и проходящей через центр окружности пер-
пендикулярно направлению перемещения указателя. Например, если в данном режиме пере-
мещать указатель в горизонтальном направлении, то модель будет вращаться вокруг верти-
кальной оси, проходящей через центр окружности. Отметим также, что указатель лучше
перемещать примерно по прямой линии, иначе можно легко запутаться в положении модели.

Поворот вокруг вертикальной оси. Наверное, вы уже заметили, что по контуру
окружности расположены четыре кружка – они также предназначены для вращения модели.
Если установить указатель мыши в левый или правый кружок, то он приобретет вид эллипса
со стрелкой, вытянутого в горизонтальной плоскости

 

Теперь при перемещении указателя вращение модели будет происходить вокруг вер-
тикальной оси, проходящей через центр окружности параллельно плоскости экрана. Чтобы
получить лучшее представление о данном режиме, можно провести аналогию вращающе-
гося на талии обруча. Даже если при перемещении указатель выйдет из маленькой окруж-
ности, вращение будет происходить до тех пор, пока вы не отпустите кнопку мыши. Чтобы
повторить вращение в этой же плоскости, опять переместите указатель в одну из окружно-
стей и начните буксировку.

Поворот вокруг горизонтальной оси. Если переместить указатель в нижний или
верхний кружок, расположенный на контуре окружности, он примет вид вытянутого в вер-
тикальной плоскости эллипса

 

В данном случае модель будет вращаться вокруг горизонтальной оси, проходящей
через центр окружности параллельно плоскости экрана. Чтобы представить себе такое вра-
щение, вообразите, что вы толкаете перед собой колесо. Так же, как и в предыдущем случае,
указатель не будет видоизменяться до тех пор, пока вы не отпустите кнопку мыши, чтобы
закончить вращение.

Последние два режима хороши тем, что, независимо от того, в каком направлении вы
будете перемещать мышь, вращение будет происходить только в одной плоскости – верти-
кальной или горизонтальной.

 
Ограниченное вращение

 
Режим ограниченного вращения в версии AutoCAD 2010 используется по умолчанию.

Инструмент Constrained Orbit (Ограниченная орбита) можно вызвать одним из перечислен-
ных выше способов. При этом окружность на экране не появится, а указатель примет такой
же вид, как при вращении в режиме сферы с линиями

 

Основное отличие от поворота в режиме сферы с линиями состоит в том, что теперь
вращение будет происходить в положительной полусфере, то есть вы не сможете взглянуть
на модель со стороны отрицательного направления оси Z.
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Совет
Чтобы быстро переключиться в режим Free Orbit (Свободная

орбита), находясь в режиме Constrained Orbit (Ограниченная орбита),
нажмите и удерживайте клавишу Shift. Кроме того, чтобы просто
активизировать режим Constrained Orbit (Ограниченная орбита),
нажмите клавишу Shift и среднюю кнопку (колесико) мыши. Отпустив
кнопку или клавишу, вы вернетесь в режим черчения.

 
Непрерывное вращение

 
После выбора режима Continuous Orbit (Непрерывная орбита) необходимо задать

направление вращения модели. Для этого нужно, удерживая нажатой левую кнопку мыши,
указать то направление, которое необходимо. Для окончания вращения модели нажмите кла-
вишу Esc или щелкните кнопкой мыши.

 
Настройки режима Orbit (Орбита)

 
Как говорилось ранее, в режиме Orbit (Орбита) невозможно выполнение команд, то

есть их нельзя ввести в командную строку. Однако щелчком правой кнопки мыши можно
вызвать контекстное меню с достаточно богатым набором возможностей (рис. 9.11).

 

Рис. 9.11. Контекстное меню в режиме Orbit (Орбита)
Рассмотрим команды, которые имеются в контекстном меню.
• Пункт Exit (Выход) завершает выполнение команды и убирает контекстное меню с

экрана.
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• Выделив строку Current Mode (Текущий режим), вы просто свернете контекстное
меню без завершения работы команды.

• В подменю Other Navigation Modes (Другие режимы навигации) перечислены все
возможные инструменты, позволяющие просматривать модель различными способами в
интерактивном режиме. Обратите внимание на то, что каждой команде назначена своя
цифра, поэтому переключаться между данными режимами можно, не вызывая контекстное
меню, а просто нажимая соответствующую клавишу на клавиатуре.

· Первые три позиции занимают различные варианты режима Orbit (Орбита), описан-
ные достаточно подробно.

· После выбора пункта Adjust Distance (Регулировка расстояния) указатель принимает
вид стрелки. Теперь если перемещать его вверх или вниз при нажатой левой кнопке мыши,
то чертеж на экране будет приближаться или удаляться соответственно.

· Команда Swivel (Шарнир) позволяет сымитировать вращение камеры вокруг верти-
кальной оси.

· Команды Walk (Прогулка) и Fly (Полет) предоставляют ранее недоступные возмож-
ности. При выборе первой из них появляется возможность «прогуляться» по модели и рас-
смотреть ее с точки зрения обозревателя. Управление осуществляется клавишами управле-
ния курсором и с помощью палитры Position Locator (Положение наблюдателя) (рис. 9.12),
которая появляется автоматически после вызова команды.
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Рис. 9.12. Палитра управления перемещением по модели
Инструмент Fly (Полет) во многом аналогичен предыдущему. Эти две команды можно

настроить в окне Options (Параметры) на вкладке 3D Modeling (Трехмерное моделирова-
ние).

· Используйте команды Zoom (Масштабирование) и Pan (Панорамирование) точно так
же, как если бы вы находились не в орбитальном режиме. В данном случае масштабирование
производится в режиме реального времени.

• Команды Zoom Window (Показать рамкой), Zoom Extents (Показать границы) и
Zoom Previous (Показать предыдущий) предназначены для увеличения или уменьшения
изображения модели в режиме Orbit (Орбита). Заметим, что изменять масштаб объектов
можно и не вызывая контекстное меню, а просто используя колесико мыши.

• Параллельную или перспективную проекцию можно выбрать, воспользовавшись
командой Parallel (Параллельный) или Perspective (Перспективный). При применении пер-
вого способа все параллельные линии модели останутся таковыми и в изображении. Если
же выбрать вариант Perspective (Перспективный), то линии, уходящие вглубь экрана, будут
визуально сходиться. Такой эффект обычно используют в архитектурных чертежах.

• Команда Reset View (Сбросить вид) может помочь в том случае, когда после долгих
манипуляций с моделью вы желаете вернуть на экран вид, который был до перехода в режим
Orbit (Орбита).

• Из подменю Preset Views (Стандартные виды) можно выбрать один из стандартных
видов модели, рассмотренных ранее.

• В подменю Visual Styles (Стили визуализации) перечислены все стили визуализации,
кроме 2D Wireframe (Двухмерный каркас).

• Наконец, подменю Visual Aids (Визуальные средства) позволяет воспользоваться
некоторыми дополнительными средствами, помогающими сориентироваться в трехмерном
пространстве:

· Compass (Компас) – изображение на экране дополнится тремя окружностями – X, Y
и Z, расположенными во взаимно перпендикулярных плоскостях;

· Grid (Сетка) – в плоскости XY вырисовывается сетка;
· UCS Icon (Знак ПСК) – добавляет на экран трехмерную пиктограмму ПСК (эта функ-

ция включена по умолчанию).
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Трехмерные координаты

 
Построение новых объектов всегда происходит путем задания координат. Как в двух-

мерном, так и в трехмерном пространстве для этого могут применяться различные методы.
Правда, ввод трехмерных координат обладает некоторыми особенностями, которые мы и
рассмотрим.

 
Ввод трехмерных координат

 
При построении трехмерных объектов можно использовать те же способы задания

координат, которые применяются при двухмерном моделировании. Отличительной особен-
ностью указания пространственных координат является лишь то, что к осям X и Y, использу-
емым ранее, добавляется еще и ось Z, проходящая перпендикулярно плоскости XY. Поэтому
положение точек теперь будет определяться тремя координатами: x, y и z

Что касается полярных координат, применяемых в двухмерных чертежах, то в трех-
мерном пространстве их аналогами являются цилиндрические и сферические координаты.
Кроме того, задавать координаты можно и в интерактивном режиме, то есть указывая их
непосредственно на чертеже с помощью мыши.

 
Декартовы координаты

 
В трехмерном пространстве декартовы координаты имеют формат @X,Y,Z. Как видно,

прямоугольные координаты почти так же указывались и в двухмерном пространстве – только
добавилась третья координата. Напомним, что символа @ может и не быть, тогда положение
точки будет задано относительно начала текущей системы координат – абсолютные коор-
динаты. Если же этот символ присутствует, то задается положение точки относительно пре-
дыдущей, то есть используются относительные прямоугольные координаты. В трехмерных
чертежах чаще применяют именно относительные координаты.

 
Цилиндрические координаты

 
Абсолютные цилиндрические координаты представляются в формате

расстояние<угол,расстояние. В данной записи первое расстояние – это длина проекции
на плоскость XY вектора, начинающегося в начале текущей системы и заканчивающегося
в точке, координаты которой задаются. Угол указывает значение между осью X и упомяну-
той проекцией вектора на плоскость XY. Второе расстояние, которое вводится после запя-
той, – это смещение точки вдоль оси Z. Как видно, цилиндрические координаты отличаются
от полярных лишь добавлением координаты z Как задается точка с координатами 10<30,5
показано на рис. 9.13.
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Рис. 9.13. Указание точки методом абсолютных цилиндрических координат
Если применяются относительные цилиндрические координаты, то перед предыдущей

записью будет еще добавлен символ @. Тогда координата точки будет указываться путем
смещения ее относительно предыдущей. Следует заметить, что при использовании цилин-
дрических координат, как абсолютных, так и относительных, указываемые расстояния фак-
тически представляют собой катеты прямоугольного треугольника.

 
Сферические координаты

 
Абсолютные сферические координаты представляются в формате расстояние <угол

<угол. В данной записи расстояние – это длина вектора, который проходит от начала коор-
динат до указываемой точки. Первый угол отсчитывается от оси X до проекции вектора на
плоскость XY. Еще одно значение, которое следует указать, – это угол между плоскостью XY
и упомянутым вектором. Точка с координатами 5<30<45 показана на рис. 9.14.

 

Рис. 9.14. Указание точки методом абсолютных сферических координат
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Сферические координаты также могут быть и относительными. В этом случае как все-
гда добавляется знак @, а координата точки указывается путем смещения ее от предыду-
щей точки. Следует отметить, что, в отличие от цилиндрических координат, где расстояние
до точки указывалось косвенным образом, в сферических координатах расстояние до точки
указывается прямо.

 
Координатные фильтры

 
Координатные фильтры предназначены для указания координат комбинированным

способом – выбирая точки с помощью перекрестья на чертеже и вводя недостающие коор-
динаты с клавиатуры. Существуют следующие фильтры точек:.X, Y, Z, XY, YZ и. XZ. Напри-
мер, запись. XYозначает, что координаты x и y вы сможете «скопировать» с чертежа, а коор-
динату z задать иным способом – вводом с клавиатуры. Допустим, необходимо указать точку,
отстоящую от конца отрезка, который расположен в горизонтальной плоскости, в направле-
нии оси Z на заданное расстояние. Делается это следующим образом.

1. Вызовите какую-либо команду построения графического объекта, например LINE.
2. Наберите в командной строке. XY, чтобы задать координаты x и y для новой точки.
3. Щелкните кнопкой мыши на точке, координаты x, y которой необходимо скопиро-

вать. Обычно при этом используется один из режимов объектной привязки.
4. Переместите курсор вертикально вверх и введите с клавиатуры координату Z созда-

ваемой точки.
Мы рассмотрели фильтр. XY подробно, так как он наиболее часто используется при

трехмерных построениях: нередко модель начинают вычерчивать в плоскости XY, а затем
уже задают смещение в вертикальном направлении. Применение координатных фильтров –
достаточно трудоемкий способ задания координат, однако случается так, что задать точку
каким-либо иным методом еще более затруднительно.

В целом, фильтрация точек применяется достаточно редко, так как применение объ-
ектных привязок значительно упрощает построение объектов.

 
Объектная привязка в трехмерном пространстве

 
Как в двухмерных, так и в трехмерных чертежах привязка к существующим объектам

намного упрощает построение модели. Использование объектной привязки позволяет одно-
значно указать нужную точку, причем сделать это с абсолютной точностью. Однако не стоит
забывать, что на трехмерных чертежах в определенных видах некоторые объекты могут сли-
ваться. Поэтому следует выбирать вид без этого недостатка. В остальном же использование
привязки к объектам в двухмерных моделях полностью аналогично применению ее в трех-
мерном пространстве.

 
Различные системы координат

 
Основной системой координат в AutoCAD является прямоугольная декартова система

координат, которая называется мировой системой координат (МСК).
Она используется по умолчанию при создании нового чертежа. Направление осей

демонстрируется с помощью трех стрелок (рис. 9.15). В трехмерных чертежах оси X и Y
составляют горизонтальную плоскость, а ось Z направлена перпендикулярно вверх, то есть
по умолчанию ось X соответствует ширине объекта, Y – глубине, а по оси Z отсчитывается
высота.
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Рис. 9.15. Трехмерное обозначение системы координат в AutoCAD
Кроме присутствующей во всех чертежах МСК, вы можете создать несколько соб-

ственных систем координат, называемых пользовательскими системами координат (ПСК).
Применение ПСК обычно оправдано при создании трехмерных моделей, в которых присут-
ствуют плоскости, не параллельные XY. Чтобы выполнять построения в таких плоскостях,
необходимо создать систему координат, плоскость XY в которой будет параллельна одной из
поверхностей объекта.
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Резюме

 
Программа AutoCAD обладает богатыми возможностями для трехмерного моделиро-

вания. Из прочитанной главы вы узнали о существовании трех видов модели для пред-
ставления объектов в трехмерном пространстве. Вы познакомились с режимами просмо-
тра трехмерных объектов как посредством статических видов, так и с помощью различных
интерактивных режимов. Владея навыками задания трехмерных координат, вы без труда
сможете перейти непосредственно к построению трехмерных моделей.



А.  А.  Орлов.  «AutoCAD 2010»

309

 
Глава 10

Трехмерные поверхности
 

• Трехмерная грань
• Многоугольная сеть
• Поверхности вращения
• Поверхности сдвига
• Поверхности соединения
• Поверхность Куна
• Плоская поверхность
• Поверхностные примитивы
• Создание отверстий
• Резюме
Данная глава посвящена созданию поверхностных моделей, которые в AutoCAD также

называют сетями. Трехмерные поверхности могут довольно правдоподобно описывать
реальные объекты, так как в этом случае, кроме ребер, создаются еще и грани объектов.

Все основные кнопки для работы с трехмерными поверхностями и твердотельными
моделями, которые мы рассмотрим в этой главе, находятся в группе Modeling (Моделиро-
вание) (рис. 10.1), расположенной на вкладке Home (Основная).

 

Рис. 10.1. Группа Modeling (Моделирование) на вкладке Home (Основная)
Если вы переключитесь в пространство 3D Modeling (Трехмерное моделирование), то

все кнопки будут у вас под рукой и вам не придется долго путешествовать по меню в поиске
нужного инструмента.
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Трехмерная грань

 
Команда 3DFACE позволяет создать плоские поверхности из граней, ограничен-

ных тремя или четырьмя ребрами. За один сеанс выполнения команды можно начертить
несколько граней, причем каждая из них может быть ориентирована произвольным обра-
зом. Расположение ребер, ограничивающих создаваемую поверхность, указывают с помо-
щью угловых точек. Точки должны располагаться по часовой стрелке или против нее, но не
по диагонали, иначе вы получите грань неправильной формы.

Чтобы приступить к созданию грани, выполните команду меню Draw → Modeling →
Meshes → 3D Face (Черчение → Моделирование → Сети → Трехмерная поверхность) или
введите с клавиатуры команду 3DFACE. После этого в командной строке появятся пригла-
шения указать первую, а затем и последующие точки создаваемой грани:

Specify fi rst point or [Invisible]:
Specify second point or [Invisible]:
Specify third point or [Invisible] <exit>:
Specify fourth point or [Invisible] <create three-sided face>:
После указания координат точки программа предлагает задать следующие точки, опре-

деляющие расположение ребер. Последнее ребро создается автоматически путем соедине-
ния первой и последней указанных точек.

Если после указания третьей точки, когда появится запрос Specify fourth point or
[Invisible] <create three-sided face>:, нажать клавишу Enter, то будет создана трехсторон-
няя грань. Чтобы создать четырехстороннюю грань, в ответ на данное приглашение просто
укажите расположение четвертой точки. Выполнение команды на этом не завершается, и
можно формировать новые грани путем указания новых точек. При этом учтите, что ребро
грани, созданное последней парой точек, будет служить первым ребром для вновь создавае-
мой грани. Поэтому, например, если создаваемая в данный момент грань должна быть четы-
рехсторонней, то для ее формирования необходимо указать всего две точки. Выполнение
команды, как обычно, завершается нажатием клавиши Esc или Enter.
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Многоугольная сеть

 
Рассмотрим, как можно создать сеть произвольной конфигурации. Такую сеть можно

построить с помощью команды 3DMESH. Данный объект формируется путем указания мас-
сива вершин.

Сначала появится приглашение:
Enter size of mesh in M direction:
Задайте количество вершин в одном направлении (M).
Затем программа попросит указать количество вершин в другом направлении:
Enter size of mesh in N direction:
После этого необходимо будет указать координату каждой точки сети. Например, при

размерности сети M х N, равной 3 х 4, количество точек будет равно 12. При этом первая
точка будет называться (0, 0), а последняя – (2, 3). Обратите внимание, что нумерация точек
начинается с нуля:

Specify location for vertex (0, 0):
Specify location for vertex (0, 1):
...
Specify location for vertex (2, 3)
Пример многоугольной сети размерностью 3 х 4 показан на рис. 10.2.

 

Рис. 10.2. Сеть размерностью 3 × 4
Заметим, однако, что точки не обязательно задавать в той последовательности, в кото-

рой они показаны на рис. 10.2. Вы можете разбросать точки совершенно в произвольном
направлении – в этом случае получится сеть причудливой формы.
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Созданная сеть представляет собой единый объект. Однако ее можно расчленить, и
тогда каждый отдельный объект будет представлять собой трехмерную грань. При выделе-
нии многоугольной сети во всех вершинах появляются маркеры, с помощью которых можно
легко изменить ее конфигурацию.
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Поверхности вращения

 
Еще один способ построения поверхностных моделей предоставляет команда

REVSURF. С ее помощью поверхности создаются путем вращения какого-либо объекта
– определяющей кривой – вокруг заданной оси. Сформированные таким образом модели
называются поверхностями вращения.

Чтобы запустить данную команду, необходимо выполнить команду Draw → Modeling
→ Meshes → Revolved Mesh (Черчение → Моделирование → Сети → Сеть вращения). В
процессе выполнения команды требуется сначала указать тело вращения, а затем задать ось,
вокруг которой оно будет повернуто:

Select object to revolve:
Select object that defines the axis of revolution:
За один сеанс выполнения команды можно повернуть только один объект. Вращать

можно отрезок, дугу, окружность, эллипс, полилинию или трехмерную полилинию. В каче-
стве оси вращения следует указать отрезок или незамкнутую полилинию, при этом ось
вращения будет определяться вектором, проходящим из первой вершины полилинии в
последнюю. Если нужно создать вспомогательный объект, определяющий ось вращения, это
следует сделать до начала выполнения команды.

Ось вращения можно указать щелчком кнопкой мыши на нужном объекте. При этом
имеет значение, ближе к какому концу отрезка или полилинии будет находиться указанная
вами точка, потому что этот конец отрезка будет воспринят как начало оси вращения. Если
смотреть на объект с начала оси вращения, то положительное направление поворота будет
соответствовать вращению по часовой стрелке.

Начальный угол, который программа попросит указать, определяет отступ начала
поверхности вращения от плоскости определяющей кривой:

Specify start angle <0>:
Если оставить указанное по умолчанию значение 0°, то поворот будет начат с опреде-

ляющей кривой.
Затем появится запрос об указании угла поворота:
Specify included angle (+=ccw, – =cw) <360>:
Если вы собираетесь создать замкнутую модель, то оставьте значение угла поворота по

умолчанию – 360°. Причем в данном случае не имеет значения, как вы указали ось вращения.
Однако повернуть образующую кривую можно на любой угол, при этом можно задать как
положительное значение угла (соответствует вращению по часовой стрелке), так и отрица-
тельное (вращение происходит против часовой стрелки). По умолчанию вращение произво-
дится по часовой стрелке, поэтому знак + можно с клавиатуры не вводить.

По аналогии с величинами M и N, которые задают количество вершин в сети, созда-
ваемой с помощью команды 3DMESH, при построении поверхностей вращения использу-
ются системные переменные SURFTAB1 и SURFTAB2. Дело в том, что на экране криво-
линейная поверхность, полученная путем вращения какого-либо объекта, отображается в
виде ребер, составляющих эту поверхность. Чем больше значения переменных SURFTAB1
и SURFTAB2, тем больше линий используется для построения сети и тем более правдопо-
добно будет выглядеть модель.

На рис. 10.3 показана поверхность, полученная путем вращения окружности на 270°.
Слева модель изображена при значениях системных переменных SURFTAB1 и SURFTAB2,
равных 6, а во втором случае переменной SURFTAB1 присвоено значение 15, а SURFTAB2
– 10.
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Рис. 10.3. Поверхность вращения при различных значениях переменных SURFTAB1
и SURFTAB2

Следует отметить, что изменение значений переменных SURFTAB1 и SURFTAB2 не
влияет на существующие объекты, поэтому изменять эти значения следует до начала постро-
ения поверхности вращения.

После выполнения команды REVSURF объекты, использовавшиеся для построения
поверхности вращения, сохраняются и их можно использовать повторно. Если такой необ-
ходимости не возникнет, лучше их удалить.
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Поверхности сдвига

 
Команда TABSURF служит для построения поверхностей путем сдвига образующей

кривой вдоль указанного вектора. Создание такой поверхности обычно начинается с постро-
ения образующей кривой, в качестве которой может выступать отрезок, дуга, окружность,
полилиния, эллипс или эллиптическая дуга, и вычерчивания объекта (отрезка или полили-
нии), который в дальнейшем будет служить вектором сдвига.

Чтобы запустить данную команду, выполните команду меню Draw → Modeling →
Meshes → Tabulated Mesh (Черчение → Моделирование → Сети → Сеть сдвига). Про-
грамма попросит указать профиль сдвига:

Select object for path curve:
В ответ на это приглашение выделите объект, служащий основой для создания поверх-

ности. Появится запрос:
Select object for direction vector:
Щелкните кнопкой мыши на объекте, задающем направление объекта. При этом за

начало вектора принимается тот конец отрезка, ближе к которому вы щелкнете. Поэтому,
например, если задать вектор, щелкнув ближе к верхнему концу отрезка, то поверхность
будет построена путем сдвига в противоположном направлении, то есть вниз. При этом
высота поверхности будет равна абсолютной длине вектора. Следует также отметить, что
вектор, задающий направление, может быть расположен под любым углом к плоскости, в
которой находится задающая кривая.

Примеры построенных поверхностей сдвига показаны на рис. 10.4. Обратите внима-
ние, что поверхность, расположенная слева, построена при значении системной переменной
SURFTAB1, равном 25. При построении второй поверхности за начало вектора был принят
верхний конец отрезка, а системной переменной SURFTAB1 в этом случае было присвоено
значение по умолчанию – 6.

 

Рис. 10.4. Поверхности сдвига
Системная переменная SURFTAB1 регулирует плотность сети, то есть задает количе-

ство отрезков, которыми будет определена криволинейная поверхность.
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Итак, после выполнения команды TABSURF поверхность сдвига и объект, вдоль кото-
рого происходил сдвиг поверхности, остаются неизменными, а на экране появляется трех-
мерная сеть, состоящая из полилиний.
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Поверхности соединения

 
Поверхности, создаваемые с помощью команды RULESURF, связывают между собой

два примитива, в качестве которых могут выступать отрезки, полилинии, сплайны, окруж-
ности, точки, эллипсы и эллиптические дуги. Например, если такими объектами будут
две окружности, расположенные в параллельных плоскостях, то при выполнении данной
команды на экране появится либо цилиндр, либо усеченный конус – в зависимости от соот-
ношения размеров окружностей (рис. 10.5). При этом должно соблюдаться следующее усло-
вие – оба объекта должны быть либо замкнутыми, либо разомкнутыми.

 

Рис. 10.5. Поверхности соединения
Чтобы запустить команду RULESURF, выполните команду меню Draw → Modeling

→ Meshes → Ruled Mesh (Черчение → Моделирование → Сети → Сеть соединения). В
командной строке последовательно появятся следующие запросы:

Select first defining curve:
Select second defining curve:
В ответ на них укажите объекты, между которыми будет «натянута» поверхность.

Последовательность задания объектов не играет никакой роли. Может иметь значение
только указание точек на конкретном объекте. Чтобы не получить пересекающуюся поверх-
ность (рис. 10.6), старайтесь указывать точки, расположенные примерно в одной плоскости.
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Рис. 10.6. Нормальная и пересекающаяся поверхность соединения
После указания второго объекта на экране появится созданная поверхность. Как и в

предыдущем случае, системная переменная SURFTAB1 определяет количество отображае-
мых линий на поверхности, которую вы создаете. Данный параметр необходимо задавать до
вызова команды RULESURF.
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Поверхность Куна

 
Воспользовавшись командой EDGESURF, можно построить поверхность на осно-

вании четырех соприкасающихся объектов. Такая поверхностная сеть может получиться
достаточно причудливой конфигурации, учитывая то, что в качестве задающих объектов
могут выступать отрезки, дуги, сплайны и полилинии (рис. 10.7). Эта сеть получила назва-
ние поверхность Куна.

 

Рис. 10.7. Поверхность Куна, ограниченная тремя отрезками и сплайном
Прежде чем вызывать команду построения такой поверхности, необходимо начертить

четыре объекта, на которые будет натянута сеть. При этом следует иметь в виду, что объекты
могут быть произвольным образом ориентированы друг относительно друга, однако они
должны соприкасаться, то есть между ребрами не должно быть зазоров.

Приступая к построению поверхности Куна, выполните команду меню Draw →
Modeling → Meshes → Edge Mesh (Черчение → Моделирование → Сети → Сеть Куна)
или введите в командную строку EDGESURF. Программа попросит последовательно указать
четыре объекта, которые будут являться определяющими кривыми создаваемой поверхно-
сти:

Select object 1 for surface edge:
Select object 2 for surface edge:
Select object 3 for surface edge:
Select object 4 for surface edge:
Последовательность, в которой вы будете задавать объекты, не имеет значения. После

выделения четвертого (последнего) объекта сеть будет построена.
Количество линий создаваемой сети в двух направлениях зависит от значений систем-

ных переменных SURFTAB1 и SURFTAB2. Напомним, что изменять эти параметры необ-
ходимо до создания поверхности.
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Плоская поверхность

 
Команда PLANESURF позволяет создавать прямоугольные поверхности путем зада-

ния угловых точек. Кроме того, воспользовавшись дополнительным параметром этой
команды, можно конвертировать объект в замкнутую поверхность, состоящую из любого
количества примитивов.

Чтобы создать прямоугольную поверхность с помощью команды PLANESURF, щелк-
ните на кнопке Planar Surface (Плоская поверхность), расположенной на вкладке Home
(Основная) в группе Modeling (Моделирование).

Программа запросит координаты первого угла прямоугольной поверхности:
Specify first corner or [Object] <Object>:
Введите координаты точки с клавиатуры или укажите их, щелкнув на нужном месте

чертежа. Появится запрос о вводе второго угла:
Specify other corner:
Просто переместите указатель в нужную позицию и щелкните кнопкой мыши, чтобы

завершить построение прямоугольной поверхности.
Команда PLANESURF обладает одним полезным свойством. Как уже говорилось, с ее

помощью можно преобразовать любой замкнутый контур в поверхность. Для этого доста-
точно в ответ на запрос об указании первого угла просто нажать клавишу Enter, тем самым
выбрав параметр Object, а затем путем выделения объектов определить контур, подлежащий
преобразованию в поверхность. Выделив объекты, нажмите клавишу Enter, чтобы завер-
шить выполнение команды PLANESURF. На экране появится поверхностная модель, осно-
ванная на выбранном контуре.
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Поверхностные примитивы

 
Стандартные трехмерные примитивы в программе AutoCAD можно создать несколь-

кими способами. Первый способ – использование команды 3D. После ее запуска в команд-
ной строке появится запрос:

Enter an option
[Box/Cone/DIsh/DOme/Mesh/Pyramid/Sphere/Torus/Wedge]:
Выбрав один из параметров (Box (Параллелепипед), Cone (Конус), DIsh (Чаша), DOme

(Купол), Mesh (Сеть), Pyramid (Пирамида), Sphere (Сфера), Torus (Тор) или Wedge (Клин)),
можно создать нужный примитив.

Второй способ является, наверное, наиболее удобным. Его суть заключается во вводе
в командную строку команды AI_ с именем фигуры. Например, команда AI_SPHERE пред-
назначена для построения сферы.

Создание стандартных трехмерных примитивов с помощью различных команд рассмо-
трено в следующих подразделах.

 
Параллелепипед

 
Внешний вид параллелепипеда приведен на рис. 10.8.

 

Рис. 10.8. Поверхностный примитив параллелепипед
Чтобы построить параллелепипед, вызовите команду AI_BOX. Появится приглаше-

ние:
Specify corner point of box:
Укажите координаты левого нижнего угла параллелепипеда. Появится следующий

запрос:
Specify length of box:
Задайте длину параллелепипеда вдоль оси X. Программа выдаст очередной запрос:
Specify width of box or [Cube]:
Определите ширину фигуры, то есть размер вдоль оси Y. Если выбрать параметр Cube,

то программа не попросит определения размера по вертикали, а создаст куб, все стороны
которого будут равны длине, указанной в ответ на предыдущий запрос.
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Далее последует такое приглашение:
Specify height of box:
Укажите высоту параллелепипеда.
Последнее, что нужно сделать, – это определить угол поворота вокруг оси Z в ответ

на запрос:
Specify rotation angle of box about the Z axis or [Reference]:
В процессе формирования параллелепипед будет отображаться на экране желтыми

линиями.
 

Клин
 

Чтобы приступить к формированию клина (рис. 10.9), вызовите команду AI_WEDGE.
 

Рис. 10.9. Клин
Создание клина во многом схоже с построением параллелепипеда: при этом необхо-

димо указать аналогичные параметры.
После вызова команды AI_WEDGE появится приглашение:
Specify corner point of wedge:
Укажите координаты левого нижнего угла. Появится запрос:
Specify length of wedge:
Определите длину клина – размер вдоль оси X. Программа выдаст следующий запрос:
Specify width of wedge:
Задайте линейный размер по оси Y. Появится приглашение:
Specify height of wedge:
Укажите вертикальный размер клина. AutoCAD выдаст последний запрос:
Specify rotation angle of wedge about the Z axis:
В ответ укажите угол поворота клина в плоскости XY.

 
Пирамида

 
Команда AI_PYRAMID позволяет построить пирамиду (рис. 10.10).

 



А.  А.  Орлов.  «AutoCAD 2010»

323

Рис. 10.10. Пирамиды
После запуска команды появится первое приглашение:
Specify first corner point for base of pyramid:
Укажите координаты одной из угловых точек основания пирамиды. Появится следую-

щее приглашение:
Specify second corner point for base of pyramid:
Введите координаты второй точки. Программа попросит указать координаты третьей

точки:
Specify third corner point for base of pyramid:
Задайте координаты третьей угловой точки. Появится очередной запрос:
Specify fourth corner point for base of pyramid or [Tetrahedron]:
В ответ на него можно указать четвертую точку основания. Если вам необходимо

построить пирамиду с треугольным основанием, выберите параметр Tetrahedron (пирамида
с треугольным основанием называется тетраэдром).

В зависимости от ответа на данный запрос построение пирамиды будет продолжаться
разными путями.

• Если вы указали четыре точки основания, то программа предложит указать точку
схода пирамиды:

Specify apex point of pyramid or [Ridge/Top]:
Можно выбрать параметр Ridge, чтобы путем указания двух точек построить пирамиду

с ребром в вершине. Параметр Top позволяет создать усеченную пирамиду.
• Если же вы собираетесь построить тетраэдр и, соответственно, выбрали параметр

Tetrahedron, то далее появится приглашение:
Specify apex point of tetrahedron or [Top]:
В ответ можно указать точку, служащую вершиной пирамиды, или, выбрав параметр

Top, построить усеченный тетраэдр.
Указание некоторых угловых точек пирамиды может быть непростой задачей, так как

обычно их абсолютные координаты неизвестны. Поэтому перед построением пирамиды вам,
возможно, понадобится выполнить вспомогательные построения.

 
Конус

 
С помощью команды AI_CONE можно построить полный или усеченный конус

(рис. 10.11).
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Рис. 10.11. Конусы
В первую очередь следует указать центр основания конуса в ответ на запрос:
Specify center point for base of cone:
После этого появится следующее приглашение:
Specify radius for base of cone or [Diameter]:
В ответ нужно задать радиус окружности, служащей нижним основанием конуса.

Выбрав параметр Diameter, можно задать диаметр основания.
Далее появится запрос:
Specify radius for top of cone or [Diameter] <0>:
Задайте радиус или диаметр (если ранее вы выбрали параметр Diameter) верхнего

основания конуса. Если нажать клавишу Enter, то будет выбрано значение по умолчанию
– 0 единиц, то есть будет создан полный конус. Ввод отличного от нуля значения создаст
усеченный конус.

После появления приглашения Specify height of cone: укажите высоту конуса. Про-
грамма выдаст следующий запрос:

Enter number of segments for surface of cone <16>:
Задайте количество сегментов, составляющих поверхность конуса. Большое значение

позволит более реалистично отобразить поверхность, однако и потребует большей произво-
дительности компьютера.

 
Сфера

 
Основными параметрами, которые следует указать при построении сферы (рис. 10.12),

являются центр и радиус (диаметр).
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Рис. 10.12. Сфера
Чтобы приступить к построению сферы, наберите в командной строке AI_SPHERE.

Сначала программа попросит указать центральную точку сферы:
Specify center point of sphere:
Помните, что в этом случае обязательно указывать все три координаты, иначе положе-

ние по оси Z будет принято за 0. Далее появится следующий запрос:
Specify radius of sphere or [Diameter]:
Задайте радиус сферы или, выбрав параметр Diameter, определите диаметр. AutoCAD

выдаст запрос:
Enter number of longitudinal segments for surface of sphere <16>:
В ответ можно задать количество меридианов, то есть линий, проходящих из верхней

центральной точки в нижнюю. Естественно, чем большее число вы укажете, тем более глад-
кой будет выглядеть поверхность.

Далее появится следующий запрос:
Enter number of latitudinal segments for surface of sphere <16>:
Задайте количество параллелей, служащих для отображения сферы.
Аналогично сфере строятся купол и чаша, так как они представляют собой верхнюю

и нижнюю половины сферы.
 

Купол
 

Чтобы построить купол (рис. 10.13), вызовите команду AI_DOME.
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Рис. 10.13. Купол
Первым приглашением команды будет следующее:
Specify center point of dome:
В ответ на него следует задать центр купола. Появится запрос:
Specify radius of dome or [Diameter]:
Задайте радиус купола. Следующие запросы предназначены для указания количества

меридианов и параллелей соответственно:
Enter number of longitudinal segments for surface of dome <16>:
Enter number of latitudinal segments for surface of dome <8>:

 
Чаша

 
Чаша является нижней половиной сферы (рис. 10.14), и ее построение начинается с

вызова команды AI_DISH.
 

Рис. 10.14. Чаша
После запуска команды появится приглашение:
Specify center point of dish:
Задайте центр купола. Далее программа выдаст следующий запрос:
Specify radius of dish or [Diameter]:
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Укажите радиус купола. После этого в ответ на запросы следует определить количество
меридианов и параллелей, составляющих поверхность чаши:

Enter number of longitudinal segments for surface of dish <16>:
Enter number of latitudinal segments for surface of dish <8>:

 
Тор

 
Интересную возможность предоставляет команда AI_TORUS: с ее помощью создается

тор – фигура, изображенная на рис. 10.15.
 

Рис. 10.15. Тор
После запуска команды AutoCAD попросит указать центральную точку тора:
Specify center point of torus:
Далее появится следующий запрос:
Specify radius of torus or [Diameter]:
Задайте радиус тора или, выбрав параметр Diameter, укажите его диаметр. Программа

выдаст запрос:
Specify radius of tube or [Diameter]:
В ответ укажите радиус или диаметр фигуры. Появится приглашение:
Enter number of segments around tube circumference <16>:
Укажите количество сегментов тора. Наконец, появится последнее приглашение:
Enter number of segments around torus circumference <16>:
Введите число, указывающее количество отрезков вдоль окружности тора.

 
Трехмерная сеть

 
Еще одной стандартной поверхностью, которую вы можете построить, является трех-

мерная сеть (рис. 10.16). Чтобы сформировать такую сеть, введите с клавиатуры команду
AI_MESH. Построение трехмерной сети во многом схоже с созданием сети с помощью
команды 3DMESH. Правда, команда AI_ MESH предоставляет значительно меньше параме-
тров. Все, что требуется указать, – это координаты четырех угловых точек и значения пара-
метров M и N. После этого трехмерная сеть сразу появится на чертеже.
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Рис. 10.16. Трехмерная сеть: M = 20, N = 10
Воспользовавшись данной командой, можно быстро создать трехмерную сеть доста-

точно большого размера, а затем уже с помощью маркеров подкорректировать положение
узловых точек.
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Создание отверстий

 
До сих пор вы создавали поверхности с помощью различных команд, однако ни разу не

сталкивались с формированием отверстий. Запомните, что если вы сформировали поверх-
ность с помощью одной из перечисленных выше команд, то создать в ней отверстие невоз-
можно. Поэтому отверстия необходимо создавать на этапе построения плоской грани. В
этом случае для построения поверхностей используется команда REGION, которая создает
область из выделенных объектов. Применяя к существующим областям операцию вычита-
ния, можно создать отверстия.

Рассмотрим процесс создания отверстия круглой формы в прямоугольной поверхности
(рис. 10.17).

 

Рис. 10.17. Прямоугольная область с отверстием
1. Для начала необходимо создать объекты, которые в дальнейшем определят границы

областей. В рассматриваемом случае это прямоугольник и круг.
2. Создадим области из существующих поверхностей. Для этого вызовите команду

REGION. Появится запрос:
Select objects:
3. Выделите окружность и нажмите клавишу Enter. Окружность превратится в

область, но на практике области можно считать поверхностями.
4. Повторно вызовите команду REGION, чтобы создать прямоугольную область.
5. Теперь необходимо вычесть из прямоугольной области круглую. Для этого наберите

в командной строке команду SUBTRACT или щелкните на одноименной кнопке
 

в группе Solid Editing (Редактирование тел) на вкладке Home (Основная) ленты.
Появится приглашение:

Select solids, surfaces, and regions to subtract from
...
Select objects:
6. Выберите объект, из которого в дальнейшем будет вычитаться другая область, и

нажмите клавишу Enter. Появится запрос:
Select solids, surfaces, and regions to subtract..
Select objects:
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Примечание
Команда SUBTRACT является одним из инструментов теоретико-

множественных операций, которые мы более подробно рассмотрим в
следующей главе.

7. Выберите окружность, то есть вычитаемый объект, и нажмите клавишу Enter.
На этом создание отверстия завершено. Чтобы увидеть изменения, можно выбрать

стиль визуализации Realistic (Реалистичный).
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Резюме

 
Прочитав эту главу, вы познакомились с трехмерными поверхностями. В AutoCAD

поверхности моделируются так называемыми сетями, способы создания которых мы и рас-
смотрели. Кроме того, можно сформировать поверхность путем создания трехмерных при-
митивов. Наиболее часто подобные поверхности применяются для отображения, например,
таких объектов, как гнутые профили и штампованные детали.
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Глава 11

Твердотельные модели
 

• Создание типовых тел
• Выдавливание тел
• Тела вращения
• Сложные объемные тела
• Основы редактирования трехмерных моделей
• Резюме
Кроме каркасных моделей, которые могут строиться с помощью обычных команд двух-

мерного черчения, и поверхностей, рассмотренных в предыдущей главе, в AutoCAD можно
создавать твердые тела, хранящие наиболее полную информацию о формируемом объекте.
Создавать тела даже проще, чем остальные модели. Кроме того, применение объемных моде-
лей позволяет получать более реалистичные чертежи.

Все основные кнопки для работы с твердотельными моделями можно найти в груп-
пах Modeling (Моделирование) (см. рис. 10.1) и Solid Editing (Редактирование тел) вкладки
Home (Основная) ленты, чтобы не обращаться к меню Draw → Modeling (Черчение →
Моделирование) или Modify → Solid Editing (Редактирование → Редактирование тел).
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Создание типовых тел

 
Построение типовых объемных тел во многом схоже с созданием типовых поверхност-

ных моделей, рассмотренным в предыдущей главе.
Чтобы построить одну из типовых объемных моделей, необходимо воспользоваться

меню Draw → Modeling (Черчение → Моделирование), кнопками в группе Modeling (Моде-
лирование) ленты или кнопками на панели инструментов Modeling (Моделирование). Для
создания трехмерных тел предназначены следующие кнопки (пункты меню): Box (Паралле-
лепипед), Wedge (Клин), Cone (Конус), Sphere (Шар), Cylinder (Цилиндр), Pyramid (Пира-
мида), Torus (Тор) и Polysolid (Полисолид).

 
Параллелепипед

 
Параллелепипед (рис. 11.1) является одной из фигур, которые приходится строить наи-

более часто. Чтобы приступить к его созданию, вызовите команду BOX, выполнив команду
меню Draw → Modeling → Box (Черчение → Моделирование → Параллелепипед) или же
щелкнув на кнопке Box (Параллелепипед) в группе Modeling (Моделирование) на вкладке
Home (Основная) ленты.

 

Рис. 11.1. Параметры параллелепипеда
В командной строке появится первое приглашение:
Specify first corner or [Center]:
В ответ необходимо указать координаты одной из вершин параллелепипеда. Если

выбрать параметр Center, то программа попросит задать центр параллелепипеда. Центр зада-
ется во всех трех измерениях, поэтому не забывайте указывать и координату z, иначе точка
будет расположена в плоскости XY.

Далее появится следующий запрос:
Specify other corner or [Cube/Length]:
Укажите противоположную точку основания параллелепипеда. Кроме того, можно

выбрать один из двух параметров.
• Воспользовавшись параметром Cube, вы сможете построить куб, указав всего один

линейный размер в ответ на приглашение Specify length:. Еще до определения размера куба
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можно соответствующим образом повернуть его в плоскости XY с помощью мыши, причем
построение примитива на этом и завершится.

• Если выбрать параметр Length, то программа сначала попросит указать длину парал-
лелепипеда, а затем ширину создаваемого объекта.

В ответ на последний запрос необходимо задать высоту параллелепипеда:
Specify height or [2Point] <0.0000>:
Если выбрать параметр 2Point, то высоту можно задать путем вычисления расстояния

между двумя определенными точками.
 

Клин
 

Чтобы приступить к построению клина, вызовите команду WEDGE, щелкнув на одно-
именной кнопке в группе Modeling (Моделирование) на вкладке Home (Основная) ленты
или выполнив команду меню Draw → Modeling → Wedge (Черчение → Моделирование →
Клин). Пример клина, построенного с помощью этой команды, показан на рис. 11.2. Обра-
тите внимание, что клин представляет собой половину параллелепипеда, то есть из двух
одинаковых клиньев всегда можно составить параллелепипед.

 

Рис. 11.2. Параметры клина
После запуска команды в командной строке появится приглашение:
Specify first corner or [Center]:
В ответ необходимо указать координаты одной из вершин клина. Если выбрать пара-

метр Center, то программа попросит задать центр клина. Не забывайте указывать и коорди-
нату z, иначе точка будет расположена в плоскости XY.

Далее появится следующий запрос:
Specify other corner or [Cube/Length]:
Укажите противоположную точку основания клина или выберите один из двух доступ-

ных параметров.
• Воспользовавшись параметром Cube, вы сможете построить клин, все перпендику-

лярные стороны которого будут равны, то есть клин будет представлять собой половину
куба. Указав всего один линейный размер, в ответ на приглашение:

Specify length <0.0000>:
задайте длины сторон клина. Построение примитива на этом завершится. Прежде чем

определить размер клина, можно соответствующим образом повернуть его в плоскости XY
с помощью мыши.

• Если выбран параметр Length, то программа сначала попросит указать длину клина,
а затем его ширину.
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В ответ на последнее приглашение команды задайте высоту клина:
Specify height or [2Point] <0.0000>:
Выбрав параметр 2Point, можно задать высоту путем вычисления расстояния между

двумя определенными точками.
 

Конус
 

Команда CONE позволяет построить прямой конус с окружностью или эллипсом в
основании. Данная команда также дает возможность создавать не только полный, но и усе-
ченный конус (рис. 11.3).

 

Рис. 11.3. Параметры конуса
Чтобы приступить к построению конуса, выполните команду меню Draw → Modeling

→ Cone (Черчение → Моделирование → Конус) или щелкните на кнопке Cone (Конус) в
группе Modeling (Моделирование) на вкладке Home (Основная) ленты.

Появится запрос:
Specify center point of base or [3P/2P/Ttr/Elliptical]:
Укажите координаты центральной точки основания конуса или выберите один из пара-

метров, чтобы задать конфигурацию основания каким-либо другим способом.
• Выберите параметр 3P, чтобы задать основание конуса путем определения трех точек

окружности.
• Параметр 2P позволяет задать размеры основания, указав координаты двух диаме-

трально противоположных точек на окружности.
• Параметр Ttr предоставляет возможность создать круглое основание конуса путем

указания двух касательных к окружности и значения ее радиуса. Касательные линии должны
существовать на чертеже до вызова команды создания конуса.

• Выбрав параметр Elliptical, вы сможете создать в качестве основания эллипс. В этом
случае необходимо задать большую и малую оси эллипса, а при желании еще и указать центр
эллиптического основания.

Если вы не выбирали дополнительный параметр, а просто указали центральную точку
основания, то появится запрос:

Specify base radius or [Diameter]:
В ответ необходимо ввести радиус или, выбрав параметр Diameter, определить диаметр

круга в основании конуса. Появится запрос:
Specify height or [2Point/Axis endpoint/Top radius] <0.0000>:
Задайте высоту или определите пространственное положение конуса, выбрав один из

параметров.
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• При выборе параметра 2Point высота будет равна расстоянию между двумя указан-
ными точками. Основание конуса будет параллельно плоскости XY.

• Выберите параметр Axis endpoint, чтобы указать координаты верхней точки конуса.
Таким образом можно построить прямой конус, наклоненный к плоскости XY.

• При выборе параметра Top radius введите значение радиуса верхнего основания усе-
ченного конуса в ответ на приглашение:

Specify top radius <0.0000>:
Если нажать клавишу Enter, выбрав тем самым значение 0, установленное по умолча-

нию, то будет построен не усеченный, а полный конус. После указания радиуса верхнего
основания программа выдаст запрос:

Specify height or [2Point/Axis endpoint] <0.0000>:
В ответ укажите высоту конуса.

 
Шар

 
Построение шара (рис. 11.4) выполняется очень просто, так как необходимо указать

минимальное количество параметров.
 

Рис. 11.4. Шар
Чтобы приступить к построению шара, выполните команду меню Draw → Modeling

→ Sphere (Черчение → Моделирование → Шар) или нажмите кнопку Sphere (Шар) в группе
Modeling (Моделирование) на вкладке Home (Основная) ленты. Так вы запустите команду
SPHERE, а в командной строке появится первый запрос:

Specify center point or [3P/2P/Ttr]:
Укажите центральную точку шара или выберите один из параметров.
• Выбрав параметр 3P, можно создать шар, указав любые три точки, лежащие на его

поверхности.
• Параметр 2 P позволяет определить размеры шара, указав координаты двух диаме-

трально противоположных точек.
• Параметр Ttr предоставляет возможность создать шар путем указания двух касатель-

ных к нему и значения радиуса. Касательные должны существовать на чертеже до вызова
команды создания шара.

Далее появится следующий запрос:
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Specify radius or [Diameter] <0.0000>:
Укажите радиус или выберите параметр Diameter, чтобы задать диаметр шара.

 
Цилиндр

 
Еще одной типовой фигурой является цилиндр (рис. 11.5). Как и в случае с конусом,

основанием цилиндра может быть как окружность, так и эллипс.
 

Рис. 11.5. Параметры цилиндра
Построение цилиндра начинается с вызова команды CYLINDER щелчком на одно-

именной кнопке в группе Modeling (Моделирование) на вкладке Home (Основная) ленты
или выполнением команды меню Draw → Modeling → Cylinder (Черчение → Моделирова-
ние → Цилиндр). Внешне цилиндр похож на конус, поэтому при его построении необходимо
задать практически те же параметры.

После запуска команды появится приглашение:
Specify center point of base or [3P/2P/Ttr/Elliptical]:
Укажите координаты центральной точки основания цилиндра или выберите один из

параметров, чтобы задать конфигурацию основания каким-либо другим способом.
• Выберите параметр 3P, чтобы задать основание цилиндра путем определения трех

точек окружности.
• Параметр 2P позволяет определить размеры основания, указав координаты двух диа-

метрально противоположных точек окружности.
• Параметр Ttr предоставляет возможность создать круглое основание цилиндра путем

указания двух касательных к окружности и значения ее радиуса. Касательные линии должны
существовать на чертеже до вызова команды создания цилиндра.

• Выбрав параметр Elliptical, вы сможете создать в качестве основания эллипс. В этом
случае необходимо задать большую и малую оси эллипса, а при желании также указать центр
эллиптического основания.

Если вы не выбрали дополнительный параметр, а просто указали центральную точку
основания, то появится запрос:

Specify base radius or [Diameter] <0.0000>:
Введите радиус или, выбрав параметр Diameter, определите диаметр круга в основании

цилиндра. Появится последний запрос:
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Specify height or [2Point/Axis endpoint] <0.0000>:
Вы можете указать высоту или определить наклон цилиндра, выбрав один из следую-

щих параметров.
• При выборе параметра 2Point высота будет равна расстоянию между двумя указан-

ными точками, а основание цилиндра – параллельно плоскости XY.
• Выберите параметр Axis endpoint, чтобы указать координаты центральной точки

верхнего основания. Так можно построить цилиндр, который будет наклонен к плоскости XY.
 

Пирамида
 

Команда PYRAMID позволяет создавать пирамидальные тела различной конфигура-
ции (рис. 11.6). Основанием пирамиды служит правильный многоугольник.

 

Рис. 11.6. Пирамиды
Приступая к созданию пирамиды, щелкните на кнопке Pyramid (Пирамида) в группе

Modeling (Моделирование) на вкладке Home (Основная) ленты или выполните команду
меню Draw → Modeling → Pyramid (Черчение → Моделирование → Пирамида).

После запуска команды появится запрос:
Specify center point of base or [Edge/Sides]:
Введите координаты центральной точки основания пирамиды или выберите один из

параметров.
• Выберите параметр Edge, если хотите определить конфигурацию основания пира-

миды, задав координаты двух соседних угловых точек многоугольника.
• Параметр Sides служит для определения количества сторон многоугольника в осно-

вании пирамиды. По умолчанию создается пирамида с квадратом в основании, то есть дан-
ному параметру присвоено значение 4.

Если на предыдущем этапе вы указали центр пирамиды, то появится запрос:
Specify base radius or [Inscribed]:
Необходимо указать радиус окружности, вписанной в многоугольник, то есть окруж-

ности, для которой все стороны многоугольника будут являться касательными. Можно также
выбрать параметр Inscribed и в ответ на запрос:

Specify base radius or [Circumscribed]:
указать радиус мнимой окружности, проходящей через все вершины основания мно-

гоугольника.
Последний запрос команды выглядит следующим образом:
Specify height or [2Point/Axis endpoint/Top radius]:
Задайте высоту пирамиды или выберите один из параметров.
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• 2Point – высота будет равной расстоянию между двумя указанными точками. При
этом основание пирамиды расположится параллельно плоскости XY.

• Выберите параметр Axis endpoint, чтобы указать координаты верхней точки пира-
миды.

• Выбрав параметр Top radius, введите значение радиуса верхнего основания усечен-
ной пирамиды в ответ на приглашение Specify top radius <0.0000>:. Обратите внимание,
что здесь указывается радиус вписанной или описанной окружности в зависимости от того,
какая окружность была указана для нижнего основания. Если нажать клавишу Enter, выбрав
тем самым значение 0, установленное по умолчанию, будет построена полная пирамида.
После указания радиуса верхнего основания программа выдаст запрос:

Specify height or [2Point/Axis endpoint]:
В ответ необходимо указать высоту пирамиды.

 
Тор

 
Тор – это тело, которое можно сравнить с обручем или пространственным кольцом

(рис. 11.7).
 

Рис. 11.7. Виды торов
Тор можно построить с помощью команды TORUS, которую вызывают щелчком на

кнопке Torus (Тор) в группе Modeling (Моделирование) на вкладке Home (Основная) ленты
или выполнением команды меню Draw → Modeling → Torus (Черчение → Моделирование
→ Тор).

Появится приглашение:
Specify center point or [3P/2P/Ttr]:
Укажите центральную точку тора или выберите один из параметров.
• Параметр 3P позволяет сразу задать окружность, указав три ее произвольные точки.
• Выбрав параметр 2P, укажите две диаметрально противоположные точки окружности

тора.
• При выборе параметра Ttr окружность тора определяется путем задания двух каса-

тельных и величины радиуса.
Если на предыдущем этапе был определен центр тора, то появится запрос:
Specify radius or [Diameter] <0.0000>:
Задайте радиус или диаметр тора.
Следующим шагом является определение размеров трубы тора. Появится приглаше-

ние:
Specify tube radius or [2Point/Diameter]:
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Введите радиус тора или, воспользовавшись параметром Diameter, укажите диаметр
трубы тора. Параметр 2Point позволяет задать размеры трубы указанием координат двух
внешних точек диаметра.

Путем манипулирования радиусами тора и его трубки можно получить тела, мало
напоминающие стандартный бублик.

 
Полисолид

 
Еще одной новой фигурой, создаваемой в AutoCAD, является полисолид (рис. 11.8).

По сути, он представляет собой полилинию, но имеющую еще и ширину и высоту, поэтому
его построение во многом схоже с созданием полилинии. Кроме того, получить полисолид
можно путем преобразования таких объектов, как линия, двухмерная полилиния, окруж-
ность и дуга.

 

Рис. 11.8. Полисолид
Чтобы создать полисолид, вызовите команду POLYSOLID, щелкнув на кнопке

Polysolid (Полисолид) в группе Modeling (Моделирование) на вкладке Home (Основная)
ленты или выполнив команду меню Draw → Modeling → Polysolid (Черчение → Модели-
рование → Полисолид).

В командной строке появится приглашение:
Specify start point or [Object/Height/Width/Justify] <Object>:
Задайте начальную точку или выберите один из предлагаемых параметров.
• Параметр Object позволяет создать полисолид из имеющихся объектов. После выбора

этого параметра появится предложение выбрать объект, преобразовываемый в полисолид.
• Если вы собираетесь задать определенную высоту объекта, воспользуйтесь параме-

тром Height. Высоту следует указывать именно на этом этапе.
• Ширину создаваемого объекта задают, выбрав параметр Width. Так же, как и в случае

с высотой, переопределить этот параметр в дальнейшем не удастся, поэтому задавать его
следует перед началом построения.

• Выбрав параметр Justify, можно определить, где будет расположена начальная точка
– на левой, правой кромке или по центру.

Далее программа предложит указать следующую точку:
Specify next point or [Arc/Undo]:
По умолчанию полисолид формируется из прямолинейных объектов, однако, выбрав

параметр Arc, можно создать дуговой сегмент.
Появится следующее приглашение:
Specify endpoint of arc or [Close/Direction/Line/Second point/Undo]:
Создайте дугу путем указания ее конечной точки или выберите один из параметров.
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• Выбор параметра Close завершает построение полисолида путем соединения послед-
ней точки текущего сегмента и самой начальной точки. При этом между первой и последней
точками не должно быть других сегментов, иначе замкнуть полисолид не удастся.

• С помощью параметра Direction вы сможете указать направление дуги в начальной
точке.

• Выбрав параметр Line, вы вернетесь к построению прямолинейного сегмента.
• Параметр Second point задает вторую точку дуги.
• Отменить создание последнего сегмента (прямого или дугообразного) можно с помо-

щью параметра Undo.
После указания всех последующих точек нажмите клавишу Enter, чтобы завершить

построение полисолида.
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Выдавливание тел

 
Для получения объемных тел путем выдавливания различных двухмерных объектов

применяется команда EXTRUDE. Данную операцию часто называют экструзией. Исход-
ными объектами в данном случае могут быть полилинии, окружности, эллипсы, дуги, элли-
птические дуги, кольца, области, сплайны, линии, плоские трехмерные поверхности, плос-
кие грани тел. При этом результат экструзии зависит от того, является исходный объект
замкнутым или нет. Если форма замкнутая, то итогом выдавливания будет тело (рис. 11.9);
если же применяется незамкнутый профиль, то получится поверхностный объект.

 

Рис. 11.9. Тело, полученное выдавливанием окружности вдоль сплайна
Вызовите команду extrude, выполнив команду меню Draw → Modeling → Extrude

(Черчение → Моделирование → Экструзия) или воспользовавшись кнопкой Extrude (Экс-
трузия) в группе Modeling (Моделирование) на вкладке Home (Основная) ленты.

Появится приглашение:
Select objects to extrude:
Последовательно укажите объекты, которые послужат для выдавливания. За один

прием можно выполнить экструзию нескольких объектов, как замкнутых, так и незамкну-
тых. Главное, чтобы при этом применялись одинаковые параметры. Таким образом, за одну
операцию можно получить одновременно и тела, и поверхности. Выделение объектов завер-
шается нажатием клавиши Enter.

Совет
Чтобы выделить для последующей экструзии грань

существующего тела, нажмите и удерживайте клавишу Ctrl, а затем
щелкните кнопкой мыши на нужном объекте.

Следующий запрос программы предлагает задать высоту экструзии:
Specify height of extrusion or [Direction/Path/Taper angle] <0.0000>:
По умолчанию экструзия осуществляется перпендикулярно к плоскости исходного

объекта, но это ограничение можно обойти, воспользовавшись дополнительными параме-
трами.

• Параметр Direction задает направление выдавливания. Для этого необходимо указать
две точки, которые зададут вектор экструзии.
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• Воспользовавшись параметром Path, можно выдавить исходную форму вдоль любой
направляющей, которой может быть отрезок, окружность, эллипс, дуга, сплайн или полили-
ния. При этом объект, задающий направление выдавливания, не должен находиться в одной
плоскости с профилем экструзии.

• Выбрав параметр Taper angle, можно задать значение угла конусности, введя его в
ответ на приглашение:

Specify angle of taper for extrusion <0>:
В этом случае грани создаваемого объекта будут сходиться, если задан положительный

угол. Если же ввести отрицательный угол конусности, то объект будет расширяться. Задав
слишком большой положительный угол, можно получить профиль, сходящийся в одну точку.
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Тела вращения

 
С помощью команды REVOLVE можно создать трехмерные объекты путем вращения

образующей кривой вокруг заданной оси. Как и в случае экструзии объектов, в качестве
образующей кривой используются полилинии, окружности, эллипсы, дуги, эллиптические
дуги, кольца, области, сплайны, линии, плоские трехмерные поверхности, плоские грани
тел. При этом итоговый объект – тело или поверхность – зависит от того, будет ли исходный
объект соответственно замкнутым или разомкнутым.

На рис. 11.10 показан объект, полученный путем поворота прямоугольника вокруг вер-
тикальной оси. Обратите внимание, что тело получилось незамкнутым, так как был указан
угол вращения меньше 360°.

 

Рис. 11.10. Тело вращения
Чтобы создать объемное тело вращения, щелкните на кнопке Revolve (Вращение)

в группе Modeling (Моделирование) на вкладке Home (Основная) ленты или выполните
команду меню Draw → Modeling → Revolve (Черчение → Моделирование → Вращение).

После запуска команды программа выдаст запрос:
Select objects to revolve:
Необходимо выбрать исходные объекты, предназначенные для создания тел вращения.

Нажмите клавишу Enter, после того как завершите выбор объектов. Появится следующий
запрос:

Specify axis start point or define axis by [Object/X/Y/Z] <Object>:
Укажите первую – начальную, а затем и вторую – конечную – точки оси вращения.
• Можно нажать клавишу Enter, выбрав тем самым параметр Object, который позволяет

задать в качестве оси вращения линию, полилинию, линейную кромку поверхности или тела.
При этом следует помнить, что за начало оси вращения будет принят конец объекта, ближе к
которому вы щелкнете кнопкой мыши. Соответственно этому будет задано положительное
направление вращения – по часовой стрелке, если смотреть со стороны начала оси вращения.

• Параметры X, Y и Z позволяют задать в качестве оси вращения осьX, Y или Z текущей
ПСК соответственно. В этом случае положительное направление оси вращения совпадает с
направлением выбранной оси системы координат.

В ответ на запрос:
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Specify angle of revolution or [STart angle] <3 60>:
задайте угол вращения или нажмите клавишу Enter, чтобы принять значение по умол-

чанию 360°, создав замкнутый объект. Заметим, что определение направления оси вращения
имеет значение только тогда, когда задается угол вращения меньше 360°. Воспользовавшись
параметром STart angle, можно задать угол, со смещения на который начнется вращение.
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Сложные объемные тела

 
Вы уже научились создавать твердотельные примитивы, однако реальные объекты

обычно имеют более сложную форму. Такие сложные конструкции представляют собой
сочетания трехмерных примитивов, созданные путем применения теоретико-множествен-
ных операций. По аналогии с логическими функциями эти операции также называют буле-
выми.

При создании объектов применяются три команды:
• UNION – создает тело на основе объединения выделенных объектов;
• SUBTRACT – вычитает одни тела из других;
• INTERSECT – тело создается на основе общей части выбранных тел.

Совет
После применения перечисленных команд исходные объекты

удаляются. Поэтому, если вы планируете использовать эти объекты,
предварительно скопируйте их в другое место на чертеже.

 
Объединение

 
Чтобы создать тело путем объединения нескольких, воспользуйтесь командой UNION.

Если исходные тела соприкасаются или пересекаются, то получится единое тело, а если тела
располагаются отдельно, то после применения команды UNION они будут выделяться как
один объект.

Результат объединения двух параллелепипедов показан на рис. 11.11. Обратите вни-
мание, что справа на рисунке ребра не проходят внутри объекта, так как теперь эта модель
представляет собой одно-единственное тело, а не самостоятельные параллелепипеды, как
это было до объединения.

 

Рис. 11.11. Объединение двух параллелепипедов
Итак, щелкните на кнопке Union (Объединение)
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в группе Solid Editing (Редактирование тел) на вкладке Home (Основная) ленты или
выполните команду Modify → Solid Editing → Union (Редактирование → Редактирование
тел → Объединение). Появится запрос:

Select objects:
Выделите объединяемые объекты. При этом последовательность, в которой будут

выбираться тела, не имеет никакого значения: от перемены мест слагаемых сумма не меня-
ется. Нажмите клавишу Enter, чтобы завершить выполнение команды.

 
Вычитание

 
Команда SUBTRACT создает новый объект методом вычитания одного множества тел

из другого. Мы уже касались данной команды при получении отверстий в областях. При-
менительно к твердотельным моделям данная команда в основном также используется для
создания отверстий, хотя, конечно же, это не догма.

Результатом вычитания цилиндра из параллелепипеда, показанных на рис. 11.12, явля-
ется тело с круглым отверстием.

 

Рис. 11.12. Круглое отверстие, полученное путем вычитания
Чтобы вычесть одно тело из другого, щелкните на кнопке Subtract (Вычитание)

 

в группе Solid Editing (Редактирование тел) на вкладке Home (Основная) ленты или
выполните команду меню Modify → Solid Editing → Subtract (Редактирование → Редакти-
рование тел → Вычитание).

После вызова команды вычитания появится первое приглашение:
Select solids, surfaces, and regions to subtract from..
Select objects:
Выделите объект, из которого нужно вычесть другие тела, а затем нажмите клавишу

Enter.
Появится следующее приглашение:
Select solids, surfaces, and regions to subtract..
Select objects:
Укажите вычитаемый объект и нажмите клавишу Enter.
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Пересечение

 
Команда INTERSECT позволяет создать новое тело, выделив общую часть заданных

объектов. При этом исходные тела после выполнения команды удаляются. Результат приме-
нения операции пересечения к цилиндру и параллелепипеду показан на рис. 11.13.

 

Рис. 11.13. Тело, полученное в результате применения команды пересечения
Чтобы начать формирование нового тела с помощью команды INTERSECT, щелкните

на кнопке Intersect (Пересечение)
 

в группе Solid Editing (Редактирование тел) на вкладке Home (Основная) ленты или
выполните команду Modify → Solid Editing → Intersect (Редактирование → Редактирование
тел → Пересечение).

Появится приглашение:
Select objects:
Выделите исходные объекты в любой последовательности и нажмите клавишу Enter,

чтобы создать новое тело. Обратите внимание: если исходные объекты не пересекаются, то
есть расположены на расстоянии или даже просто соприкасаются, они не будут иметь общей
части, и поэтому результатом применения команды INTERSECT будет удаление выделенных
тел.
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Основы редактирования трехмерных моделей

 
Трехмерные объекты, как и двухмерные, можно легко видоизменять с помощью

команд редактирования. Все команды редактирования, применяемые на плоскости, так или
иначе могут быть использованы и в трехмерном пространстве. Основным отличием явля-
ется поворот объекта, создание зеркальной копии и трехмерного массива. Во многом эти
команды схожи со своими двухмерными аналогами, однако редактирование происходит в
трех измерениях. Поэтому, например, зеркальная копия объекта в трехмерном пространстве
создается относительно плоскости, а не линии, как это было ранее.

 
Зеркальное отражение

 
Если вы собираетесь создать зеркальное отражение трехмерного объекта относи-

тельно прямой, лежащей в плоскости XY, то по-прежнему можно воспользоваться командой
MIRROR. В противном случае необходимо применить команду 3DMIRROR, создающую
отражение объектов относительно плоскости.

На рис. 11.14 показан объект, полученный путем зеркального отражения одного объ-
екта относительно другого.

 

Рис. 11.14. Применение команды 3DMIRROR
Чтобы создать зеркальную копию объекта, нажмите кнопку 3D Mirror (Трехмерное

зеркало)
 

в группе Modify (Редактирование) на вкладке Ноте (Основная) ленты или выполните
команду меню Modify → 3D Operations → 3D Mirror (Редактирование → Трехмерные опе-
рации → Трехмерное зеркало).

Появится запрос:
Select objects:
Выделите объекты, для которых требуется создать зеркальную копию. Если выделить

объекты до вызова команды, то программа сразу выдаст следующее приглашение:
Specify first point of mirror plane (3 points) or [Object/Last/Zaxis/View/XY/YZ/ZX/3points]

<3points>:
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В этом запросе AutoCAD предлагает определить плоскость зеркального отражения
одним из следующих методов.

• С помощью параметра Object можно выбрать объект на чертеже, который послужит
плоскостью отражения.

• Параметр Last возвращает последнюю используемую точку зеркального отражения.
• Параметр Zaxis позволяет определить плоскость отражения, задав некоторую ось Z

путем указания двух точек, принадлежащих данной оси. Отражение в этом случае происхо-
дит относительно плоскости XY, которая перпендикулярна заданной оси Z.

• Параметр View определяет плоскость сечения, проходящую через заданную точку
параллельно текущему виду.

• Параметры XY, YZ и ZX позволяют определить плоскость, параллельную плоскостям
XY, YZ и ZX соответственно и проходящую через заданную точку.

• Параметр 3points, выбранный по умолчанию, создает плоскость отражения по трем
указанным точкам.

В ответ на вопрос Delete source objects? [Yes/No] <N>: нажмите клавишу Enter, если
желаете сохранить исходные объекты, или выберите параметр Yes, если необходимо зер-
кально переместить объекты.

 
Трехмерный массив

 
Для создания трехмерного массива используется команда 3DARRAY. Как и на плос-

кости, в трехмерном пространстве можно создать два типа массива – прямоугольный и
круговой. Только при формировании прямоугольного массива в качестве дополнительного
параметра необходимо указать количество уровней, а при формировании в трехмерном про-
странстве кругового массива объекты поворачиваются вокруг оси, а не вокруг точки, как это
было на плоскости.

 
Прямоугольный массив

 
В трехмерном пространстве, кроме строк и столбцов, в прямоугольном массиве доба-

вляются еще и уровни.
Чтобы создать трехмерный прямоугольный массив, нажмите кнопку 3D Array (Трех-

мерный массив)
 

в группе Modify (Редактирование) на вкладке Ноте (Основная) ленты или выполните
команду Modify → 3D Operations → 3D Array (Редактирование → Трехмерные операции
→ Трехмерный массив). Программа выдаст запрос:

Select objects:
Выделите нужные объекты и нажмите клавишу Enter. Появится следующее пригла-

шение:
Enter the type of array [Rectangular/Polar] <R>:
Выберите параметр Rectangular, так как вы создаете прямоугольный массив. Появится

запрос:
Enter the number of rows (–) <1>:
Введите общее количество строк (вдоль оси X) и нажмите клавишу Enter. AutoCAD

выдаст следующий запрос:
Enter the number of columns (|||) <1>:
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Введите общее количество столбцов и нажмите клавишу Enter. Столбцы задаются
вдоль оси Y. Так как массив создается в трех измерениях, программа выдаст приглашение:

Enter the number of levels (…) <1>:
В ответ необходимо задать общее количество уровней – ячеек массива по вертикали.

Появится запрос:
Specify the distance between rows (–):
Задайте расстояние между строками. Появится еще один запрос:
Specify the distance between columns (|||):
Введите расстояние между столбцами. Наконец, появится последнее приглашение про-

граммы:
Specify the distance between levels (…):
Введите расстояние между столбцами и нажмите клавишу Enter, чтобы завершить

формирование трехмерного прямоугольного массива.
На рис. 11.15 показан массив, в котором количество строк и столбцов равно 2, а коли-

чество уровней – 3.
 

Рис. 11.15. Прямоугольный массив
 

Круговой массив
 

Для того чтобы создать круговой трехмерный массив, нажмите кнопку 3D Array (Трех-
мерный массив)

 

в группе Modify (Редактирование) на вкладке Ноте (Основная) ленты или выполните
команду Modify → 3D Operations → 3D Array (Редактирование → Трехмерные операции
→ Трехмерный массив).

Пример кругового массива, состоящего из шести объектов, приведен на рис. 11.16.
 



А.  А.  Орлов.  «AutoCAD 2010»

352

Рис. 11.16. Круговой массив
После запуска команды появится запрос:
Select objects:
Выделите нужные объекты и нажмите клавишу Enter. Если изначально выбрать объ-

екты, а затем вызывать команду 3DARRAY, то сразу появится следующее приглашение:
Enter the type of array [Rectangular/Polar] <R>:
Выберите параметр Polar для создания кругового массива. Появится запрос:
Enter the number of items in the array:
Введите общее количество элементов массива. Программа выдаст следующий запрос:
Specify the angle to fill (+=ccw, -=cw) <360>:
Укажите угол массива. Появится приглашение:
Rotate arrayed objects? [Yes/No] <Y>:
Выберите параметр Yes, чтобы повернуть создаваемые объекты массива.
На завершающем этапе выполнения команды необходимо задать ось, вокруг которой

будут повернуты объекты. Появится запрос:
Specify center point of array:
Задайте первую точку оси. AutoCAD попросит ввести координаты второй точки оси:
Specify second point on axis of rotation:
Задайте вторую точку. Последовательность указания точек имеет решающее значение

для определения направления оси, а следовательно, и для направления угла поворота.
 

Поворот объектов
 

Команда 3DROTATE поворачивает заданные объекты вокруг определенной оси. Чтобы
повернуть объект, щелкните на кнопке 3D Rotate (Трехмерный поворот)
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в группе Modify (Редактирование) на вкладке Ноте (Основная) ленты или выполните
команду меню Modify → 3D Operations → 3D Rotate (Редактирование → Трехмерные опе-
рации → Трехмерный поворот). На рис. 11.17 продемонстрирован перевернутый конус.

 

Рис. 11.17. Конус перевернут
Как всегда, в ответ на приглашение Select objects: выделите объекты, которые необхо-

димо повернуть, и нажмите клавишу Enter. В итоге на экране появятся три обруча-окружно-
сти, расположенные во взаимно перпендикулярных плоскостях. Причем каждая из окруж-
ностей по цвету соответствует оси ПСК, вокруг которой будет происходить вращение при
выделении данной окруж ности. Появится следующий запрос:

Specify base point:
Задайте одну точку оси вращения. Программа выдаст запрос:
Pick a rotation axis:
Задайте ось вращения. Для этого нужно щелкнуть на окружности, в плоскости которой

необходимо повернуть объект. Например, если тело требуется повернуть вокруг оси Y, то
следует выделить зеленую окружность, которая расположена в плоскости, перпендикуляр-
ной оси Y. Заметим, что при наведении указателя на какую-либо окружность на экране сразу
отображается соответствующая ей ось вращения.

После определения оси вращения программа выдаст приглашение:
Specify angle start point or type an angle:
Введите значение угла с клавиатуры и нажмите клавишу Enter или задайте его с помо-

щью мыши.
 

Редактирование тел
 

Для редактирования трехмерных тел предназначена команда SOLIDEDIT. Она имеет
несколько уровней параметров. Рассмотрим три основные группы.

• Параметры группы Face позволяют редактировать грани твердотельного объекта.
Выбрав один из параметров этой группы, можно перемещать, удалять, поворачивать, копи-
ровать, изменять цвет граней и пр.

• С помощью группы параметров Edge можно копировать ребра и присваивать им
новый цвет.

• Параметры группы Body используют для редактирования тела целиком.
Сложности при выполнении данных команд могут возникнуть с выделением редакти-

руемых объектов. Поэтому, чтобы выделить нужную грань или ребро, удерживайте нажатой
клавишу Ctrl, а объекты выделяйте щелчками кнопкой мыши.

По сути, каждый параметр команды SOLIDEDIT является самостоятельной командой,
которую можно запустить из меню Modify → Solid Editing (Редактирование → Редактиро-
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вание тел) или воспользовавшись кнопками в группе Solid Editing (Редактирование тел) на
вкладке Home (Основная) ленты.

Тела можно редактировать не только с помощью команды SOLIDEDIT. Начиная с вер-
сии программы AutoCAD 2007, твердотельные модели стали параметрическими, поэтому
теперь изменять геометрические размеры тел можно также с помощью стандартной пали-
тры Properties (Свойства). Чтобы открыть данную палитру, достаточно выделить редакти-
руемое тело, а затем правой кнопкой мыши вызвать контекстное меню и выбрать в нем пункт
Properties (Свойства).

Все основные параметры, влияющие на размеры и положение тела, расположены в
разделе Geometry (Геометрия).

Как выглядит палитра Properties (Свойства), например, для параллелепипеда, можно
увидеть на рис. 11.18.

 

Рис. 11.18. Раздел Geometry (Геометрия) палитры Properties (Свойства) для параллеле-
пипеда

Обратите внимание, что в разделе Geometry (Геометрия) показано не только простран-
ственное расположение параллелепипеда, но и его линейные размеры по всем трем основ-
ным направлениям. Например, чтобы изменить размер объекта по оси X, достаточно ввести
новое значение в поле Length (Длина).
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Резюме

 
Создание больших твердотельных конструкций обычно начинается с формирования

твердотельных примитивов. Объемные тела можно также получать, выдавливая или вра-
щая двухмерные профили. Обычно сложные модели создают на основе существующих тел
с помощью операций объединения, вычитания и пересечения.

За некоторыми исключениями редактирование трехмерных объектов выполняется с
помощью тех же команд, которые применяются для модифицирования двухмерных объек-
тов. Хотя, конечно, существуют и команды редактирования, предназначенные только для
твердотельных объектов. Кроме того, такие тела являются параметрическими моделями,
поэтому изменять их геометрические размеры можно с помощью палитры свойств.
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Глава 12

Тонирование трехмерных объектов
 

• Создание источников света
• Работа с материалами
• Тонирование
• Резюме
Для представления модели в процессе работы применяют различные стили визуализа-

ции, которые мы рассмотрели в главе 9. Однако существует способ создать действительно
фотореалистичное изображение готовой модели — тонирование, при котором модель ото-
бражается с учетом различных оптических эффектов.

Работа по созданию тонированного изображения занимает не так уж много времени,
однако, чтобы создать более реалистичное изображение, необходимо добавить на модель
источники света, позволяющие создавать тени, присвоить объектам материалы, добавить
эффект тумана и пр. Обычно требуется выполнить несколько пробных вариантов, чтобы
получить действительно качественное изображение.
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Создание источников света

 
Все возможности для работы с источниками света предоставляет группа Lights (Осве-

щение) на вкладке Render (Тонирование) ленты. Кроме того, можно воспользоваться коман-
дами меню View → Render → Light (Вид → Тонирование → Освещение) или кнопками на
панели инструментов Lights (Освещение).

По умолчанию трехмерные модели в программе освещаются двумя удаленными источ-
никами света. Воспользовавшись ползунками Brithness (Яркость) и Contrast (Контраст) в
группе панели Lights (Освещение), можно изменить соответствующие параметры стандарт-
ного освещения. Однако в большинстве случаев таких настроек недостаточно, поэтому про-
грамма предоставляет возможность работать с различными световыми объектами.

В AutoCAD можно создать следующие основные источники света.
• Point (Точечный) – аналог обычной лампочки, свет от которой распространяется во

всех направлениях.
• Spot (Прожектор) – источник света, световой поток от которого идет в заданном

направлении.
• Distant (Удаленный) – источник света, размещенный на значительном расстоянии.
При добавлении на чертеж первого источника света программа спрашивает, следует

ли отключать освещение, присутствующее по умолчанию (рис. 12.1).
 

Рис. 12.1. Окно, появляющееся при создании первого источника света
Дело в том, что модель может освещаться только либо созданными пользователем све-

товыми источниками, либо освещением, присутствующим на чертеже по умолчанию.
Источники света разных типов создаются практически одинаково: задаются почти

одни и те же параметры. Поэтому сначала мы рассмотрим образование точечного источника
света с подробным описанием всех параметров, а при рассказе о двух оставшихся типах
источников затронем лишь их индивидуальные настройки.

 
Точечный источник света

 
Точечный источник света имитирует обычную лампочку. Свет от такого источника рас-

пространяется во всех направлениях. При этом интенсивность светового потока может осла-
бляться по мере удаления от источника, как это и происходит в жизни.
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Пример сцены, освещенной точечным источником света, расположенным слева сверху,
показан на рис. 12.2.

 

Рис. 12.2. Объекты, освещенные точечным источником света
Чтобы создать новый точечный источник света, нажмите кнопку Point (Точечный) в

группе Lights (Освещение) на вкладке Render (Тонирование) ленты, запустив тем самым
выполнение команды POINTLIGHT. Появится первый запрос:

Specify source location <0,0,0>:
Укажите расположение точечного источника света. Сделать это можно как путем зада-

ния нужных координат в командной строке, так и щелкнув в нужной точке модели. Во вто-
ром случае лучше использовать объектную привязку.

Появится следующий запрос:
Enter an option to change [Name/Intensity factor/Status/Photometry/shadoW/Attenuation/

filterColor/eXit] <eXit>:
Нажмите клавишу Enter, чтобы создать точечный источник света с параметрами по

умолчанию, или выберите один из параметров, если вы хотите более тонко настроить новый
световой источник.

• Выбрав параметр Name, необходимо ввести название создаваемого точечного источ-
ника света. Если вы планируете добавить несколько световых источников, то для каждого из
них лучше ввести какое-либо значимое имя, чтобы по названию можно было понять, что это
именно точечный источник света. Например, первому точечному источнику по умолчанию
будет присвоено название Pointlight1.

• Интенсивность света устанавливают с помощью параметра Intensity factor, после
выбора которого в командной строке появляется приглашение:

Enter intensity (0.00 – max float) <1>:
В ответ необходимо задать яркость или интенсивность света.
• После выбора параметра Status предоставляется возможность отключить создавае-

мый источник света. Для этого в ответ на запрос:
Enter status [oN/oFf] <On>:
выберите параметр oFf. Впоследствии вы сможете легко включить как все световые

объекты, так и какой-либо конкретный.
• Благодаря параметру Photometry можно создавать еще более реалистичные источ-

ники света (по умолчанию в программе используются именно фотометрические источники
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света). Если вы хотите использовать обычные световые источники, как в ранних версиях
AutoCAD, следует изменить значение системной переменной LIGHTINGUNITS на 0. Итак,
после появления приглашения:

Enter a photometric option to change [Intensity/ Color/eXit] <I>:
выберите один из параметров.
· Выбрав параметр Intensity, вы вызовете запрос:
Enter intensity (Cd) or enter an option [Flux/Illuminance] <1500>:
В ответ можно ввести силу испускаемого источником света, измеряемую в канделах.

С помощью параметра Flux задают световой поток в люменах, а параметр Illuminance пред-
назначен для определения освещенности, которая измеряется в люксах.

· Параметр Color служит для задания цвета источника света. В ответ на приглашение
Enter color name or enter an option [?/Kelvin] <D65>: нажмите клавишу Enter, чтобы выбрать
источник белого цвета D65. Можно также определить цветовую температуру в кельвинах,
выбрав параметр Kelvin.

• В реальной жизни все объекты, на которые падает свет, отбрасывают тени, поэтому
использование теней существенно повышает реалистичность изображения. Если вы хотите,
чтобы объекты, освещенные создаваемым источником света, отбрасывали тени, выберите
параметр shadoW. При этом становятся доступны следующие параметры.

· Off – отключение отображения теней, что значительно ускоряет работу.
· Sharp – тени отображаются с острыми гранями. Такие тени программа создает путем

трассировки лучей от источника света – тени вырисовываются там, где прохождение лучей
было блокировано каким-либо объектом. В итоге тени, полученные таким образом, имеют
контрастные края и могут передавать цвет от прозрачных и полупрозрачных объектов.

· Параметр soFtmapped позволяет создавать тени с размытыми краями на основе точеч-
ного рисунка – карты теней. При выборе этого параметра появляется запрос:

Enter map size [64/128/256/512/1024/2048/4096] <256>:
В ответ необходимо указать размер карты теней в пикселах. Чем больше размер, тем

менее зернистой будет выглядеть тень, но это, в свою очередь, замедляет процесс тонирова-
ния. Далее появится следующий запрос:

Enter softness (1-10) <1>:
Задайте мягкость тени. Значение в пределах от 1 до 10, которое предлагает выбрать

программа, – это количество переходных пикселов на границе тени и изображения. Обычно
используют цифры от 2 до 4, так как слишком большое значение делает тень размытой.

· Построение тени с помощью параметра softsAmpled во многом похоже на предыду-
щий случай, только здесь необходимо выбрать форму и размер тени с помощью параме-
тра Shape и задать зернистость рисунка после выбора параметра sAmples. Параметр Visible
определяет, будет ли видна форма тени при тонировании.

Различные виды теней показаны на рис. 12.3.
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Рис. 12.3. Типы теней
Тени с мягкими краями программа просчитывает быстрее, чем тени, созданные путем

трассировки лучей, но такие тени зависят от цвета прозрачных объектов.
• Параметр Attenuation определяет уменьшение интенсивности света с увеличением

расстояния от источника света. Это значит, что объекты, которые будут находиться дальше от
точечного источника, будут более темными. Выбор этого параметра приводит к появлению
запроса:

Enter an option to change [attenuation Type/Use limits/attenuation start Limit/attenuation
End limit/eXit] <eXit>:

В ответ можно настроить ослабление интенсивности светового потока. Возможны сле-
дующие варианты.

· После выбора параметра attenuation Type появится запрос:
Enter attenuation type [None/Inverse linear/inverse Squared] <None>:
В ответ можно нажать клавишу Enter, выбрав тем самым параметр None. В этом случае

затухания не будет, то есть объекты, находящиеся на различном расстоянии от источника,
будут освещены с одинаковой интенсивностью.

При выборе параметра Inverse linear интенсивность светового потока будет убывать
обратно пропорционально расстоянию от источника освещения. Например, на расстоянии
двух единиц от источника интенсивность равна половине исходной, а на расстоянии четырех
она будет составлять четвертую часть максимальной.

Если выбрать параметр inverse Squared, интенсивность светового потока будет убывать
обратно пропорционально квадрату расстояния от источника освещения до объекта. Объект,
находящийся на расстоянии двух единиц от источника, будет освещен в четыре раза слабее,
а на расстоянии четырех единиц интенсивность уменьшится уже в 16 раз.

· По умолчанию интенсивность светового потока ослабляется во всех точках простран-
ства модели. Однако освещаемые объекты могут находиться на таком большом расстоянии
от источника света, что уменьшения интенсивности не будет заметно, в то время как на рас-
чет ослабления света будут тратиться ресурсы. Чтобы такого не происходило, воспользуй-
тесь параметром attenuation End limit, позволяющим задать предельное расстояние от источ-
ника света, дальше которого интенсивность убывать не будет.

· С помощью параметра attenuation start Limit задают расстояние от источника света,
начиная с которого уменьшается интенсивность светового потока. По умолчанию этот пара-
метр равен нулю, то есть интенсивность начинает убывать с точки, в которой расположен
световой источник.

• Параметр filterColor позволяет задать цвет фильтра, накладываемого на источник
света. При этом результирующий цвет будет получен от цвета светового источника, который
был задан ранее, и цвета фильтра. После выбора параметра появится запрос:

Enter true color (R,G,B) or enter an option [Index color/ Hsl/colorBook] <2 55,255,255>:
В ответ необходимо задать цвет светового потока, что можно сделать несколькими спо-

собами.
· По умолчанию для указания цвета программа предлагает воспользоваться моделью

RGB, в которой цвет состоит из трех компонентов: красного, зеленого и синего. Таким обра-
зом, задавая значение каждого компонента в диапазоне от 0 до 255, можно получить нужный
цвет. Если оставить значение по умолчанию – 255,255,255, то свет, испускаемый источни-
ком, будет белым.

· Параметр Index color позволяет выбрать один из индексированных цветов в диапазоне
от 1 до 255.

· После выбора параметра Hsl появится запрос:
Enter HSL color (H,S,L) <0,0,100>:
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Введите необходимые значения оттенка, яркости и насыщенности цвета, которые опре-
деляют цвет в системе HSL. Оттенок или, попросту говоря, цвет задают в диапазоне от 0 до 3
60, яркость определяется от 0 до 100 и насыщенность также можно определить в интервале
от 0 до 100.

· При выборе параметра colorBook появится приглашение:
Enter Color Book Name:
В ответ необходимо ввести название книги цветов, после чего появится приглашение:
Enter the color name:
Введите название нужного цвета из выбранной ранее книги цветов.

Совет
Сразу задать нужный цвет с помощью командной строки, скорее

всего, получится лишь в том случае, если известны точные значения
определяющих параметров, что бывает очень редко. Однако вы можете
легко изменить цвет светового потока в процессе редактирования
источника света с помощью соответствующего диалогового окна. Это
относится не только к цвету, но и к остальным параметрам.

После настройки всех параметров в очередной раз нажмите клавишу Enter, чтобы
точечный источник появился на чертеже. Если вы не отключили световой источник прину-
дительно в процессе его формирования, то увидите на экране результат применения нового
освещения.

 
Создание прожектора

 
Создание прожектора во многом аналогично формированию точечного источника

света. Отличие состоит в том, что свет от прожектора распространяется не во все стороны,
а в заданном направлении в виде конуса. Поэтому в данном случае необходимо задать не
только расположение самого источника света, но еще и координаты целевой точки. Кроме
того, с помощью прожектора можно сформировать две области с различной яркостью: яркое
световое пятно, находящееся в центре, и окружающую его область с меньшей яркостью.

Объекты, освещенные прожектором, который расположен слева сверху, показаны на
рис. 12.4.
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Рис. 12.4. Объекты, освещенные прожектором
Чтобы создать новый прожектор, щелкните на кнопке Spot (Прожектор), запустив на

выполнение команду SPOTLIGHT. Появится приглашение:
Specify source location <0,0,0>:
Укажите расположение источника света. Сделать это можно как путем ввода нужных

координат в командной строке, так и щелкнув кнопкой мыши в нужной точке модели. Во
втором случае лучше использовать объектную привязку.

Далее появится запрос:
Specify target location <0,0,-10>:
Задайте расположение целевой точки. Появится запрос:
Enter an option to change [Name/Intensity factor/Status/Photometry/Hotspot/Falloff/

shadoW/Attenuation/filterColor/eXit] <eXit>:
Нажмите клавишу Enter, чтобы создать прожектор с настройками по умолчанию, или

выберите один из параметров для более тонкой настройки.
Рассмотрим настройки, которые необходимо сделать только при формировании про-

жектора. Диаграмма направленности прожектора представляет собой конус. В вершине
конуса расположен прожектор, от которого свет и распространяется в пределах этого мни-
мого конуса. Поэтому при формировании прожектора, кроме диаграммы направленности,
которую мы задали на втором шаге, указывая целевую точку, необходимо определить угол
раскрытия конуса – объемный угол в вершине конуса. Однако на самом деле таких мни-
мых конусов от прожектора исходит два: один с меньшим углом раскрытия и максимальной
интенсивностью создает на объекте наиболее светлое пятно, а второй, с несколько большим
углом раскрытия (углом полного светового конуса) и меньшей интенсивностью, формирует
вокруг светлого пятна область с чуть меньшей освещенностью.

Рассмотрим параметры, отвечающие за эти настройки.
• Чтобы определить угол максимальной интенсивности, выберите параметр Hotspot.

Появится приглашение:
Enter hotspot angle (0.00-160.00) <45>:



А.  А.  Орлов.  «AutoCAD 2010»

363

Введите нужное значение в интервале от 0 до 160 или нажмите клавишу Enter, чтобы
оставить значение по умолчанию.

• После выбора параметра Falloff, служащего для задания угла полного светового
конуса, появится запрос:

Enter falloff angle (0.00-160.00) <50>:
Задайте угол в пределах от 0 до 160 или нажмите клавишу Enter, чтобы принять зна-

чение по умолчанию 50°.
Угол полного светового потока должен быть больше угла максимальной интенсив-

ности. Поэтому если ошибочно ввести значение параметра Hotspot равным или меньшим
Falloff, программа автоматически изменит углы таким образом, что угол полного светового
потока будет на единицу больше угла максимальной интенсивности. Например, если оста-
вить значение Hotspot по умолчанию равным 45, а параметру Falloff присвоить значение 30
(30 < 45), в итоге будет создан прожектор с углом максимальной интенсивности 29° (29 =
30 – 1).

Чтобы завершить создание прожектора и увидеть результаты его освещения на чер-
теже, нажмите клавишу Enter.

 
Создание удаленного источника света

 
Исходя из названия удаленного источника света предполагается, что он расположен

на большом расстоянии и, следовательно, все лучи, исходящие от него, в пределах модели
идут параллельно. Кроме того, предполагается, что такой источник освещает все объекты
модели с одинаковой интенсивностью. При создании удаленного источника света его точные
координаты не указываются, необходимо лишь задать направление светового потока.

Обратите внимание на равномерно освещенную горизонтальную поверхность при
использовании удаленного источника света (рис. 12.5).

 

Рис. 12.5. Объекты, освещенные удаленным источником света
Если вы собираетесь создавать удаленный источник света, лучше отключить

фотометрические параметры. Для этого следует присвоить системной переменной
LIGHTINGUNITS значение 0.

Итак, чтобы создать новый удаленный источник света, введите в командную строку
DISTANTLIGHT, запустив на выполнение соответствующую команду.
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Как уже говорилось, сначала необходимо задать направление лучей, исходящих от уда-
ленного источника света. После вызова команды появится первый запрос:

Specify light direction FROM <0,0,0> or [Vector]:
Укажите координаты первой точки, от которой будет исходить свет. Не следует думать,

что это координаты удаленного источника света.
Появится следующий запрос:
Specify light direction TO <1,1,1>:
Задайте вторую точку, в направлении которой свет будет распространяться от первой

заданной точки. Заметим, что если координаты первой точки могли быть произвольными, то
именно расположение второй точки относительно первой определяет направление распро-
странения светового потока.

Программа выдаст следующий запрос:
Enter an option to change [Name/Intensity/Status/shadoW/Color/eXit] <eXit>:
Выберите один из параметров, чтобы более точно настроить удаленный источник

света, или нажмите на клавишу Enter, если хотите применить настройки, заданные по умол-
чанию.

 
Подключение солнца и неба

 
Примером удаленного источника света может служить солнце. Этот световой источник

присутствует во всех моделях. Чтобы быстро включить или отключить его, щелкните на
кнопке Sun Status (Состояние солнца), расположенной в группе Sun & Location (Солнце и
местоположение) на вкладке Render (Тонирование) ленты.

В природе освещенность объектов, находящихся под открытым небом, зависит не
только от солнца, но и от состояния воздуха (неба). Например, в ясную погоду свет
будет ярким, а при повышенной облачности может приобретать сероватые или голубова-
тые оттенки. Поэтому в AutoCAD имеется возможность подключить небо к освещенности
модели. Для этого необходимо щелкнуть на кнопке Sky Off (Выключить небо) в группе Sun
& Location (Солнце и местоположение) на вкладке Render (Тонирование) ленты и выбрать
из появившегося списка нужный вариант.

Как известно, освещенность настоящим солнцем зависит от географических коорди-
нат, в которых расположен объект, и от времени суток. Поэтому в AutoCAD также присут-
ствует возможность настройки солнечного освещения в зависимости от этих параметров.
Такой прием обычно используют для архитектурных и топографических моделей.

 
Географическое положение

 
Нажмите кнопку Set Location (Установить местоположение) в группе Sun & Location

(Солнце и местоположение) на вкладке Render (Тонирование) ленты. Откроется диалоговое
окно (рис. 12.6), предлагающее задать месторасположение модели одним из трех способов.
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Рис. 12.6. Настройка географического положения
• Импорт из внешнего файла с расширением KML или KMZ.
• Выбор координат в программе Google Earth.
• Использование диалогового окна Geographic Location (Географическое положение).
Если выбрать третий способ задания географических координат, на экране появится

окно Geographic Location (Географическое положение) (рис. 12.7). Оно предназначено для
указания географического расположения модели, что впоследствии отразится на освещении
модели солнцем.
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Рис. 12.7. Диалоговое окно Geographic Location (Географическое положение)
В полях Latitude (Широта) и Longitude (Долгота) указывают соответственно широту

и долготу, в которых расположена модель. В области North direction (Направление на север)
можно определить угол отклонения направления на север. По умолчанию направлению на
север соответствует направление оси Y. Кроме того, в соответствующих списках нужно
выбрать полушарие – North (Северное) или South (Южное), East (Восточное) или West
(Западное). Если долгота и широта точно не известны, можно выбрать город, рядом с кото-
рым расположена модель. Для этого щелкните на кнопке Use Map (Использовать карту),
чтобы открыть окно для выбора местоположения на карте (рис. 12.8).
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Рис. 12.8. Выбор местоположения на карте
Установите флажок Nearest Big City (Ближайший крупный город) и выберите нужный

город из списка Nearest City (Ближайший город). Можно также щелкнуть кнопкой мыши
на карте – при этом красный крестик переместится к крупному городу, ближайшему к ука-
занному месту. Имейте в виду, что список городов и рисунок, отображаемый на карте, зави-
сят от выбранного материка или страны в раскрывающемся списке Region (Регион). В зави-
симости от пункта, выбранного в списке Time Zone (Часовой пояс), автоматически будет
установлен часовой пояс.

 
Дата и время

 
Изменить дату и время можно с помощью инструментов Date (Дата) и Time (Время) в

группе Sun & Location (Солнце и местоположение) на вкладке Render (Тонирование) ленты.
При этом текущие дата и время отображаются рядом в соответствующих полях.
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Редактирование источников света

 
Конечно же, существующие источники света можно редактировать. Для этого предна-

значены специальные палитры, работать с которыми значительно удобнее, чем создавать
источники света в режиме командной строки.

Чтобы открыть палитру Lights In Model (Источники света в модели) (рис. 12.9), содер-
жащую список всех имеющихся на чертеже источников света, выполните команду меню
View → Render → Light → Light List (Вид → Тонирование → Освещение → Список источ-
ников света) или щелкните на кнопке Lights in Model (Источники света в модели)

 

в группе Lights (Освещение) на вкладке Render (Тонирование) ленты.
 

Рис. 12.9. Список источников света, имеющихся на чертеже
Непосредственно с этой палитры можно удалить ненужный источник света. Кроме

того, выбрав в контекстном меню источника команду Properties (Свойства), вы получите
доступ к одноименной палитре (рис. 12.10), на которой можно изменять все настройки
выбранного источника света. Эту палитру можно также открыть, выбрав соответствующий
пункт в контекстном меню выделенного источника света в пространстве модели.
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Рис. 12.10. Настройки точечного источника света
Здесь можно изменить все параметры, заданные при создании источника. Кроме того,

на палитре присутствуют дополнительные настройки отображения теней. Поэтому, если
вам привычнее работать с диалоговыми окнами, чем с командной строкой, можно сначала
создать источник света с параметрами по умолчанию, а затем без особых проблем изменить
его настройки, что займет меньше времени.

Возможно, вы обратили внимание на то, что в списке источников света отсутствует
такой источник, как солнце, хотя он присутствует на всех моделях. Чтобы получить доступ
к настройкам солнца и неба, выполните команду меню View → Render → Light → Sun
Properties (Вид → Тонирование → Освещение → Свойства солнца) или щелкните на кнопке
Sun Properties (Свойства солнца)
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в группе Sun & Location (Солнце и местоположение) на вкладке Render (Тонирование)
ленты. Откроется палитра Sun Properties (Свойства солнца) (рис. 12.11).

 

Рис. 12.11. Настройки солнца и неба
Эта палитра во многом схожа с предыдущей. Отличительной особенностью является

то, что здесь вы сможете изменить дату и время, а также просмотреть текущее географиче-
ское расположение модели.
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Работа с материалами

 
Материал является свойством объекта, отвечающим за его внешний вид: цвет, отража-

ющую способность, прозрачность и т. п.
По умолчанию в программе содержится библиотека с более чем 100 образцами мате-

риалов, основные из которых расположены на нескольких вкладках палитры Tool Palletes
(Инструментальные палитры) (рис. 12.12). Данная палитра появляется при нажатии сочета-
ния клавиш Ctrl+3 или автоматически при переключении в пространство 3D Modeling (Трех
мерное моделирование).

 

Рис. 12.12. Палитра, содержащая образцы материалов
Все основные средства работы с материалами расположены в группе Materials (Мате-

риалы) на вкладке Render (Тонирование) ленты, а также на палитре Materials (Материалы)
(рис. 12.13), которую можно вызвать щелчком на одноименной кнопке

 

в этой же группе ленты. Кроме того, можно ввести с клавиатуры команду MATERIALS.
 



А.  А.  Орлов.  «AutoCAD 2010»

372



А.  А.  Орлов.  «AutoCAD 2010»

373

Рис. 12.13. Палитра Materials (Материалы)
В верхней части палитры расположена область Available Materials in Drawing (Мате-

риалы, доступные на чертеже), где отображаются образцы материалов, подключенные к
чертежу. Ниже, в области Material Editor (Редактор материала), отображаются настройки
выбранного материала. По умолчанию на чертеже присутствует только один образец мате-
риала – Global (Глобальный). Однако после добавления на чертеж новых материалов все они
отображаются в этом окне. Чтобы выбрать какой-либо материал для дальнейшего редакти-
рования, щелкните на нем кнопкой мыши, при этом вокруг рисунка появится желтая рамка.

Представление образцов материалов в виде маленьких рисунков не слишком инфор-
мативно, но с помощью кнопки Toggle Display Mode (Переключить способ показа), распо-
ложенной в правом верхнем углу палитры, можно быстро растянуть образец материала на
все окно, что увеличит детальность его отображения (это удобно при редактировании).

Ниже области с образцами расположены две группы кнопок, позволяющие работать с
материалом. С левой стороны находятся три кнопки.

• По умолчанию образцы материалов отображаются в виде шара. Однако при желании
можно изменить форму образца с помощью кнопки Swatch Geometry (Геометрия образца)

 

которая позволяет выбрать один из трех вариантов: куб, цилиндр или шар. Напри-
мер, если в дальнейшем вы собираетесь применить материал к параллелепипеду, то лучше
выбрать куб, чтобы заранее увидеть, как будет выглядеть подобный объект с новым матери-
алом.

• После нажатия кнопки Checkered Underlay Off (Пестрое основание выключено)
 

(при этом она изменит свое название на Checkered Underlay On (Пестрое основание
включено)) выбранный образец материала отображается на пестром фоне, что очень удобно
для настройки непрозрачности материала.

• Кнопка Preview Swatch Lighting Model (Просмотр образца освещенности модели)
 

позволяет увидеть, как будет выглядеть материал при освещенности с одной или с
нескольких сторон.

Теперь рассмотрим кнопки, расположенные справа.
• Процесс создания нового материала достаточно прост. Щелчок на кнопке Create New

Material (Создать новый материал)
 

вызывает небольшое одноименное окно. Задав название и описание создаваемого
материала в полях Name (Имя) и Description (Описание) соответственно, нажмите кнопку
OK.

• Кнопка Purge from Drawing (Очистить чертеж)
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позволяет удалить выбранный материал с чертежа. Однако удалить можно только мате-
риалы, которые не присвоены объекту или слою. Кроме того, удалению не поддается мате-
риал Global (Глобальный).

• После нажатия кнопки Indicate Materials in Use (Указать используемые материалы)
 

изменяется отображение материалов, которые используются в чертеже, – в правом
нижнем углу чертежа появляется небольшой рисунок, свидетельствующий о том, что дан-
ный образец материала присвоен какому-либо объекту.

• Кнопка Apply Material to Objects (Применить материал к объектам)
 

позволяет назначить выбранный материал какому-либо объекту на чертеже. После
щелчка на ней указатель приобретает вид кисточки. Чтобы назначить материал каким-либо
объектам, выберите их, а затем нажмите клавишу Enter.

• Использование кнопки Remove Materials from Selected Objects (Удалить материалы
из выбранных объектов)

 

позволяет удалить материалы из объектов. Если быть более точным, то в результате
объектам будет присвоен материал Global (Глобальный), используемый по умолчанию.

 
Редактирование материала

 
Хотя в AutoCAD присутствует большая библиотека материалов, если вас по каким-

либо причинам полностью не устраивает ни один из них, можно создать собственный мате-
риал, взяв за основу готовый.

 
Основные настройки

 
Отредактировать основные свойства материала можно с помощью элементов управле-

ния, расположенных в области Material Editor (Редактор материала) палитры Materials
(Материалы) (см. рис. 12.13).

Наиболее радикально изменить внешний вид материала позволяет раскрывающийся
список Type (Тип), в котором выбирают один из четырех типов элементов. Для каждого
типа материала будут доступны свои настройки. Рассмотрим параметры для типа Realistic
(Реалистичный).

• Из списка Template (Шаблон) выбирают один из шаблонов материалов. По сути,
шаблон является сохраненным набором параметров, позволяющим создать иллюзию какого-
либо материала: стекла, металла, дерева и пр.

• Параметр Color (Цвет) позволяет назначить материалу цвет.
• С помощью ползунка Shininess (Блеск) можно настроить количество бликов на

поверхности. Чем меньше это значение (минимум – 0), тем больше бликов будет на поверх-
ности объекта. Если установить максимальное значение – 100 единиц, – на материале
вообще не будет бликов.

• Opacity (Непрозрачность) определяет области непрозрачности и прозрачности.
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• Чем больше различаются значения параметра Refraction index (Коэффициент пре-
ломления) для двух различных сред, тем сильнее будет преломляться свет на их границе.
Например, для воздуха коэффициент преломления можно принять равным 1. В итоге, если
смотреть на объекты сквозь материал с большим коэффициентом преломления (в программе
он изменяется от 1 до 3), то изображение за объектом получается сильно искаженным, что
легко заметить, включив в качестве фона пестрое основание.

• Чем больше значение параметра Translucency (Светопроницаемость), тем с меньшим
ослаблением проходит световой поток сквозь материал и тем лучше будут освещены объ-
екты, находящиеся за ним. Значение светопроницаемости задается в процентах: 0 – мате-
риал непрозрачен, 100 – прозрачен, насколько это возможно.

• Установив переключатель в положение Self-Illumination (Самосвечение) и передви-
нув соответствующий ползунок вправо, вы создадите светящийся материал. Объекты, кото-
рым он будет назначен, будут как бы испускать легкое свечение. Того же эффекта можно
добиться, установив переключатель в положение Luminance (Яркость), только в этом слу-
чае необходимо задать яркость свечения в кд/м2.

 
Карты наложения

 
На поверхность трехмерного объекта можно наложить двухмерный растровый рису-

нок, что позволяет создать иллюзию, например, плитки или дерева. Такие настройки произ-
водятся в области Maps (Карты). В AutoCAD доступны следующие типы карт наложения.

• Diffuse map (Рассеянная карта) – позволяет назначать материалу в качестве цвета
образец или текстуру. Это наиболее общий способ наложения текстур.

• Opacity map (Карта непрозрачности) – определяет области непрозрачности и про-
зрачности.

• Bump map (Карта микрорельефа) – создает на поверхности объекта рельефный
эффект или эффект барельефа. Использование карты микрорельефа значительно увеличи-
вает время расчета, но делает модели более реалистичными.

На один объект можно наложить несколько видов текстур. В принципе, проецирование
различных типов карт происходит по одному и тому же алгоритму.

Чтобы наложить карту на материал, сначала необходимо выбрать нужный вариант в
раскрывающемся списке Map type (Тип карты). Если выбран элемент Texture Map (Карта
текстуры), то, щелкнув на кнопке Select Image (Выбор изображения), вы сможете выбрать
рисунок, который будет наложен на материал. В AutoCAD по умолчанию присутствует
большое количество файлов, которые могут вам пригодиться. Однако при желании можно
использовать рисунок из другого файла, имеющего один из следующих форматов: TGA,
BMP, PNG, JPEG, TIFF, GIF или PCX. В раскрывающемся списке Map type (Тип карты)
можно также выбрать какой-либо другой элемент, имитирующий определенный материал.

 
Настройка масштаба

 
Масштаб карты наложения можно настроить в области Material Scalling & Tiling

(Масштаб и смещение материала).
Если в раскрывающемся списке Scale units (Единицы масштаба) выбрать элемент

None (Нет), то в полях ввода со счетчиком напротив раскрывающихся списков U Tile (U-
плитка) и V Tile (V-плитка) можно задать масштаб плитки в направлении оси U и V соответ-
ственно. Оси U и V, так же как и оси X и Y, взаимно перпендикулярны, но могут иметь произ-
вольное направление и начало координат. Если же в списке Scale units (Единицы масштаба)
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заданы какие-либо единицы измерения, то в полях ввода со счетчиком напротив раскрыва-
ющихся списков Weight (Ширина) и Height (Высота) указывают абсолютный размер плитки
в выбранных единицах измерения. При желании можно щелкнуть на изображении замочка

 

что позволит сохранить пропорции между осями.
Если в раскрывающемся списке выбрать элемент Tile (Плитка), то вся поверхность

объекта покроется растровым рисунком, как будто вымостится плиткой. При этом размеры
каждой ячейки, а следовательно, и их количество будут зависеть от настроек масштаба.

 
Предварительный просмотр

 
Наконец, в самой нижней области, Material Offset & Preview (Смещение и предвари-

тельный просмотр материала), можно увидеть поверхность материала и определить распо-
ложение растрового рисунка на ней.

Чтобы наблюдать за всеми изменениями в режиме реального времени, установите фла-
жок Auto-regen (Автоматическое обновление). В полях U Offset (U-смещение) и V Offset (V-
смещение) задают смещение начала координат вдоль осей U и V соответственно. Еще один
параметр, который может пригодиться, – угол поворота, который вводят в поле Rotation
(Поворот).

Выполнив все настройки, можно применять материал к объектам модели. Конечно, в
таком количестве настроек легко запутаться, однако, немного попрактиковавшись, вы смо-
жете создавать очень интересные поверхности.

 
Способы наложения карт

 
Возможны следующие четыре типа наложения картинки на объект, которые можно

выбрать в зависимости от основной формы объекта:
• Box (Параллелепипед) – тип проецирования, используемый по умолчанию;
• Planar (Плоское) – картинка проецируется без искажения;
• Spherical (Сферическое) – проецируемая текстура загибается по вертикали и гори-

зонтали;
• Cylindrical (Цилиндрическое) – для образования цилиндра загибаются горизонталь-

ные края.
Для того чтобы настроить тип наложения картинки на объект, введите команду

MATERIALMAP. Появится запрос:
Select an option [Box/Planar/Spherical/Cylindrical/copY mapping to/Reset

mapping]<Box>:
С помощью одного из параметров выберите тип проецирования карты наложения на

объект. Параметр Reset mapping возвращает координатам карты наложения значение, задан-
ное по умолчанию.

Совет
Для того чтобы быстро выбрать нужный тип проектирования

текстуры, не вызывая команду MATERIALMAP, щелкните на
соответствующей кнопке в группе Materials (Материалы) на
вкладке Render (Тонирование) ленты (рис. 12.14). В итоге команда
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MATERIALMAP запустится с одним из параметров: Box, Planar,
Spherical или Cylindrical.

 

Рис. 12.14. Список с вариантами наложения карт материала
Появится следующий запрос:
Select faces or objects:
Выберите объекты, для которых необходимо изменить способ наложения карты. Это

может быть твердотельная модель, грань или двухмерный объект с толщиной. Чтобы
перейти к следующему шагу, нажмите клавишу Enter. Появится приглашение:

Accept the mapping or [Move/Rotate/reseT/sWitch mapping mode]:
В ответ можно изменить положение карты наложения. Нажмите клавишу Enter, чтобы

завершить работу без дополнительных настроек, или выберите один из параметров.
• С помощью параметра Move можно перемещать карту наложения подобно тому, как

перемещаются объекты с помощью команды 3DMOVE.
• Выбор параметра Rotate позволяет вращать текстуру вокруг осиX, Yили Z. Вращение

изображения происходит точно так же, как при вызове команды 3DROTATE.
• Параметр reseT возвращает координатам карты наложения значения, принятые по

умолчанию.
• Параметр sWitch mapping mode позволяет вернуться к предыдущему шагу.
• Чтобы завершить настройку наложения карты, нажмите клавишу Enter.

 
Подключение материалов

 
После того как необходимые материалы созданы и отредактированы, можно подклю-

чить их к объектам. Для назначения материала какому-либо объекту достаточно переместить
нужный образец с палитры на выбранный объект. Однако можно назначить материал сразу
всем объектам, принадлежащим определенному слою.

Чтобы подключить материал к слою, щелкните на кнопке Attach by Layer (Подклю-
чить к слою) в группе Materials (Материалы) на вкладке Render (Тонирование) ленты.
Откроется диалоговое окно Material Attachment Options (Параметры подключения мате-
риала) (рис. 12.15).
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Рис. 12.15. Окно подключения материала к слою
Данное окно разделено на две части. Слева расположен список всех материалов, под-

ключенных к чертежу. В данном случае помимо основного материала Global (Глобальный)
присутствуют еще три образца. В списке справа перечислены все слои, созданные на чер-
теже, с подключенными к ним материалами. На рис. 12.15 видно, что слою 0 назначен мате-
риал по умолчанию.

Назначить новый материал слою достаточно просто. Перетащите нужный образец
материала из списка слева на выбранный слой, расположенный в списке справа. При этом ко
всем объектам, присутствующим на данном слое, также будет подключен данный материал.

Если вы ошибетесь и назначите материал объектам не того слоя, то, щелкнув на кнопке
Detach (Отделить), можно отменить изменение.

Нажмите кнопку OK, чтобы применить изменения и закрыть диалоговое окно.
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Тонирование

 
Когда предварительная стадия завершена, можно приступить к настройкам тонирова-

ния и непосредственно к самому процессу создания тонированного изображения.
 

Создание эффекта тумана
 

Интересным средством тонирования является туман. При его добавлении удаленные
объекты становятся менее различимы, чем близкие.

Чтобы создать эффект присутствия тумана, выполните команду View → Render →
Render Environment (Вид → Тонирование → Тонирование окружающей среды). Появится
одноименное диалоговое окно (рис. 12.16).

 

Рис. 12.16. Диалоговое окно настроек тонирования
Параметру Enable Fog (Включить туман) следует задать значение On (Включено),

чтобы при создании тонированного изображения появился туман. Цвет тумана выбирают с
помощью параметра Color (Цвет).

В этом же окне можно установить дальнюю и ближнюю дистанцию, где туман будет
начинаться и заканчиваться, а также задать относительную плотность тумана вблизи и вдали.
Выполнив все настройки, нажмите кнопку OK.

 
Настройки качества тонирования

 
Качество будущей тонированной картинки можно изменить с помощью раскрывающе-

гося списка в группе Render (Тонирование) на вкладке Render (Тонирование) ленты, где
можно выбрать один из пяти предустановленных наборов качества (рис. 12.17): Draft (Чер-
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новое), Low (Низкое), Medium (Среднее), Hight (Высокое) или Presentation (Представи-
тельское). Выбор качества зависит от результатов, которые необходимо получить, и от произ-
водительности компьютера, так как чем лучшее качество вы выберете, тем продолжительнее
будет процесс тонирования и реалистичнее получаемое изображение.

 

Рис. 12.17. Список с вариантами качества тонирования
Каждый режим тонирования скрывает за собой очень большой набор параметров,

которые можно изменить с помощью палитры Advanced Render Settings (Расширенные
настройки тонирования) (рис. 12.18), вызываемой нажатием одноименной кнопки

 

в группе Render (Тонирование) ленты или выбором соответствующего пункта в под-
меню View → Render (Вид → Тонирование).
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Рис. 12.18. Палитра с настройками качества тонирования
В принципе, вам должно хватить пяти стандартных предустановленных наборов каче-

ства тонирования, которые предоставляет программа. Если же понадобится часто создавать
тонированные изображения с нестандартными настройками, то лучше всего подготовить
собственный набор на основе одного из стандартных и затем изменить в нем необходимые
настройки.

Чтобы создать новый набор параметров тонирования, вызовите диалоговое окно
Render Presets Manager (Менеджер предустановок тонирования) (рис. 12.19), набрав
команду renderpresets или выбрав пункт Manage Render Presets (Управление предуста-
новками тонирования) из раскрывающегося списка в группе Render (Тонирование) (см.
рис. 12.17).
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Рис. 12.19. Менеджер предустановок тонирования
В списке слева перечислены все существующие предустановки настроек тонирования.

Правее расположен список параметров выбранной предустановки, который также отобра-
жается на палитре Advanced Render Settings (Расширенные настройки тонирования) (см.
рис. 12.18).

Кнопка Set Current (Сделать текущим) позволяет назначить для использования
выбранный набор параметров. Как несложно догадаться, кнопка Delete (Удалить) удаляет
один из наборов качества. Правда, пять стандартных наборов не могут быть удалены.

Самое главное, что можно сделать в этом окне, – это создать новый набор параметров.
Сначала в списке слева выберите один из существующих наборов, на базе которого плани-
руется создать новый, и щелкните на кнопке Create Copy (Создать копию). Появится окно
Copy Render Preset (Копировать предустановки тонирования).

Введите имя и описание нового набора параметров в поля Name (Имя) и Description
(Описание) соответственно. Щелкните на кнопке OK, чтобы закрыть окно.

Наконец, изменив параметры, которые вас не устраивают, можете закрыть диалоговое
окно Render Presets Manager (Менеджер предустановок тонирования).

 
Завершающая стадия

 
Если вы добрались до этого шага, значит, все настройки уже выполнены и теперь

можно легко создать тонированное изображение.
 

Тонирование области
 

Сам процесс тонирования требует от компьютера больших ресурсов и может занять
значительное время, особенно в отношении больших и сложных моделей. Однако суще-
ствует возможность создать тонированное изображение не всей модели, а небольшой
области на чертеже, например, чтобы быстро увидеть результаты изменения каких-либо
настроек.
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Чтобы тонировать небольшую область, щелкните на кнопке Render Region (Тони-
ровать область) в группе Render (Тонирование) ленты, запустив тем самым команду
RENDERCROP. Появится запрос:

Pick crop window to render:
В ответ задайте положение первой точки. Появится еще один запрос:
please enter the second point:
Укажите противоположный угол прямоугольной области тонирования. Программа

быстро визуализирует изображение.
 

Тонирование в отдельном окне
 

Запустите команду RENDER, щелкнув на одноименной кнопке в группе Render (Тони-
рование) ленты или выполнив команду View → Render → Render (Вид → Тонирование →
Тонирование).

На экране появится окно Render (Тонирование) (рис. 12.20) с результатом тонирования
модели. Прежде чем можно будет увидеть все изображение, скорее всего, придется подо-
ждать: время, затраченное на визуализацию, может быть достаточно большим и зависит от
сложности модели, настроек качества тонирования и, конечно же, производительности ком-
пьютера.

 

Рис. 12.20. Окно Render (Тонирование)
Окно Render (Тонирование) по умолчанию разделено на три области: непосредственно

само окно, в котором отображается тонированная модель, Status Bar (Строка состояния), где
находится список всех тонированных изображений, и область статистики (Statistics Pane),
расположенная справа. В последней приводятся статистические данные процесса тониро-
вания.
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Сохранение тонированного изображения

 
Полученное при тонировании изображение можно сохранить. Впоследствии его

можно открыть в другой программе и распечатать. Рассмотрим процесс сохранения тониро-
ванного изображения.

Если тонирование осуществлялось в видовом экране, то выполните команду Tools →
Display Image → Save (Сервис → Вывод изображения → Сохранить), а если в отдельном
окне, то выберите File → Save (Файл → Сохранить). В любом случае откроется диалоговое
окно Render Output File (Выходной файл тонирования).

Данное окно предоставляет стандартные возможности по сохранению файла. Отметим
лишь, что в раскрывающемся списке Files of type (Тип файлов) необходимо выбрать один из
возможных форматов: BMP, PCX, TGA, TIF, JPEG или PNG. Чтобы завершить сохранение
файла, нажмите кнопку Save (Сохранить).

Совет
Чтобы открыть окно Render (Тонирование), в котором

отображаются результаты последнего тонирования изображения,
щелкните на кнопке Render Window (Окно тонирования) в группе
Render (Тонирование) ленты.
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Резюме

 
Итак, представим общий алгоритм создания тонированных изображений.
1. Создайте и настройте нужные источники света.
2. Подключите материалы к объектам чертежа. При желании можно создать новые

материалы или отредактировать существующие.
3. Настройте параметры тонирования. При необходимости можно добавить эффект

тумана.
4. Выполните тонирование модели и сохраните полученное изображение.
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